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Welcome Welcome

Welcome

This help provides in-depth information on how to use the SPECMON3 and SPECMONG6 Real-Time
Spectrum Analyzers. This help contains the most complete descriptions of how to use the analyzer. For

a shorter introduction to the Signal Analyzer, refer to the SPECMON3 Real Time Signal Analyzer and
SPECMONG Series Real-Time Signal Analyzer Quick Start User Manual. To see tutorial examples of how
to use your analyzer to take measurements in different application areas, refer to the SPECMON3 Real
Time Spectrum Analyzer and SPECMONG Real-Time Spectrum Analyzer Application Examples Reference.
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About Tektronix Analyzers Your Tektronix Analyzer

Your Tektronix Analyzer

The SPECMON3 and SPECMONG6 Analyzers will help you troubleshoot the toughest transient
interference issues by eliminating the guess work when using conventional instrument. Built-in mapping
supports both manual and automatic “drive test”. The revolutionary DPX display offers an intuitive

live color view of signal transients changing over time in the frequency domain, giving you immediate
confidence in the stability of your design, or instantly displaying a fault when it occurs. This live display
of transients is impossible with other signal analyzers. Once a problem is discovered with DPX, the
Tektronix Analyzers can be set to trigger on the event, capture a continuous time record of changing RF
events and perform time-correlated analysis in all domains. You get the functionality of a wideband vector
signal analyzer, a spectrum analyzer and the unique trigger-capture-analyze capability of a Real-Time
Analyzer — all in a single package.

Discover

B DPX Minimum Event Time Capture: 3.7 us (Option 110), 3.7 us (Option 85), 3.9 us (Option 40),
4 us (standard).

Trigger

®  Patented DPX Density Trigger (Option 200), Frequency Mask Trigger (Option 52) and advanced
triggering allows signal capturing with as short as 3.7 ps in frequency domain and 9.1 ns in time
domain, best in its class

Capture

B All signals within a 110 MHz bandwidth span are captured into memory (Option 110 only, 85 MHz
acquisition bandwidth with Option 85, 40 MHz acquisition bandwidth with Option 40, and 25 MHz
standard)

Analyze

B Extensive time-correlated multi-domain displays connect problems in time, frequency, phase and
amplitude for quicker understanding of cause and effect when troubleshooting.

B Power measurements and signal statistics help you characterize components and systems: ACLR,
Multi-Carrier ACLR, Power vs. Time, CCDF, Phase Noise, and Spurious.
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About Tektronix Analyzers Product Software

Advanced Measurement Suite (Option 20): Pulse measurements including rise time, pulse width, duty,
ripple, power, frequency and phase provide deep insight into pulse train behavior.

General Purpose Digital Modulation Analysis (Option 21): Provides vector signal analyzer
functionality.

Product Software

The instrument includes the following software:

SPECMON System Software: The SPECMON product software runs on Windows 7. As with
standard Windows 7 installations, you can install other compatible applications, but the installation
and use of non-Tektronix software is not supported by Tektronix. If you need to reinstall the operating
system, follow the procedure in the Restoring the Operating System chapter in the SPECMON3
Real-Time Spectrum Analyzer and SPECMONG6 Real-Time Spectrum Analyzer Quick Start User
Manual (Tektronix part number 071-3064-XX, English). You can download a PDF version of the
Quick Start User Manual at www.tektronix.com/manuals. Do not substitute any version of Windows
that is not specifically provided by Tektronix for use with your instrument.

Product Software: The product software is the instrument application. It provides the user interface
(UI) and all other instrument control functions. You can minimize or even exit/restart the instrument
application as your needs dictate.

Occasionally new versions of software for your instrument may become available at our Web site. Visit
www.tektronix.com/software for information.

Software and Hardware Upgrades

Tektronix may offer software or hardware upgrade kits for this instrument. Contact your local Tektronix
distributor or sales office for more information.

Standard Accessories

The standard accessories for the RSA6100B Series and RSA5100A Series instruments are shown below.
For the latest information on available accessories, see the Tektronix Web site .

Quick Start User Manual

English - Option L0, Tektronix part number 071-3064-XX

Japanese - Option L5, Tektronix part number 071-3068-XX

Russian, Option L10, Tektronix part number 071-3070-XX
Simplified Chinese - Option L7, Tektronix part number 071-3066-XX
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About Tektronix Analyzers Standard Accessories

Applications Instructions

B English — Tektronix part number 071-3065-XX

®  Simplified Chinese - Option L7, Tektronix part number 071-3067-XX
B Japanese - Option L5, Tektronix part number 071-3069-XX

B Russian, Option L10, Tektronix part number 071-3071-XX

Product Documentation CD-ROM

The Product Documentation CD-ROM contains PDF versions of all printed manuals. The Product
Documentation CD-ROM also contains the following manuals, some of which are available only in
PDF format:

B SPECMON3 Real-Time Spectrum Analyzer and SPECMONG6 Real-Time Spectrum Analyzer
Declassification and Security Instructions manual PDF, Tektronix part number 077-0754-XX

m  RSAS5100A Series and SPECMON Series Service Manual PDF, Tektronix part number 077-0755-XX

B SPECMONS3 Real-Time Spectrum Analyzer and SPECMONG6 Real-Time Spectrum Analyzer
Programmer Manual PDF, Tektronix part number 077-0741-XX

®  SPECMONS3 Real-Time Spectrum Analyzer and SPECMONG6 Real-Time Spectrum Analyzer
Specifications and Performance Verification PDF, Tektronix part number 077-0742-XX

®  Other related materials

NOTE. To check for updates to the instrument documentation, browse to www.tektronix.com/manuals
and search by your instrument's model number.

Important Documents Folder

B Certificate of Calibration documenting NIST traceability, 2540-1 compliance, and ISO9001 registration

Power Cords

®  North America - Option A0, Tektronix part number 161-0104-00)

B Universal Euro - Option A1, Tektronix part number 161-0104-06

m  United Kingdom - Option A2, Tektronix part number 161-0104-07

B Australia - Option A3, Tektronix part number 161-0104-05

B 240V North America - Option A4, Tektronix part number 161-0104-08
m  Switzerland - Option AS, Tektronix part number 161-0167-00

B Japan - Option A6, Tektronix part number 161-A005-00

®  China - Option A10, Tektronix part number 161-0306-00
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About Tektronix Analyzers Recommended Accessories

®  [ndia - Option A1l, Tektronix part number 161-0324-00

B No power cord or AC adapter - Option A99
Optical Wheel Mouse

Product Software CD

Recommended Accessories

The recommended accessories for the SPECMON Series instruments are shown in the following table. For
the latest information on available accessories, see the Tektronix Web site .

Item Ordering part number
Additional Removable Hard Drive (Windows 7 and 065-0924-00
instrument software installed)

Transit Case 016-2026-XX
Rackmount Installation Kit RSA56KR

Additional Quick Start User Manual (paper) 071-3064-XX
Additional Documents CD (all manuals in PDF format) 063-4468-XX
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About Tektronix Analyzers Options

Options

To view a listing of the software options installed on your instrument, select Help > About Your
Tektronix Real-Time Analyzer. There is a label on the rear-panel of the instrument that lists installed
hardware options.

Options can be added to your instrument. For the latest information on available option upgrades, see
the Tektronix Web site.

Documentation

In addition to the help, the following documents are available:

Quick Start User Manual (071-3064-XX - English). The Quick Start User Manual has information
about installing and operating your instrument. The Quick Start User Manual is also available in
Simplified Chinese (071-3066-XX), Japanese (071-3068-XX), and Russian (071-3070-XX).

Application Examples Reference (071-3065-XX). The Application Examples Reference provides
examples of specific application problems and how to solve those problems using a SPECMON
Series Signal Analyzer. The Application Examples Reference is also available in Simplified Chinese
(071-3067-XX), Japanese (071-3069-XX), and Russian (071-3071-XX).

Programmer Manual (077-0741-XX). The Programmer Manual is provided as a printable PDF file,
which is located on the Documents CD. See the Documents CD-ROM for installation information.

Service Manual (RSA5100A Series and SPECMON Series: 077-0755-XX). The Service manual is
provided as a printable PDF file, which is located on the Documents CD. See the Documents CD-ROM
for installation information. The Service manual includes procedures to service the instrument to the
module level and restore the operating system.

Specifications and Performance Verification Technical Reference Manual (SPECMON Series:
077-0742-XX). This is a PDF-only manual that includes both the specifications and the performance
verification procedure. It is located on the Documents CD.

Declassification and Security Instructions (SPECMON Series: 077-0754-XX) This document helps
customers with data security concerns to sanitize or remove memory devices from the instrument.
It is located on the Documents CD.

The most recent versions of the product documentation, in PDF format, can be downloaded from
www.tektronix.com/manuals. You can find the manuals by searching on the product name.

Other Documentation

Your instrument includes supplemental information on CD-ROM:

Documents CD (Tektronix part number 063-4468-XX)
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Orientation Front Panel Connectors

Front Panel Connectors

q )
(S

[_eo

L] ®_®
Item Connector Description
1 Trig Out Trigger output connector. 50 Q, BNC, High > 2.0 V, Low < 0.4V, (output
current 1 mA).

2 Trig In External Trigger input connector, 2.5 V to +2.5 V (user settable).
3 USB 2.0 USB 2.0 connector.
4 USB 2.0 USB 2.0 connector.
5 RF Input RF input connector 50 Q.

Front-Panel Controls

Settings @
| TN N
Freq { Acquire

®-|—®
o e

0513044
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Orientation

10

Reference

ltem

Function

Front-Panel Controls

Menu Equivalent

1

Media

DVD-RW or removable hard disk
drive.

Displays

Opens the Displays dialog box
enabling you to select which
displays to open.

Setup > Displays

Settings

Openslcloses the Settings control
panel for the selected display.

Setup > Settings

Trigger

Opens/closes the Trigger control
panel. On the RSA5100A Series,
this button lights when the trigger
mode is set to Triggered.

Setup > Trigger

Acquire

Opens/closes the Acquire control
panel.

Setup > Acquire

Analysis

Opens/closes the Analysis control
panel.

Setup > Analysis

Freq

Press to adjust the measurement
frequency.

Setup > Analysis > Frequency

Span (Spectrum)

Press to adjust the span or press
and hold to display the Freq & Span
control panel for the General Signal
Viewing displays.

Amplitude

Opens/closes the Amplitude control
panel.

Setup > Amplitude

10

BW (Spectrum)

Press to adjust the bandwidth or
press and hold to display the BW
control panel for the General Signal
Viewing displays.

,e.s\
a2 ) N 19
G ) ‘

@

Q)

0519-045
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Orientation Front-Panel Controls

Reference Item Function Menu Equivalent

" Run/Stop Starts and stops acquisitions. Run > Start Run > Stop

12 Peak (Markers Moves the active marker to the Markers > Peak
section) maximum peak of the trace in the

selected display. If markers are
turned off, the marker reference (MR)
will appear at the maximum peak.

13 Select (Markers Selects the next marker. If markers
section) are turned off, the MR marker (marker
reference) will appear.
14 Define (Markers Opens the Markers control panel.
section) If markers are turned off, the MR

marker (reference) will appear.

15 Control knob Changes values in numeric and list
controls. Pressing the knob (clicking
it) is the same as pressing the Enter
key on a keyboard.

16 Arrow keys Move the Markers. The Up arrow
moves the selected marker to the
next highest peak. The down arrow
moves the selected marker to the
next lower peak value. The right and
left arrows move the selected marker
to the next peak.

17 Increment/decre- Increments or decrements the
ment keys selected value
18 Delete, (Markers Deletes the selected marker
section)
19 Add, (Markers Add a marker to the selected trace
section)
20 Replay Replays the current acquisition record
21 Single Sets the Run mode to Single
Sequence
n Bksp

@ 7 (8 (9) @) (=)
(4 (5 (o) (e
) (2 (3D G

x1/dBx " Enter

Co0) () (o) (He)! (et

0519-046
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Orientation Front-Panel Controls

Reference Item Function Menu Equivalent

22 Keypad Enters values in numeric controls.

23 Enter Completes data entry in controls.
Same as pressing the Enter key on
an external keyboard.

Recall Help
) < Touch Screen
@ Save off
j Presets
D ( DPX Preset
0519-043

Reference Item Function Menu Equivalent

24 Recall Opens the Recall dialog box. File > Recall

25 Save Opens the Save As dialog box. File > Save As

26 Touch Screen Off Turns the touch screen on and off. It
is off when lighted.

27 Help Displays the help. Help > Online Manual

28 Applic Sets the instrument to the selected Setup > More Presets > Application
Application Preset values.

29 DPX Sets the instrument to the selected Setup > More Presets > DPX
DPX Preset values.

30 User Sets the instrument to the selected Setup > More Presets > User
User Preset values.

31 Preset Returns the instrument to the default Setup > Preset
or preset values.
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Orientation Touch Screen

Touch Screen

You can use touch to control the instrument in addition to the front-panel controls, mouse, or extended
keyboard. Generally, touch can be used anywhere that click is mentioned in this help.

To disable the touch screen, push the front-panel Touch Screen Off button. When the touch screen is off,
the button is lighted. You can still access the on-screen controls with a mouse or keyboard.

You can adjust the touch screen operation to your personal preferences. To adjust the touch screen settings,
from Windows, select Start > Control Panel > Touch Screen Calibrator.

NOTE. If the instrument is powered on in Windows Safe Mode, the touch screen is inoperative. You will
need to use a mouse or keyboard to restore normal operation.

Touch-Screen Actions

You can use the touch screen to change marker settings and how waveforms are displayed by using the
Touch-screen Actions menu.

E Select
f

Span Zoom

+* CFPan
& 1 Zoom

Y
% pan
\

Reset scale

Marker to peak
Mext peak 3

Add marker
Delete marker

All markers off

Trigger On This

To use the Touch-screen Actions menu, touch the display in a graph area and hold for one second, then

remove your finger. You can also use a mouse to display the Touch-screen Action menu by clicking
the right mouse button.
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Orientation

Icon

Menu

Touch-Screen Actions

Description

k

Select

Selects markers and adjusts their position.

o]

Span Zoom

Zooms the graph area about the selected point. Touch the graph
display at a point of interest and drag to increase or decrease the
span about the point of interest. Span Zoom adjusts the span
control and can affect the acquisition bandwidth.

CF Pan

Adjusts the Center Frequency according to horizontal movement.

Zoom

Adjusts horizontal and vertical scale of the graph. The first
direction with enough movement becomes the primary scale of
adjustment. Adjustment in the secondary direction does not occur
until a threshold of 30 pixels of movement is crossed.

Dragging to the left or down zooms out and displays a smaller
waveform (increases the scale value). Dragging to the right or up
zooms in and displays a larger waveform (decreases the scale
value).

Pan

Adjusts horizontal and vertical position of the waveform. The first

direction with enough movement becomes the primary direction of
movement. Movement in the secondary direction does not occur

until a threshold of 30 pixels of movement is crossed.

Reset Scale

Returns the horizontal and vertical scale and position settings
to their default values.

Marker to peak

Moves the selected marker to the highest peak. If no marker is
turned on, this control automatically adds a marker.

Next Peak

Moves the selected marker to the next peak. Choices are Next
left, Next right, Next lower (absolute), and Next higher (absolute).

Add marker

Defines a new marker located at the horizontal center of the graph.

Delete marker

Removes the last added marker.

All markers off

Removes all markers.

Trigger On This

Use to visually define trigger parameters in the DPX display
(present only in the DPX Spectrum display).

Touch-Screen Menu for Spurious Display

The Touch-screen actions menu in the Spurious display has some minor changes compared to the standard

version used in other displays.

14
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Orientation Elements of the Display
IE Select
'@\ Zoam
Y "I,i' Fan
Reset scale
Marker to peak
Mext peak »
Add marker
Delete marker
All markers off
Single-range
Marker -= Sel Spur
Icon Menu Description
- Single-range Changes the current multi-range display to a single range display.
The displayed range is the range in which you display the
touchscreen-actions menu. Selecting Single-range from the menu
is equivalent to selecting Single on the Settings > Parameters tab.
- Multi-range Changes the current single-range display to a multi-range display.

Selecting Multi-range from the menu is equivalent to selecting
Multi on the Settings > Parameters tab.

Marker -> Sel Spur

Moves the selected marker to the selected spur.

Elements of the Display

The main areas of the application window are shown in the following figure.
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Orientation Elements of the Display

Menu bar Trace confrols and readouts
Title bar Application toolbar
B Tek RAS10L. - fm fast frame tig - | Spectrurn] == ==
File  View Run Replay @iarkers Setup  Tools M ndow  Help x
B & & T % % 14| Frequency 500000 MHz € Reflev: 10.00 dBm Freset B Replay | < | = Run
Replay toolbar —®zepisy: scqan <14 4@ b b B D Selectdll Select.. B 12 9/21/2011 11:27:36.27
# Tacel [show +Peak Normal [Gear]
© 10,00 dBrm
» dB/div:
10.0dB
o REW:
. 500 Hz
Vertical scale vew:
controls and \ | \ L ‘H ' l, \ i‘ \ '
other H * H F w u Fi
measurement ‘ N ﬁ I n
controls and l |
readouts ‘ f\k
-90.00 dem 4 il }F ‘
Autosca|e | Autgscale | © CFi 500.000 MHe & Span: 500 kHz
markers [ Defne |« MR @ |Frequency = |S00 MHz Tocenter | [ peak | [«] | %] [#] [#] [Taoke |[x |
Stopped ACq BW: 110,00 MHz, Acg Length: 2,167 us Real Tine  Free Run RefiInt At =an: 10dB Preamp
) 0518015
Marker toolbar Horizontal scale controls
Status bar Measurements area

Specific elements of the display are shown in the following figure.
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Elements of the Display

Orientation

@Q@@@@@@@@ OR0 @jg

_L ek RS# 5100A [Cha 1nel PJwer m:l M"
B/ ey TS —— e ) — [ ]

e — e

File | View/ Pun / Reriay ~ Mz7ers  Setup  Tooly Window  Help
=) o & T = & 14, | Frequency: 1.50000 GHz RefLev: 0.00 dBm Preset! | B Replay - | ) Run -
< 12 1010
¢ 0.00 dBm
o dB/div:
10.0 dB
LA1 UA1
-66.91 dB -66.04 dB
i
I"ul' I|I |||] |I '| m
V] .
\ |||||Ir' |I | p|||| ||'“"I
-100.00 dBm i
o Pos: 1.50000 GHz o Scale: 5.16 MHz
1
Avg Channel | ch  Offset Lower Upper
Power (Main): Al 2.000 MH 66.91 dB 66.04 dB
-3.83 dBm . ze o8-
Stopped Acg BW: 20.00 MHz, Acq Length: 99.360 us Real Time Free Run Ref: Int Atten: 15 dB
2838010
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Ref Setting Description

number

1 Displays Opens the Select Displays dialog box so that you can select measurement
displays.

Markers Opens or closes the Marker toolbar at the bottom of the window.
Settings Opens the Settings control panel for the selected display. Each display has
its own control panel.
Trigger Opens the Trigger control panel so that you can define the trigger settings.
Acquire Opens the Acquire control panel so that you can define the acquisition settings.
Analysis Opens the Analysis control panel so that you can define the analysis settings
such as frequency, analysis time, and units.

7 Frequency Displays the frequency at which measurements are made. For spectrum
displays, this is called “Center Frequency”. To change the value, click the
text and use the front panel knob to dial in a frequency. You can also enter
a frequency with the front panel keypad or use the front panel up and down
buttons.

8 Reference Level Displays the reference level. To change the value, click the text and enter a
number from the keypad or use the front panel up and down buttons.

9 Amplitude Opens the Amplitude control panel so that you can define the Reference Level,
configure internal attenuation, and enable/disable the (optional) Preamplifier.

10 Replay Runs a new measurement cycle on the last acquisition data record using any
new settings.

" Run Starts and stops data acquisitions. When the instrument is acquiring data, the
button label has green lettering. When stopped, the label has black lettering.
You can specify the run conditions in the Run menu. For example, if you
select Single Sequence in the Run menu, when you click the Run button,
the instrument will run a single measurement cycle and stop. If you select
Continuous, the instrument will run continuously until you stop the acquisitions.

12 Check mark indicator The check mark indicator in the upper, left-hand corner of the display indicates
the display for which the acquisition hardware is optimized.

13 Recall Displays the Open window in order to recall setup files, acquisition data files,
or trace files.

14 Save Opens the Save As dialog in order to save setup files, pictures (screen
captures), acquisition data files, or export measurement settings or acquisition
data.

15 Preset Recalls the Preset (Main) (see page 402) preset.
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Orientation Rear-Panel Connectors

Rear-Panel Connectors

6 -
- @ )
. 13) (14 J
Ref number Connector, Description
1 AC Input, main power connector
2 GPIB
4,5 Real Time IQ Out (Option 55)
6 +28 VDC output, switched
7 Microphone in; Headphone, audio output; and Line In connectors
8 External Trigger 2 Input
9 COM 2, serial port for connecting peripherals
10 VGA external monitor output (resolution not limited to VGA)
1 PS2 Keyboard input
12 USB 2.0 ports for mouse and other peripherals (printers, external hard disks)
13 Ref Out, reference frequency output
14 Ref In, reference frequency input
15 LAN, Ethernet network connector

Setting Up Network Connections

Because the instrument is based on Windows, you configure network connections for the instrument the
same way you would for any PC based on Windows. See Help and Support in the Windows Start menu
to access the Windows Help System for information on setting up network connections.
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20 SPECMON3 & SPECMONG Printable Help



Operating Your Instrument Restoring Default Settings

Restoring Default Settings

To restore the instrument to its factory default settings:
m  Select File > Preset (Main) to return the analyzer to its default settings.

Preset resets all settings and clears all acquisition data. Settings and acquisition data that have not been
saved will be lost.

Running Alignments

Alignments are adjustment procedures. Alignments are run by the instrument using internal reference
signals and measurements and do not require any external equipment or connections.

There are two settings for Alignments:
B Automatically align as needed
®  Run alignments only when the Align Now button is pressed

If Automatically align as needed is selected, alignments run whenever the signal analyzer detects a
sufficient change in ambient conditions to warrant an alignment.

If Run alignments only when "Align Now" button is pressed is selected, the signal analyzer never runs
an alignment unless you manually initiate an alignment using the Align Now button.

NOTE. There are a few critical adjustments that must run occasionally even if Automatically align is
not enabled.

Alignment Status

When the signal analyzer needs to run an alignment, it displays a message on screen. If no message is
displayed, you can assume that the signal analyzer is properly aligned.

NOTE. If you must use the instrument before it has completed its 20-minute warm-up period, you should
perform an alignment to ensure accurate measurements.

Initiating an Alignment
1. Seclect Setup > Alignments.
2. Select the Align Now button.

The signal analyzer will run an alignment procedure. Status messages are displayed while the alignment
procedure is running. If the instrument fails the alignment procedure, an error message will be displayed.
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If the instrument fails an alignment, run Diagnostics (Tools > Diagnostics) to see if you can determine
why the alignment failed.

NOTE. While an alignment is running, both the IF and IQ outputs are disabled.

Alignments during warm-up. During the 20-minute warm-up period, the signal analyzer will use the
alignment data generated during the previous use of the instrument as it warms to operating temperature
(if Auto mode is selected). During the specified period for warm-up, the instrument performance is not
warranted.

Alignments during normal operation. Once the signal analyzer reaches operating temperature +3 degrees C
(as detected inside the instrument), an alignment will be run. If an alignment becomes necessary during a
measurement cycle (if Auto mode is selected), the measurement is aborted and an alignment procedure is
run. Once an alignment procedure is completed, the measurement cycle restarts.

NOTE. The first time the instrument runs after a software upgrade (or reinstall), the instrument will
perform a full alignment after the 20—minute warm-up period. This alignment cannot be aborted and it
occurs even if alignments are set to run only when manually initiated.

Alignments Are Not Calibrations

Alignments are adjustment procedures run by the instrument using internal reference signals and
measurements. Calibrations can only be performed at a Tektronix service center and require the use of
traceable test equipment (signal sources and measuring equipment) to verify the performance of the
instrument.

Presets

22

Menu Bar: File > More presets > Preset options
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Application Preset Description

Modulation Analysis The Modulation Analysis setup application preset provides you with the most common
displays used during modulation analysis. Only present when Option 21 is installed.

Phase Noise The Phase Noise application preset opens the Phase Noise display, and makes changes

to the default parameters to settings better optimized for phase noise analysis. Only
present when Option 11 is installed.

Pulse Analysis The Pulse Analysis application preset provides you with the most common displays used
during pulse analysis, and makes changes to the default parameters to settings better
optimized for pulsed signal analysis. Only present when Option 20 is installed.

Spectrum Analysis The Spectrum Analysis application preset provide you with the settings commonly used
for general purpose spectrum analysis.

Spur Search Multi Zone The Spur Search application preset configures the instrument to show the Spurious

9k-1GHz display with the frequency range set to 9 kHz to 1 GHz.

Time-Frequency Analysis The Time-Frequency preset configures the instrument with settings suited to analyzing
signal behavior over time.

DPX Preset Description

Open the DPX display The Open the DPX display opens the DPX display without closing existing displays.

Real Time The DPX Real Time Preset displays the DPX Spectrum display with the center frequency

set to 1.5 GHz and the span set to the maximum available real-time bandwidth.

Swept The DPX Swept Preset displays the DPX Spectrum display with the center frequency
set to 1.5 GHz and the span set to 3 GHz.

Zero Span (instruments with The DPX Zero Span Preset displays the DPX Zero Span display with the center

Option 200) frequency set to 1.5 GHz and the sweep set to 1 ms.
Main Presets Description
Current This Preset sets the instrument to display a Spectrum display with settings matched

to show a Spectrum display with settings appropriate for typical spectrum analysis
tasks. This preset was updated from the original factory preset with version 2.4 of the
instrument software.

Original This Preset is the original factory preset used with software versions 1.0 through 2.3.
This version of the factory preset is included to allow users to maintain compatibility with
existing remote control software.

User Description

User Preset 1 This Preset is provided as a example for you to create your own Presets. This preset
displays the Spectrum, Spectrogram, Frequency vs Time, and Time Overview displays.

User Preset 2 This Preset is provided as a example for you to create your own Presets. This preset
displays the Spurious display configured to test for Spurious signals across four ranges.

Modulation Analysis
The Modulation Analysis application preset opens the following displays:

®  Signal Quality: Shows a summary of modulation quality measurements (EVM, rho, Magnitude
Error, Phase Error, and others).

m  Constellation: Shows the I and Q information of the signal analyzed in an I vs. Q format.

B Symbol Table: Shows the demodulated symbols of the signal.
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24

To use the Modulation Analysis preset (assuming that Modulation Analysis is the selected preset on the list
of Application Presets and Preset action is set to Recall selected preset):

1. Select File > More presets > Application.

2. Set the measurement frequency using the front-panel knob or keypad. Your signal should appear in
the DPX display.

3. Set the reference level so that the peak of your signal is about 10 dB below the top of the DPX display.

4. Set the modulation parameters for your signal. This includes the Modulation Type, Symbol Rate,
Measurement Filter, Reference Filter and Filter Parameter. All of these settings are accessed by
pressing the Settings button.

For most modulated signals, the Modulation Analysis application preset should present a stable display of
modulation quality. Additional displays can be added by using the Displays button, and other settings can
be modified to better align with your signal requirements.

Phase Noise

The Phase Noise application preset opens the Phase Noise display.

Pulse Analysis

The Pulse Analysis application preset opens the following displays:

=  DPX: The DPX display is opened with the maximum available span.
B Time Overview: Shows amplitude vs. time over the analysis period.

m  Pulse Trace: Shows the trace of the selected pulse and a readout of the selected measurement from
the pulse table.

B Pulse Measurement Table: This shows a full report for the user-selected pulse measurements.

You can make a selected pulse and measurement appear in the Pulse Trace display by highlighting it in the
Pulse Measurement Table. Key pulse-related parameters that are set by the Pulse Analysis application
preset are:

B Measurement Filter: No Filter.

B Measurement Bandwidth: This is set to the maximum real-time bandwidth of the instrument (25 MHz
in a SPECMON3, 85 MHz in SPECMONG®6, and 110 MHz in instruments with Option 110). Note:
The label on the “Measurement Bandwidth” setting is just “Bandwidth”. Like the main instrument
Preset command and the other application presets, the Pulse Analysis application preset also sets
most other instrument controls to default values.

B Analysis Period: This is set to 2 ms to ensure a good probability of catching several pulses for
typical signals.

To use the Pulse Analysis preset (assuming that Pulse Analysis is the selected preset on the list of
Application Presets and Preset action is set to Recall selected preset):
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1. Select File > More presets > Application. Click OK.
2. Set the Center Frequency control to the carrier frequency of your pulsed signal.

3. Set the Reference Level to place the peak of the pulse signal approximately 0-10 dB down from
the top of the Time Overview display.

You may need to trigger on the signal to get a more stable display. This is set up in the Trigger control
panel. (“Trig” button). Using the Power trigger type with the RF Input source works well for many
pulsed signals.

4. Set the Analysis Period to cover the number of pulses in your signal that you want to analyze. To do
this, click in the data entry field of the Time Overview window and set the analysis length as needed.

Spectrum Analysis

The Spectrum Analysis application preset opens a Spectrum display and sets several parameters. The
Spectrum Analysis preset sets the analyzer as follows.

m  Spectrum Analysis : Sets the frequency range to maximum for the analyzer, and sets the RF/IF
optimization to Minimize Sweep Time.

To use the Spectrum Analysis preset (assuming that Spectrum Analysis is the selected preset on the list of
Application Presets and Preset action is set to Recall selected preset):

1. Select File > More Presets > Application.
2. Set the measurement frequency using the front-panel knob or keypad.

3. Adjust the span to show the necessary detail.

Time-Frequency Analysis
The Time-Frequency Analysis application preset opens the following displays:
m  Time Overview: Shows a time-domain view of the analysis time ‘window’.

B Spectrogram: Shows a three-dimensional view of the signal where the X-axis represents frequency,
the Y-axis represents time, and color represents amplitude.

B Frequency vs. Time: This display's graph plots changes in frequency over time and allows you to
make marker measurements of settling times, frequency hops, and other frequency transients.

B Spectrum: Shows a spectrum view of the signal. The only trace showing in the Spectrum graph
after selecting the Time-Frequency Analysis preset is the Spectrogram trace. This is the trace from
the Spectrogram display that is selected by the active marker. Stop acquisitions with the Run button
because its easier to work with stable results. In the Spectrogram display, move a marker up or down
to see the spectrum trace at various points in time.

The analysis period is set to 5 ms.

To use the Time-Frequency Analysis preset (assuming that Time-Frequency Analysis is the selected preset
on the list of Application Presets and Preset action is set to Recall selected preset):
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1. Select File > More presets > Application.

2. When the preset's displays and settings have all been recalled and acquisitions are running, adjust the
center frequency and span to capture the signal of interest.

3. Set the Reference Level to place the peak of the signal approximately 0-10 dB down from the top of
the Spectrum graph.

4. Ifthe signal is transient in nature, you might need to set a trigger to capture it. For more information
on triggering in the time and frequency domain, see Triggering

When the signal has been captured, the spectrogram shows an overview of frequency and amplitude
changes over time. To see frequency transients in greater detail, use the Frequency vs. Time display.

The Time-Frequency Analysis preset sets the analysis period to 5 ms. The Spectrum Span is 40 MHz. The
RBW automatically selected for this Span is 300 kHz. For a 300 kHz RBW, the amount of data needed for
a single spectrum transform is 7.46 ps. A 5 ms Analysis Length yields 671 individual spectrum transforms,
each one forming one trace for the Spectrogram to display as horizontal colored lines. This preset scales
the Spectrogram time axis (vertical axis) to -2, which means that the Spectrogram has done two levels of
time compression, resulting in one visible line for each four transforms. This results in 167 lines in the
Spectrogram for each acquisition, each covering 29.84 ps.

Creating User Presets

You can add your own presets to the list that appears in the User Presets dialog box. Configure the analyzer
as needed for your application and create a Setup file in C:\SPECMON Files\User Presets. The name you
give the file will be shown in the User Presets list on the Presets tab of the Options control panel. For
instructions on how to save a Setup file, see Saving Data (see page 379).

Configuring How Presets Are Recalled

Recalling Presets results in either of two actions. One action is to immediately execute a Preset. The
second action displays a list of Presets from which you select the Preset you want to recall. You specify
which action occurs when you recall a preset using the Presets tab on the Options control panel.

Configuring how a preset is recalled. To configure how a preset is recalled:

1. Select File > More presets > Preset options This displays the Presets tab of the Options control panel.

Prasets | Analysis Time | Save and Export | GPIB | Security | Frefs |

Preset type: Presets: | modulation Analysis —*

spplication Phase Moise
Pulse Analysis

. . Arrange

Preset action: Spectrum &nalysis

Show list - Spur Search Multi Zone 9k-1GHz Y
Time-Frequency Analysis

2. Select the Preset type from the drop-down list that you want to configure. For each type listed there
are unique presets that appear in the Presets box.

3. Select the Preset action from the drop-down list,
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4. If you select Recall selected preset from the Preset action list, click in the Presets list box on the
preset you wish to recall.

The selected preset, indicated by a tan background highlight, is the Preset that is recalled; you can also
press one of the Preset buttons on the front panel.

5. Set the measurement frequency using the front-panel knob or keypad.

6. Adjust the span to show the necessary detail.

Recalling a Preset
To recall the factory defaults Preset:

B Press the Preset button on the front panel, select the Preset icon in the menu bar, or select File >
Preset (Main).

To recall a named preset (an Application, DPX, or User Preset) from a menu:

m  Select File > More presets > “Preset type”. The Preset at the top of the Presets list for the selected
Preset type will be recalled (if Preset action is set to Recall named preset).

To recall a named preset from the front panel:

B Press the button on the front panel matching the preset type you want to recall. For example, to
recall a DPX preset type, press the DPX button.

Setting Options

Menu Bar: Tools > Options

There are several settings you can change that are not related to measurement functions. The Option
settings control panel is used to change these settings.

Presets |Analysis Tirne I Save and Export I GPIB | Security | Prefs ‘

IFIESE ({28 Presets: | ciprent: v2.4 and later —
Main = original: ¥1.0 - ¥2.3 *
Arrange

Preszet action:

Recal selected preset =

k]
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Settings tab Description

Presets Use this tab to configure Presets. You can specify the action to take when a preset is
recalled and which preset to recall when the Preset button is selected.

Analysis Time Use this tab to specify the method used to automatically set the analysis and spectrum
offsets when the Time Zero Reference (see page 349) is set to Trigger.

Save and Export Use this tab to specify whether or not save files are named automatically and what
information is saved in acquisition data files.

GPIB Use this tab to set the primary GPIB address for the instrument.

Security Selecting the Hide Sensitive readouts check box causes the instrument to replace
measurement readouts with a string of asterisks.

Prefs Use this tab to select different color schemes for the measurement graphs and specify

how markers should react when dragged.

Presets

The Presets tab allows you to specify actions taken when you press the Preset button.

Preset type. You can choose from the following preset types:

B Main — There are two choices: Current: 2.4 and later and Original: V1.0-V2.3. Choose Current unless
you have existing tests or procedures that depend on values set by the older version of Preset.

B Application — There are several application presets, depending on installed options. Each preset
selects a group of displays suited to the selected application type.

B DPX — There are four DPX preset types: Open the DPX display, Swept, Real Time, and Zero Span.

B User — These are setup files that have been saved by users in the folder C:ASPECMON Files\User
Presets.

Preset action. The Preset action list allows you to specify what the instrument should do when you
request a preset. The choices are:

E  Recall selected preset — This action sets up the instrument to immediately recall the preset selected in
the Preset box without any further input from the user.

®  Show list — This action sets up the instrument to display a list box from which the user can select a
preset to recall.

Presets. This list box displays the available presets for the selected Preset type. The preset highlighted in
the list is the preset that will be recalled when Preset action is set to Recall selected preset.

Arrange. Use the Arrange buttons to change the order in which presets appear in the Presets dialog box
when Preset action is set to Show list.

Analysis Time

The Analysis Time tab in the Options control panel is used to specify the method used to automatically set
the analysis and spectrum offsets when the Time Zero Reference (see page 349) is set to Trigger. The
available settings are:
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B Include trigger point — Selects an algorithm that uses the measurements to determine how far in
advance of the trigger to set the analysis offset. The analyzer tries to ensure that data about the trigger
point is included in the analyses.

m  Start at trigger point (legacy) — The method used by the instrument in prior versions, which sets the
Analysis Offset to zero when possible. The analyzer tries to ensure that data following the trigger
point is included in the analyses. Use this method if your measurements or procedures depend on past
behavior of the Auto Analysis Offset function.

Save and Export

The Save and Export tab allows you to specify whether or not files are saved with an automatically
generated name, and how much data is saved in an acquisition data file.

All files. The Automatically increment filename/number function can automatically name saved files by
appending a number to a base file name. Use this tab to enable/disable automatic naming of files. For
example, if Automatically Increment Filename Number is disabled, when you select Save from the File
menu, you will have to enter a name for the file.

Acquisition data files. This setting specifies whether saved data files include the entire acquisition record
or only the data for the analysis length (a subset of the acquisition record).

TIQ acquisition data files. Specifies which data records to save. You can choose from the following:
B Current acquisition: Saves the current acquisition.

B Current frame: If Fast Frame is enabled, saves only the current frame. The current frame is the
one most recently analyzed.

m  Selected frames: If Fast Frame is enabled, saves the specified frames.
m  All in history: Saves all acquisition records in the history.

m  Save TIQ file now: Invokes the Save As dialog box with the Save as type drop-down list set to TIQ.

Prefs

The Prefs tab enables you to set properties that apply to all displays.

Color scheme. The Color scheme setting provides three color schemes for the measurement graphs. The
color scheme setting does not change the overall instrument application or Windows color scheme.

B Thunderstorm — This scheme displays graphs in shades of blue. This provides a less vibrant color
scheme than the default setting.

®  Blizzard — This scheme displays graphs with a white background to save ink when printing.

B (Classic — The default setting. This scheme displays the graph area with a black background.

Markers snap to peaks when dragged. When selected, this setting causes makers to automatically jump
to the next peak (see page 338) when you drag them. When this setting is deselected, you can drag a
marker to any point on the trace.
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Operating System Restore

The instrument contains an operating system restore file on a separate partition of the hard drive.

The preferred method to restore the instrument operating system is to use the hard disk restore file.

CAUTION. Using the restore process reformats the hard drive and reinstalls the operating system. All
saved data is lost. If possible, save important files to external media before performing a system restore.

1. Restart the instrument. During the boot-up process you will see the following message at the top of the
screen: Starting Acronis Loader... press F5 for Acronis Startup Recovery Manager.

NOTE. To successfully complete the system restore, you must use the Windows version of the Acronis
software. Using a generic MAC keyboard starts the DOS version of the Acronis software. Do not use a
MAC keyboard.

2. Repeatedly press the F5 key until the Acronis True Image Tool opens. There is a 5-second time period
from when the message appears until the instrument proceeds with the normal instrument startup. If
the instrument does not open the Acronis application, power off the instrument, then power on the
instrument and try again.

3. Click Restore.

4. In the Confirmation dialog box, click Yes to restore the instrument operating system, or No to exit
the restore process. The restore process takes approximately 30 minutes; the actual time depends on
the instrument configuration.
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Selecting Displays

Menu Bar: Setup > Displays
Application Toolbar:

Use the Select Displays dialog to choose the displays that appear on the screen.

Select Displays

Folders: Available displays:

Lo =]

Choose any combination below, or use an Application Preset, l Application Presets. .. ‘

General Signal Yiewing AMPL
Analog Modulation
GP Digital Modulation
RF Measurements

OFDM Analysis Time

Pulsed RF -
Audio Analysis M

Selected displays:

DPX

armplitude vs  Fregquency
Time
Spectrogram  Spectrum
add
Remove
l l Caricel ‘

To select displays:

1. Press the Displays button or select Setup > Displays.

Selecting Displays

2. Select one of the choices under Folders. The folder chosen determines the choices available in

Available displays.

3. Double-click the desired display in the Available displays box or select the desired display and

click Add.
4. Click OK.

Interactions Between Displays

Different displays can require different settings, for example acquisition bandwidth, analysis length, or
resolution bandwidth, to achieve optimum results. The application automatically adjusts some settings
to optimize them for the selected display. The check mark indicator in the upper, left-hand corner of the
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display indicates the display for which the application is optimized. Depending on application settings,
some displays might stop displaying results if they are not the selected display.
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Available Measurements

The automatic measurements available include RF power measurements, analog modulation
measurements, digital modulation measurements, and pulse measurements.

Power Measurements

Measurement Description

Channel Power The total RF power in the selected channel (located in the Channel Power & Str display).

Adjacent Channel Power Ratio Measure of the signal power leaking from the main channel into adjacent channels.

Multi-Carrier Power Ratio The ratio of the signal power in the reference channel or group of channels to the power
in adjacent channels.

Peak/Avg Ratio Ratio of the peak power in the transmitted signal to the average power in the transmitted
signal (located in the CCDF display).

CCDF The Complementary Cumulative Distribution Function (CCDF). CCDF shows how much

time a signal spends at or above a given power level relative to the average power of
a measured signal.
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Available Measurements

Digital Modulation Measurements

Measurements for all modulation types except nFSK, C4FM, OQPSK and SOQPSK

Measurement

Description

EVM

The normalized RMS value of the error vector between the measured signal and the ideal
reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Phase Error

The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.
MER (RMS) The MER is defined as the ratio of 1/Q signal power to I/Q noise power; the result is

indicated in dB.

1Q Origin Offset

The magnitude of the DC offset of the signal measured at the symbol times. It indicates
the magnitude of the carrier feed-through signal.

Frequency Error

The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Gain Imbalance

The gain difference between the | and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different form
height.

Quadrature Error

The orthogonal error between the | and Q channels. The error shows the phase
difference between | and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Not valid for BPSK modulation type.

Rho

The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.
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Measurements for OQPSK and SOQPSK modulation types

Measurement

Description

EVM

The normalized RMS value of the error vector between the measured signal and the ideal
reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Offset EVM

Offset EVM is like EVM except for a difference in the time alignment of the | and Q
samples. For EVM, | and Q samples are collected at the same time, for every symbol
decision point (twice the symbol rate for offset modulations). For Offset EVM, the | and Q
symbol decision points are time-aligned before collecting the | and Q samples. In this
case, one | and one Q sample is collected for each symbol (half as many samples as the
same number of symbols for (non-offset) EVM.

Phase Error

The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.
MER (RMS) The MER is defined as the ratio of 1/Q signal power to I/Q noise power; the result is

indicated in dB.

1Q Origin Offset

The magnitude of the DC offset of the signal measured at the symbol times. It indicates
the magnitude of the carrier feed-through signal.

Frequency Error

The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Gain Imbalance

The gain difference between the | and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different form
height.

Quadrature Error

The orthogonal error between the | and Q channels. The error shows the phase
difference between | and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Not valid for BPSK modulation type.

Rho

The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.
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Available Measurements

Measurements for nFSK modulation types

Measurement Description
Peak FSK err Peak value of the frequency deviation error at the symbol point.
RMS FSK Err RMS value of the frequency deviation error at the symbol point.

Peak Mag Err

The Peak magnitude difference between the measured signal and the reference signal
magnitude.

RMS Mag Err The RMS magnitude difference between the measured signal and the reference signal
magnitude.
Freq Error The frequency difference between the measured carrier frequency of the signal and the

user-selected center frequency of the instrument.

Freq Deviation

Frequency distance from the center frequency at the symbol point.

Symbol Rate Error

This compares the user-entered symbol rate to the instrument calculated symbol rate of
the analyzed signal.

Symbol Rate

When in Auto-symbol rate, the instrument calculates the symbol rate of the signal and
the instrument calculates the error between the user entered value and the instrument
calculated value.

Measurements for C4FM modulation type

Measurement

Description

RMS Error Magnitude

RMS value of the frequency deviation error at the symbol point.

Carrier Frequency Error

Frequency difference between averaged signal frequency and the center frequency.

Deviation

Frequency distance from the center frequency at the symbol point.

Length

Number of symbols in the analysis area.

Analog Modulation Measurements

Measurements for AM modulation

Measurement Description

+AM Positive peak AM value.

-AM Negative peak AM value.

Total AM Total AM value, which is equal to the peak-peak AM value divided by 2.

Measurements for FM modulation

Measurement Description

+Pk Positive peak frequency deviation.

-Pk Negative peak frequency deviation.

RMS RMS value of the frequency deviation.

Pk-Pk/2 Peak-to-peak frequency deviation divided by 2.
Pk-Pk Peak-to-peak frequency deviation.
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Measurements for PM modulation

Measurement Description

+Pk Positive peak phase deviation.
-Pk Negative peak phase deviation.
RMS RMS value of the phase deviation.
Pk-Pk Peak-to-peak phase deviation.

Pulse Measurements

Measurement

Description

Average ON Power

The average power transmitted during pulse on.

Peak Power

Maximum power during pulse on.

Average Transmitted Power

The average power transmitted, including both the time the pulse is on and the time
it is off, and all transition times.

Pulse Width The time from the rising edge to the falling edge at the -3 dB / —6 dB level (50%) of the
user selected 100% level. Level is user selectable for Volts or Watts.

Rise Time The time required for a signal to rise from 10% to 90% (or 20% to 80%) of the user
selected 100% level.

Fall Time The time required for a signal to fall from 90% to 10% (or 80% to 20%) of the user

selected 100% level.

Repetition Interval

The time from a pulse rising edge to the next pulse rising edge.

Repetition Rate

The inverse of repetition interval.

Duty Factor (%) The ratio of the width to the pulse period, expressed as a percentage.

Duty Factor (Ratio) The ratio of the pulse width to the pulse period.

Ripple Ripple is the peak-to-peak ripple on the pulse top. It does not include any preshoot,
overshoot, or undershoot. By default, the first 25% and the last 25% of the pulse top is
excluded from this measurement to eliminate distortions caused by these portions of
the pulse.

If the Amplitude units selected in the Amplitude panel (affects all amplitude measurements
for the analyzer) are linear, the Ripple results will be in %Volts. For log units, the Ripple
results will be in %Watts. The default for the general Units control is dBm, so the Ripple
results default is %Watts.

See also Ripple (see page 429).

Ripple dB The Ripple measurement expressed in dB.

Droop Droop is the power difference between the beginning and the end of the pulse On time. A
straight-line best fit is used to represent the top of the pulse. The result is a percentage
referenced to the Average ON Power.

Droop dB The Droop measurement expressed in dB.

Overshoot The amount by which the signal exceeds the 100% level on the pulse rising edge. Units
are %Watts or %Volts.

Overshoot dB The Overshoot measurement expressed in dB.

Pulse-Pulse Phase Difference

The phase difference between the selected pulse and the first pulse in the analysis
window. The instantaneous phase is measured at a user-adjustable time following the
rising edge of each pulse.
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Measurement

Available Measurements

Description

Pulse-Pulse Freq Difference

The difference between the frequency of the current pulse and frequency of the previous
pulse. The instantaneous frequency is measured at a user-adjustable time following the
rising edge of each pulse.

RMS Freq Error

The RMS Frequency Error measurement is the RMS average of the Freq Error vs. Time
trace, computed over the Measurement Time.

Max Freq Error

The maximum frequency error is the difference between the measured carrier frequency
of the signal and the user-selected center frequency of the analyzer.

RMS Phase Error

The RMS Phase Error measurement is the RMS average of the Phase vs Time trace,
computed over the Measurement Time.

Max Phase Error

The phase is measured at each point during the pulse's ON time. The phase error for
each point is the difference between the measured phase value and the calculated ideal
phase value. After the phase error is calculated for all points in the acquisition record,
the largest error in the positive direction and the largest in the negative direction are
determined. Whichever of these two values has the greater absolute value is designated
the Max Phase Error.

Freq Deviation

The Frequency Deviation measurement is the difference between the maximum and
minimum measured values of the signal frequency during the Measurement Time.

Phase Deviation

The Phase Deviation is the difference between the maximum and minimum Phase values
measured during the ON time of a pulse.

Impulse Response Amplitude

The difference in dB between the levels of the main lobe and highest side lobe.

Impulse Response Time

The difference in time between the main lobe and highest side lobe.

Time

This is the time in seconds relative to the time reference point in the first acquisition
record in the data set.
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Overview

The displays in the General Signal Viewing folder (Displays > Folders > General Signal Viewing) are:
B Amplitude vs Time

®  DPX Spectrum

®  Frequency vs Time

B Phase vs Time

m RFI & Q vs Time

B Spectrogram

B Spectrum

m  Time Overview

These displays provide extensive time-correlated multi-domain views that connect problems in time,
frequency, phase and amplitude for enabling you to more quickly understand cause and effect when
troubleshooting.

DPX Primer

NOTE.

With the DPX display (which displays only DPX waveforms saved by SPECMON/RSAS5000/RSA6000
Series Analyzers) you can detect and accurately measure transients as brief as 3.7 ps (instruments with
Option 200). The instrument computes up to 292,000 spectrums per second (up to 48,833 without Option
200) of the digitized input signal. Then it displays all these spectrums as a color-graded bitmap that reveals
low-amplitude signals beneath stronger signals sharing the same frequency at different times.

The strong signal in the DPX spectrum graph, shown in Figure 1, is a repeating pulse at a fixed frequency.
There is also a lower-power CW signal that steps very quickly through the same span. During the pulse's
on time, the power of the two signals is additive, resulting in nearly undetectable differences in the pulse
envelope shape. But during the time the pulse is off, the sweeping signal is detected and shown in its true
form. Both signals are visible in the bitmap because at least one full cycle of their activities occurs
within a single DPX display update.
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Figure 1

Compare the display of a traditional swept spectrum analyzer (Figure 2) and that of a real-time signal
analyzer with a DPX display (Figure 3). The signal captured is a typical WLAN interchange between
a nearby PC and a more-distant network access point (AP). The laptop signal is nearly 30 dB stronger
than the AP's signal because it is closer to the measuring antenna.
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Figure 2
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Figure 3

The traditional swept spectrum analyzer display, Figure 2, uses line traces that can show only one level for
each frequency point, representing the largest, the smallest or the average power. After many sweeps, the
Max Hold trace shows a rough envelope of the stronger laptop signal. +Peak detection was selected for the
other trace in an attempt to capture the weaker but more frequent AP signal, but the bursts are very brief,
so the likelihood of seeing one in any particular sweep is small. It will also take a long time to statistically
capture the entire spectrum of a bursted signal due to the architecture of the swept spectrum analysis.

The DPX display, Figure 3, reveals much more insight on the same signal. Since it is a bitmap image
instead of a line trace, you can distinguish many different signals occurring within each update period
and/or different version of the same signal varying over time. The heavy band running straight across the
lower third of the graph is the noise background when neither the laptop nor the AP is transmitting. The red
lump of energy in the middle is the ON shape of the AP signal. Finally, the more delicate spectrum above
the others is the laptop transmissions. In the color scheme used for this demonstration (‘“Temperature”),
the hot red color indicates a signal that is much more frequent than signals shown in cooler colors. The
laptop signal, in yellow, green and blue, has higher amplitude but doesn't occur nearly as often as the AP
transmissions because the laptop was downloading a file when this screen capture was taken.

How DPX Works

This section explains how DPX displays are created. The input RF signal is conditioned and
down-converted as usual for a signal analyzer, then digitized. The digitized data is sent through an FPGA
that computes very fast spectral transforms, and the resulting frequency-domain waveforms are rasterized
to create the bitmaps.

The DPX bitmap that you see on screen is composed of pixels representing X, y, and z values for
frequency, amplitude, and Density (instruments without Option 200 provide hit count as the z-axis value
in place of Density). A multi-stage process, shown in Figures 4a - 4d, creates this bitmap, starting with
analog-to-digital conversion of the input signal.
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Simplified Flow of Multi-stage Processing from RF Input Through to Spectrum Processing:

input RF Input & ~, fab7d9e37afe781826fa2a5b6029. .
signal”| Downcoversion ADC D i
continuous stream of time-domain data samples

Figure 4a. RF signals are downconverted and sampled into a continuous data stream.

fab7d9%e37afe781626fa2a5b6929
— .~ .., faB7d9e3, 7afe7818, 26fa2aSb, 6g29....

chopping the sample stream into non-overlspped data records

Figure 4b. Samples are segmented into data records for FFT processing based on the selected resolution bandwidth.

37af.e78 1826, fa2 DPX jk' 'JA k
A Processing D — .

continuous stream of .
Engine sadions s o £ J——
time-domain data records g continuous stream of spectral waveforms

Figure 4c. Data records are processed in the DPX transform engine

chopping the sample stream info overlapping data records
o~ ....fa67, fa67d9e3, d9e37afe, 7afe7818, ...
i T
fab7d9%e37afe781826fa2a5b6929

Figure 4d. Overlapping the FFTs shortens the minimum event duration required for 100% probability of intercept.

Collecting spectral data. Sampling and digitization is continuous. The digitized data stream is chopped
into data records whose length is based on the desired resolution bandwidth (RBW). An additional
requirement is placed on FFT length by the desired number of points in a trace (instruments with Option
200). Table 1 shows this relationship and the FFT length is reported in the display if desired. Then the
DPX transform engine performs a discrete Fourier transform on each record, continually producing
spectral waveforms.

m  RF signals are downconverted and sampled into a continuous data stream.

B Samples are segmented into data records for FFT processing based on the selected resolution
bandwidth.

B Data records are processed in the DPX transform engine.

B QOverlapped processing is used to improve minimum event duration performance.

Table 1: Minimum FFT length versus trace length - independent of span and RBW (RSA6100B Series and
RSA5100A Series with Option 200)

Trace length (points) Minimum FFT length
801 1,024
2,401 4,096
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Table 1: Minimum FFT length versus trace length - independent of span and RBW (RSA6100B Series and
RSA5100A Series with Option 200) (cont.)

Trace length (points) Minimum FFT length
4,001 8,192
10,401 16,384

As long as spectral transforms are performed faster than the acquisition data records arrive, the transforms
can overlap each other in time, so no events are missed in between. Minimum event length for guaranteed
capture depends on the length of the data records being transformed. An event must last through two
consecutive data records in order for its amplitude to be accurately measured. Shorter events are detected
and visible on screen, but may be attenuated. The DPX Spectrum RBW setting determines the data
record length; narrow RBW filters have a longer time constant than wide RBW filters. This longer time
constant requires longer FFTs, reducing the transform rate. Additional detail on minimum signal duration
is provided in Guaranteed Capture of Fast Events (see page 49).

The spectral waveforms are plotted onto a grid of counting cells called the “bitmap database”. The number
held by each database cell is the z-axis count. For simplicity, the small example grid used here in Figure 6
is 11x10, so our spectral waveforms will each contain 11 points. A waveform contains one (y) amplitude
value for each (x) frequency. As waveforms are plotted to the grid, the cells increment their values each
time they receive a waveform point.

1
1
1 2
T g 14
2 E
5 s 2 |1
: 1 |1 £ 15 |7
1 1 7 8
11 1 11 1 o ol o[ 1/ 1] 1 1[ 1] 9/ 9/ 9

Frequency Freguency

Figure 5. Example 3-D Bitmap Database after 1 (left) and 9 (right) updates. Note that each column contains
the same total number of “hits”.

The grid on the left shows what the database cells might contain after a single spectrum is plotted into it.
Blank cells contain the value zero, meaning that no points from a spectrum have fallen into them yet.

The grid on the right shows values that our simplified database might contain after an additional eight
spectral transforms have been performed and their results stored in the cells. One of the nine spectrums
happened to be computed as a time during which the signal was absent, as you can see by the string of “1”
occurrence counts at the noise floor.

Frame updates. The maximum rate for performing the variable-length frequency transforms that produce
those waveforms can be greater than 292,000 per second. Measurement settings that slow this transform
rate include narrowing the RBW and increasing the number of points for the line traces available in the
DPX display along with the bitmap. Even at their slowest, spectral transforms are performed orders of
magnitude faster than a physical display can respond, and also too fast for humans to see, so there's no
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need to update the screen or measurements at this rate. Instead, the grid collects thousands of waveforms
into “frames”, each covering about 50 milliseconds (ms). A 50 ms frame contains the counts from up to
14,600 waveforms. After each frame's waveforms have been mapped into the grid, the cell occurrence
counts are converted to colors and written to the DPX bitmap, resulting in a bitmap update rate of
around 20 per second.

Frame length sets the time resolution for DPX measurements. If the bitmap shows that a -10 dBm

signal at 72.3 MHz was present for 10% of one frame's duration (5 ms out of 50 ms), it isn't possible to
determine just from the DPX display whether the actual signal contained a single 5 ms pulse, one hundred
50 microsecond (us) pulses, or something in between. For this information, you need to examine the
spectral details of the signal or use another display with finer time resolution, such as Frequency vs.
Time or Amplitude vs. Time.

Converting occurrence counts to color. About 20 times per second, the grid values are transferred to the
next process step, in which the z-axis values are mapped to pixel colors in the visible bitmap, turning
data into information (Figure 6). In this example, warmer colors (red, orange, yellow) indicate more
occurrences. The color palette is user-selectable, but for now we will assume the default “temperature”
palette.

Number of Occurrences Color
0 black
blue
light blue
cyan

green blue
green

yellow
orange

red orange

O Nl WO IN|—

red

Figure 6. Example Color-mapping algorithm

The result of coloring the database cells, Figure 7, according to the number of times they were written into
by the nine spectrums, one per pixel on the screen, creates the DPX displays.
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Amplitude

Frequency

Figure 7. Color-coded low-resolution example (left) and a real DPX display (right).

In addition to the choice of palette, there are z-axis scaling adjustments for Maximum, Minimum, and
Curve. Maximum sets the occurrence value that will be mapped to the highest color in the palette.
Minimum sets the occurrence value for the lowest color. In the “temperature” palette, the highest color is
deep red and the lowest is dark blue. Occurrence values less than the selected Minimum are represented
with black pixels, while pixels that exceed the selected Maximum are red in hue but somewhat transparent.
Values between Maximum and Minimum are represented by the other colors of the palette.

Adjusting the Minimum above the black default allows you to concentrate most of your color resolution
over a small range of medium or higher occurrence rates to visually discriminate between different signals
that have nearly equal probability values.

To see why adjustable color scaling is useful compare Figures 8 and 9. On the Scale tab, the Max control is
set to 100% in Figure 8. The range of colors now covers the full z-axis range of densities from 0 to 100%.
The signals used to create this bitmap are fairly diffused in both frequency and amplitude, so most pixels
have low occurrence counts or density values and the upper half of the color palette is unused.

-100.00 d8m

DPX Spectrum | Freg & Span | B Traces Scale | Prefs | Density | Audio Demod
Settings B

utoscale Autoscale Min: |0.000 % . | Colo

Figure 8. DPX spectrum bitmap with default color scale settings.
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When the Auto Color button is selected, the Maximum control's value is set to the highest pixel value
in the current bitmap, shown in Figure 9. Now none of the available colors remain unused. The entire
palette is mapped to the occurrence values present at the time the button is selected, providing better
visual resolution for low densities. Selecting the Autoscale button in the DPX display scales all three
axes based on current results.

. :

Figure 9. The Auto Color function optimizes the color scale settings.

Color Mapping Curves

The mapping between z-axis values and color does not have to be linear. The Curve control lets you
choose the shape of the mapping equation. A Curve setting of 1 selects the straight-line relationship.
Higher Curve numbers pull the curve upwards and to the left, concentrating color resolution on lower
densities. Settings less than 1 invert the curve, moving the focus of the color range towards higher density
values. Figure 10 shows the mapping curves.

Curve = 1

Calar

Curve =1

) - 1 1
0 10 20 30 40 50 60 70 80 90 100
Density (%)

Figure 10. Representative color mapping curves for the “Temperature” palette.

Using the same signal shown in Figures 8 and 9, the impact of the Curve control can be observed. With
the Curve control set to 1 in the Scale tab, shown in Figure 11, the mapping between color and density is
linear, so the colors spread evenly across the full density range. The color distribution is visible in the
colored palette illustration to the left of the Curve control in the Settings panel.
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DPX Bitmap (Signal Density)

Color; | Temperature v| Curve

Max: |7.000 %

]
Auto
Min: |0.000 % . Color

Figure 11. Over a narrow Signal Density range, the color curve is set to 1.

When the Curve control is set to 0.5, as shown in Figure 12, the best color resolution is in the upper half of
the density range, and only the dark blues are assigned to densities below 50%. Note the difference in
the palette illustration.

000 %

3 - v
= 0.5
Auto
Min: (0.000 % Color

Figure 12. Adjusting to values less than 1, increases the contrast for viewing events in the top half of the selected
density range.

In Figure 13, the Curve control is increased to 3. The majority of colors shifts to the lower half of the
density scale, but various shades of orange and red are still available for densities above 50%.

DPX Bitmap (Signal Density)

Color: | Temperature v Curve

Max: |7-000 %

Auto
Min: [0.000 % -

Figure 13. For color curve settings greater than 1, better contrast is provided for events near the low end of the
density range.

Swept DPX

DPX Spectrum is not limited in span by its real-time bandwidth. Like the regular Spectrum display, DPX
Spectrum steps through multiple real-time frequency segments, building a wide-span display with line
traces and the bitmap (instruments with Option 200). See Figure 14.
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Figure 14. Off-air ambient signals over a 1 GHz span in the swept DPX display.

The analyzer “dwells” in each frequency segment for one or more DPX frames, each containing the results
of up to 14,600 spectral transforms. Dwell time is adjustable, so you can monitor each segment of the
sweep for up to 100 seconds before moving to the next step. While dwelling in a segment, the probability
of intercept for signals within that frequency band is the same as in normal, real-time spans: 100% capture
of events as short as 10.3 usec.

A full pixel bitmap is created for every segment and compressed horizontally to the number of columns
needed for displaying the frequency segment. Compression is done by averaging pixel densities of the
points being combined together. The final swept bitmap contains a representation of the same pixel bitmap
resolution, just like the non-swept bitmaps. Line traces are also created in full for each segment, and then
horizontally compressed to the user-selected number of trace points for the full span.

A complex algorithm for determining the number and width of each frequency segment has been
implemented. The variables in the equation include user-adjustable control settings like Span, RBW, and
number of trace points, RF and IF optimization, and Acquisition BW. Installed hardware options also can
affect the span segmentation. The number of segments ranges from 10 to 50 for each 1 GHz in a sweep.

A helpful piece of information for operators is the actual Acquisition Bandwidth used for capturing each
segment. “Acq BW” is shown in the Acquire control panel on the Sampling Parameters tab. Acq BW is
typically set automatically by the instrument, based on the needs of all the open displays, but can also be
set manually. In either case, the displayed bandwidth is used for every frequency segment in the swept
DPX display, though in practice, the displayed portion of the segment is somewhat narrower than the
actual Acquisition BW, for performance reasons.

The entire instrument frequency range of many GHz can be covered in a DPX sweep. The Dwell Time
control sets the amount of time DPX spends in each segment. This control, circled in Figure 15, can be
set between 50 ms and 100 seconds.

Traces | Scale || Prefs | Density | Audio Demod

Center[488.27 Hz Span{10.00 MHz Vax Saan

Start:|483.27 MHz
Dwell time: | 50.4 ms Auto
Stop:|493.27 MHz (swept only)

Figure 15. During swept DPX operation, the Dwell time control adjusts the observation time of each frequency
segment used to construct the composite DPX display.
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Guaranteed Capture of Fast Events

The main reason that swept-tuned and step-tuned spectrum analyzers can't provide 100% Probability of
Intercept, POI, for a signal that isn't continuously present is that they spend only a short period of time
tuned to each segment of their frequency span during each sweep. If something happens in any part of
the span other than where it is tuned at that instant, that event will not be detected or displayed. There
is also a period of time between sweeps, retrace time, during which the analyzer is not paying attention
to the input signal. FFT-based analyzers, including vector signal analyzers, also miss signals during
the time between acquisitions. Their POI depends on a combination of factors including span, number
of FFT points, acquisition time, memory read/write time, and signal processing speed. Vector analyzers
process information sequentially, so when read/write from data and processing is occurring, data is not
being acquired.

RSAs, on the other hand, capture data across all frequencies within their real-time span during every
acquisition. With Tektronix' exclusive Frequency Mask trigger and DPX Density trigger, POI increases to
100%, insuring capture of any spectral event matching the trigger definition. When operating in free run as
a simple signal analyzer, the RSA has a POI similar to other FFT-based analyzers, with gaps between
each acquisition. Processing is done concurrent with the acquisitions.

Guaranteed Capture in DPX Real-Time Spans

The DPX display captures any signal that is at least 10.3 microseconds long (instruments with Option 200)
and within the real-time bandwidth. This performance is possible because the SPECMON computes up to
292,000 spectrum transforms per second. The faster the spectrum updates, the shorter the time between
acquisitions and the greater the probability that any signal will be detected.

Table 1 shows the specified minimum signal duration (MSD) for 100% probability of intercept under
various combinations of Span and RBW in DPX for a representative RSA model. As you can see, MSD is
affected by multiple factors.

Table 2: Minimum signal duration specifications for RSA6100B series signal analyzers !

Span RBW Span/RBW FFT MSD for
(MHz) (kHz) Ratio Length Spectrum/sec 100% POI (ps)
110 10000 1 1024 3.7
10 1000 110 1024 292,969 5.8
110 300 367 2048 146,484 14.8
110 100 1100 4096 73,242 37.6
10 30 3667 16384 18,311 134.6
110 20 5500 32768 9,155 229.2

1 With Options 110 under various combinations of control parameters.

To demonstrate the POI in action, a challenging bi-stable signal is used. A CW sinusoid sits at 2.4453 GHz
most of the time, but every 1.28 seconds, its frequency changes for about 100 ps before returning to
normal. The duty factor of this transient is less than 0.01%.

Figure 16 shows a swept analyzer set up for a 5-second sweep of its MaxHold trace. It shows that there is
something occurring around the signal. This sweep rate was empirically determined to be the optimum rate
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for reliable capture of this signal in the shortest time. Faster sweep times can reduce the probability of
intercept and result in fewer intersections of the sweep with the signal transient.
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Figure 16. Swept spectrum display of the infrequent transient.

The DPX display shown in Figure 17 shows the exact same event, also captured over a 5 second period. A
lot more information can be discovered about the transient. It is obvious at first glance that the signal is
hopping by about 3 MHz, with 1.2 MHz of frequency overshoot on transitions

& 0.00 dBrn
o dB/fdiv:
10.0 dB
~ RBW:
100 kHz

-100.00 dBm

o CF: 2.44530 GHz o Span: 10.00 MHz

Figure 17. The DPX spectrum display after 5 seconds. The MaxHold trace is cyan.
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Guaranteed Capture in DPX Swept Spans

Probability of intercept (POI) for signals within a single segment, while DPX is dwelling in that segment,
is the same as for non-swept DPX operation (POI = 100% for events as brief as 10.3 microseconds).

But just as in traditional swept analyzers, during the time the acquisition is tuned to any one segment,
the analyzer is not monitoring signals in any of the other segments, so probability of capture in segments
other than the current one is zero. Because of the wide real-time bandwidth, the number of segments
needed to cover the span is much less than for swept analyzers, so the overall probability of intercept is
significantly better for DPX sweeps.

Another factor affecting POI is number of trace points. The bitmap is always 801 points wide, but the
line traces allow user selection for number of points. 801 is the default and the other choices are 2401,
4001, and 10401. Frequency transforms for traces containing more than 801 points take longer, and this
lower waveform update rate increases the minimum signal duration proportionally. This caution applies
for swept and non-swept operation. The trace length control is on the Prefs tab in the DPX control panel.

DPX Density Measurements

“Density” is a measure of the amount of time during a defined measurement period during which signals
are present within a particular area of the DPX Spectrum bitmap. A clean CW tone gives a 100% reading,
while a pulse that is on for one microsecond out of every millisecond reads 0.1%. This section describes
how density is computed from hit counts.

If we plot 41 more waveforms into the example grid we used previously in Figure 6 (in addition to the nine
we already plotted), each column ends with a total of 50 hits (Figure 18). The density for any one cell in a
column is its own count value divided by 50, expressed in percent as shown in Figure 19. The math is
very simple: a cell with 24 counts has a 48% density. In practice, instead of batches of 50 waveforms, we
collect a frame of thousands of waveforms before each update to the density bitmap.

13

18

47 | 46 | 47 | b5 4 3 7 | 43 | 47 | 46 | 47

Figure 18. Grid showing cell counts after 50 waveforms. For each column, the sum of z-axis values is 50.
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0% | 0% | 0% | 0% [ 0% [ 0% [ 0% | 0% | 0% | 0% | 0%

0% | 0% | 0% | 0% [ 0% | 8% | 0% | 0% | 0% | 0% | 0%

0% | 0% | 0% | 0% | 0% [12%| 0% | 0% | 0% | 0% | 0%

0% | 0% | 0% | 0% | 0% |26%| 0% | 0% | 0% | 0% | 0%

0% | 0% | 0% | 0% | 0% [36%| 0% | 0% | 0% | 0% | 0%

0% | 0% | 0% | 0% [ 2% | 6% | 2% | 0% | 0% | 0% | 0%

0% | 0% | 2% | 4% [ 8% | 0% | 8% | 0% | 0% | 0% | 0%
2% | 4% | 2% |86% [82%| 4% |76%|12% | 2% | 4% | 4%
94% |92%|94% | 10% | 8% | 6% |14% |86% |94% |92% [94%
4% | 4% | 2% | 0% [ 0% [ 2% | 0% | 2% | 4% | 4% | 2%

Figure 19. Grid after converting occurrence counts to percent density values. The sums of the cell density
measurements within each column are all 100%.

Measuring Density with Markers

Hit counts are cleared after every frame update, as long as Persistence is not turned on. The density
value for any pixel is simply the percent of time it was occupied during the most recent 50 ms frame.
Markers can be used to see the Density value for one or more individual points on the screen, enabling
measurements of the signal density at any interesting point in the DPX display.

In Figure 20, Wireless LAN signals are analyzed in the presence of a Bluetooth radio signal in the 2.4 GHz
ISM band.

& -60.00 dBm

o dBfdiv:
5.00 dB

© RBW:
300 Kz

-110.00 dBm

© CF: 246332 GHz © Span: 40,00 MHz
Markers v MR | Frequency v[2 46295 GHz @ E] [z] @

Figure 20. DPX display of WLAN and Bluetooth signals, with a marker on the highest signal.

The “Marker to Peak” function was used to find the peak signal recorded in the display. The marker
readout in the upper left corner of Figure 20 shows the Density, Amplitude, and Frequency for the
pixel you selected with the marker. By adding additional markers, you can measure the signal density
differences between multiple signals of interest.
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Marker Peak Search in the DPX Bitmap

Markers on the DPX bitmap can search for peaks, similar to marker peak searching on spectrum line
traces. For a human, it is pretty easy to discern “signals” in the bitmap picture. Your brain intuitively
identifies strings of contiguous bright pixels. This isn't so easy for a computer. The first thing the RSA
must do for any peak search is analyze pixel density values to identify apparent signals. Then it can sift
through these density peaks for the amplitude peaks you want to find.

Z-axis density values for the pixels in each column of the bitmap are internally converted into histograms
to find density peaks indicating the presence of signals. Table 2 shows the five middle columns from

the example grid we used to illustrate density measurements in a previous section (Figure 19). The
density values for each pixel in the middle, highlighted column are plotted on the y axis in the bar chart in
Figure 21. The bar chart x axis is bitmap row number, numbering from the top of the table.

Table 3: Bitmap section showing density values.

0% 0% 0% 0% 0%
0% 0% 8% 0% 0%
0% 0% 12% 0% 0%
0% 0% 26% 0% 0%
0% 0% 36% 0% 0%
0% 2% 6% 2% 0%
4% 8% 0% 8% 0%
86% 82% 4% 76% 12%
10% 8% 6% 14% 86%
0% 0% 2% 0% 2%

Density value of Pixel

S

1 2 3 4 8 ] f ] 4 10

Bitmap Row Number

Figure 21. Bar chart of the density values in the bolded column of Table 2.

Assume that Density Threshold is set to 5% and Density Excursion to 5% also. Starting with x=1 in the
bar chart, test each bar against the threshold. The threshold criteria is met at x=2. Keep testing until you
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find a bar that is shorter than the previous bar by at least the Excursion setting. In this case it is x=6. This
tells us that a “signal” covers rows 2 through 5. Its density peak is at row 5.

Now you can look for another peak. Continue looking at bars to the right and you will find a density
value at row 9 that meets the threshold criteria, but since there are no bars to the right of it that meet the
excursion criteria, we can't declare row 9 a signal because it fails to meet the excursion criteria. If row 1
had 1% density, then row 9 would be a density peak.

Once density peaks are found for all columns in the bitmap, we can start looking for the amplitude peaks.
When the Peak button is selected, the analyzer checks the histograms of every column in the bitmap and
finds the density peak with the highest amplitude. The amplitude search has its own versions of Threshold
and Excursion settings, but in dBm and dB units. When Next Peak Down command is given, the search
will scan inside the current column for the next density peak. Next Peak Right examines each column to
the right of the current marker location to locate density peaks that also meet the amplitude peak criteria.

To demonstrate the value of marker peak search in the DPX bitmap, we will use the time-multiplexed
signals showing multiple amplitude levels from an example earlier in this manual. The Peak button
and its menu equivalent place the active marker on the peak signal in Figure 22. The peak signal is the
density peak of highest amplitude in the bitmap.

v v Bitmap  [“]Show File:Sweep and Pulse, Clear
% 0.00 dBm

= dB/div:
10.0 dB
=~ REW:

500 kiHz
-100,00 dBm _
Autoscake & CF: 20510 GHz & Span: 50.0 MHz

Markers -~ MR Fregquency % |2.051 GHe To Center Peak lﬂ lij lﬂ l:J E]

Figure 22. The marker was positioned by selecting the Peak button. Density, frequency, and amplitude measurements
at the marker are displayed in the upper left corner of the graph.

The Marker Toolbar, at the bottom of Figure 22, allows easy navigation of peak signals (Peak Left, Peak
Right, Next Peak Up, or Next Peak Down). Selecting the arrow keys enables the marker to search for
amplitude/density peaks at other frequencies, while the Next Peak Up and Next Peak Down arrows
enable the marker to search for other high-density points at the same frequency.

In the Define Peaks tab of the Define Markers control panel, Figure 24, you can adjust the density threshold
and excursion controls to modify search behavior. The amplitude threshold and excursion controls also
apply to DPX marker searches. Smoothing keeps the marker from finding multiple peaks within the same
apparent signal by averaging an adjustable number of pixel densities together, but it does not affect the
single-pixel measurement readout displayed by the marker.
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Figure 24. Amplitude and Signal Density controls can be adjusted to define Peak search behavior.

Density Measurements over an Adjustable Area (“The Box”)

The density for a single pixel is its ratio of actual hits vs. possible hits over a defined time period, and
markers display these density values. For measuring density over an area larger than one pixel, the DPX
display (instruments with Option 200) includes a measurement box you can resize and drag around in the
DPX display with your mouse or finger.

If you could make the box so narrow that it contained only points within a single column of pixels, the
density of this area would be the sum of the included pixels' density values. For example, if the box was
three pixels tall and the density values for these pixels were 4, 2, and 7% respectively, the overall density
for the three-pixel area would be 13%. Imagine a box one pixel wide and as tall as the graph. Assume that
the input signal's amplitude was such that all hits fell at or near the vertical center of the screen. Since
100% of the waveforms written to the bitmap passed through the box, the density for the box is 100%.

Sumof densities of all pixels
P
(Number of columns)

Density of an area =

When you widen the box to cover a broader range of frequencies, software computes the density sum for
the included pixels in each column inside the box. The aggregate density value for this box is the average
density, calculated by adding the column density sums then dividing by the number of columns. For a 100%
result, there must not be any hits above the top edge of the box or below its bottom edge. In other words,
every waveform drawn across the graph entered the box through its left side and exited the box through its
right side, with no excursions out the top or bottom. Figure 24 demonstrates this principle on a CW signal.
As you can see on the left-hand side, no amplitudes exist above or below the box; the density of the signal
is 100%. On the right hand side, there are signals below the box, therefore the density is less than 100%.
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Figure 24. Density of signals defined within an area. Left: Correct measurement of a CW signal. All columns in the
box include the signal. Right: Incorrect measurement area. The measurement is accurate, but probably not what you
expected. Some columns in the box contain no hits, so they contribute zeros to the calculation of average density.

The density measurement box' vertical size and location are always set in dB and dBm, no matter what
units you have selected for measurements. (Amplitude control panel > Units tab) The box is not draggable
when the selected units are linear (such as Amps, Volts, Watts...), though you can still adjust its size and
location using the Frequency and Amplitude controls in both the DPX Settings > Density and Trigger >
Event tabs. Since the vertical scale is non-linear, a box of constant amplitude changes visual height as it
changes vertical position, a disconcerting effect if you are trying to drag it.

Freq & Span || BW Traces | Scale | Prefs | Density | Audio Demod
Measurement box
Show measurement Frequency: |1.50000 GHz +/- |2.00000 MHz

(measurementalways
visible for DPX Trigger)

Amplitude: |-20.00 dBm +/- |5.00de

Figure 25. DPX Density control panel is used to define the area of interest for DPX density measurements.

A readout will appear somewhere in the graph. If the box is off-screen, the readout will be accompanied by
an arrow pointing towards the invisible box. Grab this readout with your mouse or finger and drag the
density readout to the area you want to measure.

To adjust the box size, a mouse is the easiest way to drag the sides and corners of the rectangle. For precise
settings, use the knob, arrow keys, or keyboard to adjust frequency and amplitude values for the rectangle.
These controls are located in the right half of the Density tab in the control panel.

Persistence

Previous sections of this topic have assumed that persistence was not applied to the DPX bitmap. Without
persistence, hit counts in the grid are cleared after each frame update. Now we will describe how
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persistence modifies this behavior, starting with infinite persistence because it is simpler than variable
persistence.

Hit counts are not cleared between frames if infinite persistence is enabled. When the instrument is set
up for continuous acquisitions, hits keep collecting until you stop acquisitions or click the Clear button
above the DPX display. Software keeps track of the total number of waveforms computed during the
entire collection period. Density equals the total number of hits to a cell divided by the total number of
waveforms.

Variable persistence is trickier. A single-occurrence signal shown in the bitmap does not disappear
suddenly upon the next frame update, nor does it linger forever. It fades gradually away. The user sets

a time constant for the Dot Persistence control which determines how long it takes for signals to fade.
Fading is accomplished by reducing the hit count in every cell, after each frame update, by a factor based
on the persistence time constant. The longer the time constant, the less the hit counts are reduced.

Figure 26. Example of fast transient discovery with and without variable persistence turned on. In the display on the
left, with variable persistence of 10 seconds, the occasional sub-second transient that spikes up above the normal
signals is held in the display rather than disappearing as soon as the signal goes away. The display on the right, with
persistence turned off, requires watching the display continually to see the brief signal.

Not only are single-occurrence signals allowed to remain in the display for awhile by variable persistence,
additional hits keep piling on. The result is that cell values are no longer pure hit counts; they include
counts due to new hits from waveforms plus proportionally reduced counts from prior frames. As part

of translating hit counts into density values, a new software algorithm uses a finite-series equation to
discriminate between the effects of persistence and the arrival of new hits. The inflationary effects of
persistence on cell counts are removed, so density readings represent the true ratio of actual hits to possible
hits over the persistence interval.

The density computation for variable persistence is a very good estimate of true signal density, with errors
of less than 0.01%. For exact density measurements, use either no persistence or infinite persistence.

Another subtlety of persistence is its smoothing effect on the density measurement of intermittent signals.
Consider a pulse that is on for 10 ms and off for 90 ms of each 100 ms cycle. We'll make the simplifying
assumption that the pulse ON time always falls entirely within a single DPX frame update (50 ms). If
persistence is not applied, the density measurement is computed on each individual frame. The results
will be 20% for each frame containing the ON time and 0% for the other frames. If infinite persistence
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is enabled, however, the density measurement will settle to 10% after the second frame, and remain at
this value for as long as the pulsing continues. With persistence, the density is effectively computed
over many frames.

Persistence Effects on Density

Persistence does not alter colors in a density-based bitmap. Its effect is to extend the amount of time over
which densities are calculated, leaving signal events visible for the persistence duration.

Before the introduction of density measurements and extra-long hit counters, persistence caused colors

to “bloom”, becoming more and more intense over time as the hit counts increased. Longer persistence
intervals caused increased blooming, turning crisp signals into fat red stripes. When hit counts are
converted to density values (instruments with Option 200), the display is not subject to this effect. As long
as the input signals maintain reasonably stable repetition rates and duty ratios, their density values will also
remain stable despite ever-increasing hit counts in the underlying grid cells.

If you are accustomed to the original hit-count-based persistence displays, it may seem counter-intuitive
that repeating signals in a density-based bitmap will not get brighter and redder over time with infinite
persistence. A quick review of the density algorithm explains why: the hit count is divided by the total
number of waveforms over the persistence interval. For example, if a signal occupies a pixel 50% of the
time over a period of 15 minutes, the density reading will be 50% throughout the entire 15 minutes,
though the underlying hit count is steadily increasing.

Z-Axis Resolution

Another factor that can cause color bloom is overflow of the hit counters. If a pixel could only count up to
1000 hits, its density and color values would clip at 100% after just 1000 hits, even if waveform points
continue to arrive in the same pixel location. With waveform points being written to the bitmap at rates
approaching 300k/sec, counts add up really fast for highly-repetitive signals. Deeper counters permit
higher hit counts, so overflow happens much later, as shown in Table 3.

Table 4: Comparison of DPX z-axis resolution and its effect on saturation.

SPECMON Series with Option 200
Hit Count 36-bit custom float (equivalent to 33-bit integer)
Maximum Hit Count 233

Minimum Time until Overflow (for pixels with 100% density) 8.1 hours

Clipping due to overflow of the counters in one or more cells will not occur until hours have passed, or
even days.

One more benefit to having deeper hit counters is better visual resolution of density. RSAs with the
highest-performance DPX hardware installed use floating-point numbers to count hits, allowing us to count
billions of waveforms while retaining one-hit resolution, providing better than 99 dB of dynamic range
for density measurements. Density measurements in u%, n%, and even % ranges are quite possible for
extremely rare signals captured with infinite persistence.

With straight-line mapping between density and color (Curve setting of 1), resolution is fixed by the
number of colors in the palette. For non-linear mappings (Curve settings higher or lower than 1), most
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of the colors are concentrated at either the low or high end of the density scale, so you can visually
discriminate finer differences between density values in that range.

Persistence Adjustments

Dot Persistence can be enabled for the “Bitmap” trace using the Settings control panel. The Persistence
can be displayed as Infinite or Variable. For Variable Persistence, you can select the time constant for
fading in seconds as shown in Figure 27.

ale || Prefs | Density | Audio Demod

Show [CIFreeze

Dot Persistence

(¥ Variable: |1.0 s

O Infinite U

Figure 27. The trace settings control panel allows user control of persistence parameters.

Figure 28 demonstrates the observed behavior of variable persistence when a CW signal, represented in
the first frame, is turned off. Even if the event was instantaneous and was confined within a single frame,
you will observe the color changing to indicate lower and lower density values, until the signal finally
disappears entirely.

Figure 28. With variable persistence, a brief CW signal captured by DPX remains in the display for an adjustable
period of time before fading away.

DPX Density Trigger

The standard DPX display shows you a clear picture of transients and other hard-to-find signals. The
version of DPX in instruments with option 200 goes well beyond helping you discover these difficult
to find signals by actually triggering on their appearance to capture them into acquisition memory for
in-depth analysis. If you can see it in the DPX bitmap, you can trigger on it.

Other trigger methods can detect signals that exceed an amplitude threshold, or even a sophisticated
amplitude-vs-frequency mask, but they can't find a signal at a particular frequency if another signal of
higher amplitude is sometimes present at that same frequency. The Runt trigger addresses some of these
signal-under-signal cases, but not all. As shown in Figure 29, the DPX Density trigger can discriminate
signals within a precise amplitude-frequency range without the operator having to know any characteristics
of the target signal besides where it might show up in the DPX Spectrum graph.
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Figure 29. Example of Density Trigger. Left: A free-run DPX display showing pulses with varying frequency.
Occasionally, a short pulse in the middle appears for a split instant, but it is hard to capture it with just a Run/Stop
button. Right: The triggered DPX displays shows the low-amplitude pulse that was not apparent in the untriggered
display. The analyzer was set to trigger whenever the average density in the user-drawn box measured 50% or higher.

The DPX Density trigger uses the same screen-based measurement box as the DPX Density measurement.
While the target signal is absent, the density measurement characterizes the “normal” signals within the
box. When the target signal finally appears, the density value increases. The trigger system monitors the
density measurement and activates a trigger whenever the density value exceeds the adjustable density
threshold. The only thinking you have to do is to set this threshold to a level somewhere between the
normal density readings and the density due to the trouble-making signal. However, the instrument
software can compute the threshold value automatically.

Trigger On This™

The Trigger On This™ function allows you to point and click to set up the DPX Density trigger. By
right-clicking on a spot within the DPX display, or pressing and holding your finger on the touchscreen
display for about a second, a menu selection will appear. Selecting Trigger On This causes a DPX Density
box to appear and automatically adjusts the threshold. The DPX display will now only update whenever
the automatic threshold is exceeded. Subsequently, if needed for your signal, open the Trigger control
panel to adjust the density threshold or the size of the measurement box until the event is reliably captured.

Automatic Threshold Adjustment by Trigger On This™

The trigger density threshold automatically set by Trigger On This is 80% of the measured value. If the
signal was present at the moment you selected Trigger On This, the threshold will be 20% less than the
signal density, so the next time the signal is present long enough (or present enough times) to exceed
the threshold density, it will cause a trigger. If the signal happened to be missing when you selected
Trigger On This, the threshold value will be even lower. If you clicked in a part of the display with no
signal activity at all, the threshold will be set to zero. Any signal that shows up here will fire the trigger,
as shown in Figure 32.
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' DPX Spectrum
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Figure 30. The analyzer triggered when the density in the DPX measurement box exceeded the threshold set by
Trigger On This. You can see in the Spectrogram and Frequency-vs-Time displays that the signal event which caused
the trigger was a quick frequency hop. The Time Overview shows that the signal amplitude never changed, so a
power level trigger would not have worked.

DPX Density Trigger Timing

The time resolution for DPX density measurements is the frame length, around 50 ms. A basic
implementation of the DPX Density trigger concept is also frame-based, so a trigger event that occurs
anywhere within a frame will not be recognized until the end of the frame. Therefore, the worst case
trigger uncertainty is 50 ms.

DPX Density trigger doesn't always have to wait until the end of a frame before firing. For the
common configuration of triggering when the measured density is higher than the threshold, the density
measurement in the trigger can be computed many times within each frame and it can fire the trigger
as soon as the threshold is exceeded.

Consider the case where the threshold is zero. As soon as a single waveform causes a hit within the
measurement box, we know that the density is greater than zero. It takes a little longer to test for a 5 or
10% density, and even more time for thresholds at or near 100%.

The DPX Density trigger can also be set to fire when the measured density is below the threshold value.
This is useful when you suspect that your signal is missing some of the time. For a signal that is supposed
to be CW, you can set the trigger controls to acquire when the density measurement of the signal peak
drops below 100%. When using the “lower than” form of the DPX Density trigger, the time resolution is

SPECMON3 & SPECMONG Printable Help 61



General Signal Viewing DPX Display Overview

one frame because of the following logic: We can't be sure the actual density is less than, say, 15% until at
least 85% of the full test time has elapsed. In order to keep things simple and fast in the trigger module, the
RSA just waits until the end of each 50 ms frame to do the “lower than” comparisons.

Persistence and DPX Density Trigger

The smoothing effect of persistence on density measurements can help in determining a good threshold
value. With persistence turned off, an infrequent signal's density reading jumps between higher and lower
values as it turns on and off, and it can be hard to read these flashing numbers. By turning persistence
on, you instruct the instrument to average the density over a longer time period. This density result is
somewhere between the ON and OFF density values - the very definition of a good trigger threshold.

Unlike the DPX Density measurement, the DPX Density trigger is not affected in any way by persistence.
Density calculations in the trigger system are made with hit count data received from each individual DPX
frame, before any persistence is applied. Even when the density measurement reading in the display

is averaged over many frames due to persistence, the trigger is computing density for each frame and
comparing these quick snapshots against the threshold setting.

DPX Display Overview

The DPX display enables you to see how traces change over time and thus displays signal events that
cannot be seen on a swept spectrum analyzer. A DPX Spectrum indicates how traces change in two ways.
First, it uses color shading to show how consistent the shape of a trace is. Second, it uses persistence to
hold signals on the screen so you can see them longer.

DPX Display

62

The DPX display works by using a two-dimensional array to represent points on the display. Each time a
trace writes to a point on the display, a counter in the array is incremented. A color is assigned to each point
in the display based on the value of its counter. Thus, as acquisitions occur over time, a colored waveform,
the Bitmap, develops on the display that shows how frequently each display point has been written to.

An important feature of the DPX display is dot persistence. Dot persistence sets how long a point on the
display will be visible. You can set the Dot Persistence to be Variable or Infinite. In variable persistence
mode, you specify a decay period that limits how long a point will be displayed. In infinite persistence
mode, once a point in the display has been written to, it will remain visible indefinitely.

The DPX display can plot the trace in the following views:
To display a DPX view:
1. From the Folders box, select General Signal Viewing.

2. Select DPX from the Available displays box.
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3. Click the Add button. This will add the DPX icon to the Selected Displays box (and remove it from
the Available displays box).

4. Click the OK button. This displays the DPX Spectrum view.
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DPX Display

Item Display element Description

1 Vert Position Sets the top of graph value. This is only a visual control for panning the graph.
The Reference Level is adjusted in the Toolbar and the Ampl control panel. By
default, Vert Position = Ref Level.

dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.
RBW Sets the resolution bandwidth. Note that when the RBW is set to Auto, its value is
italicized.

4 DPX view Selects the DPX view. Choices are Spectrum, Zero Span, Frequency, Phase,
DPXogram, and Split.

5 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on screen.

6 Pos/CF Spectrum: Center Frequency - Adjusts the analyzer center frequency. For Zero
Span, Frequency, or Phase the Position is in seconds.

7 Span/Scale, Sweep/Scale Spectrum display: Span - Adjusts frequency range of the measurement. Scale - If
Horizontal scale has been manually adjusted in Settings > Scale, then this control
adjusts the visual graph scaling without affecting the Span. Zero Span, Frequency,
Phase displays: Sweep - adjusts the trace duration in seconds. Scale - adjusts the
visual graph scaling without affecting the Sweep time.

8 Clear Erases the bitmap and traces in the graph and restarts multi-trace functions
(Avg, Hold).

9 Function Readout of the Detection and Function selections for the selected trace.

10 Show Controls whether the selected Trace is visible or not. When trace is Off, the box is
not checked.

1 Trace Selects a trace. Touching here pops up a context menu listing the available

traces, whether they are enabled or not. If user selects a trace that is not currently
enabled, it will be made enabled.

Additional Elements of the DPXogram Split Display
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Item Display element Description

1 Spectrums/line Appears only when the display is stopped. Readout of the number of spectrum
lines represented by each line of the DPXOgram display. This value changes
when the Time/div or Time resolution settings are changed.

2 Color scale Legend at the right side of the DPX Spectrum display. This element illustrates the
relationship between the colors in the DPXogram plot and the amplitude axis of the
DPX Spectrum plot. This scale changes with Color (DPXogram) palette selection
and Max and Min settings on the Ampl Scale tab.

3 DPXogram trace The selected line in the DPXogram graph can be shown in the DPX Spectrum
graph of the Split view. The most recent DPXogram line, usually at the bottom
of the graph, is selected by default. If any markers are on, the selected marker
determines the selected line.

Time Resolution of DPXogram Display

Due to the large amount of data produced by the DPX hardware during acquisitions, a compressed version
of the plot is shown while running. This plot is limited to 500 lines, with each line having 267 points.
However, a much longer record, with higher frequency resolution is being collected. As soon as the
instrument is stopped, this underlying data is shown, replacing the temporary version. There are 50 lines
in each vertical division of the 2-D DPXogram plot, so the time resolution of the graph is Time/div
divided by 50. However, you can set the instrument to collect multiple spectra per line, allowing you to
zoom in later on this high-time-resolution data.

10 x Time/Division

500
When the DPXogram display is stopped, the analyzer can display the full resolution of the captured data.
The Time Resolution readout applies only when the DPXogram is running.

Time Resolution =

Effects of Changing Time Resolution. The Time Resolution control affects acquisition parameters for the
DPX hardware. This means that if you change the Time Resolution value while the instrument is stopped,
the new value applies to the NEXT acquisition, and might not represent the results currently shown in
the display.

Time resolution can be changed either directly, by manually adjusting the Time Resolution control, or
automatically, by changing the Time/div control. Auto is the default, yielding one spectrum per line in the
display. When the Time Resolution is decreased below its auto value, multiple spectra are collected to
create each line in the DPXogram graph. Once you stop the instrument, you can decrease the Time/div
value or use Zoom to see increased time resolution.

If the time resolution is set to a very small number while the Time/div is set to a large value, you might
notice that there is a limit to the number of spectra that can be collected. This limit depends on the number
of trace points selected. For 801-point spectra, 60,000 underlying spectra can be collected. The number of
2401-point spectra collected is 20,000, and for 4001-point spectra the number is 12,000. When the limit is
reached, the oldest spectra are discarded as newer spectra are captured.
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Touchscreen Actions on Markers in the Graph Area

Action Description

Mouse click within 1/2 div. of ~ Selects the marker and updates the marker display to show the selected marker's values.
a marker

Touch marker to select and Adjust the setting associated with the Marker.
then use knob, or arrow keys
Touch and drag a marker Changes marker position to the "drop point". You can use Tools > Options > Prefs to

change whether markers jump from one peak to the next while dragging or move smoothly
along the trace.

Available Traces for Display — Standard Instrument

Five traces can be shown in the DPX display— one bitmap and four line traces. The default traces are
Bitmap and +Peak detection. The other three traces are —Peak detection, average detection, and math.

Trace Description

Bitmap Displays the density of acquired data. The number of data points acquired at each pixel
(representing a particular amplitude level at a specific frequency at a point in time) is indicated
by color.

+Peak detected Line trace. Displays the maximum values acquired in each update. Normal and Hold functions

are available for this trace.

—Peak detected Line trace. Displays the minimum values acquired in each update. Normal and Hold functions
are available for this trace.

Average detected Line trace. Displays the average of all the values acquired in each update. Normal and Hold
functions are available for this trace.

Math Trace Line trace. Displays the difference between two traces. The two traces used are set in the
Traces tab of the Settings panel.

Determining Which Trace Types Are Displayed

You can see the status of all the traces by selecting the Trace drop-down list. Traces that are not displayed
are preceded by "Enable". In the following figure, you can tell that the Bitmap and -Peak Trace traces are
displayed but the +Peak, Average, and Math Traces are not displayed.

Selecting Enable -Peak Trace from the Trace list displays the -Peak detected values trace.

+ % _Bitman__ [V Shnw On

& 0,00 dBm Etnan

© dB/div; Tracel |
10.0 de Enable Trace2

© REW: Enable Trace3
10.00 MHz Enable Math

You can see whether a trace is enabled by looking at its Show check box. The "selected trace" is selected
in the Trace list. The Show check box is checked when the selected trace is enabled. To the right of the
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show box are readouts for detection of the selected trace (+Pk, Avg (VRMS), ) and its function (Hold,
Normal,). You can enable/disable the selected trace by checking or unchecking Show.

< “ Bitnap (¥ Show

Selecting Traces for Display — Standard Instrument
To select a trace for display:
1. Use the Settings control panel:
= Select Setup > Settings or click the Settings button.
= Select the Traces tab.
= Select the trace from the drop-down menu.
= Select the Show check box.

2. Select a trace from the Trace drop-down list.

v v _Ritman__ ¥ Shownin
& 0.00 dBm Btk
T 1
o dB/div: race
10.0 dB Enable Trace2
2 REW: Enable Trace3
10.00 MHz

Enable bath i

Specifying How +Peak, —Peak, and Average Traces Are Displayed

You control how the +Peak, —Peak and Average (Avg (VRMS)) traces are displayed from the Traces tab of
the Settings control panel. From the Traces tab, you can also specify whether these traces display results
from single updates or results collected over multiple updates.

To change how the traces are displayed:
1. Select Setup > Settings or click the Settings button.
2. Select the Traces tab.

3. Select the trace type from the drop-down list.

SPECMON3 & SPECMONG Printable Help 67



General Signal Viewing DPX Display

68

4. If you select +Peak Trace or -Peak Trace, use the Function drop-down list to select either Normal or
Hold.

a. Select Normal to set the trace to display the maximum/minimum values acquired in each
individual update.

b. Select Hold to set the trace to display the maximum/minimum values acquired over time. The
trace values are updated only if they exceed the existing values.

5. Ifyou select Avg (VRMS) or Avg (of logs), use the Function drop-down list to select either Normal,
Average (VRMS), or Avg (of logs).

a. Select Normal to set the trace to display the average values acquired in each update.

b. Select Average (VRMS) or Avg (of logs) to set the trace to display an average of the average
values. Use the Count box to enter the number of times the trace is averaged.

Available Traces for Display (Instruments with Option 200)

Five traces can be shown in the DPX Spectrum, Zero Span, Frequency, and Phase displays— one bitmap
and four line traces. The default traces are Bitmap and Trace 1. The other three traces are 2, 3, and Math.
Line traces 1, 2, and 3 have user-selectable Detection and Function settings. The final line trace is Math,
allowing you to subtract one line trace from another.

For the DPXogram display, only one trace is available — the DPXogram trace.

For the Split display, which consists of a DPXogram display on the top half and a DPX Spectrum display
on the bottom half, you can display the Bitmap trace, Trace 1, Trace 2, Trace 3, Math trace, and Ogram
Line (the selected line from the DPXogram display) on the bottom half of the display.

Selecting Traces for Display (Instruments with Option 200)

This is done almost the same as with the standard instrument, except that the choices available for Trace
are different. Instead of +Pk, —Pk, and Avg traces, you select Trace 1, 2, and 3 and independently set the
Detection method for each of these traces to +Pk, -Pk, Avg (VRMS), or Avg (of logs).

Reference. Changing the DPX Spectrum Display Settings (see page 270)

Tx BER Testing in the DPX Frequency View

The Transmit Bit Error Rate Testing (Tx BER) function measures the bit error rate in a data stream
modulated on a carrier. The modulation type supported is a 2-level FSK signal (2FSK) with a symbol rate
of 16 kHz. Tx BER is available only in the DPX Frequency plot.

The Center Frequency must be set to the carrier frequency. The RBW or Measurement BW must be set
high enough to pass the full frequency deviation of the modulated signal. The vertical scaling on the
display does not affect the measurement. The measurement is also unaffected by trigger settings.

The 16k symbol/second rate has a tolerance of £10ppm. The data patterns supported are PRBS-9,
PRBS-11, PRBS-15, and User.
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The User pattern is a user-defined fixed pattern of arbitrary length up to 30 seconds in duration. The
synchronization pattern (of length “n”) can be specified to be up to 32 bits, and is the first "n" bits of the
user's pattern. The test duration with User pattern can be one time through or repeating. If PRBS lengths
other than the three listed above are needed, the User pattern can be used in repeating mode to get any
PRBS length up to PRBS-18.

When a test is started, the incoming data is sampled to seed the PRBS receiver or find the starting
pattern for User pattern. If errors are occurring in the signal, it is possible to get a spurious match at
test start time, resulting in an invalid measurement. In this case, for a PRBS pattern the error rate will
be 50%, and for User pattern the rate will be pattern-dependent. If this happens, the test can be restarted
with the Clear results function. The symbol count, error count, and error rate (BER) are displayed on
the screen. For a User pattern, the measurement starts after the synchronization pattern has been seen,
so the synchronization pattern symbols are not included as part of the symbol count, although they are
included in the pattern length.

To measure Tx BER, see Tx BER Tab (see page 83).
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DPX Settings

DPX Settings

Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The measurement settings for the DPX display are shown in the following table.

Settings tab

Description

Freq & Span (see page 113)

Sets frequency and span parameters for the DPX display. This tab appears for the
Spectrum and DPXogram displays.

Params (see page 71)

Sets sweep time and scroll settings. This tab appears only for the DPX Zero Span,
DPX Frequency and DPX Phase displays.

Freq & BW (see page 72)

The Freq & BW tab specifies frequency and bandwidth parameters for the DPX Zero
Span, DPX Frequency, and DPX Phase views.

BW (see page 118

Sets Resolution Bandwidth.

Traces (Bitmap) Tab (see
age 72

:

Allows you to configure the Bitmap Trace.

Traces Tab (see page 75)

Allows you to select the number and types of traces to display and their functions.

Traces (Math) Tab (see
age 11

:

Allows you to configure the Math Trace.

Horiz & Vert Scale Tab (see

QO
(0]
-
oo

Sets the vertical and horizontal scale parameters for all the DPX views.

os)

itmap Scale Tab (see

QD
@D
-
©

Sets the DPX Bitmap display parameters.

pg

mplitude Scale Tab (see

[

[<5)
(]
(o]
(=)

The Amplitude Scale tab allows you to change the vertical scale and offset, enable the
3-D Waterfall display, and set the color scheme used for the DPXogram trace.

Time & Freq Scale Tab (see

The Time and Freq Scale tab allows you to change the vertical and horizontal scale

page 81) settings, number of points in the trace, and Time resolution.

Prefs (see page 120) Specifies whether certain display elements are visible.

Density (see page 82) Specifies location and size for the DPX Density measurement box. (Spectrum display
only; instruments with Option 200 only)

Tx BER Tab (see page 83) Specifies BER testing parameters. (Frequency plot only).

Audio Demod (see page 86) Enables and sets parameters for audio demodulation function.
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Params Tab — DPX Zero Span, DPX Frequency and DPX Phase Views

Params Tab — DPX Zero Span, DPX Frequency and DPX Phase Views

The Params tab sets the sweep time for the DPX Zero Span, Frequency and Phase views. Use the Params

tab to set the scroll mode settings for the DPX Zero Span, Frequency and Phase views. In Scroll mode,
points of the trace are plotted as they occur, as opposed to normal mode where the trace is plotted after
an acquisition is completed.

Paramsz | Freq 8 ElWl Traces | Hariz & Yert: Scalel Bitrnap Scale I Prefs |

Sweep time:  1.000 ms

Trace rmotion for Sweep = 1 sec:

{preserves persistence control

< S and trace functions)

Params tab settings Zero Span, Frequency and Phase views

Setting

Description

Sweep time

Sets the time period for the measurement. By default, the Horizontal Scale is equal to
Sweep time and the sweep covers 10 divisions. When the graph is zoomed in, the
sweep time extends beyond the left and/or right edges of the graph. Range: 100 ns -
2000 s. Default: 1 ms.

Trace motion for Sweep

Specifies how the trace is displayed when the sweep time is equal to or greater than

=1 sec 1 second.

Normal Select Normal to scroll the position at which data points are added to the trace. In this
mode, a caret (") moves below the graph to indicate the latest position.

Roll Select Roll to scroll the trace as points are added at the right side of the graph. When
Roll is selected, the trace moves to the left as points are added to the trace at the right
side of the graph.

None Select None to display the trace without motion.
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Freq & BW Tab — DPX Zero Span, DPX Frequency and DPX Phase Views

Freq & BW Tab — DPX Zero Span, DPX Frequency and DPX Phase Views

The Freq & BW tab specifies frequency parameters for some of the DPX display views.

| Params | Freq & Bw | Traces | Scale I Prefs ‘

Center Frequency:
1.500 GHz

Step Sizer
5.0000 Mz Auto

Bandwidth

) Measurerment Bw: 25,0 MHz ‘
(no fitter) Actual BW:

@ RBW filter:
(Tirme-domain By

1.000 MHz 1.000 MHz

BW settings shared with Power Trigger

Freq & BW tab settings for the bitmap trace (Standard and option 200)

Setting

Description

Center Frequency

Sets the frequency at the center of the measurement bandwidth.

Step Size Sets the increment size when changing the Frequency using the knob or mouse wheel.
Arrow keys have an increment 10 times this setting.
Auto When Auto is enabled, the step size is adjusted automatically based on Spectrum's

span setting.

Measurement BW, no filter

Specifies the measurement bandwidth.

RBW (Time-domain BW) filter

RBW (Time-domain BW) is a filter used to process the input signal before the system
analyzes the signal. The filter value determines the acquisition bandwidth that the view
requires. Range: 1 HZ to 60 MHz.

Actual BW

Shows the actual bandwidth being used for the display.

Traces Tab — Bitmap

The Traces Tab allows you to set the display characteristics of displayed traces in the DPX display. The
Traces tab for the DPX display has two versions: one for the DPX Bitmap trace (described in this topic)

72

and one for line traces (see page 75).

| Paramns I Freq & BW| Traces | Hariz & Wert Scalel Bitrnap Scale I Prefs |

Trace: Showe [CIFresze
Dot Persistence
® Wariable: 1.0%
O Infinite E]

Traces tab — Bitmap trace (Instruments with Option 200)
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Traces Tab — Bitmap

| Freq 8 Spanl B | Traces |Amp| Scale | Time & Freg I Prefs I Audio Demod|

Detection:  |+Peak -

Trace: |DPXOgram - [¥] show

[CIFreeze

Traces tab — DPXogram trace (Instruments with Option 200)

Traces tab settings for the bitmap trace (Instruments with Option 200)

Setting Description

Trace Select Bitmap or DPXogram to set the parameters of the DPX Bitmap or DPXogram trace.
Show Specifies whether or not the selected trace is displayed.

Detection (DPXogram trace Sets the Detection method (see page 114) used for the trace. Available detection

only) methods are +Peak, -Peak, and Avg (VRMS).

Intensity (standard instrument Use Intensity to control the visibility of events. An increased intensity level allows a
only) single, short event to be seen. This also makes such an event subject to the persistence

controls. This allows you to see the effect of the Persistence controls on infrequent
events. Range is 1-100%. Resolution: 1.

Dot Persistence

Allows a dot to remain visible if it is not updated with new data. Choices for this setting
are Variable and Infinite. (Not available for the DPXogram trace.)

Variable

The Variable dot persistence setting controls how long a point in the display is visible
before fading (not available for the DPXogram trace). This setting has no units
associated with it.

Range: 1-1000. Resolution 0.1.
Instruments with Option 200 Range: 50 ms -100 s.

Infinite

The Infinite dot persistence setting prevents a point in the display from fading (not
available for the DPXogram trace).

Freeze

Halts updates to the selected trace.

Save Trace As

Saves the selected trace to a file for later recall and analysis.

Show Recalled Trace

Displays a saved trace instead of a live trace (not available for the DPXogram trace).

Dot Persistence

Dot Persistence is the characteristic of the DPX display that determines how long a pixel in the display

remains visible.

To set the Persistence:

1. Select Setup > Settings.
2. Select the Traces tab.

3. Select Dot Persistence.
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4. Select either Infinite or Variable.

Traces Tab — Bitmap

5. Ifyou select Variable, enter a value in the text box. The Variable persistence value can be set from
0.05 to 100 seconds (instruments with Option 200) and 1 to 1000 in instruments without option 200.

Saving Traces

To save a trace for later analysis:

1. Seclect the Save Trace As button. This displays the Save As dialog box.

Save s @
e
-9 [ v Computer » DefaultiC) » RSASIODAFiles » [ 42 || Search R5A51004 Fites ol
Organize + New folder = - (%]
¢ Faworites i Marne Date rmodified Type Size
B Desktop Example Files 62172011 356 PM File folder
& Downloads Sample Data Records 62172011 356 PM File folder
=l Recent Places User Presets 6/2172011 356 P File folder
- Libraries
3 Documnents
.JT Music
=] Pictures
B videos
File name: | -
Save as type: lSa\a:ted trace 'J
=) Hide Folders Save l I Cancel I

2. Navigate to the location where you want to save the file.

3. Type a name for the saved trace and click Save.

Show Recalled Trace

You can recall a previously saved trace for comparison to a live trace. First, specify a trace for recall and

second, enable Show Recalled Trace.

To select a trace for recall:

1. Select the ... button to display the Open dialog box.

74
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Traces Tab

In the Open dialog, navigate to the location of the saved trace.
Select the desired trace file.

Select OK to complete your selection.

Select the Show recalled trace check box.

Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list

located at the top-left corner of the graph).

Traces Tab

The Traces Tab allows you to set the display characteristics of displayed traces in the DPX display. The

Traces tab for the DPX display has two versions. One for non-Bitmap traces (described in this topic)
and one for the DPX Bitmap trace (see page 72).

| Params | Freq & EIW| Traces | Horiz & Wert Scalel Bitrnap Scale I Prefs |

Trace: |Tracel A

Detection:  |[Avg (WRMS) -

Function: |Avg (WVEMS) =

Shiow [CIFreeze Save Trace &s...

Count

10 (i)

Traces tab (instruments with Option 200)

Setting

Description

Trace drop-down list

Selects which trace to configure. The available traces are Bitmap, Trace 1, Trace 2,
Trace 3, and Math (instruments with Option 200). For instruments without Option 200,
the available traces are Bitmap, +Peak detected, -Peak detected, Average, and Math.

Show

Specifies whether or not the trace shown in the Trace setting is displayed.

Freeze

Halts updates to the selected trace.

Detection (instruments with
Option 200)

Sets the Detection method used for the trace. Available detection methods are +Peak,
-Peak, and Avg (VRMS). Not all detection methods are available in all displays.

Function

Selects the trace processing method. Available settings are: Normal, Average, and Hold.

Save Trace As

Saves the selected trace to a file for later recall and analysis.

Show Recalled Trace

Displays a saved trace instead of a live trace.

Count

Enables user adjustable number of averages. This setting is only present when Function
= Average.

Detection

Trace Detection occurs when the trace is being decimated by the measurement. For example, if the
maximum number of trace points is 100,000, and the selected analysis region is 200,000 samples, the
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measurement must decimate the 200,000 resulting trace points by 2 to prevent exceeding the 100,000 trace
point limit. Since only one value can be selected for each trace point, an algorithm must be used to select
(detect) the appropriate value to use.

The available detection methods are:

B +Peak — Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

B -Peak — Each point on the trace is the result of detecting the negative peak value present in the set of
1Q samples available to that trace point.

B Avg (VRMS) [Average Vrus] — Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

NOTE. The Detection setting does not affect the trace until the spectrum length is longer than the Auto
setting.

DPX Trace Processing

The +Peak, -Peak, and Average traces can be processed to display in different ways. The Function setting
controls trace processing.

B Hold - Displays the value in the trace record for each display point. Each new trace display point is
compared to the previous maximum value and the greater value is retained for display and subsequent
comparisons. Available for traces using +Peak or -Peak detection.

B Normal - Displays the trace record for each display point without additional processing. Available
for all detection selections.

m  Average - Default setting for the Average. Multiple traces are averaged together to generate the
displayed trace. There is one vertical value for each underlying frequency data point. Once the
specified number of traces have been acquired and averaged to generate the displayed trace, each new
trace takes the place of the oldest trace in the calculation. The Count setting specifies how many
traces are averaged. Available for traces using Average detection.

Trace averaging uses the exponential method. If Count = 10, the newest trace's contribution to the
averaged trace is 10%. When Count is not checked, the algorithm assumes the maximum number of
traces contributing to the average is 232

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.
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Save s @
=
UU | . » Computer » Default (C) » RSAII00AFiles » - ‘ ‘?l | Segroh REASIO0A Fifes jel |
Organize * New folder = - @

¢ Favorites it Marne : Date modified Type Size

Pl Desktop . Example Files G/2172011 256 PM File folder

& Downloads . Sample Data Records 672172011 3:56 PM File folder

| RecentPlaces |5 . User Presets 672172011 3:56 PM File folder

wal Libraries
3 Documents
.JT Music
[E=) Pictures

B8 videos

File name: | -

Save as type: ISeIected trace vI

< Hide Folders sve | [ concel |

2. Type a name for the saved trace and click Save.

Recalling Traces

You can recall a previously saved trace for comparison to a live trace. First, specify a trace for recall and
second, enable Show Recalled Trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.

]

2. Navigate to the desired file and click Open.
3. Check the Show Recalled Trace check box.

4. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).
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Horiz & Vert Scale Tab

The Horiz & Vert Scale tab allows you to change the vertical scale settings used for the Bitmap trace.
Changing the scale settings changes how the trace appears on the display but does not change control
settings such as Measurement Frequency.

| Params | Freq & Bw| Traces | Horiz & Vert Scale | Bitmap Scale | Prafs |

Wertical

Srale:  100.00 dB

Pasition:  0.00 dBm

Hoarizontal

Scale: 1.000¢

Position: 0,000 =

| Autoscale | | Autoscde |
Setting Description
Vertical Controls the vertical position and scale of the trace display.
Scale Changes the vertical scale.
Offset Adjusts the Reference Level away from the top of the trace display.
Reset Scale Sets Scale to its default value and Offset to zero. Disabled when Units (Setup > Analysis
> Units) is set to Watts or Volts.
Autoscale Resets the scale of the vertical axis to contain the complete trace. Disabled when Units
(Setup > Analysis > Units) is set to Watts or Volts.
Horizontal Controls the horizontal position and scale of the trace display.
Scale Changes the horizontal scale.
Position Adjusts the horizontal position of the signal. This does not change the center frequency.
Autoscale Resets the scale of the horizontal axis to contain the complete trace.
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Bitmap Scale Tab

The Bitmap Scale tab allows you to set the color scheme used for the Bitmap trace. Changing the DPX
bitmap Color, Max and Min scale settings changes how the trace appears on the display but does not
change control settings such as Measurement Frequency.

| Freg & span| 8w | Traces | Horiz & wert Scals| Bitmap Scale | prefs | Density | Audio Demod |

DP¥ Bitrmap (Signal Density)

Max: 100,000 %%

Color: | Temperature - Curve

3

Auto
Min:  0.000 % [— Colar

Setting Description
DPX Bitmap (Signal Density) Controls the appearance and scale of the DPX Bitmap trace.
Color Allows you to select the color palette used for the DPX Bitmap trace.
Max Sets the hit density represented by the top of the color scale. "Clipping" occurs for
densities greater than this value.
Range: 1p% - 100%; Default: 100%.
Min Sets the hit density represented by the bottom of the color range. Range: 0 - 80%;
Default: 0.
Curve Adjusts how colors are mapped to the signal density. The mapping can be linear (Curve
=1), or it can be set to concentrate the resolution on the lower level of the range (Curve >
1) or the mapping can be set to show the best resolution on the upper range of density
or hit count (Curve < 1).
Auto Color Adjusts the Max and Min settings to display the broadest range of colors.
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Amplitude Scale Tab

The Amplitude Scale tab allows you to change the vertical and horizontal scale settings, enable the 3-D
Waterfall display, and set the color scheme used for the DPXogram trace.

| Freg & Span [ Bw | Traces | Ampl Scale | Time & Freg| Prefs | Audio Demod |

Height
Scale: 100.00dB

Offsst:  0.00 dBm

Color (DP¥ogram)
[7] 2O wyaterfall

Coor: [Temperatwe <]
Orientation: Temperature
Mortheast v va 700 G

[ autoscale |  Reset Scale Min: -82.00 dBm
Setting Description
Height Height controls apply only to the 3-D Waterfall display.
Scale Changes the vertical scale for trace Amplitude in the graph (not the vertical scale for
Time).
Position Specifies the level displayed at the bottom edge of the graph. (Bottom front edge in
the 3-D view).
Autoscale Adjusts the vertical position bottom for linear units like Amps and Volts. Adjust the vertical
position top for log units like dBm. dBm is the default.
3-D Waterfall Displays the DPXogram in a 3-D format.
Northeast Shifts the perspective of the 3-D graph so that the oldest traces move back and to the
right.
Northwest Shifts the perspective of the 3-D graph so that the oldest traces move back and to the left.
Reset Scale Resets the Height and Color settings to their default values.
Color (DPXogram)
Color Displays a drop-down list that allows you to set the color scheme used for the DPXogram
trace.
Max Sets the power level represented by the top of the color scale.
Min Sets the power level represented by the bottom of the color scale.
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Time & Freq Scale Tab

The Time and Freq Scale tab allows you to change the vertical and horizontal scale settings, set the time
resolution and number of trace points of the DPXogram display.

| Freg & span| 8w | Traces | ampl Scale | Time & Fred | prafs | Audio Demod |

wertical (time)

Tirne/div:  10.05

Position: 0.0 div

Time at position:  0.000 s

201 -

Capacity:  3:16:36.48

Horizontal (frequency)

Scale: 85,0 MHz

200 e Auto
Offset:  1.9000 GHz

[ Reset Scals | | Autoscale |
Setting Description
Vertical (time)
Time/div For most Spectrogram applications. Primary time scale control is Time/div. Time
scale can be zoomed in or out when acquisitions are stopped.
Position The position of the DPXOgram record at the bottom of the display. Position cannot

be changed while acquisitions are active, and is reset to zero when acquisitions
are started again.

Time at position

Displays the time of the DPXogram line shown at the bottom of the graph. This time
is relative to the Time Zero Reference of the current acquisition. If Position is setto a
negative value, the Time at position readout will be blanked.

Reset Scale

Sets the Time/div and Position settings to their default values.

Trace Points

Sets the number of trace points computed for each DPXogram line. These are the
points used for marker measurements and for results export.

Time resolution

Specifies the length of time represented by each line in the graph.

Auto Sets the time represented by each line in the graph to be adjusted by the analyzer
checked) or manually (when unchecked). When Auto is enabled, Time Resolution
change based on Time/div.

Capacity Readout of the total length of time that can be captured. This readout is provided

so that you can see how changing the Trace Points and Time resolution affects
the amount of data that can be captured. Capacity is represented in the format
dd:hh:mm:ss.

Horizontal (frequency)

Scale Sets the displayed frequency range of the graph. This control affects only visual
scaling, and does not change the acquisition or analysis parameters.

Position Sets the frequency displayed at the center of the graph. Changing this value does
not change the Frequency setting.

Autoscale Sets the frequency scale to the Spectrogram Span value.
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Density Tab - (instruments with Option 200)

The Density tab specifies the parameters of the measurement box used for measuring average signal
density of an area in the bitmap. The measurement box is also used by DPX Density triggering.

| Freg & Span| Bw | Traces | Horiz & vert Scale | Bitmap Scales | Prefs | Density | Audio Demod |

Measurernent bos

Show measurement Frequency: 1.50000 GHz +j-  2.00000 MHz

{measurement always
visible for DP¥ Trigger)

Amplitude:  -20.00 dBm +/- 5.00de

To measure the average signal density over a rectangular portion of the DPX bitmap, you can adjust the
size and location of the measurement area using these controls, or by dragging the measurement box in
the graph. You move the box by dragging the readout. You adjust the size of the box by dragging the
corners or edges.

Displays | | Markers |[Settings || Trig || Acg || Anz | ¢ Freq: 2.05099 GHz < RefLev: 0.00 dBm
< w Bitmap [¥]Show File:Sweep and

< 0.00 dBm

o dB/div:
10.0 dB

& RBW:
300 kHiz

-100.00 dBm

© CF: 2.05099 GHz © Span: 40.00 MHz
DPX Spectrum | Freg & Span | BW | Traces | Scale | Prafs | Density | Audio Demod
Settings
Measurement box
Show measurement Frequency: |2.04355 GHz +/- |2.31250 MHz

(measurement always
visible for DPX Trigger)

Amplitude: |-46.50 dBm /- |4.00 dB
Setting Description
Show Measurement Shows or hides the measurement box in the graph when Triggering is not set to DPX
Density. If Triggering is set to DPX Density, the measurement box is always visible.
Frequency Specifies the frequency at the center of the measurement box. The +/- value specifies
the width of the measurement box.
Amplitude Specifies the amplitude of the center of the measurement box. The +/- value specifies

the height of the measurement box.
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Tx BER Tab

The Transmit Bit Error Rate Testing (Tx BER) function enables you to perform bit error rate testing on
a modulated carrier. Tx BER testing is accessed from the Tx BER tab of the DPX Frequency plot (see

page 68) display settings.
To measure Tx BER:

1.

A

e x2S

Select Freq and use the front panel knob or number keys to set the measurement frequency to the
carrier frequency.

Select the Displays button or Setup > Displays.
From the Folders box in the Select Displays window, select General Signal Viewing.
Select DPX from the Available displays box.

Click the Add button. This will move the DPX icon to the Selected Displays box from the Available
displays box.

Click the OK button. This displays the DPX Spectrum view.
Select the Frequency view from the Plot drop-down list on the left side of the graph.
Click the Settings icon or select Setup >Settings from the menu bar.

Set the Data Pattern as needed. Select User if you want specify a data pattern that is not shown
in the Data Pattern drop-down list.

. Set the RBW, at the left side of the display, so that it is high enough to pass the full frequency

deviation of the modulated signal.

. Click the Enable BER checkbox so that it is checked.

When you enable BER testing, the Tx BER readout will appear.
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Readout Description

Tx BER Displays status of BER test. Status is either Sync or Active. Sync indicates the
instrument is in the process of syncing with the data pattern. Active indicates that testing
is in progress.

BER Readout of the Bit Error Rate.
Bits Readout of the number of symbols counted.
Error Readout of the number of errors counted.
Elements of the Tx BER Tab
| Paramns | Freq & By I Traces I Hariz & \ert Scalel Bitrap Scale I Prefs | Tx BER |
Enable BER Data pattern:  |PRBES-9 - C:\RSAS1004 Files\Example FilesiUse | |...
[T Irvert

Clear results [] Rewerse (PRBS pattern only)

Setting Description

Enable BER Starts and stops BER testing.

Data pattern Specifies the data pattern as PRBS-9, PRBS-11, PRBS-15, or User defined.

Invert Specifies whether the data pattern is normal or inverted.

Reverse (PRBS pattern only) Specifies whether or not the data pattern is in normal order or reversed.

Repeat (user pattern only) Select to specify the test duration for a User Pattern. A User Pattern test duration can be

one time through or it can repeat.

Use the ellipsis button to select a User Pattern file to specify a custom data pattern.

Creating a User Pattern File

A User Pattern file is a CSV file that defines the data pattern used in a signal. Use a User Pattern when
your signal does not use one of the predefined data patterns.

A User pattern is a user-defined fixed pattern of arbitrary length up to 30 seconds in duration. The
synchronization pattern (of length “n”) can be specified to be up to 32 bits, and is the first "n" bits of the
user's pattern. The test duration with User pattern can be one time through or repeating. If PRBS lengths
other than PRBS-9, PRBS-11, or PRBS-15 are needed, the User pattern can be used in repeating mode to
get any PRBS length up to PRBS-18.

The following table contains the keywords required in the User Pattern file. The keywords are specified in
the listed order. The keywords are case insensitive.

Keyword Value Description

[parameters] — Parameters group

Radix Hex, binary Specify if the symbols are in hex or binary format. For example,
the symbol data is: 4A (Hex), 01001010 (Binary)

[Trace] — Symbol group
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Keyword Value Description

NumberSymbols 16 — 491520 Total number of symbols including User and Sync symbols in the
file.

NumberSyncSymbols 1-32 Number of Sync symbols

The Sync symbols are specified immediately after the NumberSyncSymbols line, followed by the User
symbols. Blank line is not allowed within the symbol data. The Tx BER measurement only supports 2FSK
modulation, so the symbol data should be either 0 or 1.

When a user pattern is started, the circuit stays in the Sync state until the synchronization symbols are
seen, it then enters the Active state. If the pattern is repeating, the circuit stays in the Active state. If the
pattern is not repeating, after one time through the symbols, the Done state is entered.

The following text is an example of the content of a User Pattern file.

[Parameters]
Radix,Hex
[Trace]
Numbersymbols, 16

NumbersyncSymbols, 1

©O O B B O O B O O O ©O rBr o o o o
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Audio Demod Tab

Audio demodulation can help you identify unknown radio signals. You control the audio demodulation
function with the Audio Demod tab. You access the Audio Demod tab from the Settings control panel of

the DPX display.

NOTE. Audio Demodulation is available only in real-time acquisition mode (not swept acquisition), and
the Trigger mode must be set to Free Run (not Triggered).

| Freq & Span | Bw | Traces | Horiz & vert Scale| Bitmap Scale | Prefs | Density | Audio Dernod

Audio
Gain*
Off
[

Tune with: |Freg contral -

Receiver Freq: 1019 MHz

Ak Receiver Byy; 0-000kHz

kL

* Sound level is also affected by Windows volume control.

Setting Description

On/Off Enables/disables audio demodulation.

Audio Gain Adjusts the volume of the demodulated audio.

AM Selects Amplitude Modulation as the demodulation method.

FM Selects Frequency Modulation as the demodulation method.

Tune with Specifies how the frequency to be demodulated is specified. You can select markers

or the frequency control.

Receiver Freq

Readout of the frequency to be demodulated.

Receiver BW

Adjusts the equivalent receiver bandwidth for the audio demodulation. The range of
values is 1 kHz to 500 kHz.

AM / FM

Note that these buttons select the demodulation method; they do not specify a frequency band.

Tune with

The choices for this setting are: one of the markers (MR, M1, M2, M3, M4) or the Frequency control
(either the front-panel knob or the Freq control in the application).

To use a marker to specify the frequency to be demodulated:

1. Select Markers > Define Markers to display the Define Markers control panel.

2. Select Add to turn on the next marker.
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NOTE. The first marker defined will always be MR. The MR marker is the reference for delta marker
readouts.

3. Select the trace to which the marker should be attached from the drop-down list.
4. Click Add to add additional markers. Assign them to the appropriate trace.

5. Click the close button to remove the Define Markers control panel.

Select markers. Select one of the markers in the Tune with drop-down list and then set the location of the
marker to the frequency you want to demodulate. If the marker you select is not enabled, the analyzer will
tune to the frequency the marker was last set to.

Receiver BW

The Receiver BW setting will not change the acquisition bandwidth. Thus, if the acquisition bandwidth
is too narrow, audio demodulation will be disabled. The following three cases illustrate the relationship
between the Acquisition BW, Receiver Frequency, and Receiver BW.

Case 1. In this case, the upper limit of the Receiver BW exceeds the upper limit of the acquisition
bandwidth. When this occurs, audio demodulation is disabled and an error message is displayed.

Acquisition B 4—‘

R BIY

R

R Frequency

Case 2. In this case, the upper and lower limits of the Receiver BW exceed the upper and lower limits
of the acquisition bandwidth. When this occurs, audio demodulation will be disabled and an error
message is displayed.
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Acquisiion B 4—‘

} e

R BIY

A
Y

R Frequency

Case 3. In this case, the upper and lower limits of the Receiver BW fall within the upper and lower
limits of the acquisition bandwidth. This is the desired relationship between the three settings, and audio
demodulation is enabled.

e Acquisiion BW 4—‘

P

R BIY

R Frequency

Time Overview Display
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The Time Overview display shows the entire acquisition record and shows you how the spectrum time and
analysis time fit within the acquisition record. This enables you to see how you can adjust the spectrum
time and analysis time to measure portions of the data.

You can specify the maximum number of trace points in the Time Overview display. You can set the
maximum number of trace points to 1K, 10K, 100K, 1M points or to Never decimate. If the Acquisition
Length includes more than 10,000 sample points (and Max trace points is not set to Never decimate), the
trace is decimated (using the +Peak method, similar to +Peak detection in a Spectrum display) to 10,000
points. This decimated trace is what is used for marker measurements.

The Time Overview window displays the Spectrum Length and Analysis Length. The Spectrum Length
is the period of time within the acquisition record over which the spectrum is calculated. The Analysis
Length is the period of time within the acquisition record over which all other measurements (such as
Amplitude vs. Time) are made. The Spectrum Length and Analysis Length can be locked together so
that the data used to produce the Spectrum display is also used for measurement displays; however, they
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do not have to be tied together. They are by default specified separately and used to analyze different
parts of the acquisition record.

Elements of the Display

@ 2 G ® O e

@ a]— | [sTJEd 2990 = Actual: 2.940 us +Peal Narmal [Clear |
© 0,00 dBm

\, deyciv:
@ 10.0d8

100,00 dém ko
Autoscale = Position: -2,587 us 2 Scale: 5,187 us
0519017

SPECMON3 & SPECMONG Printable Help 89



General Signal Viewing

Time Overview Settings

Item Element Description

1 Analysis Time Control Click a button to select the value to be adjusted. In order, the buttons
represent Analysis Offset, Analysis Length, Spectrum Offset, and Spectrum
Length.

Position and Scale Adjusts the vertical scale and position.

Amplitude vs. Time graph The trace represents the entire acquisition record (at full horizontal scale).
The graph indicates the Analysis Length or Spectrum Length on the graph
with a darker background.

4 Autoscale button Resets the horizontal scale to display the entire acquisition record and the
vertical scale to show all trace points.

5 Horizontal Offset Adjusts the horizontal offset.

6 Results Timeline This fuchsia line indicates the portion of the record actually used for
calculating the selected result. For example: if a pulse measurement is
selected, it shows the period of the specific pulse. For a constellation display,
it shows the points included in the demodulation.

7 Horizontal Scale Adjusts the span of the graph. By decreasing the scale, the graph essentially
becomes a window that you can move over the acquisition record by adjusting
the offset.

8 Spectrum Length and Offset This red line indicates the Spectrum Length and Offset. The longer the time,

Indicator the longer the bar. Adjusting the offset shifts the bar left or right.

9 Function This readout displays the Function setting (Setup > Settings > Trace).

10 Detection This readout displays the Detection setting (Setup > Settings > Trace).

1 Actual length display Displays the actual time for the selected value. If the user-adjusted length
extends past the end of the acquisition record, the realizable analysis length
is less than requested.

12 Analysis Length and Offset This blue line indicates the Analysis Length and Offset. The longer the time,

Indicator the longer the bar. Adjusting the offset shifts the bar left or right.
13 Setting Adjustment box Click in this box to adjust the value selected by the Analysis Time Control

buttons.

NOTE. The area with black background (not gray) in the Amplitude vs. Time Graph highlights the control
selected in the Analysis Time Control drop-down list.

Changing the Time Overview Display Settings (see page 90)

Time Overview Settings

90

Menu Bar: Setup > Settings

Front Panel : Settings

Application Toolbar: &
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Trace Tab

The Setup settings for Time Overview are shown in the following table.

Settings tab

Description

Scale (see page 120)

Adjusts the vertical and horizontal scale and offset of the display.

Trace (see page 91)

Allows you to select the types of trace to display and its function.

Prefs (see page 120)

Specifies whether or not certain display elements are shown.

Trace Tab

The Trace Tab allows you to set the display characteristics of displayed traces.

Scale | Trace |prefs

[¥] shay [ClFreeze Save Trace &s...
Detection:  |+Peak -
Count
Function: |&vg (VRMS) + 10 D

Setting Description

Show Shows / hides the selected trace.

Detection Sets the Detection method used for the trace. Not available for saved traces. Available
detection methods are +Peak, -Peak, +/-Peak, Avg (VRMS), and Sample. Not all
detection methods are available in all displays.

Function Selects the trace processing method. Available settings are: Normal, Average, Max
Hold, and Min Hold.

(Number of Traces) Sets the number of traces averaged to generate the displayed trace. (Present only
when Function is set to Average.)

Freeze Halts updates to the selected trace.

Save Trace As

Saves the selected trace to a file for later recall and analysis.

Show Recalled trace

Displays a saved trace instead of a live trace.

Detection

Trace Detection occurs when the trace is being decimated by the measurement. For example, if the
maximum number of trace points is 100,000, and the selected analysis region is 200,000 samples, the
measurement must decimate the 200,000 resulting trace points by 2 to prevent exceeding the 100,000 trace
point limit. Since only one value can be selected for each trace point, an algorithm must be used to select
(detect) the appropriate value to use.

The IQ samples in a data acquisition can be detected in a variety of ways. The number of IQ samples
available to each trace point varies with both analysis length and trace length. For example, with Spectrum
Length set to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one
1Q sample pair per trace point. In this case, the detection method chosen has very little effect, as the
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+Peak, -Peak, Avg (VRMS) and Sample values are all equal. Changing the Spectrum Length causes the
available detection methods to differ in value because they have a larger set of samples for the various
detection methods to process.

The available detection methods (depending on the display) are:

+Peak — Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

-Peak — Each point on the trace is the result of detecting the negative peak value present in the set of
1Q samples available to that trace point.

+/-Peak — Selects the highest and lowest values of all the samples contained in two consecutive
acquisition intervals.

Avg (VRMS) [Average Vrus] — Each point on the trace is the result of determining the RMS Voltage
value for all of the 1Q samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average

for RMS values.

Sample — The result is calculated based on the first sample available in the set of IQ samples for
each trace point.

Trace Processing

Traces can be processed to display in different ways. The Function setting controls trace processing.

Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a
single vertical value.

Average - Multiple traces are averaged together to generate the displayed trace. There is one vertical
value for each underlying frequency data point. Once the specified number of traces have been
acquired and averaged to generate the displayed trace, each new trace takes the place of the oldest
trace in the calculation. The Number of Traces setting specifies how many traces averaged.

Max Hold - Displays the maximum value in the trace record for each display point. Each new trace
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.

Min Hold - Displays the minimum value in the trace record for each display point. Each new trace
display point is compared to the previous minimum value and the lesser value is retained for display
and subsequent comparisons.

Saving Traces

To save a trace for later analysis:

1.

92

Select the Save icon . This displays the Save As dialog box.
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Save s @
=
A | . » Computer » Default (C) » RSAII00AFiles » - ‘ ‘?l | Segrch REASID0A Fifes ol
Organize * New folder = - @

- Favorites it Marne : Date modified Type Size

Pl Desktop . Example Files G/2172011 256 PM File folder

& Downloads . Sample Data Records 672172011 3:56 PM File folder

| RecentPlaces |5 . User Presets 672172011 3:56 PM File folder

wal Libraries
3 Documents
.JT Music
[E=) Pictures

B8 videos

File name: |

Save as type: ISeIected trace vI

< Hide Folders sve | [ concel |

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces

You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.
2. Check the Show check box.

3. Click the ... button to display the Open dialog box.

4. Navigate to the desired file and click Open.
5. Check the Show Recalled Trace check box.

6. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).
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Spectrum Display

94

To display a spectrum:
1. Click the Displays button or select Setup > Displays.
2. From the Folders box, select General Signal Viewing.

3. Double-click the Spectrum icon in the Available displays box. This adds the Spectrum icon to the
Selected displays box (and removes it from the Available displays box). Alternatively, you can click
the Spectrum icon and then click the Add button to select Spectrum for display.

4. Click the OK button.

Elements of the Spectrum Display

v Trace3  [¥IShow Ava (VRMS)Avg [clear |
© -11.00 dBm

o dBfd:

10.0 dB
» RBW:
200 kHz
: VBW:

-111.00 d8m
| Autoscale | = CF: 1.85000 GHz © Span: 20.00 MHz
025004

® ® @
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Spectrum Settings

Item Display element Description
1 Vert Position Sets the top of graph value. This is only a visual control for panning the graph.
The Reference Level is adjusted in the Toolbar and the Ampl control panel.
By default, Vert Position = Ref Level.
dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.
RBW Sets the resolution bandwidth. Note that when the RBW is set to Auto, its
value is italicized.
4 VBW Enables the VBW (Video Bandwidth) filter. See Setup > Settings > BW Tab
(see page 118).
5 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on
screen.
6 Position Default function is CF - center frequency (equivalent to the Freq setting).
If Horizontal scaling has been manually adjusted in Settings > Scale, then
Offset will replace CF as the setting at the bottom-left corner of the screen.
7 Span / Scale Default function is Span - frequency difference between the left edge of
the display and the right edge. If Horizontal scaling has been manually
adjusted in Settings > Scale, then Scale will replace Span as the setting at
the bottom-right corner of the screen.
Clear Restarts multi-trace functions (Avg, Hold).
Function Readout of the Detection and Function selections for the selected trace.
10 Show Controls whether the selected Trace is visible or not. When trace is Off, the
box is not checked.
1 Trace Selects a trace. Touching here pops up a context menu listing the available

traces, whether they are enabled or not. If user selects a trace that is not
currently enabled, it will be made enabled.

Touchscreen Actions on Markers in the Graph Area

Action Description

Mouse click within 1/2 div. of Selects the marker and updates the marker display to show the selected marker's values.
a marker

Touch marker to select and Adjust the setting associated with the Marker.

then use knob, or arrow keys

Touch and drag a marker Changes marker position to the "drop point".

Changing the Spectrum Display Settings (see page 95)

Spectrum Settings

Menu Bar: Setup > Settings
Front Panel: Settings

Application Toolbar: i
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Scale Tab

The settings for the Spectrum display are shown in the following table.

Settings tab

Description

Freg & Span (see page 113)

Sets frequency and span parameters for the Spectrum Analysis display.

BW (see page 118

Sets Resolution Bandwidth and windowing parameters.

Traces (see page 114)

Sets Trace display parameters.

Traces (Math) (see page 117)

Sets the traces used to create the Math trace.

Scale Tab (see page 96)

Sets vertical and horizontal scale and position parameters.

Prefs Tab (see page 120)

Specifies whether or not certain display elements are shown.

Scale Tab

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

| Freq & Spanl B ITraces| Scale |Prefs |

Wertical

Harizortal

crale: 100,00 dB Crgler 50.0 MHz
Pasition: 0,00 dBm Reset Scale Position;  1,9000 GHe
| autoscale | [E] Log  Autoscale
Setting Description
Vertical
Scale Changes the vertical scale.
Position Vertical Position adjusts the top of graph amplitude value. This control allows you to
move (“pan”) the traces up and down in the graph without changing the Reference Level.
Autoscale Resets the Offset so that the trace appears below the top of the graph.
Horizontal
Scale Allows you to change the range of frequencies shown in the graph without changing the
span or measurement frequency.
Position Allows you pan the graph.
Autoscale Resets Scale to the Span setting.
Reset Scale Resets all settings to their default values.
Log scale Resets the display to show the frequency axis in a logarithmic scale.
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Spectrogram Display

The Spectrogram is a display with the vertical axis (time) composed of successive spectral displays, each
having the amplitude represented by color or intensity. The horizontal axis represents frequency. The most
recently acquired spectrum results are added to the bottom of the spectrogram. The addition of a new
spectrum can occur at the fastest rate that new spectra can be plotted, or, if you choose, new spectra can be
added at a timed rate. The spectrogram view is well-suited to displaying long-term trends of spectral data.
The maximum number of lines that can be displayed in a spectrogram is 125,000.

The spectrogram can also be displayed in a 3-D waterfall format. In the 3-D waterfall format, the
spectrogram displays the time axis along a simulated Z-axis.

NOTE. Spectrogram data is shared with the Spectrum display. There is no linkage between DPX and
Spectrogram.

To display a Spectrogram:
1. Select the Displays button or select Setup > Displays. This displays the Select Displays dialog box.
2. From the Folders box, select General Signal Viewing.

3. Double-click the Spectrogram icon in the Available Displays box. This adds the Spectrogram icon
to the Selected displays box.

4. Click the OK button. This displays the spectrogram view.

o

To display a 3-D version of the spectrogram, select the 3-D checkbox.

Elements of the Spectrogram Display

setp Tods vindow| rely

na | @ Freq: z.4lm)o t\iz © Reflev: 0.00 dBm
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Item Display element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows
when the Spectrogram display is the optimized display.

2 Time/div Sets the length of time represented by each vertical division. Divisions are
indicated by tick marks along the left edge of the graph.

3 RBW Sets the resolution bandwidth. Note that when the RBW is set to Auto, its
value is italicized.

4 VBW Enables the VBW (Video Bandwidth) filter. See Setup > Settings > BW Tab
(see page 118).

5 3-D checkbox Enables and disables the 3-D view.

6 Selected records indicators Shows the positions of the start and stop records selected on the Select data
records tab. Drag the indicators to select which records will be played by
Replay All. Note that these are not visible while acquisitions are running; the
instrument must be stopped for the indicators to be visible.

7 T Trigger indicator. This icon indicates the trigger point within the current
acquisition.

8 Pos Position indicates the bottom line visible in graph. Changing this setting
scrolls the window up and down through the displayed acquisition records.

9 Autoscale Resets Vertical and Horizontal scale and Pos to default values.

10 CF Sets the Center Frequency.

" Span Sets the span of the spectrogram display.

12 Current data record indicator A blue line indicates the current data record. When the analysis length is
short, the blue line appears as a thin line much like the selected indicator
line. When the analysis length is relatively long, the blue line appears more
like a blue bar.

13 Position scroll bar Changes the position of the trace in the window. Changing the position scroll
bar is the same as adjusting the Pos setting.

14 Selected indicator This inverse-colored line indicates the Spectrogram line that will appear in

the Spectrum display when the Spectrogram trace is enabled. This line is
attached to the selected marker.
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Item

Display element

Spectrogram Settings

Description

15

Clear

Clears the spectrogram display; however, data records in acquisition history
remain in memory and are available for replay. To clear memory, select File >
Acquisition Data Info > Delete All Data.

16

Marker indicators

These icons indicate the position of markers in the spectrogram. You can
move markers by dragging the desired marker indicator.

17

Detection setting

Displays the selected Detection method (see Settings > Trace (see page 100)
tab).

18

Marker readout

Marker readout for the selected marker. In the Spectrogram display, the
marker readout includes a date and timestamp. The time is displayed
in a 24-hour format. The timestamp readout can be shown or hidden
independently of the other marker readouts (see Settings > Prefs (see

page 120)).

19

Time Scale status readout

Three readouts can appear here depending on settings: Time/update,
Spectrums/line, and Overlap. See Time Scale Status Readout (see

page 99).

Time Scale Status Readout

Three types of readouts can appear in the display depending on settings:

Time/update — Displays minutes:seconds when Spectrum Monitor is selected in the Settings > Time
& Freq Scale tab in the Vertical (Time) section.

Spectrums/line — Displays an integer number when vertical scale is Normal and each line contains the
results from one or more frequency transforms (whether zoomed out or not).

Overlap — Displays the overlap percentage when vertical scale is Normal and each line's transform
shares some points with the transforms of lines before and after it (zoomed in). Overlap can only be
done when the Analysis Length > 2x RBW frame length.

The Spectrogram can show results from one or multiple acquisitions and it can show one or multiple
lines for each acquisition.

Changing the Spectrogram Display Settings (see page 99 )

Spectrogram Settings

Menu Bar: Setup > Settings

Front Panel: Settings

Application Toolbar: &t

The Setup settings for the Spectrogram display are visible when Spectrogram is the selected display.
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Settings tab

Trace Tab

Description

Freq & Span (see page 113)

Sets frequency and span parameters for the Spectrogram display.

BW (see page 118

Sets Resolution Bandwidth and windowing parameters.

Trace (see page 100)

Sets Trace display parameters.

Amplitude Scale (see

page 101)

Selects between 2-D and 3-D, sets height scale, position and orientation for 3-D display.
Sets color parameters for the spectrogram trace.

Time & Freq Scale (see

page 101)

Sets the vertical and horizontal scale parameters for the spectrogram trace. The
Spectrum Monitor controls are also on this tab.

Prefs (see page 120)

Specifies whether or not certain display elements are shown.

Trace Tab

100

The Spectrogram Trace tab controls let you specify the Detection method, save traces, and recall saved
traces for display. The Spectrogram Trace tab does not have all the controls that other Trace tabs contain,
however, it does have a unique display element, the Selected Line readout. For details on Detection,
Freeze, and saving and recalling traces, see the Traces Tab (see page 114).

| Freq & Spanl By | Trace |f-\mplitude Scale | Timne & Freq Scalel Prefs |

Selected Line:
6/30/2006

Detection: |+Peak -

[ClFreeze Save Trace &s...

Selected Line

Displays the time at the Selected Line. If Markers are enabled, the selected line is positioned by the
selected marker. If no markers are enabled, the selected line is the first line in the current analysis period.
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Amplitude Scale Tab

The Amplitude Scale tab allows you to change the vertical and horizontal scale settings, enable the 3-D
Waterfall display, and set the color scheme used for the spectrogram trace.

| Freg & Span| Bw | Trace | Ampitude Scale | Time & Freq Scale | Profs |

Height (3-D only) Color (Poweer)
Scale: 100,00 dB 30 waterfal Colar: | Ternperature -
Position:  -5.00 dEm biodtheast = Max; 0.00 dBm —

Autoscale Reset Scale Mir:  -100.00 dBrn .

Setting Description
Height (3-D only)
Scale Changes the vertical scale for trace Amplitude in the graph (not the vertical scale for
Time).
Position Specifies the level displayed at the bottom edge of the graph. (Bottom front edge in
the 3-D view).
Autoscale Adjusts the vertical position and scale of the trace lines to bring them into the visible
portion of the graph.
3-D Waterfall Displays the spectrogram in a 3-D format.
Northeast Shifts the perspective of the 3-D graph so that the oldest traces move back and to the
right.
Northwest Shifts the perspective of the 3-D graph so that the oldest traces move back and to the left.
Reset Scale Resets the Height and Color settings to their default values.
Color (Power)
Color Displays a drop-down list that allows you to set the color scheme used for the
spectrogram frace.
Max Sets the maximum power level represented by the top of the color scale.
Min Sets the minimum power level represented by the bottom of the color scale.

Time & Freq Scale Tab

The Time and Freq Scale tab allows you to change the vertical and horizontal scale settings, enable the 3-D
Waterfall display, and set the color scheme used for the spectrogram trace.
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Time & Freq Scale Tab

| Freq & Span| Bw | Trace | Amplitude Scale | Time & Freq Scale | prefs |

Yertical (Tirme)
@ Mormal

Crverlap, 94 %

Timefdiv:  72.0 us Scale:  10.00 MHz
Visible elapsed kime:  396.7 us

Hotizontal (Frequency)

] Position: 12,3 div Position:  2.44530 GHz
- Spectrum Manitar Tirne ak position: 1,261 ms
om 1s Reset Scale I I Autoscale Autoscale
Setting Description
Vertical (Time)
Normal For most Spectrogram applications. Primary time scale control is Time/div. Time scale

can be zoomed in or out.

Spectrum Monitor

For long-term signal monitoring applications. In spectrum monitor mode, each line in the
spectrogram represents the period of time specified by the Time/update parameter. Time
scale can be zoomed out, but not zoomed in (no overlap).

Time/update Sets the time, in minutes and seconds, represented by each line of the spectrogram.
Only available in Spectrum Monitor.

Reset Scale Resets the Time/div and Pos settings to their default values.

Autoscale Scales the vertical (time) axis to compress all existing trace lines into the visible area
of the graph. Resets the Position value to zero, placing the most recent spectrogram
line at the bottom of the spectrogram display. Only Position is affected by Autoscale
when Spectrum Monitor is selected.

Time/div Sets the time displayed per division.

Visible elapsed time

Displays the length of time visible in the display. This does not represent the total time
available to view.

Position

Adjusts vertical position of the trace within the graph area. Setting represents the offset,
in divisions, between the bottom of the graph and the bottom (most recent) line in the
results trace.

Time at position

Displays the time of the spectrogram line shown at the bottom of the graph. This time is
relative to the Time Zero Reference of the current acquisition.

Horizontal (Frequency)

Scale Sets the frequency range of the graph without changing the Span value.

Position Sets the frequency displayed at the center of the graph. Changing this value does not
change the Freq setting.

Autoscale Sets the frequency scale to the Spectrogram Span value.

Spectrum Monitor

Spectrum Monitor performs long term monitoring. The monitor mode compresses time into each line

of the spectrogram, which enables you to monitor long periods of time (from 1 second per line up to
600 minutes per line). With extended memory (Option 02) installed in the instrument, you can capture up
to 125,000 lines. With standard memory installed in the instrument, the maximum number of lines you

can capture is 31,250.

During each line's collection period, spectrum transforms are computed for each acquisition taken by the
instrument. As each transform completes, it is incorporated into the current spectrogram line. How each

102
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line of the spectrogram is created in spectrum monitor mode depends on the detection setting (Settings >
Trace). For example, if Detection is set to +Peak, each spectrogram line is effectively a peak hold display
of all the spectral data captured since the prior line.

Amplitude Vs Time Display

The Amplitude vs. Time display plots the signal amplitude against time. The amplitude appears on the
vertical axis while time is plotted along the horizontal axis.

Note that the trace(s) in the Amplitude vs. Time display can be set to a maximum of 100,000 points
(however, the actual number of trace points can extend up to 1,000,000 points if Max trace points is set
to Never Decimate). If the Analysis Length includes more than the selected Max trace points value, the
trace is decimated (using the method specified with the Detection control) to be equal to or less than the
Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or
undecimated) trace is what is used for marker measurements and for results export. You can set the Max
trace points on the Settings > Prefs tab.

To show Amplitude vs. Time display:
1. Press the Displays button or select Setup > Displays.

In the Select Displays dialog, select General Signal Viewing in the Folders box.

»

In the Available displays box, double-click the Amplitude vs. Time icon or select the icon and click
Add. The Amplitude vs. Time icon will appear in the Selected displays box and will no longer
appear under Available displays.

Click OK.

>

Elements of the Display

< v Trace 1 VIShowr +Peak Narmal Clear’
& 0,00 dEm

dpfdv:
10.0de
Spary
40.00 MHz

@ee

-100.00 dBm
Autoscale o
RMS: -17.43 dBm @ Position: 853.624 us © Scale: 250.000 us
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Amplitude Vs Time Settings

104

Amplitude Vs Time Settings

Item Display element Description
1 Vert Position Adjusts the vertical display offset.
2 Vertical scale adjustment Adjusts the vertical scaling.
3 Span Adjust the bandwidth of the data to be analyzed. (Not the period of time
shown in the display.)
Autoscale Adjusts the vertical and horizontal settings to provide the best display.
Offset Adjust the horizontal offset.

Max and Min readouts

Displays the maximum and minimum amplitudes, as well as when those
values occur.

Scale

Sets the time spanned by the graph.

Clear button

Restarts multi-trace functions (Avg, Hold).

Trace function

Displays the current trace function setting (Settings > Trace tab > Function).

Reference. Changing Amplitude vs Time Display Settings (see page 104)

Menu Bar: Setup > Settings

Front Panel: Settings

Application Toolbar: &

The settings for the Amplitude vs. Time display are shown in the following table.

Settings tab Description

BW (see page 105 Sets the Bandwidth Method used for setting the measurement bandwidth.
Traces (see page 114) Allows you to select the type of trace to display and their functions.
Traces (Math) (see page 117) Sets the traces used to create the Math trace.

Scale (see page 120) Sets the vertical and horizontal scale parameters.

Prefs (see page 120) Specifies whether certain display elements are visible.
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Freq & BW Tab

The Freq & BW (Bandwidth) tab allows you to specify the measurement frequency the bandwidth
parameters used for setting measurement bandwidth. This determines what Acq BW the measurement
will request.

Freq & BW | Traces | Scale | Prefs

@ Measuremnent B, no filter: 40,00 MHz Link to Span

Measurement Freq:
2.70000 GHz _) Time-domain BW filter: 1.00 MHz

Set to max Bw

Settings Description

Span The frequency span used for analysis in the Amplitude vs. Time display. If the spectrum
display is open, the span is automatically set to the analyzer bandwidth.

Frequency Vs Time Display

The Frequency vs. Time Display shows how the signal frequency varies with time.

Note that the trace(s) in the Frequency vs. Time display can be set to a maximum of 100,000 points
(however, the actual number of trace points can extend up to 1,000,000 points if Max trace points is set
to Never Decimate). If the Analysis Length includes more than the selected Max trace points value, the
trace is decimated (using the method specified with the Detection control) to be equal to or less than the
Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or
undecimated) trace is what is used for marker measurements and for results export. You can set the Max
trace points on the Settings > Prefs tab.

To display the Frequency vs. Time Display:
1. Select the Displays button or Setup > Displays.
2. In the Select Displays dialog, select General Signal Viewing in the Folders box.

3. Inthe Available displays box, double-click the Frequency vs. Time icon or select the icon and click
Add. The Frequency vs. Time icon will appear in the Selected displays box and will no longer
appear under Available displays.

4. Click OK to display the Freq vs. Time display.
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Frequency Vs Time Settings
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Elements of the Display

@

Frequency Vs Time Settings
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Item Display element Description

1 Top of graph adjustment Use the knob to adjust the frequency range displayed on the vertical axis.

2 Offset adjustment Adjusts the frequency shown at the center of the display.

3 Autoscale button Adjusts the offset and range for both vertical and horizontal to provide the
best display.

4 Maximum and Minimum Displays the maximum and minimum values, as well as when those values

frequency readouts

occur.

Horizontal Scale

Sets the time spanned by the graph.

Clear button

Restarts Average trace.

Trace function

Displays the current trace function setting (Settings > Trace > Function).

Changing Frequency vs Time Display Settings (see page 106)

Menu Bar: Setup > Settings

Front Panel: Settings

Application Toolbar: &

The Setup settings for Frequency vs. Time are shown in the following table.
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Settings tab Description

Freq & Span (see page 113) Sets the frequency and span parameters.

Trace (see page 114) Sets the trace display parameters.

Scale (see page 120) Sets the Veertical and Horizontal scale and offset parameters.
Prefs (see page 120) Specifies whether certain display elements are visible.

Phase Vs Time Display

The Phase vs. Time display plots the signal phase against time. The phase appears on the vertical axis
while time is plotted along the horizontal axis.

Note that the trace(s) in the Phase vs. Time display can be set to a maximum of 100,000 points (however,
the actual number of trace points can extend up to 1,000,000 points if Max trace points is set to Never
Decimate). If the Analysis Length includes more than the selected Max trace points value, the trace is
decimated (using the method specified with the Detection control) to be equal to or less than the Max trace
points setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated)
trace is what is used for marker measurements and for results export. You can set the Max trace points

on the Settings > Prefs tab.

To display Phase vs. Time:
1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select General Signal Viewing in the Folders box.

3. In the Available displays box, double-click the Phase vs. Time icon or select the icon and click
Add. The Phase vs. Time icon will appear in the Selected displays box and will no longer appear
under Available displays.

4. Click OK to show the Phase vs. Time display.
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Elements of the Display

Phase Vs Time Settings
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Item Display element Description

1 Top of graph adjustment Adjusts the vertical scale. Use the knob to adjust the value of the top of the
graph.

2 Vertical offset adjustment Adjusts the phase error shown at the vertical center of the display.

Autoscale button

Adjusts the vertical and horizontal settings so that the entire trace fits in the
view.

Horizontal Offset

Adjusts the horizontal position of the trace.

5 Max and Min readouts Displays the maximum and minimum value of the phase error within the
analysis times and the times at which they occurred.
6 Horizontal Scale Sets the time spanned by the graph.

Clear button

Restarts multi-trace functions (Avg, Hold).

8 Trace function

Shows the trace function as set on the Settings > Trace tab.

Changing the Phase vs Time Display Settings (see page 108)

Phase Vs Time Settings

108

Menu Bar: Setup > Settings
Front Panel: Settings

Application Toolbar: Wt

The settings for the Phase vs. Time display are shown in the following table.
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Settings tab Description

Freq & Span (see page 113) Sets the frequency and span parameters.

Trace (see page 114) Sets the trace display parameters.

Scale (see page 120) Sets the Veertical and Horizontal scale and offset parameters.
Prefs (see page 120) Specifies whether certain display elements are visible.

RF |1 & Q vs Time Display

This is a plot of the baseband In-Phase (I) and Quadrature (Q) components of a modulated carrier. The plot
is in the time domain, with I and/or Q values the Y-axis.

Note that the trace(s) in the RF I & Q vs. Time display can be set to a maximum of 100,000 points
(however, the actual number of trace points can extend up to 1,000,000 points if Max trace points is set
to Never Decimate). If the Analysis Length includes more than the selected Max trace points value, the
trace is decimated (using the method specified with the Detection control) to be equal to or less than the
Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or
undecimated) trace is what is used for marker measurements and for results export. You can set the Max
trace points on the Settings > Prefs tab.

To display an RF I & Q vs. Time display:
1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Folders box, select General Signal Viewing.

3. Double-click the RF 1&Q vs. Time icon in the Available Displays box. This adds the RF I & Q vs.
Time icon to the Selected displays box.

4. Click the OK button.
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Elements of the Display
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Item Display element Description

1 Top of Graph adjustment Use the knob to adjust the vertical scaling.

2 Vertical offset adjustment Adjusts the level shown at the center of the display.

3 Autoscale button Adjusts the offset and scale for both vertical and horizontal to provide the

best display.

4 Maximum and Minimum level Displays the maximum and minimum values, within the Analysis Time, as well
readouts as the times at which they occurred.

5 Scale Sets the time spanned by the graph.
Clear button Restarts multi-trace functions (Avg, Hold).
Trace function Displays the current trace function setting (Settings > Trace > Function). If the

traces are averaged, the number of averages is displayed.

8 Trace Control Selects which trace is displayed (using the drop-down list) and which trace is
active (click on the trace name to display a menu).

Changing the RF I & Q vs Time Display Settings (see page 110)

RF | & Q vs Time Settings

10

Menu Bar: Setup > Settings

Front Panel: Settings

Application Toolbar: o
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The Setup settings for RF 1&Q vs. Time are shown in the following table.

Settings tab Description

Freg & BW (see page 112) Sets the frequency and span parameters.

Trace (see page 114) Sets the trace display parameters.

Scale (see page 120) Sets the Vertical and Horizontal scale and offset parameters.
Prefs (see page 120) Specifies whether certain display elements are visible.
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General Signal Viewing Shared Measurement Settings

General Signal Viewing Shared Measurement Settings

The control panel tabs in this section are identical or very similar for each of the displays in the General

Signal Viewing folder (Setup > Displays). Some tabs are shared by all the displays, some tabs are shared
by only a couple of displays.

For some tabs, the control values are shared across all the General Signal Viewing displays. For other
control values, each display has unique values for the controls. Details are provided for the specific tabs.

Common controls for general signal viewing displays

Settings tab

Description

Freg & Span (see page 113)

Sets the frequency and span parameters.

Trace (see page 114)

Sets the trace display parameters.

Traces — Math (see page 117)

Sets the traces used to create the Math trace.

BW (see page 118

Sets the Bandwidth Method used for setting the measurement bandwidth.

Scale (see page 120)

Sets the Vertical and Horizontal scale and offset parameters.

Prefs (see page 120)

Specifies whether certain display elements are visible.

Freq & BW Tab — RF | & Q Vs. Time Display

12

The Freq & BW tab provides access to settings that control frequency settings for the RF I & Q vs Time

display.

Setting

Description

Measurement Freq

The frequency at the which measurements are made. This value is the same as the
setting for Frequency in the Application bar.

Measurement BW

This control limits the bandwidth of measurements. You use the measurement bandwidth
setting to improve the signal-to-noise ratio of the measurement, resulting in lower
measurement uncertainty. However, if the measurement bandwidth is set too low,
resulting in fewer samples per second, it can reduce the number of points within the
measurement length below the 256 stable samples required, thus causing the analysis
to fail.

Link to Span When enabled, the measurement bandwidth of the RF | & Q display is determined by
the span of the analyzer. When unchecked, the measurement bandwidth is specified by
the user, and no additional filter is applied.

Set to max BW Sets the measurement bandwidth to the maximum acquisition bandwidth of the

instrument.
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General Signal Viewing

Freq & Span Tab

Freq & Span Tab

The Freq & Span tab provides access to settings that control frequency settings for the trace display. The
control values set in this tab are shared by all the General Signal Viewing displays.

Freq & Span By | Traces | Horiz & vert Scale | Bitmap Scale | Prefs | Density | Audio Demod |

Center: 19000 GHz
Start: 1,8375 GHz

Stop: 1.9425 GHz

Span: 83.0 MHz Max Span

Dweel time:  50.0 ms Auto
(=wept only)

Step Size: 3, 0000 Mt [¥] Auto
Setting Description
Center The frequency at the center of the selected Span.
Start The lowest frequency in the span.
Stop The highest frequency in the span.
Step Size Sets the increment/decrement size for Center, Start and Stop values.
Span The difference between the start and stop frequencies. This is the measurement

bandwidth for the general signal viewing displays.

Dwell time (DPX display only)

The amount of time the DPX sweep remains in a frequency segment collecting data
and updating the bitmap and traces before moving on to the next higher frequency
segment. The minimum Dwell Time setting is 50 ms, the normal update rate for DPX
computations. Maximum Dwell Time per frequency segment is 100 s. The number of
frequency segments and their start/stop frequencies are internally determined based on
span, acquisition bandwidth, RBW and other parameters.

Max Span

Sets the Span to the maximum value.

Center, Start, Stop, and Span Frequencies Are Correlated

Changing the values for Center frequency, Start frequency, Stop frequency or Span will change the values
for the other settings, depending on which setting you change. For example, if you change the Center
frequency, the Start and Stop frequencies will be adjusted automatically to maintain the same Span.

Note however that if the Start and Stop frequencies are changed so that they are closer than the minimum
span setting, the Start and Stop frequencies will be adjusted to maintain the minimum Span setting.

Setting Changed Manually

Settings Changed Automatically As Setting Not Automatically Changed

a Result
Start Center, Span Stop
Stop Center, Span Start
Center Start, Stop Span
Span Start, Stop Center
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Traces Tab

Traces Tab

The Traces Tab allows you to set the display characteristics of displayed traces.

| Freg & Span| Bw | Traces |Scale | profs |

Trace: |Trace 1 - [¥] Shavw [CFreeze Save Trace As...
Detection:  |+Peak h
Function: | Morrnal - D

Setting Description

Trace Selects a trace. (This setting is not present for every display.)

Show Shows / hides the selected trace.

Detection Sets the Detection method used for the trace. Not available for saved traces. Available
detection methods are +Peak, -Peak, +/-Peak, Avg (VRMS), Sample, CISPR Avg, CISPR
Pk, and CISPR QPk. Not all detection methods are available in all displays.

Function Selects the trace processing method. Available settings are: Normal, Average, Max
Hold, and Min Hold.

Count Sets the number of traces averaged to generate the displayed trace. (Present only when
Function is set to Average, Min Hold, or Max Hold.)

Freeze Halts updates to the selected trace.

Save Trace As

Saves the selected trace to a file for later recall and analysis.

Show Recalled trace

Displays a saved trace instead of a live trace.

Trace

Available traces for Spectrum are: Trace 1, Trace 2, Trace 3, Math, and Spectrogram. Other displays
support fewer traces. Traces 1-3 are based on the input signal and enable you to display the input signal
using different processing. For example, you could display Trace 1 with Function set to Normal, Trace 2
with Function set to Max Hold and Trace 3 with Function set to Min Hold.

The Math trace is the result of subtracting one trace from another.

The Spectrogram trace applies only to the Spectrum display and is available only if the Spectrogram
display is shown. The Spectrogram trace shows the trace selected in the Spectrogram as a spectrum trace.

Detection

Trace Detection is used to reduce the results of a measurement to the desired number of trace points. For
example, if the maximum number of trace points is 100,000, and a measurement over the selected analysis
length yields 200,000 points, the measurement must decimate these 200,000 trace points by 2 to prevent
exceeding the 100,000 trace point limit. Since only one value can be represented for each trace point, an
algorithm must be used to select (detect) the appropriate value to use.
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The results array from an analysis can be detected (or “decimated”) in a variety of ways. The number

of results points produced for each trace point varies with both analysis length and trace length. For
example, the frequency transform used for the Spectrum display produces just one output value for each
desired trace point. In this case, the detection method chosen has no effect, as no decimation is required.
Increasing the Analysis Length (or for the Spectrum display, the Spectrum Length), causes the available
detection method's output traces to differ from each other because they have a larger set of samples for the
various detection methods to process.

The available detection methods (depending on the display) are:
B +Peak — The highest value is selected from the results to be compressed into a trace point.
m  -Peak — The lowest value is selected from the results to be compressed into a trace point.

B +/-Peak — Both the highest and lowest values are selected from the results to be compressed into a
trace point.

®  Avg (VRMS) [Average Vrus] — Each point on the trace is the result of determining the RMS Voltage
value for all of the results values it includes. When displayed in either linear (Volts, Watts) or Log (dB,
dBm), the correct RMS value results.

m  Avg (of logs) — The detector is used to emulate legacy spectrum analyzer results and for the
specification of displayed average noise level. In older swept analyzers, a voltage envelope detector is
used in the process of measuring signal level, and the result is then converted to Watts and then to
dBm. Averaging is then applied to the resultant traces.

For CW signals, this method results in an accurate power measurement. However, with random noise
and digitally modulated carriers, errors result from this 'average of logs' method. For random noise,
the average of logs methods results in power levels -2.51 dB lower than that measured with a power
meter, or with a signal analyzer that measures the rms value of a signal, and performs averaging on the
calculated power in Watts and not dBm or other log-power units.

This detector should be used when following a measurement procedure that specifies it, or when
checking the Displayed Averaged Noise Level (DANL) of the instrument. The 'average of logs'
detection and trace function is used for DANL specification to provide similar results to other
spectrum/signal analyzers for comparison purposes. Use of the Average of Logs method of
measurement is not recommended for digitally modulated carriers, as power measurement errors
will occur.

NOTE. The Detection setting does not affect the trace until the spectrum length is longer than the Auto
setting.

B Sample — The first value is selected from the set of results to be compressed into a trace point.

m  CISPR Peak — The trace value is calculated by the methods described for peak detectors in the
CISPR documents.

Trace Processing

Traces can be processed to display in different ways. The Function setting controls trace processing.
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Traces Tab

B Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a

single vertical value.

Average - Multiple traces are averaged together to generate the displayed trace, which will contain just
one vertical value for each underlying frequency data point. Once the specified number of traces have
been acquired and averaged to generate the displayed trace, additional traces contribute to the running
average, except in Single Sequence run mode. In the case of Single Sequence, the instrument stops
running after the specified number of traces have been averaged together. The Number of Traces
setting specifies how many traces are averaged. The averaging is performed on the linear (Voltage)
values, resulting in the correct RMS average).

Max Hold - Displays the maximum value in the trace record for each display point. Each new trace's
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.

Min Hold - Displays the minimum value in the trace record for each display point. Each new trace's
display point is compared to the previous minimum value and the lesser value is retained for display

and subsequent comparisons.

Saving Traces

To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

Save As

5

’k,/\\./ [ » Computer » Default(C:) » RSAS1004 Files »

Organize * Mew folder

-
. Mame
- Favorites

Bl Desktop Example Files
& Downloads Sarnple Data Records

Ol RecertPlaces  |F User Presets

o Libraries
3 Docurnents
J Music
| Pictures

B videos

Date maodified

6/21/2011 356 P
6/21/2011 356 P
6/21/2011 356 P

~ | 49 || Search RsA51004 Fites )

= @

Size

File name: |

Save as type: ISE\ELted trace

= Hide Folders

Save l I Cancel I

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces

You can recall a previously saved trace for analysis or comparison to a live trace.
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To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.
2. Check the Show check box.

3. Click the ... button to display the Open dialog box.

]

4. Navigate to the desired file and click Open.
5. Check the Show Recalled Trace check box.

6. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).

Traces Tab — Math Trace

This tab is not a distinct tab, it is just how the Traces tab appears when Math is selected in the Traces
drop-down list.

| Freg & Span | Bw | Traces |scale | prefs |

Trace: |Math - [¥] showe [CIFreeze Save Trace As..,

Trace2 +| minus | Tracel - D

Trace 4 is a mathematically-derived trace defined as Trace A minus Trace B. You can select Trace 1, 2, or
3 to serve as either Trace A or Trace B.

Setting Description

Trace When set to Trace 4 (Math), this tab is displayed.

Show Shows / hides the selected trace.

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.
Trace minus Trace Selects which traces serve as Trace A and Trace B.
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BW Tab

18

The BW (bandwidth) tab allows you to change Resolution Bandwidth and Video Bandwidth settings,
and set the windowing method used by the transform process by selecting a filter shape (not present
for all displays).

| Freq & Span| BW | Traces | Scale | prefs |

@ REW a00 kHz Auto Span/REW ratio: 100
*) Filter Shape [Kaiser (REW 'I WEwW: 500 kHz
Setting Description
RBW Sets the Resolution Bandwidth value to be used in the spectrum analysis view. The

value is italicized when Auto is selected.

Auto When Auto is checked, the RBW is calculated as a percentage of the Span. Kaiser is
selected as the windowing method. When Auto is unchecked, the RBW is set by the user.
Selecting any Window other than Kaiser changes the RBW setting to manual.

Span/RBW ratio If Auto is checked, this value is used to calculate the RBW. If Auto is unchecked, this
setting is not selectable.

Filter Shape Specifies the windowing method used for the transform (when Auto is unchecked).
(Spectrum and Spectrogram displays only.)

VBW Adjusts the VBW (Video Bandwidth) value. (Spectrum and Spectrogram displays only.)

Filter Shape Settings

In the analyzer, computationally efficient discrete Fourier transform algorithms such as FFT (Fast Fourier
Transform) or CZT (Chirp-Z Transform) are generally employed to transform time-domain signals into
frequency-domain spectra. There is an assumption inherent in the mathematics of Discrete Fourier
Transforms that the data to be processed is a single period of a periodically repeating signal. The
discontinuities between successive frames will generally occur when the periodic extension is made to the
signal. These artificial discontinuities generate spurious responses not present in the original signal, which
can make it impossible to detect small signals in the presence of nearby large ones. This phenomenon is
called spectral leakage.

Applying a filter, such as Kaiser, to the signal to be transformed is an effective method to combat the
spectral leakage problem. Generally the filter has a bell shape. Multiplying the transform frame by the
filter function eliminates or reduces the discontinuities at the ends of the frame, however, at the expense of
increased RBW.
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Filter Shape Characteristics

The choice of filter shape depends on its frequency response characteristics such as side-lobe level,
equivalent noise bandwidth and maximum amplitude error. Use the following guidelines to select the
best filter shape.

Filter Shape Characteristics

Kaiser (RBW) Best side-lobe level, shape factor closest to the traditional Gaussian RBW.

-6dB RBW (MIL) These filters are specified for bandwidth at their -6 dB point, as required by military
EMI regulations.

CISPR These filters comply with the requirements specified in the P-CISPR 16 -1-1 document
for EMI measurements.

Blackman-Harris 4B Good side-lobe level.

Uniform (None) Best frequency resolution, poor side-lobe level and amplitude accuracy.

Flat-Top Best amplitude accuracy, best representation of brief events captured near the beginning
or end of the time-domain data frame, poor frequency resolution.

Hanning Good frequency resolution, high side-lobe roll-off rate.

VBW

The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers
to reduce the effect of noise on the displayed signal. The VBW algorithm in the analyzer emulates the
VBW filters of traditional swept analyzers.

The maximum VBW value is the current RBW setting. The minimum VBW value is 1/10,000 of the RBW
setting. VBW is disabled when the Filter shape is set to CISPR.

NOTE. Ifyou are following a procedure that says to "set VBW to three times the RBW value or greater”, it
means that the test should be conducted with no VBW effects. In the analyzer, this condition is met by
disabling the VBW function.
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Scale Tab

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

The Scale tab values are unique to each display. Also, note that each display uses horizontal and vertical
units that are appropriate for the display. For example, for the Spectrum display uses power (dBm) units
and frequency (Hz) units; the Amplitude vs. Time display uses power (dBm) and time (seconds) units; and
the Phase vs. Time display uses phase (degrees) and time (seconds) units.

| Freg & Spanl BwW ITraces| Scale |Prefs |

wertical Haorizortal
Srale: 10000 dB Foom Start:  1.857 GHz
Position; 0,00 dBrm M Zoom Stop: 1,942 GHz
| Autoscde | Clog [ sutoscae |
Setting Description
Vertical Controls the vertical position and scale of the trace display.
Scale Changes the vertical scale.
Offset Vertical Offset adjusts the reference level away from top of the graph.
Autoscale Resets the scale of the vertical axis to contain the complete trace.
Horizontal Controls the span of the trace display and position of the trace.
Zoom Start Sets the starting frequency for ...
Zoom Stop Sets the stop frequency for ...
Log Resets the scale of the horizontal axis to contain the complete trace.
Reset Scale Resets all settings to their default values.

Prefs Tab

120

The Prefs tab enables you to change parameters of the measurement display. The parameters available on
the Prefs tab vary depending on the selected display, but include such items as enabling/disabling Marker
Readout, switching the Graticule display on/off, and Marker Noise mode.

Each of the General Signal Viewing displays maintains its own separate values for the controls that appear
on the Prefs tab. Some parameters appear with most displays while others appear with only one display.
For example, the Show Marker readout in graph check box appears in the Prefs tab for every display.
However, the Show Power Trigger level check box only appears on the Amplitude vs Time Prefs tab.
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Freq & Span | B

Show: | Start, Stop hd

V| Showe graticule

| Showe trace legend

Prefs Tab

Traces | Scale | Prefs

Trace points: (201 A

| Showe Marker readout in graph (selected marker)

Marker Moise mode (Requires dBrm Arnpl units and
Awerage trace detect)

The following table explains the controls that can appear on the Prefs tab.

Setting

Description

Show:

Selects the horizontal settings that appear below the graph area. You can choose Start,
Stop or Center, Span.

Trace points

Sets the number of trace points used for marker measurements and for results export.

Show trace legend

Enables display of a legend in the measurements area that shows the Detection method
and Function setting for displayed traces. The color of the legend text matches the color
of the associated trace.

Show graticule

Select to display or hide the graticule.

Show Parameter Readouts

For the DPX display, enables/disables the display of DPX parameters. The parameters
readout shows 100% Probability of Intercept, Transforms/s, and FFT Points.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Show timestamp in graph
(selected line)

For spectrogram displays, this readout shows or hides the timestamp associated with the
selected line or marker position.

Show Power Trigger Level

Displays or hides a green line in the graph that indicates the level at which the power
trigger is set. The line is not displayed if Trigger is set to Free Run.

Marker Noise mode

Select to enable or disable the Marker Noise mode. Use this mode to measure noise on
the trace. See Using Noise Markers in the Spectrum Display (see page 340).

Show Parameter Readouts (DPX Spectrum Only)

The elements of the Show Parameter Readouts are:

B 100% POI — This is the minimum event duration required to ensure 100% Probability of Intercept or
event capture. This duration depends on interaction between span, RBW, and FFT length. You can
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General Signal Viewing Prefs Tab
use the POI time value to determine if you are at risk of either missing a narrow transient or of its
captured amplitude being less than the actual signal.

Minimum signal duration vs. RBW

Minimum signal duration

Span RBW (kHz) FFT length Spectrums/s for 100% POI, ps
110 MHz 10000 1024 3.7
1000 1024 292,969 5.8
300 2048 146,484 14.8
100 4096 73,242 37.6
30 16,384 18,311 134.6
20 32,768 9,155 229.2
85 MHz 1000 1024 292,969 5.8
300 2048 146,484 1.4
100 4096 73,242 37.6
30 16384 18,311 134.6
20 16384 18,311 174.6
40 MHz 1000 1024 292,969 5.8
300 1024 292,969 1.4
100 2048 146,484 30.8
30 4096 73,242 93.6
20 8192 36,621 147.3
10 16384 18,311 294.5
25 MHz 300 1024 292,969 1.4
100 1024 292,969 275
30 4096 73,242 93.8
20 4096 73,242 133.9
10 8192 36,621 267.8

B Transforms/s — This is the number of transforms/second being performed by the DPX engine.
It is a function of the selected resolution bandwidth and number of trace points. The desired
RBW determines the number of points required in each transform, which alters the transform rate.
Additionally, the selected trace length may place requirements on the number of points required in
the transform independent of the selected resolution bandwidth.

m  FFT Points — The approximate number of points in the FFT of the input signal. FFT points provides
an indication of frequency resolution, but it is not an exact measurement. Note that higher numbers
for FFT points mean that the instrument is taking a longer string of input samples for each FFT,
which decreases the time resolution.
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Minimum FFT length versus trace length - independent of span and RBW (instruments with option 200

Trace length (points) Minimum FFT length
801 1,024

2,401 4,096

4,001 8,192

10,401 16,384
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Analog Modulation Overview

Overview

The displays in the Analog Modulation folder (Displays > Folders > Analog Modulation) are:

AM
M
PM

The Analog Modulation displays provide measurements and time-domain trace displays.

AM Display

The Amplitude Modulation Display is a graph of Modulation Factor vs Time. The AM display includes
three numeric readouts.

To show the AM display:

1.
2.
3.

=

Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
From the Folders box, select Analog Modulation.

Double-click the AM icon in the Available Displays box. This adds the AM icon to the Selected
displays box.

Click the OK button. This shows the AM display.

Elements of the Display

@e © 66

| —
| N +Peak Normal [ ciear ¢ I
| © 703 %

723 %

[ putoscale | & Position: 400,000 us © Scale: 4.600 ms
| Jram: 65.0% -AM: -66.5%  Tokal AM: 65.8%
{

0513022

® @
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Analog Modulation AM Settings
Item Element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows
when the AM display is the optimized display.
2 Top of Graph Sets the %AM indicated at the top of the graph by increasing or decreasing
the vertical scale. Changing the top value affects the bottom of graph value
because the graph scales about vertical center. Also, note that the top of
graph setting interacts with the internal vertical scale setting (which is not
user settable).
3 Position Specifies the %AM shown at the center of the graph display.

Bottom Readout

Displays the value of the modulation factor shown at the bottom of graph.

5 Measurement readouts Displays numeric values for the +AM (positive modulation factor), —-AM
(negative modulation factor), and Total AM.

Position Specifies the horizontal position of the trace on the graph display.

Scale Adjusts the horizontal range of the graph. By decreasing the scale (time
across the entire graph), the graph essentially becomes a window that you
can move over the trace by adjusting the position.

Clear Erases the trace from the graph.

9 Trace Detection readout Displays the Settings > Trace > Detection setting.

Changing the AM Settings (see page 126)

AM Settings

126

Menu Bar: Setup > Settings

Application Toolbar: &

The AM Settings control panel provides access to settings that control parameters of the AM Display.

Parameters | Trace | Scale | Prefs

Cartiet Amplitude Detection

@ Average

_) Median

Measurement Bw: 10,00 MHz
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Setting Description

Parameters (see page 127) Sets the Carrier Amplitude Detection method. You can choose either Average or Median.
Trace (see page 128) Sets Trace display parameters.

Scale (see page 131) Sets vertical and horizontal scale and position parameters.

Prefs (see page 132) Specifies whether or not certain display elements are shown. Specifies the maximum

number of points shown in the display graph.

Parameters Tab
The Parameters tab enables you to specify two parameters that control the carrier amplitude detection.

Parameters | Trace IScaIe IF‘refs

Carrier Arnplitude Detection
o Average Measurement BW:  10.00 MHz
' Median
Setting Description
Average Selects the Average method for computing the average baseline for measurements.
Median Selects the Median method for computing the average baseline for measurements.
Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.

AM Modulation

An amplitude modulated carrier can be described mathematically by:
X (t) =[A+a(t)] coswot

A, in the above equation, represents the carrier amplitude, a(t) represents the time-varying modulation
and o, represents the carrier frequency.

The signal modulation envelope is given by:
EM(t) :A+a(t)

There are several ways to express the AM modulation depth, expressed as a percentage.

Peak method - ’
AM ModulationDepth = az | A'I' a(t)]
Trough Method i A ’

AM ModulationDepth = = in[A+a(t)

A
Max-Min Method
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Analog Modulation Trace Tab

Maxr[A+a(t)] — Min[A+a(t)]
2A
In each case, the value of the carrier amplitude, 4, needs to be estimated from the input signal.

AM ModulationDepth =

The instrument represents signals in a sampled form. The sampled envelope can be expressed as a function
of sample index K and sampling period T as:
Ey[KT] = A+ a|KT]

The instrument allows the choice of two methods for estimating the carrier amplitude:

Average Method
A = Average {Ey [KT]}

Median Method
A = Median {Ey [KT|}

In both cases, the instrument computes the average and the median over the analysis period. It should be
noted that the two methods give the same result for sinusoidal modulation where the sampling frequency
is much higher than the modulation frequency.

Trace Tab

128

The Trace Tab allows you to set the display characteristics of a trace.

|F‘arameters| Trace |Scale |F‘refs |

Shiowe [CFreeze Save Trace As..
Detection:  |+Peak h

Function: Normaliv D

Setting Description

Show Shows/hides the trace. If the instrument continues to run, the measurement results below
the graph display continue to update even if the trace is hidden.

Detection Sets the Detection method used for the trace. Available detection methods are +Peak,
-Peak, and Avg (VRMS). Not available for saved traces.

Function Selects the trace processing method. The only available setting is Normal.

Freeze Halts updates to the trace.

Save Trace As Saves the trace to a file for later recall and analysis.

Show recalled trace Displays a saved trace instead of a live trace.
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Detection

Detection refers to the method of processing the data acquisition points when creating a trace. The 1Q
samples in a data acquisition can be detected in a variety of ways. The number of 1Q samples available to
each trace point varies with both analysis length and trace length. For example, with Spectrum Length set
to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one 1Q sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak,
and Avg (VRMS) are all equal. Changing the Spectrum Length causes the available detection methods to
differ in value because they have a larger set of samples for the various detection methods to process.

The available detection methods are:

m  +Peak — Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

B -Peak — Each point on the trace is the result of detecting the negative peak value present in the set of
1Q samples available to that trace point.

B Avg (VRMS) [Average Vrus] — Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

Trace Processing

Traces can be processed to display in different ways. The Detection setting controls trace decimation,
when needed. When the trace points each cover more than one sample data point, the vertical results
values for multiple data points are combined into each trace point. Each trace point ends up with a single
vertical value.

B Average - Each trace point is computed by averaging together the multiple results points it represents.
B +Peak - Each trace point represents the highest vertical value among the results it includes.

B —Peak - Each trace point represents the lowest vertical value among the results it includes.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.
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130

Save s @
e
uv | . » Computer » Default (C) » RSASI00AFiles » - |G, H Search REASIO0A Files ,OI
Organize + New folder = - (%]
¢ Faworites i Marne : Date rmodified Type Size
B Desktop Example Files 62172011 356 PM File folder
& Downloads Sample Data Records 62172011 356 PM File folder
Sl RecertPlaces  |= User Presets 6/2172011 356 P File folder
o Libraries
3 Documnents
.JT Music
=] Pictures
B videos
File name: | h
Save as type: ISa\acted trace 'J
= Hide Folders swe | [ cancel |

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces

You can recall a previously saved trace for analysis or comparison to a live trace.
To select a trace for recall:

1. Click the ... button to display the Open dialog box.

2. Navigate to the desired file and click Open.

3. Check the Show Recalled Trace check box.
4

. Verify that the Show check box is selected.
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Scale Tab

Scale Tab

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

| Pararneters | Trace | Scale |F‘refs |

Wertical Harizontal
Scale: 143 % Scale:  4.600 ms
Position:  -1.00 % Position: 400,000 us
Autoscals Autoscale
Setting Description
Vertical
Scale Changes the range shown between the top and bottom of the graph.
Position Adjusts the level shown at the center of the graph.
Autoscale Resets the Position so that the entire trace is in the graph.
Horizontal
Scale Changes the range shown between the left and right sides of the graph.
Position Adjusts the position of the acquisition record shown at the left edge of the graph.
Autoscale Resets the Scale and Position settings to provide the optimum display.
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Prefs Tab

The Prefs tab enables you to change appearance characteristics of the AM display.

Pararneters | Trace | Scale | Prefs

Max trace points: | 100K A

| Show graticule V] Showe Marker readout in graph (selected marker)
Setting Description
Show graticule Shows or hides the graticule.

Show Marker readout in graph Shows or hides the readout for the selected marker in the graph area.
(selected marker)

Max trace points The trace in the AM display can be set to a maximum of 100,000 points (however, the
actual number of trace points can extend up to 500,000 points if Max trace points is
set to Never Decimate). If the Analysis Length includes more than the selected Max
trace points value, the trace is decimated (using the method specified with the Detection
control) to be equal to or less than the Max trace points setting (except when Max trace
points is set to Never Decimate). This decimated (or undecimated) trace is what is used
for marker measurements and for results export.

FM Display

The Frequency Modulation Display shows Frequency Deviation vs. Time. The vertical axis units are

Hertz and the horizontal axis units are seconds. When taking measurements, only the first burst in the
Analysis period is analyzed. No trace points are shown for data outside the first detected burst, nor are
measurements made on data outside the first detected burst.

To show the FM display:
1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Folders box, select Analog Modulation.

3. Double-click the FM icon in the Available Displays box. This adds the FM icon to the Selected
displays box.

4. Click the OK button. This shows the FM display.
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Elements of the Display
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Item Element

FM Settings

Description

1 Check mark indicator

The check mark indicator in the upper, left-hand corner of the display shows
when the FM display is the optimized display.

2 Top of Graph control

Sets the frequency indicated at the top of the graph. Since the Position value
at the vertical center of this graph remains constant as the Top of Graph value
is adjusted, the Vertical Scale increases as the Top of Graph value increases,
which also affects the bottom of graph readout. Vertical Scale can also be
controlled from the Settings control panel's Scale tab.

3 Position

Specifies the frequency shown at the center of the graph display. Changing
this value moves the trace up and down in the graph, which affects the Top of
Graph and Bottom of Graph values as well.

Bottom of Graph Readout

Displays the frequency value at the bottom of the graph.

5 Measurement readouts

Displays numeric values for the +Pk (positive frequency deviation), -Pk
(negative frequency deviation), RMS (RMS value of the deviation), Pk-Pk
(peak-to-peak frequency deviation), and Pk-Pk/2 (peak-to-peak frequency
deviation divided by two).

Position

Specifies the horizontal position of the trace on the graph display.

Scale

Adjusts the time range of the graph. By decreasing the scale (full-scale time
over 10 divisions), the graph essentially becomes a window that you can
move over the acquisition record by adjusting the horizontal position.

Clear

Clears the trace and numeric measurement results.

Trace Detection readout

Displays the Settings > Trace > Detection setting.

10 Freq Error

This readout can show Freq Error or Freq Offset. When it displays Freq
Error, it shows the difference between the instrument Frequency setting and
the measured value of the signal's carrier frequency. When it displays Freq
Offset, it shows the frequency offset specified on the Settings > Parameters
tab. If Freq Error is displayed, it also indicates that the Carrier frequency
detection setting is Auto. If Freq Offset is displayed, it indicates that the
Carrier frequency detection setting is manual.

Changing the FM Settings (see page 134)

FM Settings

Menu Bar: Setup > Settings

Application Toolbar: &b

The FM Settings control panel provides access to settings that control parameters of the FM Display.
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Parameters | Trace IScaIe IF‘refs

Burst detect threshold:  -100 dBc

Frequency affset: |-50.54 Hz Luto
Measurernent BW:  100.0 kHz Load from marker
Setting Description
Parameters (see page 273) Sets the burst detection threshold, measurement bandwidth, and carrier frequency
detection method.
Trace (see page 137) Sets Trace display parameters.
Scale (see page 139) Sets vertical and horizontal scale and position parameters.
Prefs (see page 140) Specifies whether or not certain display elements are shown. Specifies the maximum

number of points shown in the display graph.
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Parameters Tab

The Parameters tab enables you to specify parameters for carrier detection.

Parameters | Trace | Scale | Prefs

Burst detect threshold:  -100 dBc

Frequency offset; |-50.54 Hz V| Auto
Measurernent By 1000 kHz Load from rnarker
Setting Description
Burst detect threshold This parameter specifies the power level used to determine whether a burst is present.

A valid burst is required to take measurements. The burst detected first is used for
the analysis. The units for burst detect threshold are dBc, relative to the maximum
acquisition sample data points level.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.

Frequency offset Displays the carrier signal's offset from the instrument's measurement frequency. Auto is
used to select the method for determining the carrier frequency. When Auto is selected,
the instrument determines the carrier frequency by analyzing the signal. When Auto is
deselected, you can set the carrier frequency offset using Frequency Offset.

Load from Marker Pressing this button sets the frequency offset to the frequency offset of the selected
marker. (Pressing this button automatically deselects Auto.)

Frequency Offset

In Auto (Auto is selected), the instrument scans the measurement bandwidth about the measurement
frequency and looks for the highest-powered signal. This is defined as the carrier frequency. In Manual
(Auto is deselected), the carrier frequency is specified by adding/subtracting the specified Frequency offset
from the measurement frequency. Range: -(Measurement BW*1.1)/2 to +(Measurement BW*1.1)/2. If
the Load A from marker button is pressed, the frequency offset is determined from the phase difference
between the two markers on screen compared to the time between the two markers. This function is useful
for removing frequency slope from the phase modulated signal.

Load from Marker

When the Auto check box is selected, the instrument scans the measurement bandwidth about the center
frequency and looks for the highest-powered signal. This is defined as the carrier frequency. When

the Auto check box is deselected, the carrier frequency is specified by adding/subtracting the specified
Frequency offset from the center frequency. Pressing the Load from marker button loads the marker
frequency into the Frequency offset box.
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Trace Tab

Trace Tab

The Trace Tab allows you to set the display characteristics of displayed trace.

|Parameters| Trace |Scale IF‘refs |

Detection:  |+Peak -
Function:  |[Mormal -

Shiowe [CIFreeze Save Trace As...

Setting Description

Show Shows / hides the trace. If the instrument continues to run, the measurement results
below the graph display continue to update even if the trace is hidden.

Detection Sets the Detection method used for the trace. Available detection methods are +Peak,
-Peak, and Avg (VRMS). Not available for saved traces.

Function Selects the trace processing method. The only available setting is Normal.

Freeze Halts updates to the trace.

Save Trace As

Saves the trace to a file for later recall and analysis.

Show Recalled trace

Displays a saved trace instead of a live trace.

Detection

Detection refers to the method of processing the data acquisition points when creating a trace. The 1Q

samples in a data acquisition can be detected in a variety of ways. The number of IQ samples available to
each trace point varies with both analysis length and trace length. For example, with Spectrum Length set
to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one IQ sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak,
and Avg (VRMS) are all equal. Changing the Spectrum Length causes the available detection methods to

differ in value because they have a larger set of samples for the various detection methods to process.

The available detection methods are:

B +Peak — Each point on the trace is the result of detecting the positive peak value present in the set of
1Q samples available to that trace point.

®  -Peak — Each point on the trace is the result of detecting the negative peak value present in the set of
1Q samples available to that trace point.

m  Avg (VRMS) [Average Vrus] — Each point on the trace is the result of determining the RMS Voltage

value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,

Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average

for RMS values.
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Trace Processing

Trace Tab

Traces can be processed to display in different ways. The Function setting controls trace processing.

B Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a

single vertical value.

B Average - Each trace point is computed by averaging together the multiple results points it represents.

m  +Peak - Each trace point represents the highest vertical value among the results it includes.

m  —Peak - Each trace point represents the lowest vertical value among the results it includes.

Saving Traces

To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

Save As

5

e
vv | . » Computer » Default (C) » RSASI00AFiles »

Organize * Mew folder

-
. - Mame
- Favorites

Bl Desktop Example Files
& Downloads Sarnple Data Records

Ol RecertPlaces  |F User Presets

o Libraries
3 Docurnents
.J7 Music
| Pictures

B videos

Date maodified

6/21/2011 356 P
6/21/2011 356 P
6/21/2011 356 P

~ | 49 || Search RsA51004 Fites )

= @

Size

File name: |

Save as type: ISa\acted trace

= Hide Folders

Save l I Cancel I

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces

You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.

2. Navigate to the desired file and click Open.
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Scale Tab

3. Check the Show Recalled Trace check box.

4. Verify that the Show check box is selected.

Scale Tab

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

| Pararmeters | Trace | Scale |F‘refs |

Wertical Horizortal
Scale; 100 kHz Scale:  35.280 us
Position; 0,000 Hz Position: 92,160 us
Autoscale Autoscale
Setting Description
Vertical
Scale Changes the range shown between the top and bottom of the graph.
Position Adjusts the frequency shown at the center of the graph.
Autoscale Resets the Position so that the entire trace fits within the graph.
Horizontal
Scale Changes the range shown between the left and right sides of the graph.
Position Adjusts the position of the acquisition record shown at the left edge of the graph.
Autoscale Resets the Scale and Position settings to provide the optimum display.
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Prefs Tab

The Prefs tab enables you to change appearance characteristics of the FM display.

| Parameters | Trace | Scale | Prefs |

Max trace points: | 100K A

[V Shiovwy graticule [V]Shiowy Marker readout in graph (selected marker)
Setting Description
Show graticule Shows or hides the graticule.

Show Marker readout in graph Shows or hides the readout for the selected marker in the graph area.
(selected marker)

Max trace points The trace in the FM display can be set to a maximum of 100,000 points (however, the
actual number of trace points can extend up to 500,000 points if Max trace points is
set to Never Decimate). If the Analysis Length includes more than the selected Max
trace points value, the trace is decimated (using the method specified with the Detection
control) to be equal to or less than the Max trace points setting (except when Max trace
points is set to Never Decimate). This decimated (or undecimated) trace is what is used
for marker measurements and for results export.

PM Display

The Phase Modulation Display shows Phase vs. Time. The vertical axis units are degrees and the
horizontal axis units are seconds. When taking measurements, only the first burst in the Analysis period is
analyzed. No trace points are shown for data outside the first detected burst, nor are measurements made
on data outside the first detected burst.
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Elements of the Display
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Item Element

PM Settings

Description

1 Check mark indicator

The check mark indicator in the upper, left-hand corner of the display shows
when the PM display is the optimized display.

2 Top of Graph control

Sets the phase value indicated at the top of the graph. Since the Position
value at the vertical center of this graph remains constant as the Top of Graph
value is adjusted, the Vertical Scale increases as the Top of Graph value
increases, which also affects the bottom of graph readout. Vertical Scale can
also be controlled from the Settings control panel's Scale tab.

3 Position

Specifies the phase shown at the center of the graph display. Changing this
value moves the trace up and down in the graph, which affects the Top of
Graph and Bottom of Graph values as well.

Bottom of Graph Readout

Displays the phase value at the bottom of the graph.

5 Measurement readouts Displays numeric values for the +Pk (positive phase deviation), -Pk (negative
phase deviation), Pk-Pk (peak-to-peak phase deviation), and RMS (RMS
value of the phase deviation).

Position Specifies the horizontal position of the trace on the graph display.

Scale Adjusts the time range of the graph. By decreasing the scale (full-scale time
over 10 divisions), the graph essentially becomes a window that you can
move over the acquisition record by adjusting the horizontal position.

Clear Clears the measurement results.

Trace Detection readout

Displays the Trace Detection setting (see Settings > Trace > Detection).

10 Freq Error

This readout can show Freq Error or Freq Offset. When it displays Freq
Error, it shows the difference between the instrument Frequency setting and
the measured value of the signal's carrier frequency. When it displays Freq
Offset, it shows the frequency offset specified on the Settings > Parameters
tab. If Freq Error is displayed, it also indicates that the Carrier frequency
detection setting is Auto. If Freq Offset is displayed, it indicates that the
Carrier frequency detection setting is manual.

Changing the PM Settings (see page 142)

PM Settings

Menu Bar: Setup > Settings

Application Toolbar: &

The PM Settings control panel provides access to settings that control parameters of the PM Display.
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Parameters | Trace IScaIe IF‘refs

Parameters Tab

Burst detect threshold:  -100 dBc

Measurement BW: 1,000 MHz

Frequency offsst: -383.2 Hz [ Auto

Load A from marker

Phase offset; 128 ° [ Auto

Load from rarker

Setting

Description

Parameters (see page 143)

Sets the Carrier Frequency Detection method. You can choose either Automatic or
Manual. Sets burst threshold and phase detection method.

Trace (see page 144)

Sets Trace display parameters.

Scale (see page 147)

Sets vertical and horizontal scale and position parameters.

Prefs (see page 148)

Specifies whether or not certain display elements are shown. Specifies the maximum

number of points shown in the display graph.

Parameters Tab

The Parameters tab enables you to specify parameters that control the carrier frequency and phase detection.

Parameters | Trace IScaIe IF‘refs

Burst detect threshold:  -100 dBc

Measurement BV 1,000 MHz

Frequency offset:  -383.2 Hz [T Auto

Load & frorn ratker

Phase offset; 128 ° [ Auto

Load from marker
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Setting Description

Burst detect threshold Specifies the power level used to determine whether a burst is present. A valid burst is
required to take measurements. The burst detected first is used for the analysis. The
units for burst detect threshold are dBc, relative to the maximum acquisition sample
data points level.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.

Frequency offset Displays the carrier signal's frequency offset from the instrument's Measurement
Frequency. Auto is used to select the method for determining the carrier frequency. When
Auto is selected, the instrument determines the carrier frequency by analyzing the signal.
When Auto is deselected, you can set the carrier frequency offset using Frequency Offset.

Load A from Marker Pressing this button disables the Auto Frequency Offset function and sets the Frequency
offset to the frequency offset calculated from the difference between MR (the marker
reference) and the selected marker (or M1 if MR is currently the selected marker).

Phase offset Displays the phase offset. When Auto is selected, the instrument determines the phase
offset. When Auto is deselected, the user sets the phase offset with this control.

Load from marker Pressing this button sets the phase offset to the phase offset of the selected marker.
(Pressing this button automatically deselects Auto.)

Frequency Offset

In Auto (Auto is selected), the instrument scans the measurement bandwidth about the Measurement
Frequency and looks for the highest-powered signal. This is defined as the carrier frequency. In Manual
(Auto is deselected), the carrier frequency is specified by adding/subtracting the specified Frequency offset
from the Measurement Frequency. Range: -(Measurement BW*1.1)/2 to +(Measurement BW*1.1)/2. If
the Load A from marker button is pressed, the frequency offset is determined from the phase difference
between the two markers on screen compared to the time between the two markers. This function is useful
for removing frequency slope from the phase modulated signal.

Phase Offset

In Auto (Auto is selected), the instrument sets the phase offset to fit the waveform to the screen centering
0° phase on the vertical axis. The actual phase offset is indicated on the Phase Offset readout. In Manual
(Auto is deselected), the instrument sets the phase offset using the value specified in Phase offset. For
example, when Phase offset is set to 10°, the waveform shifts upward by 10° on screen. Selecting Load
from marker sets the phase offset to the value of the selected marker. Range: —180 to +180°.

Trace Tab

The Traces Tab allows you to set the display characteristics of displayed trace.
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|Parameters| Trace |Scale IF‘refs |

Trace Tab

Detection:  |+Peak -

Shiow [CIFrecze Save Trace As...

Function:  |Mormal - D

Setting Description

Show Shows / hides the trace. If the instrument continues to run, the measurement results
below the graph display continue to update even if the trace is hidden.

Detection Sets the Detection method used for the trace. Available detection methods are +Peak,
-Peak, and Avg (VRMS). Not available for saved traces.

Function Selects the trace processing method. The only available setting is Normal.

Freeze Halts updates to the trace.

Save Trace As

Saves the trace to a file for later recall and analysis.

Show Recalled trace

Displays a saved trace instead of a live trace.

Detection

Detection refers to the method of processing the data acquisition points when creating a trace. The 1Q

samples in a data acquisition can be detected in a variety of ways. The number of IQ samples available to
each trace point varies with both analysis length and trace length. For example, with Spectrum Length set
to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one IQ sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak,
and Avg (VRMS) are all equal. Changing the Spectrum Length causes the available detection methods to

differ in value because they have a larger set of samples for the various detection methods to process.

The available detection methods are:

B +Peak — Each point on the trace is the result of detecting the positive peak value present in the set of
1Q samples available to that trace point.

®  -Peak — Each point on the trace is the result of detecting the negative peak value present in the set of
1Q samples available to that trace point.

m  Avg (VRMS) [Average Vrus] — Each point on the trace is the result of determining the RMS Voltage

value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,

Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average

for RMS values.

Trace Processing

Traces can be processed to display in different ways. The Function setting controls trace processing.
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Trace Tab

B Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a

single vertical value.

B Average - Each trace point is computed by averaging together the multiple results points it represents.

m  +Peak - Each trace point is represents the highest vertical value among the results it includes.

®  —Peak - Each trace point is represents the lowest vertical value among the results it includes.

Saving Traces

To save a trace for later analysis:

1. Seclect the Save Trace As button. This displays the Save As dialog box.

Sawve A3 @
——
() [1 v Computer » Default(C) » RSASIONAFiles » ~ [ 42 || Search RSA5100A Fites 2|
Organize ~ Mew folder = @
=
¢ Favorites it Marne Date rmadified Type Size
Bl Desktop Example Files 6212011 356 P File falder
& Downloads Sarnple Data Records 6212011 356 P File falder
ol Recent Places  |= User Presets 6/21/201L 356 P File folder
- Libraries
3 Docurments
.J7 Music
| Pictures
H videas
File name: | h
Save as type: lSE\Ected trace ‘J
=) Hide Folders swe | [ cancel |

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces

You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.

2. Navigate to the desired file and click Open.
3. Check the Show Recalled Trace check box.
4. Verify that the Show check box is selected.
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Scale Tab

Scale Tab

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

| Pararneters | Trace | Scale |F‘refs |

Wertical Horizontal
Scaler 2287 Scaler  1.840ms
Position:  -24.7 m* Position: 160,000 us
| Autoscde | | Autoscale |

Setting Description
Vertical

Scale Changes the range shown between the top and bottom of the graph.

Position Adjusts the phase shown at the center of the graph.

Autoscale Resets the Position so that the entire trace in the graph.
Horizontal

Scale Changes the range shown between the left and right sides of the graph.

Position Adjusts the phase shown at the left edge of the graph.

Autoscale Resets the Scale and Position settings to show the entire trace within the graph.
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Prefs Tab

The Prefs tab enables you to change appearance characteristics of the PM display.

| Parameters | Trace | Scale | Prefs |

Max trace points: | 100K A

[V Shiovwy graticule [V]Shiowy Marker readout in graph (selected marker)
Setting Description
Show graticule Shows or hides the graticule.

Show Marker readout in graph Shows or hides the readout for the selected marker in the graph area.
(selected marker)

Max trace points The trace in the PM display can be set to a maximum of 100,000 points (however, the
actual number of trace points can extend up to 500,000 points if Max trace points is
set to Never Decimate). If the Analysis Length includes more than the selected Max
trace points value, the trace is decimated (using the method specified with the Detection
control) to be equal to or less than the Max trace points setting (except when Max trace
points is set to Never Decimate). This decimated (or undecimated) trace is what is used
for marker measurements and for results export.
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Overview

The displays in the RF Measurements folder (Displays > Folders > RF Measurements) are:

CCDF

Channel Power and ACPR
MCPR

Occupied Bandwidth

Phase Noise (Option 11)

SEM (Spectrum Emission Mask)

Spurious

The RF Measurements power measurements and signal statistics help you characterize components and
systems. With Option 11, the RF Measurements also includes Phase Noise and Jitter Measurements.

Power Measurements

Measurement Description

Channel Power The total RF power in the selected channel (located in the ACPR display).

Adjacent Channel Power Ratio Measure of the signal power leaking from the main channel into adjacent channels.

Multi-Carrier Power Ratio The ratio of the signal power in the reference channel or group of channels to the power

in adjacent channels.

Peak/Avg Ratio Ratio of the peak power in the transmitted signal to the average power in the transmitted

signal (located in the CCDF display).

CCDF The Complementary Cumulative Distribution Function (CCDF). CCDF shows how much

time a signal spends at or above a given power level relative to the average power of
a measured signal.

Channel Power and Strength Display

Use the Chan Power & Strength display to measure channel power, field strength, signal strength or
adjacent channel leakage ratio with one main channel.
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File View Run Replay Markers Setup Tools Window Help
® & & T & o A | Frequency: 15000 GHz

Reflev: 0,00 dBm Fresat Replay

Audio Normzl

< 0.00 dBm
=« dBfdiv:
10.0 dB

-100.00 dBm
Autoscale| o Pos: 1.500000 GHz

Channel Peak Channel
Power (Main):  Power (Main):
-10.00 dBm 14.02 dBm

Measuring Channel Power and Field Strength
1. Select the Displays button.

2. Select RF Measurements from the Folders box.

Channel Power and Strength Display

3. Double-click Chan Power & Strength in the Available displays box. Click OK to complete your

selection.

4. Press the front-panel Freq button and use the front panel keypad or knob to adjust the frequency to

that of your main channel.

5. Press the Run button to take the measurements.

6. If you are measuring a signal with a directional antenna, select the Audio checkbox above the graph,

on the left side.

When Audio is checked, the analyzer sounds a tone that varies in frequency with the signal strength. If
you change the direction of the antenna and the signal strength drops, the frequency of the audio tone
will also drop. If the signal strength increases, the audio tone frequency will also increase.

As signal strength changes, the signal strength indicator at the right side of the graph will rise and fall

with the signal level.

Measuring Adjacent Channel Power Ratio

1. Select the Displays button.

2. Select RF Measurements from the Folders box.

3. Double-click Chan Power & Strength in the Available displays box. Click OK to complete your

selection.

4. Press the front-panel Freq button and use the front panel keypad or knob to adjust the frequency to

that of your main channel.
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5. Press the Settings button. This displays the control panel for Chan Power and Strength (the tab
displayed will be the tab displayed the last time the Settings panel was opened).

Chan Power & Freq & RBW | Measurement Params | Channels | Scale | Prefs |
Strength
Settings

Meas Freq: 1.5000 GHz RBW: 30.000 kHz Auto

Step: 10.0000 MHz Auto [ vew:

Restore
Defaults

6. To set the number of adjacent channels, select the Channels tab. Enter the number of channels in the
Number of adjacent pairs value box. If zero is entered for the number of adjacent pairs (the default
value), the resultant measurement will be channel power only.

NOTE. As you add adjacent channels, the span of the display is adjusted so that all the channels can be
seen. Use the horizontal scale and offset to zoom the display in on any portion of the trace.

7. To set the spacing between channel centers, enter the required value in the Channel Spacing value box.

8. To set the channel bandwidth, enter the required value in the Channel Bandwidth value box.

9. After you have configured the channel settings, click the close button (—_J) in the Settings panel or
press the Settings button again to remove the settings panel.

10. Press the Run button to take the measurements.

Viewing Results

Measurement results are displayed below the graph and within the graph itself (which can be
enabled/disabled in the Settings > Prefs tab). If you are measuring adjacent channel power ratio, to see all
measurements, you might need to scroll the table. The size of the results table can be changed by dragging
the horizontal divider bar between the graph and table areas.

Channel Peak Channel
Power (Main):  Power (Main):

-10.00 dBm 14.09 dBm

Results for Channel Power and Strength

Heading Description
Channel Power (Main) The power measured for the Main channel. The channel power is displayed in dBm.
Peak Channel Power (Main) The peak power measured for the Main channel. The channel power is displayed in dBm.
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Channel Ch Offset Lower Upper
Power (Man): | 1 2000 Mz  -65.60d8  -64.82 dB
-1.94 dBm : £ -

Results display for Adjacent Channel Power

Heading Description

Channel Identifies the displayed channels. A1 means the first adjacent channel. A2 means
second adjacent channel. Adjacent channels are numbered according to their offset from
the Main channel. The closest channel is numbered 1. The next closest channel is
numbered 2; and so forth.

Lower The power measured for the lower adjacent channel. Adjacent channel power
measurements are displayed in dB relative to the Main channel.

Upper The power measured for the upper adjacent channel. Adjacent channels power
measurements are displayed in dB relative to the Main channel.

Channel Power (Main) The power measured for the Main channel. The detection type used for measuring

channel power and adjacent channel powers is Average. This means that the average of
the linear (pre-log) samples is used to determine the power. The Main channel power is
displayed in dBm.

Setting Channel Power and ACPR Settings Parameters (see page 153)

RF Channel Power Measurement

The RF channel power gives an indication of the total average (and other measures ) RF power in
a given channel.

For some communications systems, there is an “out-of-service” total power measurement defined in the
specifications that calls for a specified constant modulation. In this case, the output power should be
relatively constant. For many measurements, this may not be the case, and the Power Measurement
results will vary as the signal varies.

Average power is the square root of the sum of the squares of the voltage samples over the measurement
time.

The defined “channel” width for the Power Measurement defines the bandwidth and shape of the filter
used to remove any RF power on frequencies outside of the channel bandwidth.

Channel Power

152

The total RF power in the selected frequency band. The detection type used for measuring channel power
is Average. This means that the average of the linear (pre-log) samples is used to determine the channel
power. To measure channel power, use the ACLR measurement, and set the number of adjacent channels
to zero. This results in only the channel power being measured.

SPECMON3 & SPECMONG Printable Help



RF Measurements Average Channel Power

Average Channel Power

The total RF power in the selected channel (located in the ACPR display).

Adjacent Channel Leakage Power Ratio

Adjacent Channel Leakage power Ratio (ACLR) is the ratio of the mean power centered on the
assigned channel frequency to the mean power centered on an adjacent channel frequency. In the 3GPP
specification, both the main channel and adjacent channels are required to be filtered with RRC (Root
Raised Cosine) filters.

Adjacent Channel Power

Measure of the signal power leaking into nearby channels.

Channel Power & Strength Settings

Menu Bar: Setup > Settings

Front Panel: Settings

Application Toolbar: &

The settings for the Channel Power & Strength display are shown in the following table.

Frea & REW | Moasuremnent Params | Channsls | Scale | Prefs |

Meas Freq:  1.50000 GHz REW:  30.000 kHz Auto

Step: 20000 Mz AUt [T wewy:
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Settings tab

Channels Tab

Description

Freq & RBW (see page 160)

Specify the frequency and resolution bandwidth used for the Channel Power and ACPR
measurements.

Measurement Params (see

Specify several parameters that control the measurement, such as channel filter, chip

page 161) rate, averaging, and correcting for noise floor.

Channels (ACPR) (see This tab specifies the BW and offset parameters of the Channels for the Channel Power
page 154) and ACPR measurements.

Scale (see page 224) Specifies the vertical and horizontal scale settings.

Prefs (see page 225) Specifies whether certain display elements are visible.

Restore defaults. Sets parameters for a 1-channel WCDMA measurement.

Channels Tab

The Channels tab is where you specify parameters for the channels measured in the Chan Power display.

| Freq & Reve | Measurement Params | Channels | scale | prefs |

Murnber of adjacent pairs; 1
Channel Bandwidth: 1,000 MHz

Channel Spacing:  2.000 MHz

Setting

Description

Number of adjacent pairs

Specifies the number of adjacent channel pairs. The default value is 0. This setting is
used to measure power and strength for a single channel. Range: 0- 50; Resolution 1.

Channel Bandwidth

Specifies the frequency width of each channel (all channels share the same value).

Channel Spacing

Specifies the difference in frequency between the centers of each channel.

The following figure illustrates the settings controlled from the Channels tab.

154
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Lower Lower Upper Upper
Adjacent 2 Adjacent 1 Main Adjacent 1 Adjacent 2
| | | | |
| | | |
| | | | |
| | | | |
| | | | |
| | | | |
| | | | |
| | | | |
| | | | |
| | | | |
| | | | |

AR A AA
P N AN | WM |
Adj Chan Adj Chan Main Chan Adj Chan Adj Chan
Bandwidth Bandwidth Bandwidth Bandwidth Bandwidth
| | | | |

| | | | |
: Channel Spacing : Channel Spacing : Channel Spacing : Channel Spacing :
|

Changing the Number of Adjacent Pairs
1. Select Number of adjacent pairs number entry box.

2. Enter a value for the number of adjacent pairs using the knob or the keypad.

NOTE. As you change the value for the number of adjacent pairs, the analyzer will update the spectrum
display to identify the adjacent channels.

3. Select the Close box when you have finished making changes.

Changing the Channel Bandwidth
1. Select the Channel Bandwidth number entry box.

2. Enter a value for the number of adjacent pairs using the knob or the keypad.

NOTE. As you change the value for the number of adjacent pairs, the analyzer will update the display to
indicate the channel bandwidth

3. Select the Close box when you have finished making changes.

Channel Spacing
1. Select Channel Spacing number entry box.

2. Enter a value for the difference in center frequency between channels using the knob or the keypad.
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MCPR (Multiple Carrier Power Ratio) Display

NOTE. As you change the value for the number of adjacent pairs, the analyzer will update the display to
indicate the channel bandwidth

3. Select Close when you have finished making changes.

MCPR (Multiple Carrier Power Ratio) Display

156

Use the MCPR measurement to measure adjacent channel power ratio for multiple main channels or
when adjacent channel pairs have different offsets and/or bandwidths. The MCPR display show the
Reference Power and the ratio of each adjacent channel to the Reference Power. You can select whether
the Reference Power is the total of all active channels or a single channel.

Measuring Multiple Carrier Power Ratio

1.

2
3.
4

Press the front-panel Displays button.

From the Select Displays window, select RF Measurements from the Folders box.

Double-click the MCPR icon in the Available displays box. Click OK to complete your selection.

Press the front-panel Freq button and use the front panel keypad or knob to adjust the frequency to
that of the main channel. Select Meas. Freq to set the measurement frequency. Use the front panel
knob to adjust the frequency.

Press the Settings button. This displays the control panel for MCPR (the tab displayed will be the tab
displayed the last time the Settings panel was opened).

| Freq & REv¥ | Measurement Params | Channels | Scale | Prefs |

Main Channels

Murnber: 4
Bw:  3.840 MHz

Spacing:  5.000 MHz

Inactive

M1
M2
[ M3
] M4

Adj Chans

add...

Edit...

Delete

Chan
M1
M2
M3
M4
A1

o

By

2.840 MHz
3.840 MHz
3.840 MHz
2.840 MHz
3.840 MHz

2 0AN Rl

Offset g
-7.500 MHz

-2.500 MHz E
2,300 MHz

7.500 MHz
+/-12.500 MHz

1T Enn L

6. Click on the Channels tab. To set the number of Main channels, enter the number of Main channels in

the Number text entry box under Main Channels.

NOTE. As you add channels, the span of the display will be adjusted so that all the channels can be seen.

To set the bandwidth of all main channels, enter a value in the BW value box.

To set the spacing between the main channels, enter a value in the Spacing value box.

To prevent a main channel power level from being included in the Power Reference (Total) calculation,
select the channel to be excluded in the Inactive box.
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10. To add adjacent channels, click the Add button under Adj Chans.
a5 Edit Channel Pararmeters El@ﬂ
2 Freguency Offset

22.500 MHz
Settings for:
2 Bandwidth
32,840 MHz A3

11. To edit Frequency Offset or Bandwidth, click within the value box and use the front-panel knob or
your keyboard to set the value. Click Close to save your changes.

NOTE. Frequency Offset is the difference between the center frequency of the selected channel and
the Measurement Frequency. All channels (Main or Adjacent) are specified by their offset from the
Measurement Frequency.

12. After you have configured the Main and Adjacent channels, click the close button ( ) in the
Settings panel or the Settings button to remove the settings panel.

13. Click the Run button ( ) to take the measurements.

Viewing Results

MCPR measurement results are displayed both in the spectrum graph and in a table below the spectrum
display. Individual Main channel power measurements appear in the graph under their channel identifiers.
Individual adjacent channel power ratios also appear in the graph under the adjacent channel identifier.
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1\ Tek RSAG100A - [MCPR]
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v Mermal [ e
& 10,00 dém
= dBjchv:
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| | J
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]1‘||I I l- Kl | .||| Ih f
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.‘ I'II.,..“ |'||l | |" Jt J|.i||| " || il .|| tly
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The following table details the entries in the results table.

Heading Description

Ch Identifies the adjacent channels. Adjacent channels are numbered according to their
offset from the Main channel. The closest channel is numbered 1. The next closet
channel is numbered 2; and so forth. The prefix “L” means lower; “U” means upper.

Offset The offset is the difference in frequency between the Measurement Frequency and the
center frequency of the channel.

Lower Displays the ratio of the lower adjacent channel power to the Power Reference.

Upper Displays the ratio of the upper adjacent channel power to the Power Reference.

Power Reference Depending on the selected Power Ref, this readout displays either the power of the

selected main channel or the total power in the active main channels.

Depending on the number of adjacent channels, to see all the measurements, you might need to drag
the divider bar between the main display and the results table at the bottom of the window to change
the height of the results table.

Setting MCPR Measurement Parameters (see page 161)

Multiple Carrier Power Ratio

The ratio of the signal power in an adjacent channel to the power in one or more main channels.
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MCPR Settings

MCPR Settings

Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The Setup control panel tabs for MCPR (Multiple Carrier Power Ratio) are:

| Freg & REW | Measurement Params | Channels | scale [ prafs |

Main Charnels Adj Chans
Inactive Chan  BW Offaet i
Limberl + EEA Add... ML 3.840 MH:z -7.500 MHz
[ Mz 2 2,840 MHz -2,500 MHz =
B 3.840 MHz s Edit... M3 3.840 MHz 2,500 MHz
[ M4 M4 3,840 MHz 7.500 MHz
Spacing:  5.000 MHz Delete a1 3,840 MHz +{-12.500 MHz
Settings tab Description
Freq & RBW (see page 160) Specify the frequency and resolution bandwidth used for the MCPR measurements.
Measurement Params (see Specifies parameters controlling how the MCPR measurement is made.
page 161)
Channels (see page 163) Specifies the parameters of the channels to be measured.
Scale (see page 224) Specifies the vertical and horizontal scale and offset values.
Prefs (see page 225) Specifies whether or not certain display elements are shown.

Restore defaults. Sets parameters for a 4-carrier WCDMA measurement.
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Freq & RBW Tab for ACPR and MCPR Displays

The Freq & RBW tab specifies frequency parameters for the Channel Power & ACPR measurements and
MCPR measurement.

Fren & REW | Maasurement Params | Channels | Scale | Prefs |
Meas Freq:  1.00000 GHz REW: 30.000 kHz Auto
Step: 20000 My Auto [C] wew:
Setting Description
Center Freq Specifies the center/measurement frequency.
Step The Step control sets the increment/decrement size for the knob adjustment of the

center frequency. Arrow key adjustment of frequency is also affected (it is 10x the knob
adjustment). If Auto is enabled, the signal analyzer will adjust the Step size as required.

RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting is
Independent of the Spectrum view's RBW setting.
VBW Adjusts the VBW (Video Bandwidth) value. VBW Maximum = current RBW value. VBW

Minimum = 1/10,000 RBW setting.

NOTE. While the center frequency and step settings on this control tab are shared between ACPR, MCPR
and Occupied Bandwidth, the RBW setting is not shared. The RBW setting is unique for each measurement.

VBW

The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers
to reduce the effect of noise on the displayed signal. The VBW algorithm in the analyzer emulates the
VBW filters of traditional swept analyzers.

The maximum VBW value is the current RBW setting. The minimum VBW value is 1/10,000 of the
RBW setting.

NOTE. If you are following a procedure that says to “set VBW to three times the RBW value or greater”, it
means that the test should be conducted with no VBW effects. In the RSA6100B Series instruments, this
condition is met by disabling the VBW function.
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Measurement Params for ACPR and MCPR Displays

Measurement Params for ACPR and MCPR Displays

The Measurement Params tab is where you set parameters that control the ACPR and MCPR measurements.

Freq & REW| Measurement Params | Channels | Scale | Prefs |

Reqguires tiggerad Spmctironous s

Ayerage: [Time Domain v] Murber: 10

Correct for Moise Floor

Pawer
Reference:

[TDtaI {active channels) v]

Channel Filter:  |Root-raised Cosing

Filter Parameter:  0.22

Chip Rate:  3.84 MHz

Freq & REvY | Measurement Params | channels | scale | Prefs |

Average: [Frequency Diornain v] Murmber: 10

[Tl Correct for Moise Floor

Chanrel Filter:  |Root-raised Cosine «

Filter Parameter:  0.35

Chip Rate: 1 MHz
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Parameter Description
Average Enables/disables measurement averaging. Averaging can be enabled in either the
Frequency Domain or Time Domain.
Frequency-domain This setting takes the average linear value of the traces (so that rms values are

preserved). The number of averages is user-defined. Frequency domain averaging
is available in spans larger (or smaller) than the maximum real time bandwidth.
This is the mode to use unless you need to extract maximum dynamic range from
an ACPR measurement.

Time-domain This setting takes the average linear value of the traces. It is useful if you need to
extract maximum dynamic range from an ACPR measurement. The number of traces
is user defined. But, the signals must be triggered and repeating. That is, the signal
needs to be exactly the same for each acquisition. When this condition is met, each
waveform contains the same signal, but the random noise changes from acquisition
to acquisition and the average value of the random noise is lowered, while the signal
value remains constant. Time domain averaging is not available in spans wider
than the maximum real-time bandwidth.

Number Specifies the number of acquisitions to be averaged when Averaging is set to
Frequency Domain. Specifies the number of successive capture records that are
averaged when Averaging is set to Time Domain.

Correct for Noise Floor Enables/disables the Noise Floor Correction function.

Power Reference Specifies power against which the results are compared. Choices available are each
of the existing main channels and “Total (active channels”.

Only present when MCPR s the selected display.

Channel Filter Specify the channel filter used. Select between None (default) and Root-raised
Cosine.

Filter Parameter Value entry box for the Root-raised Cosine filter Adjacent Channel Filter.
Present only when the Channel Filter is set to Root-raised Cosine.

Chip Rate Value entry box for the Root-raised Cosine chip rate.

Present only when the Channel Filter is set to Root-raised Cosine.

Correct for Noise Floor

When this setting is enabled, the instrument applies a correction to the ACPR or MCPR measurement to
reduce the effect of instrument noise on the results. It generates this correction by taking a preliminary
acquisition to measure the instrument noise floor. Once this is done, the measurement proceeds, applying
the correction to each result. When any relevant settings (reference level, attenuator, frequency, or span)
are changed, the instrument performs a new noise measurement and correction.

The noise correction signal is created by switching off the input to the RTSA and performing acquisitions
of the instrument internal noise. 100 acquisitions are averaged to create the noise reference signal. A single
value of noise is measured for each channel defined by the measurement. The noise reference from each
channel is subtracted from the incoming signal power for each channel to create the corrected result. All
calculations are performed in Watts, and then converted to the desired units.

The amount of noise correction is limited to 12 dB to avoid the possibility of a negative power
measurement. This is a rare condition that could occur if the subtraction of the reference power from the
channel power results in a negative value (or ‘infinite’ dBm).
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Channels Tab for MCPR

The measured values differ from the displayed trace in two ways. First, any filtering applied to the channels
is not displayed on the trace. Second, the single value of measured noise for a channel is subtracted from
each trace point in the channel, rather than offsetting the entire channel by a single amount. This produces
a smooth trace with no discontinuities at the channel edges.

Channels Tab for MCPR

Path: Setup > Settings > Channels

Application Toolbar / Front Panel: Settings

The Channels tab is where you specify the parameters for the channels measured in the MCPR display.

| Freg & REW | Measurement Params | Channels | scale [ prafs |

Main Charnels Adj Chans
Inactive Chan  BW Offset it
Mumber: 4 ML Add... M1 3.840 MHz -7.500 MHz
[ mz Mz 3,840 MHz -2,900 MHz £
Byv: 3.840 MHz ] Mz M3 3.840 MHz 2,500 MHz
[ M4 M4 3,840 MHz 7,300 MHz
Spacing: 5,000 MHz A1 3.840 MHz +/-12.500 MHz
n 2 0AN Rl 17 Enn had-
Setting Description

Main Channels

Number Sets the number of Main channels.
BW Sets the bandwidth of the Main channels.
Spacing Sets the frequency difference between the centers of the Main channels.
Inactive Selected channels are ignored by the measurement routine.
Adj Chans
Add Opens the Edit Channel Parameters dialog, which you use to specify the parameters of a
new pair of adjacent channels. You can add up to 50 adjacent channel pairs.
Edit Opens the Edit Channel Parameters dialog box. (You must first select a channel to
enable the Edit button.)
Delete Deletes the selected main channel or adjacent channel pair.
Add Adj. Add a new pair of adjacent channels at the bottom. Their parameters are copied from

the channels just above them.

Channel Definition table

A table of the parameters for every channel. Offset is the frequency difference between
the Center Frequency and center of the selected channel. Nothing in the table is editable
directly.

The following figure illustrates the settings controlled from the Channels tab.
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Editing Channel Parameters

To edit the offset or bandwidth of a Main channel:

1.
2.
3.
4.
To edit the offset or bandwidth of an Adjacent channel:
1.
2.
3.
4.

Adding Channels

To add a main channel:

1.

Select the Number entry box.

Channels Tab for MCPR

Select the value in the BW or Spacing number entry boxes.
Adjust the value as required. All the Main channels share the same BW and Spacing.
Select the appropriate check box to make a channel Inactive, as appropriate.

Select the Close box when you have finished making changes.

Select the channel to be edited in the channel definition table.
Select Edit. This displays the Edit Channel Parameters dialog box.
Adjust the values for the Frequency Offset or Bandwidth as required.

Select the Close box when you have finished making changes.

2. Use the knob to enter a value for the desired number of Main channels.

3. Select the Close box when you have finished making changes.

To add an adjacent channel pair:

164
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1. Select Add. This displays the Edit Channel Parameters dialog box.

2. Use the knob to enter values for the Frequency Offset and Bandwidth as required. The Frequency
Offset is measured from the Center frequency of the Main channels.

3. Select the Close box when you have finished making changes.

Deleting Channels

To delete a main channel:

1. Select the Number entry box.

2. Use the knob to reduce the number of channels or enter a new value using the front-panel keypad.
3. Select the Close box when you have finished making changes.

To delete an adjacent channel:

1. Select the channel to be deleted in the channel definition table.

2. Select Delete. This removes the selected channel from the channel table.

3. Select the Close box when you have finished making changes.

Occupied BW & x dB BW Display

The Occupied BW display shows the bandwidth within which 99% (a user-defined value, the default is
99%) of the power transmitted within the measurement bandwidth falls.

To show the Occupied BW display:
1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select RF Measurements in the Folders box.

3. In the Available displays box, double-click the Occupied Bandwidth icon or select the icon and
click Add. The Occupied Bandwidth icon will appear in the Selected displays box and will no
longer appear under Available displays.

4. Click OK to display the Occupied Bandwidth.
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Elements of the Display
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Occupied BW & x dB BW Display

Item Display element Description

1 Check mark indicator The check mark indicator denotes the display for which the acquisition
hardware is optimized. This indictor appears only when the display is the
selected display.

2 Averaging readout Appears when averaging is enabled (Settings > Parameters tab > Average
results). Displays "Avg: n of m" while averaging the results and "Avg: m"
once the requested number of results have been averaged.

3 Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the
graph.

4 Trace function readout Displays either Normal or MaxHold to indicate trace function.

5 Clear Resets count for Average and MaxHold functions. Enabled only when
Averaging or MaxHold is enabled. Pressing Clear will clear the trace and, if
acquisition is running, restart the averaging or hold process.

6 Graph Displays the input signal. Shaded areas indicate the measurement bandwidth
(Settings > Parameters tab > Measurement BW).

7 Blue lines The blue lines indicate where the selected results (selected in the Main
results area) are being measured on the trace.

8 Grid divider Determines the portion of the display allocated to the graph and detailed
results area. You can move the grid divider all the way to the top or bottom
and any position in between.

9 Detailed results area Displays additional measurements results.

10 Position and dB/div Position sets the top of graph value. The dB/div setting is the vertical scale
value.

1" Main results area Displays results for Occupied Bandwidth (OBW) and x dB bandwidth. Use
the two radio buttons to select which of the two results are illustrated in the
graph with the blue lines and arrows. There are also controls for adjusting
OBW % Power, x dB BW, and RBW.

12 VBW Enables the VBW (Video Bandwidth) filter. Displays current VBW filter setting.

See Setup > Settings > Freq & RBW tab (see page 160).

Detailed Results Readouts

Measurement Description

Freq Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the analyzer.

OBW Level left The signal level at the left edge of the occupied bandwidth.

OBW Level right The signal level at the right edge of the occupied bandwidth.

OBW Ref Power The total power measured within the measurement bandwidth.

x dB BW Ref Power The peak power measured within the measurement bandwidth.
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Changing the Occupied Bandwidth Settings (see page 168)

Occupied Bandwidth

Bandwidth within which some defined percentage of the power transmitted on a single channel lies.

Occupied BW & x dB BW Settings

168

Menu Bar: Setup > Settings
Front Panel / Application Toolbar: Settings

The control panel tabs for the Occupied Bandwidth display are shown in the following table.

Settings tab Description

Freq & RBW (see page 219) Allows you to specify the Center Frequency, Step size and RBW.

Parameters (see page 169) Allows you to specify the Occupied BW % Power, x dB level, Measurement BW, enable
averaging and the Max Hold function.

Scale (see page 224) Allows you to set the vertical and horizontal scale parameters.

Prefs (see page 225) The Prefs tab enables you to set characteristics of the measurement display.
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Parameters Tab

The Parameters tab enables you to specify parameters that control the Occupied BW measurement.

Freq & RBw | Parameters |Scale | Prefs

Occupied BW %% Power: 99.0 %

[] Max Hald spectral data

¥ OB level -20.0 dB
Count:

Measurernent Byy: 10,00 MHz [ Average results w

Setting Description

Occupied BW % Power Specifies the proportion of power within the occupied bandwidth (referenced against the
total power in the measurement bandwidth).

x dB level x dB level defines the x dB BW level search threshold.

Measurement BW Specifies the frequency range used by the measurement.

Max Hold spectral data Enables the Max Hold function.

Average results Enables/disables results averaging. Note that this is not an averaging of the trace, but an
averaging of the results.

Count Specifies the number of results averaged to calculate the Occupied BW. Range: 2 to
10,000.

x dB Level

The x dB level determines the x dB BW. The instrument analyzes the spectrum trace to locate the
frequencies at which the level is x dB down from the peak level calculated over the measurement
bandwidth. The frequency difference between the upper and lower crossing thresholds is the x dB BW.

Range: -80.0 to -1.0 dB; Resolution: 0.1%; Inc/dec small: 0.1%, large: 1%; Default: -26 dB

Max Hold Spectral Data

Max Hold displays the maximum value in the acquisition record for each display point. Each new trace
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.

Spurious Display

To show the Spurious display:
1. Click the Displays button or select Setup > Displays.

2. From the Folders box, select RF Measurements.
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Spurious Display

3. Double-click the Spurious icon in the Available displays box. This adds the Spurious icon to the
Selected displays box (and removes it from the Available displays box). Alternatively, you can click
the Spurious icon and then click the Add button to select Spectrum for display.

4. Click the OK button.

Elements of the Spurious Display
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Spurious Display

Item Display element Description

1 dB/ div Sets the vertical scale value. The maximum value is 20.00 dB/division.

2 Vert Position Sets the top of graph value. This is only a visual control for panning the graph.
The Reference Level is adjusted in the Toolbar and the Ampl control panel.
By default, Vert Position = Ref Level.

3 Check Mark Indicator Indicates the display for which the acquisition hardware is optimized.

4 Pass / Fail readout Indicates whether one or more spurs have exceeded a limit specified on
the Settings > Limits tab.

Ref: If enabled, displays the power reference level.

Trace function Indicates the trace processing method. If Average or Max Hold is selected,
this readout displays the number of traces being processed (averaged or
compared for the Max Hold value).

Clear Restarts multi-trace functions (Average, Max Hold).

Stop Adjusts the graph stop frequency. This setting affects only visual scaling, not
measurement parameters.

9 Green bar Indicates the range that is selected on the Settings > Ranges and Settings >
Limits tabs.

10 Spur table Displays spur measurements. See the following table for details.

" Start Adjusts the graph start frequency. This setting affects only visual scaling, not
measurement parameters.

12 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on
screen. Selects Multi-range display mode.

13 Bottom-of-graph readout Indicates the amplitude at the bottom of the graph. This value changes with

the dB/div and Vertical Position settings.

Elements of the Spurious Graph Display

@
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Spurious Display

Item Display element Description

1 - The green line or shading indicates an Abs (absolute) limit. The absolute limit
is enabled when the mask is set to Abs, Abs & Rel, or Abs OR Rel. Note that
absolute and relative amplitude masks can overlap.

2 - The gray-shaded area indicates a portion of the spectrum where no
measurements are being taken.

3 - The cyan line or shading indicates a Relative limit. The relative limit is
enabled when the mask is set to Rel, Abs & Rel, or Abs OR Rel. Note that
absolute and relative amplitude masks can overlap.

4 abs rel Reminder that green-shaded areas highlight absolute limits and cyan-shaded
areas highlight relative limits.

5 v This indicates the selected spur, when it is in violation of the limits. In Run
mode, this is the peak spur violation. The selected marker is highlighted in
the Spur table below the graph with a blue background.

6 :i A spur marker. Indicates a spur that does not exceed the mask settings. See
the Settings > Ranges and Limits tab (see page 176).

7 ¥ A violation marker. Indicates a spur that exceeds the mask settings. See the
Settings > Ranges and Limits tab (see page 176).

-- O Indicates the selected spur when it is not in violation of the limits. The
selected marker is highlighted in the Spur table below the graph with a blue
background.

8 1,2, 3. A Spur number. The number indicates the row in the spur table that
corresponds to the spur. The instrument can display up to 999 spurs.

9 A, B,C,D.. Identifies the enabled ranges.

10 Green bar Indicates the range selected on the Settings > Ranges and Limits (see
page 176) tab.

11 Ref Indicates the location of the power reference. See Settings > Reference
(see page 174).

Elements of the Spur Table

Spur Range  Freq &bs Freq Rel Ampl Abs Ampl Rel  Limit Abs Lirmit Rel
1 B 1.751145 GHz — Hz -5.91 dBm 4.09 dB -15.00dEm | -15.00dE
2 E 2053875 GHz —Hz -5.93 dBm 1.01 dB -15.00 dBm | -10.00 B

- ] 1.903950 GHz —Hz -10.45 dBm  EUEERIEE 50.00 dBm | -57.00 dE

A 1.745826 GHz —Hz Sclorl. = W 29 57 dB | 57.00 dBm | -30.00 4B

_ ] 1.699062 GHz - Hz -40.31 dBm -50.00dEm | 57.00dE
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Column Description

Spur A number that identifies a spur in the graph area. The instrument can display a maximum
of 999 spurs.

Range The letter representing the frequency range where the spur is located.

Freq Abs The absolute frequency at which the spur occurs.

Freq Rel The relative frequency at which the spur occurs. The relative frequency is the difference
between the absolute frequency (absolute) and the carrier frequency.

Ampl Abs The absolute amplitude of the spur.

Ampl Rel The relative amplitude at which the spur occurs. The relative amplitude is the difference
between the absolute amplitude and the carrier amplitude. See the Settings > Limits tab.

Lim Abs The value of the absolute amplitude limit at the spur frequency. This value can vary even

with small spur frequency changes if the start and stop limit values are different. See the
Settings > Ranges and Limits tab (see page 176).

Lim Rel The relative amplitude limit at which the spur occurs. This value can vary even with small
spur frequency changes if the start and stop relative amplitude limit values are different.
See the Settings > Ranges and Limits tab (see page 176).

Blue background The cell in the Spur column with a blue background identifies the selected spur.

Red background Cells in the Spur column with a red background identify violations.
Cells in the results area with a red background identify the measurement that exceeded a
limit.

Rearranging the Columns in the Spur Table

You can rearrange the order of the columns in the Spur Table. To move a column, click on the column
heading and drag it to the desired position.

Sorting the Rows in the Spur Table

You can sort the rows in the Spur table by clicking on the column heading. For example, if you click on
the Freq Abs heading, the results in the Spur table will be sorted by frequency. If you click on Range, the
rows will be sorted by range. Clicking a second time on the same heading reverses the order.

Changing the Spurious Display Settings (see page 173)

Spurious Display Settings

Menu Bar: Setup > Settings
Front Panel: Settings

Application Toolbar: &

The control panel tabs for the Spurious display are shown in the following table.
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Settings tab

Parameters Tab

Description

Parameters (see page 174)

Specifies whether the graph displays one range or multiple ranges. Specifies whether all
spurs are shown or only spurs over specified limits.

Reference (see page 174)

Specifies the Power Reference level.

Ranges (see page 176)

Specifies start and stop frequencies of ranges and which ranges to take measurements in.
Sets parameters that define a spur. Review, save and load the Range table from this tab.

Limits (see page 176)

Specifies Pass/Fail limit parameters.

Trace (see page 220) Specifies the trace Function.
Scale (see page 224) Specifies the vertical and horizontal scale settings.
Prefs (see page 225) Specifies the appearance features of the graph area.

Restore defaults. Sets the Spurious parameters to their default values.

Parameters Tab

The Parameters tab enables you to specify settings that control the Spurious measurement.

Parameters |Reference I Ranges and Limits | Trace | Scale | Prefs |

Frequency Ranges List Spurs
@ Multi O single @ All spurs ~ Crver Limit

Setting Description

Frequency Ranges

Multi Enables the instrument to display all enabled ranges in the graph.

Single Limits the graph to the display of only one range. The displayed range is set to the range
that contains the selected spur.

List Spurs

All spurs Displays any spur that exceeds the Threshold and Excursion values set on the Ranges
tab.

Over Limit Displays only spurs that exceed both the Threshold and Excursion values set on the

Ranges tab and the limits specified on the Limits tab.

Reference Tab

The Reference tab enables you to specify the Power Reference parameter. The Power reference parameter
is used to calculate relative values in the Spur table and to calculate relative amplitude limits.

174
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Parameters | Reference |Ranges and Limnits ITrace I Scale IPrefs |

Power reference:  |Manual level - Reference power level,  -10.00 dBm

Carrier
Mo reference
Setting Description
Power Reference Specifies the power reference level used for relative values and limits.
No reference Power level readings are calculated only for absolute values, no relative values are
calculated.
Manual level The reference level for relative measurements is specified by the Reference power
level setting.
Carrier The reference level for relative measurements is based on the power level calculated at

the specified carrier frequency.

Setting the Power Reference Level to No Reference

Parameters | Reference |Ranges and Limnits ITrace I Scale IPrefs |

Poweer reference:  |Mo reference i

To set the power reference to No Reference:

m  Select No reference from the Power reference drop-down list.

Setting the Power Reference Level to Manual Level

Parameters | Reference |Ranges and Limnits ITrace I Scale IPrefs |

Power reference:  |Manual level - Reference power level,  -10.00 dBm

To set the power reference to manual level:
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Ranges and Limits Tab

1. Select Manual level from the Power reference drop-down list. This displays the Reference power

level entry box.

2. Specify the desired power level in the Reference power level entry box.

Setting the Power Reference Level to Carrier

Parameters | Reference |Ranges and Limits | Trace | Scale | Prefs |

Power reference: | Carrier -

Freguency: 1466000 GHz
Channel width:  2.500 MHz

Threshiold: Integration Bi:
-10.00 dBrmn 2 MHz

Res BW:
B85 fHz

Auto

Detection:

+Peak -

To set the power reference to Carrier:

1. Select Carrier from the Power reference drop-down list.

2. To set the Carrier frequency, specify the necessary values in the Frequency and Channel width

entry boxes .

3. Specify the Threshold level.

4. Specify the Integration BW. The Integration BW is the bandwidth over which the carrier is measured.

5. If necessary, specify the Resolution Bandwidth by changing the value in the Res BW entry box. Auto

is the recommended setting.

6. Set the Detection method. Sclect +Peak, Avg (VRMS), or Avg (of logs).

NOTE. If the power level measured over the Integration BW about the carrier frequency is below the
threshold level, the instrument concludes that no carrier is present and no relative measurements will be

taken. Absolute measurements will still be taken.

Ranges and Limits Tab

Use the Ranges and Limits tab to specify the parameters that control the Spurious measurement. From the
Ranges and Limits tab, you specify the start and stop frequencies for ranges, whether or not a range is
enabled, the parameters that specify what constitutes a spur, measurement filter shape and bandwidth, and
the detection method used for processing signals, as well as the pass/fail parameters for Limit Testing.
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Parameters | Reference | Ranges and Limits | Trace | Scale | Prefs

Ranges and Limits Tab

On  Start (Hz) Stop (Hz) SFIE:EL BW (Hz) Auto Detector \63:\; Vg:‘l |;|
» & B0 14s25006 15075006 [REW 100.000k | % |+Peak 100k B
B ¥ |1.512500G | 1.537500G |RBW 200.000k | X |+Peak 200k layout
C 0,000000 0,000000 REW I.000M X +Peak ™M
D 0,000000 0,000000 REW I.000M X +Peak ™M
E 0.000000 0.000000 REW I.000M X +Peak ™M i
4 | i b S
Setting Description
Expand Displays the Ranges and Limits Table in a new, resizeable window.

Reset layout

You can reorder columns in the Ranges and Limits Table by dragging the columns to a
new position. Clicking Reset Layout returns the column order to the factory default order.

Load

Click to load a saved Ranges and Limits table from a file.

Save

Click to save the current Ranges and Limits table to a file.

To specify the ranges and limits for the Spurious measurement:

®  Edit the values in the Ranges and Limits table.

You can edit the Ranges and Limits table in two ways:

m  Edit values directly from the Ranges and Limits tab. You will need to scroll the table to access all
settings.

m  Click the Expand button. This displays the Ranges and Limits Table in a new window that can be
sized to the fullscreen.

Ranges and Limits Table

B

Hw@moWoZEZ A~ IoONmMmON

On

X

Start (Hz)

v A B8 14925006

1.512500G
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000

Stop (Hz)
1.507500G
1.537500G
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000

Filter
Shape

RBW
RBW
RBW
RBW
RBW
RBW
RBW
RBW
RBW
RBW
RBW
RBW
RBW
RBW
RBW
RBW
RBW
RBW
RBW
RBW

.

BW (Hz)
100. 000k
200. 000k
1.000M
1.000M
1.000M
1.000M
1.000M
1.000M
1.000M
1.000M
1.000M
1.000M
1.000M
1.000M
1.000M
1.000M
1.000M
1.000M
1.000M
1.000M

Auto

B e e R e e e e e R A e e e P

Detector

+Peak
+Peak
+Peak
+Peak
+Peak
+Peak
+Peak
+Peak
+Peak
+Peak
+Peak
+Peak
+Peak
+Peak
+Peak
+Peak
+Peak
+Peak
+Peak
+Peak

VBW
Hz)

100k

200k

HHEHEHEHEEBEHEHEBEEHEEEHEHE

vBw =
on Reset layout

|
Save

The following table describes the parameters that are set in the Ranges and Limits Table.
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Ranges and Limits Tab

Ranges and Limits Table Settings

Setting Description

On Specifies whether or not measurements are taken in the specified range.

Start (Hz) Readout of the start frequency for the selected range.

Stop (Hz) Readout of the stop frequency for the selected range.

Filter shape Specifies the filter shape used for the Spurious measurement.

BW (Hz) Specifies the bandwidth used for the selected filter shape.

Auto Sets the BW automatically. If CISPR is selected for Filter shape, this control is disabled.

Detector Sets the processing method used for compressing excess intermediate data into the
desired number of trace points.

VBW (Hz) Adjusts the VBW (Video Bandwidth) value. VBW Maximum: RBW current value; VBW
Minimum: 1/10,000 RBW setting. Disabled when Filter shape is set to CISPR.

VBW On Specifies whether the VBW filter is applied.

Thrshid (dBm)

Threshold specifies the level that must be exceeded for a signal peak to be recognized
as a spur. A signal peak must also exceed the Excursion setting to be considered a spur.

Excrsn (dB)

Excursion specifies the peak to peak magnitude that must be exceeded for a signal peak
to be recognized as a spur. A signal transition must also exceed the Threshold setting
to be considered a spur.

Mask Selects the type of limits used for Pass/Fail testing. Spurs that exceed the mask settings
are considered violations. The available choices are shown below.

Abs Spurs that exceed the Absolute limits settings are identified as violations.

Rel Spurs that exceed the Relative limits settings are identified as violations.

Abs & Rel Spurs that exceed both the Absolute and Relative limits settings are identified as
violations.

Abs OR Rel Spurs that exceed either the Absolute or Relative limits settings are identified as
violations.

Off Turns off limit testing for the selecting range. Measurements are still taken in the range,
but violations are not flagged. Signal peaks that exceed the Threshold and Excursions
values will still be identified as spurs.

(Abs Start and Abs Stop) Absolute amplitude limits are not based on the measured carrier amplitude or manual
reference. Start and stop values can be different.

Abs Start (dBm) Abs Start specifies the limit at the start frequency of the range.

Abs Stop (dBm) Abs Stop specifies the limit at the stop frequency of the range.

Abs Same Sets the limit at the start and stop frequencies to the value set for the start frequency.

(Rel Start and Rel Stop)

Relative amplitude limits are calculated from the Power Reference. If the Power
Reference is set to the Carrier level, the relative amplitude limits will change with the
carrier level. Start and stop values can be different.

Rel Start (dB)

Specifies the limit at the start frequency of the range.

Rel Stop (dB)

Specifies the limit at the stop frequency of the range.

Rel Same Sets the limit at the stop frequency to the value set for the start frequency.
Save As Click to save the current Ranges and Limits table to a file.

Load Click to load a saved Ranges and Limits table from a file.

Done Save changes and close the Ranges and Limits Table window.
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Changing the Range Start and Stop Frequencies

To change the range start and stop frequencies, edit the Start and Stop frequencies in the Ranges and
Limits Table:

1. Click the Expand button on the Settings > Range and Limits tab. This displays the Ranges and
Limits Table.

2. Click the On box for a range to take measurements in the range.

3. Click on the Start or Stop frequency setting to change it. Type in a number for the frequency and a
letter as a multiplier. You can use k, m, or g to set the frequency multiplier.

4. Click Done to save your changes.

Specifying Spur Requirements

A spur is a signal peak that exceeds both the Threshold and Excursion settings in the Ranges and Limits
table. The Threshold and Excursion settings are absolute values; they are not calculated relative to a
reference. The Threshold and Excursion settings are specific to the selected range. If you want to use
different settings for spurs in different ranges, you have to set the values separately for each range. The
Excursion control is used to avoid interpreting a single spur as multiple narrower spurs by requiring the
amplitude to drop by the Excursion amount between spurs. Raising the Threshold value means that
fewer, larger signals will be identified as spurs.

To specify the spur requirements for a range:

1. Click the Expand button on the Range and Limits tab. This displays the Ranges and Limits Table.
2. Select the Range (A-T) for which you want to specify the spur requirements.

3. Set the Thrshld value.
4

Set the Excrsn value.

Setting Limits

Use the Limits settings in the Ranges and Limits Table to specify the pass/fail parameters for the Spurious
measurement. When the Mask setting is set to any value except off, the instrument identifies any signal
peak that exceeds the specified limits as a violation and displays Fail on the screen. If no signal peak
exceeds the limits, the instrument displays Pass on the screen.

Performing Pass/Fail Limit Testing

To set limits:

1. Click the Expand button on the Range and Limits tab. This displays the Ranges and Limits Table.
2. Adjust the Start and Stop frequencies as required for each range you want to test.

3. For ranges that you wish to test, verify that the On box is checked.
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4. For each range you wish to test, select the desired Mask type from the drop-down list.

5. Set the limits as desired in the Abs Start, Abs Stop, Rel Start, and Rel Stop boxes. The values you
can edit depend on the mask type you select.

6. Verify that the Thrshld and Excrsn values are set as required. These are the values that define a spur.
7. Click Done to save your changes and close the Range and Limits Table window.

8. Click Run to begin testing.

CCDF Display

The CCDF (Complementary Cumulative Distribution Function) is a statistical characterization that plots
power level on the x-axis and probability on the y-axis of a graph. Each point on the CCDF curve shows
what percentage of time a signal spends at or above a given power level. The power level is expressed in
dB relative to the average signal power level. The CCDF Display also shows the Average power level
and the Peak/Average ratio.

To show the CCDF display:
1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Folders box, select RF Measurements.

3. Double-click the CCDF icon in the Available Displays box. This adds the CCDF icon to the Selected
displays box.

4. Click the OK button.

Elements of the CCDF Display

@

v Trace1l [¥Ishow 1.000ms

0.0001

ode 20de
Avg: -8.76 dEm 35,72 % Pk/Avg: 4.82 0B

@ 0519027

] 10 1 0.1 0.01 0.001 00001
dB  3.85 4.53 4.66 4.74 -

@®
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CCDF Settings

Item Display element Description
1 100% The top of the graph represents the 100% probability that the signal will be at
or above the average signal level.
2 Power level select Adjust to display the value of the CCDF curve at a specific power level. The
selected power level is indicated by a small triangle on the CCDF curve.
3 CCDF value Readout of the value of the CCDF curve at the selected power level.
Avg Readout of the Average power level and the CCDF value at the Average
power level.
Readout Table Readout of the CCDF curve at six points.
Pk / Avg Readout of the Peak to Average power ratio.
Measurement time Readout of the length of time used for the measurement. Displays --- s when

the Measurement time is set to continuous.

Changing the CCDF Display Settings (see page 181)

CCDF Settings

Menu Bar: Setup > Settings

Front Panel: Settings

Application Toolbar: i

The control panel tabs for the CCDF Display are shown in the following table.

Settings tab

Description

Parameters (see page 182)

Specifies the time to be measured.

Traces (see page 220)

Select the trace to be measured and select reference trace for display.

Prefs (see page 225)

Specifies whether on not certain display elements are shown.

Restore defaults. Sets the CCDF parameters to their default values.
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Parameters Tab

Parameters Tab

The Parameters tab enables you to specify several parameters that control signal acquisition for the

CCDF Display.

Parameters | Traces I Prefs

Measurement Time

@ Single (use Analysis Length)

) Total Time: | 200000 8 Span:  B5.0 MHz
) Continuous

Setting Description

Single When Single is selected, the CCDF measurement is based on the Analysis Time
parameters set on Analysis control panel (Setup > Analysis > Analysis Time), shared by
all displays. In Single, CCDF is time-correlated with the other open displays.

Total Time When Total Time is selected, you can adjust its value. The value set here does not affect
the Analysis Length value set in the Analysis control panel. If the Total Time value is
longer than the Analysis Length, CCDF uses multiple acquisitions to collect signal data.

Continuous When Continuous is selected, the CCDF measurement combines each new record
(Actual Analysis Length) into the existing result. It does not erase and start over until
user presses STOP or CLEAR.

Span Specifies the range of frequencies used for analysis.

Single

To have statistically meaningful results, CCDF works best when calculated on at least 1 ms of data.
Depending on the Analysis Time setting, the CCDF display may present error messages:

m  [fthe Actual Analysis Time is greater than 1 ms, the CCDF Display will calculate the trace without
any problems.

®  [fthe Actual Analysis time is less than 1 ms, the CCDF Display will measure the data as best if
can, but if it receives fewer than 20 samples, the CCDF display will clear the trace and report "Not
enough samples".

Phase Noise Display

Phase Noise measures and graphs the power in a 1 Hz bandwidth referenced to the carrier power. This is
repeated for many frequency points across a user-adjustable span.

To show the Phase Noise display:

182

SPECMON3 & SPECMONG Printable Help



RF Measurements Phase Noise Display

1. Click the Displays button or select Setup > Displays.
2. From the Folders box, select RF Measurements.

3. Double-click the Phase Noise icon in the Available displays box. This adds the Phase Noise icon to
the Selected displays box (and removes it from the Available displays box). Alternatively, you can
click the Phase Noise icon and then click the Add button to select Phase Noise for display, or drag the
Phase Noise icon to the Selected Displays box.

4. Click the OK button.

Elements of the Phase Noise Display
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Phase Noise Display

Item Display element Description

1 Check Mark Indicator Indicates the display for which the acquisition hardware is optimized.

2 Vert Position (dBc/Hz) Sets the top of graph value. This is only a visual control for panning the graph.

3 Trace selector Selects a trace.

4 Show check box Shows/hides the selected trace.

5 Detection method / Average Displays the Detector method used for the trace. If Average detection is

count enabled, the number of averaged traces appears here.

6 Measurement Marker readout Readout of the value of the phase noise at the selected offset. The Phase
Noise measurement marker does not affect the results reported in the
readouts or table below the graph, nor is it associated with markers in any
other display.

Clear Restarts multi-trace function (Average).
Horizontal stop Readout of the Right Horizontal frequency value. This setting affects only
visual scale, not measurement bandwidth. (See Settings > Scale (see
page 139))
9 Measurement marker Indicates the position of the measurement point.
10 Integration frequency range The gray-shaded areas denote the frequencies outside the integration
indicators frequency range. (See Settings > Frequency (see page 351))

" Phase Noise Table Displays the phase noise values at different offsets.

12 Horizontal start Readout of the Left Horizontal frequency value. Affects only visual scaling,
not measurement bandwidth. (See Settings > Scale (see page 139))

13 Measurement results Display of the different measured values.

readouts

Elements of the Measurement Results Readout / Phase Noise Table

CETier pOer -5.93 dem Offeat Trace 1 Trace 2
Freq Emror -2 B He 10 Hz HA3.93 dBcHz 6346 dBofHz
RMS Phase Nose: 2,554 ° 100Hr <8675 dBc/Hz 84,91 dBc/Hz
1 ke 85,56 dBcj/Hz  -83.80 dBcjHz
= 2,902 s ! r
] "E; e o an E’c ke TIABdBcHr 6,59 dBcjHe
ol i A7 R 100 kHz 95,08 dBc/Hz  -94.04 dic/Hz
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Readout Description

Carrier power The power level at the carrier frequency.

Freq Error The measured carrier frequency error.

RMS Phase Noise The RMS value of the phase noise, measured over the Integration BW.

Jitter The jitter in seconds, measured over the Integration BW. Includes the effects of random
and coherent jitter.

Residual FM The residual frequency modulation, measured over the Integration BW.

Trace 1 The phase noise on trace 1 at different frequency offset values. Note that if Trace 1 is set

to +/- Peak detection, the value displayed in the table is the +Peak value.

Trace 2 The phase noise on trace 2 at different frequency offset values. Note that if Trace 2 is set
to +/- Peak detection, the value displayed in the table is the +Peak value.

Changing the Phase Noise Settings (see page 186)

How Phase Noise Is Measured

If carrier tracking is on, the instrument measures phase noise relative to the highest-amplitude signal within
about 20 MHz of the user-entered frequency. The difference between center frequency and the frequency
of the measured carrier is reported as frequency error. If carrier tracking is not on, the instrument measures
phase noise relative to the amplitude at the user-entered frequency.

The unit will tune to a number of offsets from the carrier frequency, and calculate the spectrum for the
frequency range about each offset using a resolution bandwidth appropriate for the offset frequency.
This is done to optimize speed while maintaining acceptable frequency resolution. A table of the values
used for measurement frequency offset, resolution bandwidths, hardware IF filter bandwidths and RF
attenuations is shown below.

RBW use
Measurement frequency Measured for spectrum
offset range span calculation Hardware IF filter RF Attenuation
10 Hz to 100 Hz 312.5 kHz 1 Hz 40 MHz Auto from ref level
100 Hz to 1 kHz 312.5 kHz 2 Hz 40 MHz Auto from ref level
1 kHz to 10 kHz 312.5 kHz 20 Hz 40 MHz Auto from ref level
10 kHz to 100 kHz 3 MHz 200 Hz 40 MHz Auto from ref level
100 kHz to 1 MHz 3 MHz 1 kHz 40 MHz Auto from ref level
1.0 MHz to 1.9 MHz 300 kHz 1 kHz 1 MHz Auto from ref level (-5 dB) !
1.9 MHz to 20.0 MHz 300 kHz 1 kHz 1 MHz Auto from reflevel (-20 dB)?
20 MHz to 100 MHz 20 MHz 10 kHz 40 MHz Auto from ref level (-5 dB) !
100 MHz to 1000 MHz 20 MHz 100 kHz 40 MHz Auto from ref level (-5 dB) !

1 Attenuator adjustment when ‘optimize dynamic range’ is selected

After acquisition and calculation, the spectrum is corrected to display power in a 1 Hz bandwidth
referenced to the carrier power (dBc/Hz). The correction algorithm does not discriminate between noise
signals and coherent signals in making the dBc/Hz correction. Since all measured signals are corrected as
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if they were noise, coherent signal measurement results can contain errors in level. This is a key difference
between an SA-based measurement and a dedicated phase noise tester.

The largest difference between operation of a swept spectrum analyzer and a real-time signal analyzer
when measuring phase noise is a result of the wide acquisition bandwidths found in the real-time signal
analyzer. The real-time signal analyzer can select between 1 MHz, 40 MHz and 110 MHz IF filters when
performing acquisitions. By contrast, a traditional spectrum analyzer uses an IF bandwidth that can range
from a few kHz wide up to 10 MHz wide, depending upon the selected resolution bandwidth. When the IF
bandwidth is small it is able to reject out-of-band carriers so they don't overload the final IF and digitizers
in the instrument. This allows the signal analyzer to begin to reduce attenuation as the phase noise
measurement tunes farther away from the carrier, improving dynamic range. The same thing is done in the
real-time signal analyzer, but the 1 MHz final IF section in the real-time signal analyzer can't reject signal
within about 1 MHz whereas a conventional spectrum analyzer can reject signals within a few kHz of the
desired carrier. This is the reason for the shape of the phase noise plot seen in the following illustration.

| Displays | | Matkers [|Settngs LIE.-' s || Ana | = Freq: S00.00 MHz & Reflev: 200 dim | arp! v | ®

un
i < Trace2 [Zlshow 8of10 ey
% -50.00 cBc/He

= dBfdiv:
10.0 cB

< Mk
1765 Mhz

-150.,00 dBcfHz
| Autaszale |

Carrier power: 3.3 dEm Offsst | Trace 1 Trace 2

Freq Emor: -730.9 He WH  -7945dBciMr 7945 dBc/Hz
RMS Phasa Nose: 10,1580 © 100Hz  -8174dBcMr 8174 dic/z
Tetal it o 1k S8.11dBcfH: 96811 dBcfz
;0"’ :'Il l:; ?33'*;" 10 ke -110.57 dBefris -110.57 Bkt
tesidun v SLOBRHE | jpope 11S4idBefe -115.91 dBoHe

1MHz  -1Z081dBcfHe  -130.81 Bofbe
10 MH:  -146.31dBcfHe  -146.31 Bobe
100MHe -145.80dBcfHz  -145.80 Br/he

Transfer Agg BW: 212,50 kHz, Acg Length: 2.230 ms St Frga Aun Raft Int  Atten: 10 d8
0519042

In the previous illustration, the effect of choosing ‘optimize dynamic range’ is seen. In the offsets between
10 Hz and 1 MHz, the 40 MHz acquisition bandwidth is used, and the RF attenuator is set based on the
reference level of the instrument to prevent overload of the RF/IF signal path.

At an offset of >1 MHz, a 1 MHz IF bandwidth is applied, 5 dB of RF attenuation is removed from the
signal path and the noise ‘floor’ of the measurement is reduced. At 2 MHz offset from carrier, 20 dB of
attenuation is removed with a resultant increase in dynamic range. Finally, at 20 MHz offsets, the 40 MHz
filter is used again with 20 dB attenuation removed. In order to be able to use the 40 MHz BW filter at a
20 MHz offset, the measurement frequency is moved so that the carrier is 30 MHz from the measurement
point, and well down the filter rejection skirt.

Phase Noise Settings

Menu Bar: Setup > Settings
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Front Panel: Settings

Application Toolbar: it

The control panel tabs for the Phase Noise display are shown in the following table.

Settings tab Description

Frequency (see page 351) Specify Measurement BW and Integration BW. Enable carrier frequency tracking and
specify the Carrier threshold level.

Parameters (see page 189) Specifies the Optimization method.

Traces (see page 220) Specifies trace parameters such as detection method and whether smoothing in enabled.
Traces can also be saved and loaded for reference from this tab.

Scale (see page 224) Specify vertical and horizontal scale settings.

Prefs (see page 225) Specify appearance features of the graph area.

Restore defaults. Sets the Phase Noise parameters to their default values.
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Frequency Tab

Frequency Tab

Use the Frequency tab to specify parameters used for taking the Phase Noise measurement.

Frequency | Paramaters | Traces | Scale | Prefs

Start Offset
Measurement BV 100.0 Hz

Integration BYW:  100.0 Hz

Setting

Stop Offset /| Track carrier frequency
100.0 MHz
Carrier threshald:
100.0 MHz -20.00 dBm
Description

Measurement BW

This sets the frequency range for the phase noise measurement range. The instrument's
Frequency control is used to set the "carrier frequency of interest". The widest available
start/stop range is from 10 Hz greater than the carrier frequency (“Stop Offset”) to 1 GHz
above the carrier (“Stop Offset”). Very small start offsets will take significant time to
measure as very narrow resolution bandwidths are used in to achieve small-offset
measurements. Large-offset stop frequencies cause small effects on measurement time,
but will increase the displayed scale of the phase noise plot.

Start Offset Sets the starting point for the Phase Noise plot. Offset is from the carrier frequency.
The minimum start offset is 10 Hz. The maximum start offset is 100 MHz. The setting
is limited to powers of ten (1, 10, 100...).

Stop Offset Sets the stopping point for the Phase Noise plot. Offset is from the carrier frequency.

The minimum start offset is 100 Hz. The maximum stop offset is 1 GHz. The Stop offset
value must be at least 10X the Start offset value. The setting is limited to powers of
ten (1, 10, 100...).

Integration BW

Integration bandwidth sets the frequency range over which integrated results for phase
noise (labeled “RMS Phase Noise”) and jitter are calculated. Integration start and stop
cannot exceed the measurement bandwidth. If you set the integration bandwidth
greater than the measurement, the error message ‘Setup error: Integration BW exceeds
Measurement BW’ will appear.

Start Offset

Specifies the Integration BW's start offset from the carrier frequency.

Stop Offset

Specifies the Integration BW's stop offset from the carrier frequency.

Track carrier frequency

The instrument finds the carrier signal and measures its frequency at least once each
time the Phase Noise measurement is taken and reports the error between the Freq
setting and the measured frequency of the carrier. When Track carrier frequency is
enabled, the measurement adjusts its tuning to counteract the carrier error or drift. When
carrier tracking is disabled, the measurement is made using the Freq setting specified by
the user.

Carrier threshold

The minimum power level required for the signal to be recognized as a carrier. If no
signal is found above this level within 20 MHz of the Freq setting, the Phase Noise
measurement will fail.

188

SPECMON3 & SPECMONG Printable Help



RF Measurements Parameters Tab

Parameters Tab

The Parameters tab enables you to specify acquisition settings that control the Phase Noise measurement.

Parameters | Traces | Scale | Prefs

[7] twerage: 10

Average. Specifies whether averaging is used or not. This setting affects integrated numeric results and
the trace display. The range for this setting is 2 to 100. The default setting is disabled.

Settling Time Measurement Overview

The Settling Time measurement (Option 12) is used to measure frequency and phase settling time

of frequency-agile oscillators and subsystems. Automated measurements can reduce user-to-user
measurement variations, improve repeatability and measurement confidence, and save time in gathering
results.

Measurement Definitions

Settling time. The time measured from a reference point to when the signal of interest settles to within
user-defined tolerance.

Settled frequency. The final reference frequency, determined automatically or manually. The tolerance
band is centered about this settled frequency.

Settled phase. The final reference phase, determined automatically or manually. The tolerance band is
centered about this settled phase.

Mask Testing

Mask testing is a tool to automatically determine the pass/fail state of the Device-Under-Test. The mask
is defined over three or fewer user-defined time zones, with an independent limit band for each time
zone. If the mask is violated, the area of violation is highlighted in red on screen, and a Fail message is
displayed. The pass/fail status of the mask test can be queried over GPIB for rapid results. To configure
Mask testing, see the Mask tab (see page 204).

The instrument's Search function can watch the Settling Time measurement for either pass or fail results,
and perform actions such as stopping or saving data when the defined condition occurs. See Search (Limits
Testing) Settings (see page 343) for details on configuring Search.
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Frequency Settling Time Theory of Operation

The following paragraphs describe how a frequency and phase settling measurement is made.

Acquisition H/W

Obtain I/Q data at
MeasF/MeasBW HOST

Compute Freq. vs.
Time waveform

'

Apply smoothing

DSP

Add to average

Y

Estimated settled frequency
(averaged waveform) @
measurement index

Analyze to waveform

Get numerical results Apply detection

i HOST

Get trace to display

Frequency settling time flow diagram
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User

Acquisition HW

Settling Time Measurement Overview

Obtain I/Q data at
MeasF/MeasBW

Filter 1/Q
(N/A)

{

Estimated settled frequency
(current I/Q data) @
measurement index

Compute Phase vs.
Time waveform

!

offset

Apply tilt
correction

Apply smoothing

Add to average

'

Analyze to waveform

1

Apply detection

Y

Get numerical results

Get trace to display

Phase settling time flow diagram

0070-029

HOST

DSP

HOST

Acquisition hardware collects I and Q samples at the measurement frequency. Sample Rate is based
on the measurement bandwidth setting.

The instantaneous phase is computed as:
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192

Ph,y = atan (%)

The instantaneous frequency is the derivative of the phase:

' Foompling
Frimy = (Phin-1) = Phni1)) % (Wzm) )

Data smoothing is applied (if selected by the user). This filtering method uses £n adjacent samples to
produce an average value that is used to replace the values of the original 2n samples. An example
is shown below.

Smooth — off Smooth — 3

0070-0:

If averaging is turned on, the smoothed data array is averaged with data arrays of previous acquisitions on
a point-by-point basis. Smoothing has the advantage of reducing noise-like variations in the measurement,
but carries the risk of masking real measurement data. The amount of smoothing applied must be
determined by evaluating the waveform you see for artifacts that result from the process.

Next, Settled Frequency is calculated. Settled frequency is the average frequency determined by looking
back in time from the point set by the Measurement Length control over a minimum of 256 samples. This
value is used to determine the frequency level about which to center the Tolerance range. The measurement
then searches backward through the data until it finds the first point that exceeds the tolerance range. A
maximum of 20 million acquisition data samples can be processed by the measurement.

Settling Time is measured as the time from the start reference to the point where the frequency remains
within the tolerance band. The start reference can be any of three points:

B The trigger point

B The beginning of the analysis period. This result can only be computed when the instrument can find a
previous settled state within the measurement period

B The point at the end of the previous frequency hop where the frequency first leaves the tolerance band.
This result can only be computed when the instrument can find a previous settled state within the
measurement period.
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Tolerance band

REEP,

Point where signal transitions
out of the tolerance band centered . .
on previous settled frequency \ / ~—— Trigger Point

WW Measurement

Length >
Control

-«—— Beginning of analysis period

¥

0070041

Settling time start reference points

All measurements are now complete and the numeric settling time values can be sent to the display.
However, no result traces have been produced yet. Detection is used to reduce the measured points (which
can number up to 10 million) to a number more easily processed by the display processor. +/- Peak
detection is always used, preserving the maximum positive and negative excursions for display. Reducing
the number of points in the result reduces the time resolution of the markers. If averaging is on, the
measurement results are computed on the average of the undecimated results.

Phase Settling Time Overview
Phase settling time is determined, as described previously, with the addition of tilt correction.

The instrument estimates tilt (or slope of the phase) using linear least square fitting over (at least)

256 samples of the phase vs. time waveform, looking backwards from the point set by the Measurement
Length. The instrument adjusts the phase waveform so that its phase is of zero value at the point set

by the Measurement Length.

Settling Time Displays

The Frequency Settling Time measurement is used to measure the frequency settling time of
frequency-agile oscillators and subsystems. The Phase Settling Time measurement is used to measure
the phase settling time of phase-agile oscillators and subsystems. Automated measurements can reduce
user-to-user measurement variations, improving repeatability and measurement confidence and saving
time in gathering results. To measure phase settling, a phase reference is required. This means that the
measurement tool must be frequency- referenced to the device under test, or must act as the frequency
reference to the device under test. To lock the reference to an external source, go to Setup > Configure
In/Out > Frequency Reference and choose External. Values from 1 MHz to 25 MHz in 1 MHz steps
can be used as an external reference.
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To show a Settling Time display:
1. Click the Displays button or select Setup > Displays.
2. From the Folders box, select RF Measurements.

3. Double-click the Freq Settling icon or the Phase Settling icon in the Available displays box. This
adds the selected display to the Selected displays box (and removes it from the Available displays box).

4. Click the OK button.
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@ Position
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Frequency settling time display
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A Ete
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Phase settling time display
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Elements of the Display

Settling Time Displays

Item Display element Description
1 Top of graph Sets the frequency/phase that appears at the top of the graph. However,
note that the top of graph setting, vertical scale setting (Settings > Scale
tab), and Vertical Position settings interact. Adjusting this value changes the
frequency/phase at the top of the graph by adjusting the scale setting.
Phase Settling Time: Sets
Vertical Position Sets the frequency/phase value at the vertical center of the graph.
Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on
screen.
Horizontal Position Sets the horizontal position of the trace on the graph.
Measurement readouts Displays measurement results. See Measurement Readout Text Color below.
Signal transition startindicator A blue vertical line that indicates the staring point of the Settling Time
measurement that is based on the signal transition away from the previous
settled state, if a previous settled state is found within the measurement
period.
7 Trigger point indicator An orange line and “T” (which appears below the graph) that indicates the
location of the trigger point in time.
+/- Tolerance indicators A pair of blue horizontal lines that show the tolerance range.
Settled time indicator Ablue vertical bar that shows the point on the trace at which the measurement
has determined the signal frequency or phase to be settled.
10 Measurement length indicator A magenta vertical line that specifies the end of the allowed measurement
period. This is a control, not a result.
1" Scale Adjusts the horizontal (time) scale of the graph.
12 Clear Restarts multi-trace functions (Avg, Hold) and erases the trace.
13 Function Displays the Detection and Function selections for the selected trace.
(Detection is always +/-Peak for Settling Time measurements.)
14 Show Controls whether the selected Trace is visible or not. When trace is Off, the
box is not checked.
15 Trace Selects a trace. Touching here displays a menu that shows the available

traces and whether they are enabled or not. If you select a trace that is not
currently enabled, it will be enabled.

Measurement Readout Text Color

The measurement readouts can appear in either black text or red text. Measurement results that appear

in black text indicate:

the signal is settled AND

the signal is settled longer than the minimum settled duration AND

the settling time is valid OR the settling time from trigger is valid

If any of the conditions listed are not met, the measurement results text is red.
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Elements of the Frequency Settling Time Graph

The following illustration shows the various indicators that appear in the Frequency Settling Time graph.

Tolerance (+/-)
A po-sme

/ Settled frequency < + »
Minimum settled

/ duration

W

AA

0070038

L Frequency settling time

Settling time from trigger

NOTE. The blue vertical bar that indicates the end of the previous settled state may not always appear.
For frequency settling time, this can happen because the starting frequency is outside the measurement
bandwidth.

Elements of the Phase Settling Time Graph

The following illustration shows the various indicators that appear in the Phase Settling Time graph. For
most phase settling time measurements, there is not a previous settled state within the measurement
period, making it impossible to measure the settling time from the previous settled value. However, the
settling time from trigger is typically available.
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Tolerance (+/-)

\{ ot

Settled phase

Minimum settled duration

e

Settling time from trigger

0070-38

NOTE. The blue vertical bar indicating the measurement start time may not appear. Zero phase is
referenced to the measured hop, as the phase will not typically have a settled value during the previous hop.

Measuring Settling Time

1.
2.
3.

Select the Displays button.
Select RF Measurements from the Folders box.

Double-click the Freq Settling icon or Phase Settling icon in the Available displays box. Click OK
to complete your selection.

Select General Signal Viewing from the Folders box.

Double-click the Time Overview icon in the Available displays box. Click OK to complete your
selection.

Press the front-panel Freq button and use the front-panel keypad or knob to adjust the frequency to
that of the signal you want to measure.
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7. Select the Trig button.

8. In the Trigger control panel, select Triggered. Configure the trigger settings an needed to achieve a
triggered signal.

For the next step in measuring settling time, you must set the starting point of the measurement. To do
this, you will use the Time Overview display.

9. Select the Time Overview display.

10. At the left edge of the graph, drag across the graph to adjust the analysis offset. Adjust the Analysis
Offset to locate the start of the settling time measurement just ahead of the signal transition where
you want to measure the settling time. Any portion of the signal in the gray area will be excluded
from the settling time measurement.

E] @E 106.184 us +Peak Mormal
& 0.00 dBm
o dBfdiv:

1.40 dB

— ve—]
-14.00 dBm
=

© Position: 0.000 s © Scale: 1.020 ms

Setting the starting point of the settling time measurement

Even if the signal transition is difficult to see on the Time Overview display, you can set the starting
point based on the location of the Trigger indicator below the graph. Or open the Frequency vs. Time
graph to see the frequency transition.

11. Click in the Settling Time display to select it.
12. Select the Settings button to display the Settling Time Settings control panel.

13. On the Define tab, adjust the Meas BW (see page 202) to improve the signal-to-noise ratio as
appropriate. Make sure the bandwidth covers the settled frequency, particularly when the instrument
Measurement Frequency is not locked to the spectrum Center Frequency (Analysis control panel >
Frequency tab).

14. Set the Target reference (see page 202) to Auto or Meas freq as appropriate. If you select Meas freq,
also set Offset to fine-tune the measurement frequency if necessary.

15. Set the Tolerance (see page 202) as required for your measurement.

If your signal must be settled for a period of time before it is considered settled, you can specify a
minimum settled duration for the settling time measurement.
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Settling Time Displays

16. Select the Time Params tab. Adjust the Min settled duration (see page 203) as required.

To get the measurement made in the correct location on the signal, you must adjust the measurement

length. You do this by dragging the magenta line in the Settling Time graph.

17. Drag the measurement length indicator (magenta line) to the correct location on the signal. Choose a
point at which the signal appears to be well settled. The measurement will then find the exact time at

which the signal actually settled to within the specified tolerance.

Note the difference in the settling time in the two illustrations that follow. In both examples, the Target
reference is set to Auto. The only difference is the measurement length, as shown by the magenta line.
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¥ Trace 1 [¥]Show Sample Normal Clear
o 2.4503 GHz

< Position: /
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i
© Posttion: 20.000 ns © Scaler 374.220 us
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from Trigger: 44.83 us

Frequency settling time display after setting the measurement length

Settling Time Settings

Menu Bar: Setup > Settings
Front Panel: Settings

Application Toolbar: &
The control panel tabs for the Phase Noise display are shown in the following table.

The settings for the Frequency and Phase Settling Time displays are shown in the following table.

Settings tab Description

Define (see page 201) Sets the measurement parameters that characterize the settling time measurement.

Time Params (see page 203) Sets measurement end-time and minimum settled duration parameters.

Mask (see page 204) Enable or disables mask testing and sets the parameters that specify the three zones
used for mask testing.

Trace (see page 204) Specifies trace display characteristics and which traces are displayed.

Scale (see page 224) Sets vertical and horizontal scale and position parameters.

Prefs (see page 225) Specifies whether or not to show certain display elements, the maximum number of points

in the exported trace, and the displayed precision of the settling time measurement.
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Settling Time Displays Shared Measurement Settings

The control panel tabs in this section are shared by the Frequency and Phase Settling Time displays. These
control panel tabs are not shared with other RF Measurement displays. With few exceptions, each display
shares values for each of the controls on these tabs. For example, Vertical Scale values are independent for
each of the displays (degrees for Phase Settling Time and Hertz for Frequency Settling Time).

Common controls for settling time measurement displays

Settings tab Description

Define (see page 201) Specifies the parameters that characterize the settling time measurement.

Time Params (see page 203) Specifies the Measurement length and minimum settled duration for the settling time
measurement.

Mask (see page 204) Specifies the parameters used for Mask testing.

Trace (see page 204) Specify which traces to show and how they are computed.

Scale (see page 207) Specifies the vertical and horizontal scale settings.

Prefs (see page 208) Specifies display parameters of the Settling Time displays.

Define Tab for Settling Time Displays

The Define tab for the Frequency Settling Time measurement controls several parameters that affect
how the measurement is made.

Define |Time Params | Mask | Trace IScaIe IF‘refs |

Meas Freq: 2.44700 GHz Target reference: Offeet: |0.0000 Hz

Meas BW: 40,00 MHz Tolerance (+§-): S00.0 kHz
actual: #0.00 MHz

Meas Freq

Select the frequency of the signal to be measured. Measurement Frequency can be selected as the target
frequency (see Target Reference).

NOTE. If Lock Center Frequency of Spectrum Display to Measurement Frequency is unchecked, then
Measurement Frequency is independent of Center Frequency) Range: Entire input frequency of the
instrument
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202

Meas BW

Target Reference

The target reference is a calculated or user-specified value of final settled frequency within the
measurement period. When set to Auto, the instrument determines this value by averaging at least the last
256 samples at the end of the measurement period. When set to Meas freq, the Target Reference is set to
the Measurement Frequency of the instrument. You can enter a manual offset from the target frequency to
fine-tune the Target Reference when Meas freq is selected.

Tolerance(+/-)

The Tolerance is the frequency or phase range within which the signal must remain to be considered

settled. This is set as a + value by the user. In the frequency settling time measurement, the tolerance
band is centered about the target value. In the phase settling time measurement, the tolerance band is
centered about the settled phase value.

The target frequency depends on the Target reference value setting:

B [f Target Reference is set to AUTO, then the target value is the settled value (the frequency at which
the signal is considered settled).

m  [f Target Reference is set to MeasFreq, then the Target value = Meas Frequency + Offset.

Offset

Offset is used for fine-tuning the Target Reference when Meas freq is selected. The value for Offset is
entered manually.
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Time Params Tab for Settling Time Displays

The Time Params tab is used to set the Measurement length and minimum settled duration parameters.

Defing | Time Params | Mask | Trace | Scals | Prefs |

Measurement length: 1,000 ms (from Analysis Offset to End of Measurement Marker)
actual: 938.4 us

Min settled duration: 0.0000 s (fromn Settled Point to End of Measurernent Marker)

Measurement Length

Measurement length locates the end of the measurement period for settling time. This value is set
independently of the analysis period for other measurements in the analyzer. This allows other
measurements to display multiple frequency hops during an analysis, while focusing the settling time
analysis on a single hop. You can set the measurement length either by entering a value in the entry box, or
by dragging the magenta bar to the desired location in the graph. Traces and the display to the right of
the measurement time are shown in grey to indicate that this section of the waveform is not being used
in the measurement. If your signal does not settle to within your tolerance band, make sure that the
measurement time ends during the settled portion of the waveform. The beginning of the settling time
measurement is set with the analysis offset control, the same as other measurements in the instrument.
Use analysis offset to exclude earlier hops from the measurement. See Analysis Time (see page 349)
for setting the analysis offset control.

If there is more than one phase or frequency hop in the signal to be analyzed, use the Measurement Length
control to instruct the analyzer which hop to measure. First, adjust the main Analysis Offset control to a
point in time slightly earlier than the transition you wish to measure. Do this in the Time Overview display
or the Analysis Settings control panel. Then adjust the Measurement Length so the end of the Settling Time
measurement falls within the apparent settled period after the signal transition. The reason it is important
for the user to set this control is that the Settling Time measurements start at this point and look backwards
in time (towards the signal transition) to find the latest trace point that is not inside the tolerance band.

NOTE. If your signal does not settle to within your tolerance bands, make sure that the measurement time
ends during the settled portion of the waveform.

Min Settled Duration

The minimum settled duration is the amount of time the signal must remain within the tolerance band to be
considered settled. Some user specifications require that the signal be settled for a minimum period. If this
is not required in your application, set this value to the default of 0 seconds.

SPECMON3 & SPECMONG Printable Help 203



RF Measurements Mask Tab for Settling Time Displays

Mask Tab for Settling Time Displays

The Mask tab is used to specify the parameters used for Mask testing.

| Define | Time Params| Mask |Trace | Scale | Prefs |

Mask time reference Tirme Lirnit (+£-1
Start 1: 0.0000 s 500.0 kHz
[T Enable mazk test @ Trigger
Start 2 100.0 us 500.0 kHz
() Signal transition Start 3: 1.000 ms 500.0 kHz
Stop: 13.18ms

Enable Mask Test

Enables or disables mask testing.

Start1, 2, 3

Sets the starting point for the time zone of interest. If you don't want to use all three zones, set the Start
Time for the unneeded zones to a time after the end of the Measurement Length.

Stop

Sets the end point for the final time zone of interest.

Limit (+-)

Sets the mask violation limits for each time zone.

Mask Time Reference

When mask testing is enabled, the Mask time reference selection specifies the starting point of the mask.
You can choose to start the mask test at the trigger point or at the point on the trace where the signal began
its transition from its previous settled frequency or phase level to the level you intend to measure.

This capability is useful because some applications do not have a trigger signal available. For those
situations where a trigger signal is available, the specification for the device-under-test may require
that measurements be referenced to that signal.

Trace Tab for Settling Time Displays

The Traces Tab allows you to set the display characteristics of displayed traces.
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| Define ITime Params | Mask | Trace |Scale IF‘refs |

] S(rggﬁf;; 2 Trace: |Trace 1 - Show [ClFreeze
Average: —
a (count) 2 LJ
Save Trace Az..,
Smooth

Smooth is a low-pass filter function that uses n points in the trace to determine the smoothed value. For
example, in the case of n=3, 3 consecutive points are averaged to determine the result of the smoothed
output. This is very useful for single-shot signals that contain significant noise where multiple trace
averages cannot be used. However, smoothing does have limits, and the user should visually determine
whether smoothing is removing noise from the measurement, or if it is affecting the signal. The following
illustration shows the effect smoothing has on the displayed trace.

Smooth — off Smooth — 3

0070-0:

The range for the Smooth function is 2—1000. The setting resolution is 1. The knob increments this value
by 1, and the arrow keys increment it in steps of 1, 2, 5, 10. When smoothing is enabled, it applies
to both traces. Smooth is turned off by default.

Average

This sets the number of acquisitions to be averaged together to produce the result. Averaging reduces
random variations but maintains the correct waveshape for repeating signal aberrations. To use averaging,
the signal must be repetitive. For example, the tuning direction must always be same for each measurement
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to be averaged. Signals that vary in tuning direction will tend to average positive-going effects with
negative-going effects and the settling time characteristics will cancel out.

The range for the Average function is 2—-1000. The resolution is 1. When averaging is enabled, it applies
to both traces. Average is turned off by default.

Trace

Selects a trace for display. Choices are Trace 1 and 2. Either trace can be a recalled trace.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

Save As @

e
L | . » Computer » Default (C) » RSASI00AFiles » v|¢,‘| Search REASIONA Fites 2

Organize + New folder = - (%]

' Favorites Marne Date rmodified Type Size

B Desktop Example Files 62172011 356 PM File folder
& Downloads Sample Data Records 62172011 356 PM File folder
Sl RecertPlaces  |= User Presets 6/2172011 356 P File folder

o Libraries
3 Documnents
.JT Music
=] Pictures

B videos

File name: | -

Save as type: ISa\acted trace vJ

=) Hide Folders swe | [ cancel |

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.
To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.
2. Check the Show check box.
3. Click the ... button to display the Open dialog box.
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(-]

4. Navigate to the desired file and click Open.
5. Check the Show Recalled Trace check box.

6. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).

Scale Tab for Settling Time Displays

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

| Define ITime Params | Mask | Trace | Scale |Prefs |

Wertical Horizorital
Srale:  7.0000 MHz Srale:  LO20mw
Pasition;  -200,00 kHz Position:  &1.802 us
Relative Freq | Autoscale | auto | Autoscdle |
Setting Description
Vertical
Scale Changes the vertical scale or span of the graph.
Position Sets the frequency (or phase) at the vertical center of the graph.
Relative Freq Sets the vertical (position) display readouts to show frequency values relative to the
center frequency or as absolute values.
Autoscale Resets the Scale and Position to center the trace in the graph.
Horizontal
Scale Sets the range of time shown in the graph.
Position Allows you to pan the graph left and right.
Autoscale Resets Scale and Position to the automatically determined settings.
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Prefs Tab for Settling Time Displays

The Prefs tab allows you to change display parameters of the Settling Time displays.

| Define | Time Params I Mask | Trace | Scale | Prefs |

Max trace points: | 100K A

[V Shiovwy graticule [V]Shiowy Marker readout in graph (selected marker)

Settling Time decimal places: 2

The following table explains the controls that can appear on the Prefs tab.

Setting Description
Max trace points Sets the number of trace points used for marker measurements and for results export.
Show graticule Select to display or hide the graticule.

Show Marker readout in graph Shows or hides the readout for the selected marker in the graph area.
(selected marker)

Settling Time decimal places Specifies the precision of the settling time measurement readout that appears below the
graph. This setting does not affect the precision of internal calculations.

SEM Display

The SEM (Spectrum Emission Mask) display measures out-of-band emissions immediately outside the
channel bandwidth that result from the modulation process and non-linearity in the transmitter. The
Spectrum Emission Mask display allows you to define up to six pair of masks, or offsets, that specify the
limits for out-of-band emissions and performs a pass/fail tests of the signal against the defined offsets
and limits.

To show the Spectrum Emission Mask display:
1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select RF Measurements in the Folders box.

3. Inthe Available displays box, double-click the SEM icon or select the icon and click Add. The SEM
icon will appear in the Selected displays box and will no longer appear under Available displays.

4. Click OK to show the Spectrum Emission Mask display.
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Elements of the Display

Item Display element Description

1 Check Mark Indicator Indicates the display for which the acquisition hardware is optimized.

2 Top of graph setting Sets the level that appears at the top of the graph.

3 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.

4 Bottom-of-graph readout Indicates the amplitude at the bottom of the graph. This value changes with
the dB/div and Vertical Position settings.

5 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on screen

6 CF / Pos Default function is CF - center frequency (equivalent to the Measurement
Freq setting). If Horizontal scaling has been manually adjusted in Setup >
Settings > Scale, then Pos replaces CF as the setting at the bottom-left
corner of the screen. Adjusting Pos shifts the trace left or right in the graph,
but does not change the measurement frequency.

7 Span / Scale Default function is Span - frequency difference between the left edge of
the display and the right edge. If Horizontal scaling has been manually
adjusted in Settings > Scale, then Scale will replace Span as the setting at
the bottom-right corner of the screen.

Clear Erases the current results from the display.
Function readout Readout of the Function selection for the Reference channel (Setup >
Processing > Function).

10 Detection readout Readout of the Detection selection for the Reference channel (Setup >
Processing > Detection).

1 Pass / Fail readout Readout indicating whether any part of the trace has exceeded the any of

the limits defined in the Offsets & Limits table (Setup > Settings > Offsets
& Limits Table).

Pass / Fail Readout

This readout displays either Pass or Fail XX%. When the signal exceeds the mask in any offset, it is
considered a mask violation, and results in Fail XX% being displayed. If there are no mask violations,
Pass is displayed.
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How the fail percentage is determined. Each offset has two sides, one lower and one upper. For example,
Offset A has two sides: AL (lower side) and AU (upper side). In the SEM display, there is a maximum of
six offsets (A-F) and each offset can have a maximum of two sides (if Both is selected for Side in the Offsets
& Limits table). This results in a total of six offsets multiplied by two sides per offset, which results in 12
offsets. Mask violations can occur in any of these offsets. The failure percentage is calculated as follows:

Fail percentage = Number of offsets with mask violations x 100 / Total number of enabled offsets

For example: Assume there are three enabled offsets: A, B, C, and all these offsets have both lower and
upper sides. Thus, the total number of enabled offsets is equal to six. Suppose there are mask violations
in the offsets AL and CU, then the number of offsets having mask violations is equal to 2. Therefore,
Fail percentage =2 * 100 / 6 = 33%.

Results Display
The Results Display shows the measurement results for the SEM display.

Ref: Total Power Row  Ofset  Swnfiea Stopfrea Pk s Y —— MRl gree e

1 EL 12,500 MHz -8.000 MHz 7383 6233 5181 - 8010000 MHz | 6844
DL -8.000 MHz 4.000 MHz 737 5167 8116 - 7460000 MHz | 6761

-16.93 dBm

3 cL 4000 MHz 3515 MHz 8763 5313 -105.62 - 3965444 MHz | 7T

BL 3515 MHz 2715 MHz 5777 7517 108,76 - 2722000MHz | 7514
5 AL 2715 MHz 2515 MHz 7018 57.68 83,16 - 2515000 MHz | 7074
6 av 2515 MHz 2715 MHz 7073 58.23 87.67 - 2515000MHz | 7054
7 BU 2715 Mtz 3.515 Mz 5766 67.24 -104.58 - 3243000MHz | 7472
8

cu 3515 MHz 4,000 MHz -88.01 63,51 -108 - 3976356MHz | 77.04
1 3

Readout Description

Ref: A two-part readout to the left of the table that displays information about the
Reference Channel. The first part of the readout displays the Measurement Type
selected on the Parameters tab. The second part of the readout displays the
measurement result for the Reference channel.

Row A sequence number for ordering the offsets. Click to organize by row number,
resort rows from high to low or low to high.

Offset The Offset name. A combination of the offset (A-F) and the location (U for upper
and L for Lower).

Start Freq The start frequency of the offset (relative to the Measurement Freq).

Stop Freq The stop frequency of the offset (relative to the Measurement Freq).

Peak Abs Absolute power peak power at worst case margin of the offset

Margin Abs The worst case difference between the trace and the absolute limit line. Note that

an offset can have different start and stop levels, thus, the margin can vary if the
offset start and stop levels are different.

Peak Rel Relative peak power of worst case margin of the offset. Relative with respect
to the reference power level.
Margin Rel The worst-case difference between the trace and the relative limit line. Because

an offset can have different start and stop levels, the margin can vary if the offset
start and stop levels are different.

@Freq The frequency at which the worst margin occurs.
Integ Abs The absolute integrated power of the offset.
Integ Rel The relative integrated power of the offset (with respect to the reference power).
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Reordering results in the results table. You can sort the results in the Results table by clicking the column
heading containing the values you want to sort on. You can sort results for the following columns: Row,
Offset, Start Frequency, Stop Frequency, Peak Abs, and Peak Rel.

Rearranging columns in the results table. You can rearrange the order of the columns and their size. To
rearrange columns, select the column heading you want to move and drag it to the new position; the new
location is indicated by a dark blue bar that appears between column headings.

You can resize the columns by selecting the divider between columns and dragging it to a new position.

Spectrum Emission Mask Settings

Front Panel: Settings

Application Toolbar: i

The settings for the Spectrum Emission Mask display are visible when SEM is the selected display. To
display the SEM Settings, select Setup > Settings.

Settings tab Description
Parameters Tab (see Specifies several characteristics that control how the measurement is made.
page 212)

Processing Tab (see page 213) Specifies settings for detection on the Reference channel and the offsets. Specifies
the function setting.

Ref Channel Tab (see Specifies how the measurements on the reference channel are performed.

page 214)

Offsets & Limits Table (see Specifies characteristics of offsets and mask limits.

page 214)

Scale Tab (see page 217) Specifies the vertical and horizontal scale settings.

Prefs Tab (see page 218) Specifies the appearance features of the graph area and the maximum trace points.
Standard settings Displays Select Standard dialog window to enable you to load settings for three

standards: 3GPP Downlink, WLAN 820.11g, and WiMax 802.16 (ETSI).

Standard Settings

Selecting one of the standard settings loads factory-defined settings appropriate to the selected standard. In
each case, one specific SEM definition is used. There may be many SEM definitions in any given standard.
Check the SEM definition for your test against the standards-based reference documents. The following
table describes the standards on which the standard settings are based.

Setting Description

3GPP Downlink 3GPP 25.141 (Release 9), BS Maximum output power P = 43 dBm
WLAN 802.11g IEEE Std 802.11 - 2007, 20 MHz Channel spacing

WiMax 802.16 (ETSI) ETSI EN 301-021, 10 MHz Channel spacing, System Type G
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Parameters Tab - SEM

The Parameters tab specifies several characteristics that control how the Spectrum Emission Mask
measurements are made.

Parameters | Processing | Ref Channel | Offsets & Limits Table | Scale | Prefs

Meas Freq:  1.500000 GHz Measurement Type: | Total Power -
Step: 1000000 AdHr J| Auto Offset definition:  |Ref Edge to OS center =
Filter shape: | Gaussian -
Setting Description
Meas Freq Specify the frequency of the signal to be measured.
Step Sets the increment size when changing the Frequency using the knob or mouse wheel.
Auto When Auto is enabled, the step size is adjusted automatically based on the span setting.
Measurement Type Specifies the type of measurement for the reference channel; used as a reference for
the offsets.
Total Power Sets the reference to the integrated power of the reference channel within the reference's
integration bandwidth.
PSD Sets the reference to the mean of the power spectral density (dBm/Hz) of the reference
channel. The trace and the absolute and relative limits line are also in dBm/Hz
Peak Sets the reference to the Peak power of the reference channel.
Offset definition Defines the relative position of the start/stop frequency of an offset. Choose the offset
definition based on the standard.
Ref center to OS center Specifies that the start/stop frequencies are defined from the center frequency of the
reference channel to the center of the filter BW.
Ref center to OS edge Specifies that the start/stop frequencies are defined from the center frequency of the
reference channel to the center of the (inner) edge of the filter BW of the offset.
Ref Edge to OS center Specifies that the start/stop frequencies are defined from the edge of the reference
channel to the center of the filter BW of the offset.
Ref Edge to OS edge Specifies that the start/stop frequencies are defined from the edge of the reference
channel to the (inner) edge of the filter BW of the offset.
Filter Shape Specifies the shape of the filter determined by the window that is applied to the data

record, in the spectrum analysis, to reduce spectral leakage. 3GPP specifies a Gaussian
window shape be applied to the reference channel measurements.

Gaussian This filter shape provides optimal localization in the frequency domain.

Rectangular This filter shape provides the best frequency, worst magnitude resolution. This is
essentially the same as no window.
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Processing Tab — SEM

The Processing tab controls the Detection settings for the Reference Channel and Offsets, as well as
selecting the Function.

Parameters | Processing | Ref Channel | Offsets & Limits Table | Scale | Prefs

Detection (in each record) Function (across multiple records)
Ref Channel: | Avg (WRMS) - |Nclrrnal '|

Offsets: | Awvg (VRMS) -

Processing settings affect all SEM numetric and trace results,

Settings tab Description

Detection (in each sweep)

Ref Channel Specifies the Detection method used for the Reference Channel. Detection is used to
produce the desired measurement result (peak or average) and to reduce the results
of a measurement to the desired number of trace points.

Avg (VRMS) For each sweep, each point of the trace is the result of determining the RMS voltage
value for the last 'n counts' of the collected traces for the same point. When 'n count' has
not been reached, partial averaging results are displayed.

+Peak Selects the +Peak detection method. With this method, the highest value is selected from
the results to be compressed into a trace point.
Offsets Specifies the detection method used for the offsets.
Avg (VRMS) Selects the Average Vrms detection method. With this method, each point on the trace

in each offset is the result of determining the RMS Voltage value for all of the results
values it includes.

+Peak Selects the +Peak detection method. With this method, the highest value in each offset is
selected from the results to be compressed into a trace point.

Function (across multiple sweeps)

Function Selects the trace processing method. Available settings are: Normal, Avg (VRMS),
and Hold.
Normal When a new trace has been computed, it replaces the previous trace.
Max Hold With each sweep, each trace point in the new trace is compared to the point’s value in

the old trace and the greater value is retained for display and subsequent comparisons.

Avg (VRMS) For each sweep, each point on the trace is the result of determining the RMS Voltage
value for all of the collected traces' values for the same point.
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Ref Channel Tab

Ref Channel Tab

The Ref Channel tab controls how the measurement of the Reference channel is performed.

| Parameters | Processing | Ref Channel | offsets & Limits Table | Scale [ prefs |

Paorerer
Reference:  -10.02 cgm

REMWY: 100,000 kHz

wBWy: 30,000 kHz

ALto Channel width: Channel Filter:
8.500 MHz [RDDt-raised Cosine A
Inteqgration BW: Filter param:  0.220
2,125 MHz

Chip rate:  2.84 MHz

Settings tab Description
Power Reference The value used to calculate relative measurements.
Auto When Auto is unchecked, you can enter a value for the reference power, and the
measured reference power is not used or displayed
RBW Sets the RBW for the Reference Channel.
VBW Enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers

to reduce the effect of noise on the displayed signal. The VBW algorithm in the analyzer
emulates the VBW filters of traditional swept analyzers. When the checkbox next to
VBW is not checked, the VBW filter is not applied. SEM standards specify what value of
VBW should be applied, if any.

Channel width

Specifies the width of the reference channel.

Integration BW

Specifies the integration bandwidth used to compute the total power in the reference
channel.

Channel Filter

Specifies the measurement filter used in the Reference Channel. Choices are None
and Root-raised Cosine.

Filter param Specifies the alpha value (or roll-off factor) of the Root-raised cosine filter. Present only
when Channel Filter is set to Root-raised Cosine.
Chip rate Specifies the chip rate used for the Root-raised Cosine filter. Present only when Channel

Filter is set to Root-raised Cosine.

Offsets & Limits Table Tab — SEM

The Offsets & Limits Table tab is used to specify parameters that define Offsets and masks.

214
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Offsets & Limits Table Tab — SEM

a5 Offsets & Limits Table

on Start {Hz)

B 5.000000m
+

11.0000001
20.000000M
| 30.000000M
50,000000M
100,000000M

TMm oA ®E
=

Stop (Hz)

11.000000r
20.0000000
30.0000000
50.0000000
100,000000M
150,000000M

Side

Both
Both
Bath
Bath
Both
Both

REW (Hz)

100,000k
100,000k
100,000k
100,000k
100,000k
100,000k

n
(REWs)

Filter Bl
in x RBW)

100,000k,
100,000k,
100,000k,
100,000k,
100,000k,
100,000k,

B (He)

30,000k
30,000k
30,000k
30,000k
30,000k
30,000k

VBN

N

1111

Rel
Rel
Rel
Rel
Rel
Rel

Mask

[E= [Eel )
Reset layout
Load...
Save &s...

Done

Expanded display of Offsets & Limits Table
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Offsets & Limits Table Tab — SEM

Setting Description
Buttons
Expand Displays the Offsets & Limits Table in a new, resizeable window.

Reset Layout

You can reorder columns in the Offsets & Limits Table by dragging the columns to a new
position. Clicking Reset Layout returns the column order to the factory default order.

Load Click to load a saved Offsets & Limits table from a file.
Save As Click to save the current Offsets & Limits table to a file.
Done When the table is expanded, click Done when you have finished editing the table to save

your changes and close the expanded table display.

Table columns

On

Specifies whether or not measurements are taken in the specified offset.

Start (Hz) Start Frequency of the selected offset.

Stop (Hz) Stop Frequency of the selected offset.

Side Specifies whether the specified range appears on both side of the carrier frequency or
just one side (left or right).

RBW (Hz) Specifies the RBW for the selected range.

n (RBWS) An integer value that specifies how many times to multiply the RBW to set the Filter

bandwidth.

Filter BW (n x RBW)

Displays the Filter BW. Filter BW is the equivalent BW of each point in the offset. When
n > 1, an integration technique is used to achieve the Filter BW using narrower RBWs.
For most SEM measurements, this value is set to 1. The 3GPP standard suggests n
greater than 1.

VBW (Hz) Adjusts the VBW (Video Bandwidth) value. VBW Maximum: RBW current value; VBW
Minimum: 1/10,000 RBW setting.

VBW On Specifies whether the VBW filter is applied.

Mask Select the type of limits used for Pass/Fail testing. Signal excursions that exceed the
mask settings are considered violations. The available choices are shown below.

Abs Start (dBm) Specifies the mask level at the inner edge of the selected offset.

Abs Stop (dBm) Specifies the mask level at the outer edge of the selected offset.

Abs Same Specifies whether the value for the inner and outer edges of the offset must be the same

value. When enabled, the Abs Stop cell is grayed-out and set to the value of the Abs
Start cell.

Rel Start (dBm)

Specifies the mask level for the Relative mask at the inner edge of the selected offset.

Rel Stop (dBm)

Specifies the mask level for the Relative mask at the outer edge of the selected offset.

Rel Same

Specifies whether the inner and outer edges of the offset must be the same value.
When enabled, the Rel Stop cell is grayed-out and its value is set to the value of the
Rel Start cell.
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Scale Tab - SEM

Use the Scale tab to change the vertical and horizontal scale settings. Changing the scale settings changes
how the trace appears on the display. In effect, these controls operate like pan and zoom controls.

| Parameters | Processing | Ref Channel | Offsets & Limits Table| Scale |F‘refs |

wertical Horizontal
Scaler  100.00 dB Scaler  100.0 MHz
Position: 0,00 dBm M Position:  1.5000 GHz
 Autoscale | | Autoscale |
Setting Description
Vertical Controls the vertical position and scale of the trace display.
Scale Changes the vertical scale units.
Position Adjusts the reference level away from top of the graph.
Autoscale Resets the scale of the vertical axis to contain the complete trace.
Horizontal Controls the span of the trace display and position of the trace.
Scale Specifies the frequency range displayed in the graph
Position Specifies the frequency shown at the center of the graph.
Autoscale Resets the scale of the horizontal axis to optimize the display of the trace.
Reset Scale Resets all settings to their default values.
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Prefs Tab — SEM

Prefs Tab — SEM

The Prefs tab enables you to change parameters of the measurement display. The parameters available on
the Prefs tab vary depending on the selected display, but include such items as enabling/disabling Marker
Readout, switching the Graticule display on/off, and Marker Noise mode. Some parameters appear with
most displays while others appear with only one display.

| Pararneters | Processing I Ref Channel | Offsets & Limits Tahlel Scale | Prefs |

Shiowe graticule

Max Trace points: 801 | (per range)

[¥] Shiowe Marker readout in graph (selected marker)

Show limits: | Line anly -

Setting

Description

Show graticule

Controls the vertical position and scale of the trace display.

Max Trace points (per range)

When the spectrum analysis produces more than the selected maximum number of
points, the method specified in Detection control is used to decimate the result. This
setting applies to both the Reference channel and offsets.

Show Marker readout in graph

Adjusts the reference level away from top of the graph.

Show limits Controls the appearance of mask limits in the graph.
Shaded Shows limits using a shaded area. Green shading is used to identify Absolute limits. Blue
shading is used to indicate Relative limits.
Line only Shows limits using only a line. A green line is used to identify Absolute limits. A blue line
is used to indicate Relative limits.
None No lines or shading are used to indicate limits in the graph. Violations of the mask are still

identified by red shading.

RF Measurements Shared Measurement Settings

The control panel tabs in this section are shared by multiple displays in the RF Measurement folder (Setup
> Displays). With few exceptions, each display maintains separate values for each of the controls on these
tabs. For example, Scale values are independent for each of the displays.

218
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Common controls for RF measurement displays

Settings tab Description

Freq & RBW (see page 219) Allows you to specify the Center Frequency, Step size and RBW.

Traces (see page 220) Specifies trace parameters such as detection method and whether smoothing in enabled.
Traces can also be saved and loaded for reference from this tab.

Scale (see page 224) Specify vertical and horizontal scale settings.

Prefs (see page 225) Specify appearance features of the graph area.

Freq & RBW Tab

The Freq & RBW tab specifies frequency parameters for some of the RF Measurements displays.

Frea & REW | Measuremnent Params | Channsls | Scale | Prefs |
Meas Freq: 1.00000 GHz REW: 30.000 A Auto
Step: 20000 Mz Auto [T] wewy:
Setting Description
Meas Freq Specifies the measurement frequency.
Step The Step control sets the increment/decrement size for the knob adjustment of the

center frequency. Arrow key adjustment of frequency is also affected (it is 10x the knob
adjustment). If Auto is enabled, the analyzer will adjust the Step size as required.

RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting is
Independent of the Spectrum view's RBW setting.
VBW Adjusts the VBW (Video Bandwidth) value.

NOTE. While the measurement frequency and step settings on this control tab are shared between ACPR,
MCPR and Occupied Bandwidth, the RBW setting is not shared. The RBW setting is unique for each
measurement.

VBW

The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers
to reduce the effect of noise on the displayed signal. The VBW algorithm in the analyzer emulates the
VBW filters of traditional swept analyzers.

The maximum VBW value is the current RBW setting. The minimum VBW value is 1/10,000 of the
RBW setting.
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Traces Tab

220

The Traces tab enables you to select traces for display. You can choose to display live traces and/or
recalled traces. The Trace tab (see page 204) for Settling Time displays is described in the Settling Time
controls section.

NOTE. Not all RF Measurements support multiple traces and/or save and recall of traces.

Parameters | Traces |prefs

Trace: |Trace 1 hd V| Shiowy Freeze Sawve Trace As...

Setting Description

Trace Selects a trace for display. Choices are Trace 1, 2, and Gaussian (CCDF display only).
Trace 1 and 2 can be recalled traces.

Show Shows / hides the selected trace.

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Show recalled trace Used to select a saved trace for display.

Detection (Phase Noise only) Sets the Detector used for the trace. Only +/- Peak and Avg (VRMS) are available for the
Phase Noise display. This setting is not available for saved traces. +/-Peak detection
results in a trace with two Y values for each X location, with shading between.

Function Selects the trace processing method (Spurious display only). Possible settings are:
Normal, Average (VRMS), Avg (of logs), and Max Hold.

Smoothing (Phase Noise only) When enabled, diminishes point-to-point trace variations. Smoothing +/- Peak traces
treats + and - lines independently. The smoothing value adjusts how many points are in
each filter set. Range: 1 - 20; Default: 5.

Detection

Trace Detection occurs when the trace is being decimated by the measurement. For example, if the
maximum number of trace points is 100,000, and the selected analysis region is 200,000 samples, the
measurement must decimate the 200,000 resulting trace points by 2 to prevent exceeding the 100,000 trace
point limit. Since only one value can be selected for each trace point, an algorithm must be used to select
(detect) the appropriate value to use.

The IQ samples in a data acquisition can be detected in a variety of ways. The number of IQ samples
available to each trace point varies with both analysis length and trace length. For example, with Spectrum
Length set to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one
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1Q sample pair per trace point. In this case, the detection method chosen has very little effect, as the
+Peak, -Peak, Avg (VRMS) and Sample values are all equal. Changing the Spectrum Length causes the
available detection methods to differ in value because they have a larger set of samples for the various
detection methods to process.

The available detection methods (depending on the display) are:

+/-Peak — Selects the highest and lowest values of all the samples contained in an acquisition interval.

Avg (VRMS) [Average Vrus] — Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average

for RMS values.

Trace Processing

The trace can be processed to display in different ways. The Function setting controls trace processing.

Max Hold - Displays the maximum value in the trace record for each display point. Each new trace
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.

Normal - Displays the trace record for each display point without additional processing.

Avg (VRMS) [Average Vrus] — Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average

for RMS values.

Avg (of logs) — This is a trace function used to emulate legacy spectrum analyzer results and for the
specification of displayed average noise level. In older swept analyzers, a voltage envelope detector is
used in the process of measuring signal level, and the result is then converted to Watts and then to
dBm. Averaging is then applied to the resultant traces.

For CW signals, this method results in an accurate power measurement. However, with random noise
and digitally modulated carriers, errors result from this 'average of logs' method. For random noise,
the average of logs methods results in power levels -2.51 dB lower than that measured with a power
meter, or with a spectrum analyzer that measures the rms value of a signal, and performs averaging on
the calculated power in Watts and not dBm or other log-power units.

This detector should be used when following a measurement procedure that specifies it, or when
checking the Displayed Averaged Noise Level (DANL) of the instrument. The 'average of logs'
detection and trace function is used for DANL specification to provide similar results to other
spectrum/signal analyzers for comparison purposes. Use of the Average of Logs method of
measurement is not recommended for digitally modulated carriers, as power measurement errors
will occur.

NOTE. The Detection setting does not affect the trace until the spectrum length is longer than the Auto
setting.
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Saving Traces

To save a trace for later analysis:

1. Select the Save Trace As button.

Traces Tab

This displays the Save As dialog box.

Save As

5

e
uv | . » Computer » Default (C) » RSASI00AFiles »

Organize * Mew folder

. . * Mame
1 Favarites

Bl Desktop Example Files
& Downloads Sample Data Records

Sl RecertPlaces  |= User Presets

o Libraries
3 Documnents
.JT Music
=] Pictures

B videos

Date rmodified

6/2172011 356 P
6/2172011 356 P
6/2172011 356 P

Type

File folder
File folder
File folder

~ | 49 || Search RsA51004 Fites 2|

=~ @

Size

File name: |

Save as type: ISa\acted trace

= Hide Folders

Save

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces

You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.

2. Check the Show check box.

3. Click the ... button to display the Open dialog box.

m
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1. Navigate to the desired file and click Open.
2. Check the Show Recalled Trace check box.

3. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).

Gaussian Trace

The Gaussian trace is a reference trace that you can compare your trace against. Because the Gaussian
trace is for reference, there are no settings for the trace other than whether or not it is shown.

| Paramaters | Traces |prafs |

Trace:  |Gaussian T [ showe
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Scale Tab

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Center Frequency.

| Freq & REIWI Measurement Params | Channels | Scale |Prefs |

Wertical

Srale: 100,00 dB

Pasition: 0,00 dBm

Horizontal

Sraler 39,00 MHz

Reset Scale Pasition:  1.50000 GHz

| Autoscale | | Autoscae |
Setting Description
Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units. This is only accessible when the vertical units are
set to dBm.

Offset Adjusts the Reference Level away from the top of the trace display.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.

Scale Allows you to, in effect, change the span.

Offset Allows you to pan a zoomed trace without changing the Measurement Frequency. Offset
is only enabled when the span, as specified by Freq / div, is less than the acquisition
bandwidth.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Log (Spurious only) Resets the display to show the frequency axis in a logarithmic scale.
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Prefs Tab

Prefs Tab

The Prefs tab enables you to change parameters of the measurement display. The parameters available on
the Prefs tab vary depending on the selected display, but include such items as enabling/disabling Marker
Readout, switching the Graticule display on/off, and Marker Noise mode. Some parameters appear with

most displays while others appear with only one display.

Freq & Span | B

Show: | Start, Stop hd

V| Showe graticule

| Showe trace legend

Setting

Traces | Scale | Prefs

Trace points: (201 A

| Showe Marker readout in graph (selected marker)

Marker Moise mode (Requires dBrm Arnpl units and
Awerage trace detect)

Description

Show graticule

Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Show power levels in graph

Shows or hides the Channel Power readout in the graph.

Max trace points

In general, time-domain traces can include up to 100K points and frequency-domain
traces can include up to 10K points. When the analysis produces a results array longer
than the selected trace length, the trace is decimated (using the method specified with
the Detection control) to be equal to or less than the Max trace points setting (except
when Max trace points is set to Never Decimate). This decimated (or undecimated) trace
is what is used for marker measurements and for results export.

Settling Time decimal places
(Frequency and Phase Settling
Time displays only)

Specifies the number of decimal places shown in the results readout below the graph.
This setting does not affect the precision of internal calculations.

Show trace legend (Phase
Noise display only)

Displays or hides the trace legend.
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OFDM Analysis Overview

Overview

The OFDM Analysis option provides measurements for OFDM signals specified by 802.11a/g/j (Wifi)
and 802.16 (ETSI) (commonly known as Fixed WiMAX) standards. User controls allow you to modify
signal parameters for analysis of non-standard signals. The analysis results give multiple views of OFDM
signal characteristics to allow diagnosing signal imperfections and impairments quickly and easily.
Display controls provide the ability to selectively display the analysis results to help locate trouble-spots in
the signal.

The displays in the OFDM Measurements folder (Displays > Folders > OFDM Measurements) are:

OFDM Channel Response
OFDM Constellation
OFDM EVM

OFDM Mag Error
OFDM Phase Error
OFDM Power

OFDM Summary

OFDM Symbol Table

OFDM Channel Response Display

The OFDM Channel Response display plots the channel response (magnitude or phase) versus the
subcarrier or frequency.

To show the OFDM Channel Response display:

1.
2.

A A

Press the Displays button or select Setup > Displays.
In the Select Displays dialog, select OFDM Analysis in the Folders box.

In the Available displays box, double-click the OFDM Chan Response icon or select the icon and
click Add. The OFDM Chan Response icon will appear in the Selected displays box and will no
longer appear under Available displays.

Click OK to show the OFDM Chan Response display.
Set the Frequency appropriate for the signal.
Select Setup > Settings to display the control panel.

Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.
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Elements of the Display

OFDM Channel Response Settings

Item Display element Description

1 Top-of-graph (magnitude) Sets the level that appears at the top of the magnitude graph. This is only a
visual control for panning the graph. The Reference Level is adjusted in the
Toolbar and the Ampl control panel. By default, Vert Position = Ref Level.

2 dB/div (magnitude) Sets the vertical scale value. The maximum value is 20.00 dB/division.

3 Display selector Selects the display type. Channel Response Magnitude or Phase can be
displayed as a Magnitude or Phase graph.

4 Bottom-of-graph readout Indicates the amplitude at the bottom of the graph. This value changes with

(magnitude) the dB/div and Vertical Position settings.

5 Autoscale Adjusts the Vertical and Horizontal scaling to display the optimize the trace
display on screen.

6 Pos Shifts the trace left or right in the graph. The readout indicates the subcarrier
or frequency shown at the left edge of the display.

Scale Specifies the number of subcarriers shown in the graph.

Top-of-graph (phase) Sets the phase value indicated at the top of the graph. Since the Position
value at the vertical center of this graph remains constant as the Top of Graph
value is adjusted, the Vertical Scale increases as the Top of Graph value
increases, which also affects the bottom of graph readout.

9 Position (phase) Specifies the phase shown at the center of the graph display. Changing this
value moves the trace up and down in the graph, which affects the Top of
Graph and Bottom of Graph values as well.

10 Bottom-of-graph (phase) Indicates the phase at the bottom of the graph. This value changes with the

Position setting.

OFDM Channel Response Settings

The OFDM Channel Response Settings control panel provides access to settings that control parameters of

the Channel Response Display.

Settings tab

Description

Modulation Params (see

page 244)

Specifies the input signal standard and additional user-settable signal parameters.

Advanced Params (see

page 245)

Specifies parameters used by the instrument to analyze the input signal.

Data Range Tab (see
page 246)

Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab (see

page 246)

Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the time units (Symbols or Seconds) for OFDM
Analysis displays.

Prefs Tab (see page 250)

Specifies the units of the display and whether elements of the graphs are displayed.
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OFDM Constellation Display

230

Display shows the OFDM signal subcarriers' amplitude and phase in 1Q constellation form.

To show the OFDM Constellation display:

1.
2.

A A

Markers | Define |~ ML Time

Press the Displays button or select Setup > Displays.
In the Select Displays dialog, select OFDM Constellation in the Folders box.

In the Available displays box, double-click the OFDM Constellation icon or select the icon and
click Add. The OFDM Constellation icon will appear in the Selected displays box and will no
longer appear under Available displays.

Click OK to show the OFDM Constellation display.
Set the Frequency appropriate for the signal.
Select Setup > Settings to display the control panel.

Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.

@

[T w Y

Symbok: 8
arie

To Center \ Peak \ |Z| \Z\ \ Table \ \Z\
0619002
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Elements of the Display

OFDM Constellation Settings

Item Display element Description
1 Plot Constellation graph.
2 Marker Readout If markers are enabled, the marker readout shows the selected Marker,

Symbol, Subcarrier, Type, Value, Magnitude, and Phase for the symbol at
the marker location. Located to the left of the constellation plot or below it,
depending on the size of the window.

OFDM Constellation Settings

Front Panel: Settings

Application Toolbar: &

The OFDM Constellation Settings control panel provides access to settings that control parameters of the

Constellation Display.

Settings tab

Description

Modulation Params (see

page 244)

Specifies the input signal standard and additional user-settable signal parameters.

Advanced Params (see

page 245)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 246)

Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab (see

Specifies parameters that define the portion of the acquisition record that is used for

page 246) analysis. Also allows you to specify the Units (Symbols or Seconds) for OFDM Analysis
displays.

Trace (see page 248) Enables you to freeze the display or hide the measurement or average trace.

Scale Tab (see page 248) Specifies the Zoom scale, and vertical and horizontal positions of the display.

Prefs Tab (see page 250) Specifies the units of the display and whether elements of the graphs are displayed.

OFDM EVM Display

The OFDM EVM display shows the data symbols' individual subcarrier Error Vector Magnitude values
versus symbol interval (time) and subcarrier (frequency).

To show the OFDM EVM display:

1. Press the Displays button or select Setup > Displays.

2. In the Select Displays dialog, select OFDM EVM in the Folders box.

3. In the Available displays box, double-click the OFDM EVM icon or select the icon and click Add.
The OFDM EVM icon will appear in the Selected displays box and will no longer appear under

Available displays.
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Click OK to show the OFDM EVM display.
Set the Frequency appropriate for the signal.

Select Setup > Settings to display the control panel.

NS e

Select the Modulation Params tab. Set the Standard as appropriate. Set the Standard, Guard Interval
and Spacing and Bandwidth controls as appropriate for the input signal.

@ 2 7.00 %
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0519008

Elements of the Display

Item Display element Description
1 Top of graph Sets the EVM value that appears at the top of the graph. This is only a visual
control for panning the graph.
2 Bottom of graph Sets the EVM value that appears at the bottom of the graph. This is only a
visual control for panning the graph.
Autoscale Adjusts the vertical and horizontal settings to provide the best display.
Pos Specifies the horizontal position of the trace on the graph display.
5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph

essentially becomes a window that you can move over the analysis results by
adjusting the position.

OFDM EVM Settings

Front Panel: Settings

Application Toolbar: %
The settings for the OFDM EVM display are shown in the following table.
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Settings tab Description

Modulation Params (see Specifies the type of modulation used for the input signal and other parameters.
page 244)

Advanced Params (see Specifies parameters used by the instrument to analyze the input signal.

page 245)

Data Range (see page 246) Specifies which symbols and subcarriers of the signal to display.

Analysis Time (see page 246) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for OFDM Analysis

displays.
Trace (see page 248) Enables you to freeze the display or hide the measurement or average trace.
Scale (see page 248) Specifies the vertical, subcarrier, and symbols scale and position settings.
Prefs (see page 250) Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Magnitude Error Display

The OFDM Mag Error display shows the data symbols' individual subcarrier Magnitude Error values
versus symbol interval (time) and subcarrier (frequency).

To show the OFDM Magnitude Error display:
1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select OFDM Analysis in the Folders box.

3. In the Available displays box, double-click the OFDM Mag Error icon or select the icon and click
Add. The OFDM Mag Error icon will appear in the Selected displays box and will no longer appear
under Available displays.

Click OK to show the OFDM Mag Error display.
Set the Frequency appropriate for the signal.

Select Setup > Settings to display the control panel.

A A

Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.
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Item Display element Description

1 Top of graph Sets the Magnitude Error value that appears at the top of the graph. This is
only a visual control for panning the graph.

2 Bottom of graph Sets the Magnitude Error value that appears at the bottom of the graph. This
is only a visual control for panning the graph.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Pos Specifies the horizontal position of the trace on the graph display.

5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph

essentially becomes a window that you can move over the analysis results by
adjusting the position.

OFDM Magnitude Error Settings

Front Panel: Settings

Application Toolbar: &

The settings for the OFDM Mag Error display are shown in the following table.
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OFDM Analysis OFDM Phase Error Display

Settings tab Description

Modulation Params (see Specifies the type of modulation used for the input signal and other parameters.

page 244)

Advanced Params (see Specifies parameters used by the instrument to analyze the input signal.

page 245)

Data Range (see page 246) Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab (see Specifies parameters that define the portion of the acquisition record that is used for

page 246) analysis. Also allows you to specify the Units (Symbols or Seconds) for OFDM Analysis
displays.

Trace (see page 248) Enables you to display or hide the measurement or average trace.

Scale Tab (see page 248) Specifies the vertical, subcarrier, and symbols scale and position settings.

Prefs Tab (see page 250) Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Phase Error Display

The OFDM Phase Error display shows the data symbols' individual subcarrier Phase Error values versus
symbol interval (time) and subcarrier (frequency).

To show the OFDM Phase Error display:
1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select OFDM Analysis in the Folders box.

3. In the Available displays box, double-click the OFDM Phase Error icon or select the icon and click
Add. The OFDM Phase Error icon will appear in the Selected displays box and will no longer
appear under Available displays.

Click OK to show the OFDM Phase Error display.
Set the Frequency appropriate for the signal.

Select Setup > Settings to display the control panel.

A A

Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.
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Item Display element
1 Top of graph Sets the Phase Error value that appears at the top of the graph. This is only a
visual control for panning the graph.
2 Bottom of graph Sets the Phase Error value that appears at the bottom of the graph. This is
only a visual control for panning the graph.
Autoscale Adjusts the vertical and horizontal settings to provide the best display.
Pos Specifies the horizontal position of the trace on the graph display.
5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph

essentially becomes a window that you can move over the analysis results by
adjusting the position.

OFDM Phase Error Settings

Front Panel: Settings

Application Toolbar: &

The settings for the OFDM Phase Error display are shown in the following table.
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Settings tab Description

Modulation Params (see Specifies the type of modulation used for the input signal and other parameters.

page 244)

Advanced Params (see Specifies parameters used by the instrument to analyze the input signal.

page 245)

Data Range (see page 246) Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab (see Specifies parameters that define the portion of the acquisition record that is used for

page 246) analysis. Also allows you to specify the Units (Symbols or Seconds) for OFDM Analysis
displays.

Trace (see page 248) Enables you to display or hide the measurement or average trace.

Scale Tab (see page 248) Specifies the vertical, subcarrier, and symbols scale and position settings.

Prefs Tab (see page 250) Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Power Display

The OFDM Power display shows the data symbols' individual subcarrier Power values versus symbol
interval (time) and subcarrier (frequency).

To show the OFDM Power display:
1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select OFDM Analysis in the Folders box.

3. In the Available displays box, double-click the OFDM Power icon or select the icon and click Add.
The OFDM Power icon will appear in the Selected displays box and will no longer appear under
Available displays.

Click OK to show the OFDM Power display.
Set the Frequency appropriate for the signal.

Select Setup > Settings to display the control panel.

XS s

Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.
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Item Display element Description
1 Vertical Position Sets the top of graph value. This is only a visual control for panning the
graph. The Reference Level is adjusted in the Toolbar and the Ampl control
panel. By default, Vert Position = Ref Level.
dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.

Bottom of graph readout

Indicates the amplitude at the bottom of the graph. This value changes with
the dB/div and Vertical Position settings.

Autoscale Adjusts the vertical and horizontal settings to provide the best display.
Pos Specifies the horizontal position of the trace on the graph display.
5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph

essentially becomes a window that you can move over the analysis results by
adjusting the position.

OFDM Power Settings

Front Panel: Settings

Application Toolbar: ot

The settings for the OFDM Power display are shown in the following table.
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Settings tab Description

Modulation Params (see Specifies the type of modulation used for the input signal and other parameters.
page 244)

Advanced Params (see Specifies parameters used by the instrument to analyze the input signal.

page 245)

Data Range (see page 246) Specifies which symbols and subcarriers of the signal to display.

Analysis Time (see page 246) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for OFDM Analysis

displays.
Trace (see page 248) Enables you to display or hide the measurement or average trace.
Scale (see page 248) Specifies the vertical, subcarrier, and symbols scale and position settings.
Prefs (see page 250) Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Summary Display

The OFDM Summary display shows several measurements of OFDM signal quality.
To show the OFDM Summary display:

1. Press the Displays button or select Setup > Displays.

2. In the Select Displays dialog, select OFDM Analysis in the Folders box.

3. In the Available displays box, double-click the OFDM Summary icon or select the icon and click
Add. The OFDM Summary icon will appear in the Selected displays box and will no longer appear
under Available displays.

Click OK to show the OFDM Summary display.
Set the Frequency appropriate for the signal.

Select Setup > Settings to display the control panel.

A

Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.
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OFDM Analysis OFDM Summary Settings

Elements of the Display

Measurement Description

Standard Display of the standard selected on the Setup > Settings > Modulation Params tab.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
measurement frequency setting.

1Q Origin Offset The average magnitude of the DC subcarrier level relative to total signal power. It
indicates the level of carrier feedthrough detected at the center (DC) subcarrier.

Average Power The average power of all symbols in the analysis. Calculated over only the data symbols
in the packet.

Symbols How many symbols were analyzed.

Symbol Clk Error The symbol clock error in parts per million.

CPE CPE, Common Pilot Error, is the RMS magnitude error of the pilots over all analyzed
symbols.

Peak-to-Average The ratio of the highest instantaneous signal power level to the average signal power.
Calculated over only the data symbols in the packet.

EVM The RMS and Peak values of the normalized subcarrier Error Vector Magnitude values.

The normalized subcarrier EVM values are calculated as the difference between the
detected received signal subcarrier constellation points and ideal reference points
estimated by the instrument from the received signal. Values are reported in units of
percent and dB. Peak values include the symbol and subcarrier location.

RMS and Peak values are displayed for groupings of all subcarriers, Pilots only and Data

only. Results are calculated over the entire signal packet analyzed, covering the number
of Symbols indicated in the Summary display.

OFDM Summary Settings

Front Panel: Settings

Application Toolbar: i

The settings for the OFDM Summary display are shown in the following table.

Settings tab Description

Modulation Params (see Specifies the type of modulation used for the input signal and other parameters.
page 244)

Advanced Params (see Specifies parameters used by the instrument to analyze the input signal.

page 245)

Data Range (see page 246) Specifies which symbols and subcarriers of the signal to display.

Analysis Time (see page 246) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for OFDM Analysis
displays.

Prefs (see page 250) Specifies the units of the display and whether elements of the graphs are displayed.
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OFDM Symbol Table Display

OFDM Symbol Table Display

The OFDM Symbol Table display shows decoded data bits for each subcarrier in each symbol in the
analyzed signal packet. Results are presented with subcarrier (frequency) indices in the horizontal

dimension and symbol (time) intervals in the vertical dimension.

To show the OFDM Symbol Table display:

1. Press the Displays button or select Setup > Displays.

2. In the Select Displays dialog, select OFDM Analysis in the Folders box.

3. In the Available displays box, double-click the OFDM Symb Table icon or select the icon and click
Add. The OFDM Symbol icon will appear in the Selected displays box and will no longer appear
under Available displays.

T N T

Set the Frequency appropriate for the signal.

Click OK to show the OFDM Symbol Table display.

Select Setup > Settings to display the control panel.
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. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.
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4 I 110100 001011 001011 110000 110101 a 101100 001110 111110 011010 011101

o 101010 100100 001100 011000 111101 [u] 111001 110010 001010 010010 010011 I

[} 011011 111010 011010 100000 110011 a 010000 010111 010001 110100 011000
I 7 100111 111111 110001 001011 111100 1 000000 100000 101011 001110 010010

8 110010 001110 010011 100001 001111 a 101001 001001 101110 000101 001000 I

9 II 001101 011011 011010 110110 011100 a 111011 100000 100001 101111 100100
I 10 101001 010100 010101 101010 110101 a 001011 011010 011011 001001 101101

11 101111 100010 000011 000000 000100 a 001110 110111 000000 110010 110100

12 000001 011101 100110 110100 100000 1 000011 010101 000001 011100 110100

TGy e ) e e )
e

Marker: M1 Symial: 12 I

Value: 100010 Subcarrier: 1

— — — — 0513014
Item Description
1 Subcarrier identifiers.
2 Symbol identifiers.
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OFDM Analysis OFDM Symbol Table Settings

(cont.)

Item Description

3 Subcarrier data values.

4 Marker readout when markers are enabled.

OFDM Symbol Table Settings

Front Panel: Settings

Application Toolbar: i

The settings for the OFDM Symbol Table display are shown in the following table.

Settings tab Description

Modulation Params (see Specifies the type of modulation used for the input signal and other parameters.
page 244)

Advanced Params (see Specifies parameters used by the instrument to analyze the input signal.

page 245)

Data Range (see page 246) Specifies which symbols and subcarriers of the signal to display.

Analysis Time (see page 246) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for OFDM Analysis
displays.

Prefs (see page 250) Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Analysis Shared Measurement Settings

Front Panel: Settings

Application Toolbar: &b

The control panel tabs in this section are shared between the displays in the OFDM Analysis folder (Setup
> Displays). Some tabs are shared by all the displays, some tabs are shared by only a couple of displays.
The settings available on some tabs change depending on the selected display.
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Modulation Params Tab — OFDM

Common controls for OFDM analysis displays

Settings tab

Description

Modulation Params (see

page 244)

Specifies the type of modulation used for the input signal and other parameters.

Advanced Params (see

page 245)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 246)

Specifies which symbols and subcarriers of the signal to display.

Analysis Time (see page 246)

Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for OFDM Analysis
displays.

Trace (see page 248) Enables you to display or hide the measurement or average trace.
Scale (see page 248) Specifies the vertical, subcarrier, and symbols scale and position settings.
Prefs (see page 250) Specifies the units of the display and whether elements of the graphs are displayed.

Modulation Params Tab - OFDM

The Modulation Params tab specifies the type of modulation used by the input signal and other parameters
that control the demodulation of the input signal.

Madulation Params |Advanced Params IData Range IAna\ysisTime ITrace IScaIe IPrefs |

Standard: |202.16 (2004) -

FFT Length @ 256

Guard Interval: |1/8 -

Spacing and Bandwidth

@ Subcartier Spacing 90,000 kHz

) Channel Bandwidth 20,160 Mz

FFT Sample Rate:  23.040 MS(s

Settings

Description

Standard

Specifies the standard used for the input signal. Choices are 802.11a/g/j and
820.16 (ETSI).

Guard Interval

Specifies the guard interval used in the input signal. Choices are 1/4, 1/8, 1/16/,
1/32, and User. When you select User, you can enter a percentage value to
specify the size of the guard interval as a percentage of the useful symbol
interval. The Guard Interval range is 0-100%.

Spacing and Bandwidth

Specifies the spacing between subcarriers and the nominal channel bandwidth.
Only one of these settings can be set at a time, the other setting is automatically
calculated.

Sample Rate

Indicates the FFT sample rate, based on the bandwidth or subcarrier setting.
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OFDM Analysis

Advanced Params Tab — OFDM

Advanced Params Tab - OFDM

The Advanced Params tab contains parameters that control the analysis of the input signal.

Modulation Params | Advanced Params \Data Range | AnalysisTime | Trace | Scale IPrefs |

Constellation determination | Auto Detect hd

Symbol analysis offset: -0.5 %

Charnel Estimation: | Preamble hd

[ swap1& Q

Piot tracking
Phase [] amplitude [T Timing

Settings

Description

Constellation determination

Specifies the method used to detect the constellation. Automatic analyzes the
signal to determine the appropriate constellation, Manual allows you to specify
the constellation type. Manual choices are: BPSK, QPSK, 16QAM, and 64QAM.

Symbol analysis offset

Specifies the analysis offset in the symbol interval. This value is a percentage
of the Guard Interval. The allowable range is -100% to 0%. -100% positions
the FFT to start at the beginning of the Guard Interval, 0% positions it to start
at the end of the Guard Interval. Default value is -50% which usually gives
the best measurement results.

Channel Estimation

Specifies the method used to estimate channel frequency response and
equalization. This control can be used to diagnose changes in frequency
response over the signal packet.

Preamble

When you select Preamble, the instrument uses only the Preamble to estimate
channel frequency response. This response is then used to equalize the entire
signal packet.

Preamble + Data

When you select Preamble + Data, the instrument makes an initial channel
frequency response estimate from the Preamble. Then estimates the channel
response for each data symbol using the decoded data content to derive
equalization for each symbol individually. This allows compensation for
time-varying channel response over the packet.

Pilot tracking

Specifies if pilot subcarriers should be used to correct amplitude, phase, and
symbol timing variations over the packet. The choices available are Phase,
Amplitude, and Timing. The default setting is Phase.

Swap 1 & Q

Select the checkbox to swap the | and Q components of a signal. This
compensates the input signal for spectral inversion.
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Data Range Tab — OFDM

Data Range Tab — OFDM

The Data Range tab enables you to control how much signal is analyzed, as well as specify the range of
results that are displayed in the Constellation, EVM, Magnitude Error, Phase Error, Power and Symbol

Table graphs.

| Modulation Pararms | Advanced params | Data Range | analysisTime | Trace [ scale | prefs |

Displaved Results

Syrnbols: | Al v | Subcariers: [al -

Max symbals to analyze: 1004

Settings Description
Symbols Specifies which symbols are displayed in the graphs.

All Select All to display all symbols.

Range Select Range to specify a subset of symbols for display.
Start Specifies the first symbol to include in the display.
Number Specifies how many symbols to display in the graphs.

Single Select Single to display a single symbol.

Index Use Index to specify the symbol you want to display.
Subcarriers Specifies which subcarriers are displayed.

All Select All to display all subcarriers in the signal.

Pilots Only Select Pilot to display only pilot subcarriers.

Data Only Select Data to display only data subcarriers.

Single Specifies a specific subcarrier for display.

Index Specifies the specific subcarrier to be displayed.

Range Specifies a range to subcarriers to be displayed.

Start Specifies the start value of the range to be displayed.
Stop Specifies the ending value of the range to be displayed.

Max symbols to analyze

Specifies how many symbols are analyzed. You can use this setting to speed
analysis by limiting the number of symbols being analyzed.

Analysis Time Tab - OFDM

The Analysis Time tab contains parameters that define how the signal is analyzed in the OFDM Analysis

displays.
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| Madulation Params | Advanced Params | Data Range | AnalysisTime | Trace | Scale | prafs |

Analysis Offset: -0.688 Sy [¥] auto Time Zero Reference: | Trigger -
Analysis Length: 88,000 sy [] auto Units:  [Symbols -

Actual: 66,000 Sym

Settings Description
Analysis Offset Specifies the location of the first time sample to use in measurements.
Auto When enabled, causes the instrument to set the Analysis Offset value based on the
requirements of the selected display.
Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in
either symbols or seconds, depending on the Units setting.
Auto When enabled, causes the instrument to set the Analysis Length value based on the
requirements of the selected display.
Actual This is a displayed value, not a setting. It is the Analysis Length (time or symbols)

being used by the analyzer, this value may not match the Analysis Length requested
(in manual mode).

Time Zero Reference Specifies the zero point for the analysis time.
Units Specifies the units of the Analysis Length to either Symbols or Seconds.
Analysis Offset

Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis
Offset outside the range of time covered by the current acquisition data. (all time values are relative
to the Time Zero Reference).

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the
current range of acquisition data settings. When the next acquisition is taken, its Acquisition Length will
be increased to cover the new Analysis Length, as long as the Sampling controls are set to Auto. If the
Sampling parameters are set to manual, or if the instrument is analyzing saved data, the actual analysis
length will be constrained by the available data length, but in most cases, measurements are able to be
made anyway. The instrument will display a notification when measurement results are computed from
less data than requested. Range: 0 to [(end of acquisition) - Analysis Length)]. Resolution: 1 effective
sample (or symbol).

Analysis Length

Use the analysis length to specify how long a period of time is analyzed. As you adjust this value, the
actual amount of time for Analysis Length, in Symbol or Seconds units, is shown below the control in the
"Actual" readout. This setting is not available when Auto is checked. Range: minimum value depends on
modulation type. Resolution: 1 symbol.
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Time Zero Reference

All time values are measured from this point (such as marker position or horizontal position (in Y vs Time
displays). Choices are: Acquisition Start or Trigger.

Parameter Description
Acquisition Start Offset is measured from the point at which acquisition begins.
Trigger Offset is measured from the trigger point.

Trace Tab - OFDM

The Trace tab allows you to set the trace display characteristics of the selected display. This tab is not
available for all OFDM displays.

‘ Modulation Pararns I Advanced Params I Data Range I AnalysisTime | Trace |Sca|e I Prefs |

Trace: |MagErrar  w Show [CIFreeze

Settings Description

Trace Use this drop-down list to select whether or not the Average trace or the measurement
trace is displayed. The measurement trace depends on the selected display.

Show Select or deselect this checkbox to show or hide the trace selected in the Trace
drop-down list.

Freeze Selecting Freeze halts updates to the trace.

Scale Tab - OFDM

The Scale tab allows you to change the scale settings that control how the trace appears on the display but
does not change control settings such as Measurement Frequency. There are two versions of the Scale tab
for OFDM displays. One version is used only for the Constellation display and the other version is used
for the OFDM EVM, OFDM Magnitude Error, OFDM Phase Error, and OFDM Power displays.
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|Mudulati0m Params | &dvanced Params | Data Range | AnalysisTime | Trace| Scale | prefs

Wertical Subrarrier Syrntiols
Scale: 41.8 % Scale: 200 Subc Scale: 12 5km
Position: -21.9 %a Position:  -100 Subc Position: & 5pm7
Autoscale Autoscale Auto Butoscale

Scale tab for OFDM EVM, OFDM Mag Error, OFDM Phase Error, and OFDM Power displays

Modulation Params | Advanced Params | Data Range | AnalysisTirme | Trace| Scale | prefs

Zoom

Scale: 3 Wertical Position: O

Harizontal Position: 0

Scale tab for OFDM Constellation display

Settings Description
Vertical Controls the vertical position and scale of the trace display.
Scale Changes the vertical scale of the graph.
Position Adjusts the reference level away from top of the graph.
Autoscale Resets the scale of the vertical axis to contain the complete trace.
Subcarrier Controls the scale of the subcarrier graph and position of the trace.
Scale Specifies how many subcarriers are displayed horizontally.
Position Specifies the subcarrier that appears at the left edge of the subcarrier graph.
Autoscale Resets the scale of the horizontal axis to contain the complete trace.
Symbols Controls the scale of the Symbols graph.
Scale Specifies the number of symbols that appear in the symbols graph.
Position Specifies the symbol that appears at the left edge of the Symbols graph.
Autoscale Resets the scale and position settings to optimize the display.
Auto When Auto is checked, the scale and position values for the Symbols graph are
automatically adjusted to maintain the optimal display.
Zoom Sets the Constellation display size and position.
Scale Sets the magnification value for the Constellation display.
Vertical Position Sets the vertical location of the Constellation display within the graph. Range is -3.7 to
+3.7.
Horizontal Position Sets the horizontal location of the Constellation display within the graph. Range is -3.7 to
+3.7.
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Prefs Tab - OFDM

250

The Prefs tab enables you to change appearance characteristics of the OFDM Analysis displays. Not all
settings on the Prefs tab shown below appear for every OFDM display.

‘ Modulation Pararms I Advanced Params I Data Range I AnalysisTime I Trace | Scale ‘ Prefs |

Frequrits: [Subcamer - ) subcarriers
Radi: Binaryiv ) Symbaols Show marker readout
Settings Description
Time units Specifies whether the displayed time units are seconds or symbols.
Freq units Specifies whether the displayed frequency units are frequency (Hz) or subcarrier channel.
Radix Specifies whether symbol values are displayed in binary or hex format (for example, in
the Symbol Table or markers readouts).

Show graphs Specifies which graph types are displayed.
Both Displays both the Subcarrier and Symbol graphs.

Subcarriers Displays only the subcarrier graph.

Symbols Displays only the symbol graph.
Show graticule Displays or hides the graticule in the graphs.
Show marker readout Displays or hides the marker readouts in the graphs.
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Pulsed RF

Overview

The displays in the Pulsed RF folder (Displays > Folders > Pulsed RF) are:

The Pulse measurements provide deep insight into pulse train behavior.

Pulse Statistics

Pulse Table

Pulse Trace

Pulse Measurements

Overview

The analyzer takes the following pulse measurements: Average ON Power, Peak Power, Average
Transmitted Power, Pulse Width, Rise Time, Fall Time, Repetition Interval (Sec), Repetition Rate

(Hz), Duty Factor (%), Duty Factor (Ratio), Ripple, Droop, Pulse-Pulse Phase Difference, Pulse-Pulse
Frequency Difference, RMS Frequency Error, Maximum Frequency Error, RMS Phase Error, Maximum
Phase Error, Frequency Deviation, Phase Deviation, and Time. See Available Measurements (see page 33)
for definitions.

Pulse Table Display

The Pulse Table lists selected measurements in a spreadsheet format, showing the pulse numbers and all

the results for each measurement on all the detected pulses. Pulses are numbered from one.

v

Freq Error: 169.1 Hz (Auto)

Freq: 2.700000169 GHz

Avg ON

-2.3542 dBm
-2,3518 dBm
-2,3510 dBm
-2,3551 dBm
-2,3513 dBm
-2,3531 dBm
-2,3537 dBm
-2,3530 dBm
-2.3547 dBm
-2,3505 dBm
-2.3541 dBm
-2,3528 dBm
-2,3561 dBm
-2,3530 dBm
-2,3500 dBm
-2,3559 dBm
-2,3563 dBm
-2,3558 dBm
-2.3564 dBm
-2,3509 dBm
-2.3566 dBm
-2.3541 dAm

Peak

-2.2729 dem
-2.2345 dBm
-2,2395 dBm
-2,2816 dBm
-2.2713 dBm
-2,2518 dBm
-2,2510 dBm
-2,3067 dBm
-2.2646 dBm
-2.2762 dBm
-2,2895 dBm
-2,2509 dBm
-2.2638 dBm
-2,3083 dBm
-2,3191 dBm
-2.2768 dBm
-2.3134 dBm
-2.2804 dBm
-2.2648 dBm
-2.28686 dBm
-2.2565 dBm
-2.2f4A dAm

£vg Ty Width

-18.732 dBm |5.1147485 us
-18.187 dBm |7.2183543 us
-18.619 dBm |5.2991536 us
-18.731 dBm |5.1165252 us
-18.192 dBm | 7.2086669 us
-18.587 dBm_|5.4644311 us
-18.727 dBm |5.1185839 us
-18.157 dBm | 7.2754278 us
-18.667 dBm |5.1216639 us
-18.735 dBm |S.1066654 us
-18,198 dBm |7.1933723 us
-18.556 dBm |5.7297557 us
-18.444 dBm |6.0395946 us
-18.730 dBm |5.1135430 us
-18,193 dBm |7.2002217 us
-18.572 dBm |5.6117051 us
-18.668 dBm |5.1218622 us
-18.740 dBm |5.1066395 us
-18,195 dBm | 7.2042967 us
-18.573 dBm |5.6055314 us
-18.669 dBm |5.1220964 us
-1R.735 dRm /51117199 15

i

Rise:

70.286235 ns
70.688479 ns
71.052249 ns
70.624202 ns
71.247657 ns
70.215551 ns
71.486205 ns
70.033572 ns
70.291136 ns
69.887697 ns
70.523072 ns
70.941773 ns
71277462 ns
70.236204 ns
71079711 ns
£9.582519 ns
70.316162 ns
70.247189 ns
71071774 ns
70.825806 ns
71.097411 ns
71.0R3370 s

Fall

69.794922 ns
70.023004 ns
69.774167 ns
70.438233 ns
70.579837 ns
70.734863 ns
70.560304 ns
£9.621585 ns
£9.699709 ns
70.510254 ns
70.412597 ns
£9.781493 ns
70.528564 ns
£9.981688 ns
71.169431 ns
70.191653 ns
£9.885253 ns
£9.825440 ns
70.909422 ns
70.736085 ns
70.708005 ns
£9.742474 ns

Rep Int

22095073 us
27567105 us
22323629 us
22096363 us
27549471 us
22846901 us
220,90306 us
275,90856 us
218.00389 us
22097585 us
27521345 us
237.95580 us
24425826 us
22097836 us
275,33952 us
23368913 us
218.00520 us
22096526 us
275,35643 us
23368525 us
218.00013 us
220,973 115

Rep Rate Ri
4.929893 kHz 0.1
3627512 kHz (0.1
4479359 kHz 0.1
4.929632 kHz |04
3629834 kHz 0.1
4.376244 kHz 0.1
4526873 kHz |0,
3.624389 kHz |0,
4.587074 kHz |0,
4.525381 kHz |0,
3.633543 kHz (0.1
4.,202461 kHz (0.1
4.094027 kHz | 0.1
4.525330 kHz (0.1
3.631880 kHz 0.1
4.,279189 kHz 0.1
4587046 kHz 0.1
4.525598 kHz 0.1
3.631656 kHz |01
4,279260 kHz (0.1
4587153 kHz (0.1
4575433 kHp M1 T
»

m
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Pulsed RF Pulse Table Settings

Displaying the Pulse Table

1. Press the Displays button or select Setup > Displays.

2. Select PulsedRF in the Folders box.

3. Double-click Pulse Table in the Available displays box to add the display to the Selected displays box.
4. Click OK.

Selecting the Measurements to Show
1. With the Pulse Table selected, press the Settings button.

2. In the Pulse Table Settings control panel, select the Measurements tab.

Measurements |Darams IDeﬁne ILeveIs IFreq Estlmat|0n|

Show in Puse [¥] verage OM Power Selert al
Peak Power
Clear 4l

[¥] Average Transmitted Power
Pulse Width
Rize Time 57

3. Select the measurements you wish to take from the list of measurements or click Select all to choose
all measurements.

4. Click the close box () to remove the Settings control panel.

Changing the Pulse Table Display Settings (see page 252)

Pulse Table Settings

Menu Bar: Setup > Settings

Front Panel: Settings

Application Toolbar: &

The Settings control panel tabs for the Pulse Table Display are shown in the following table.
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Pulsed RF

Settings tab

Measurements Tab

Description

Measurements (see page 253)

Selects the measurements to be show in the Pulse Table.

Params (see page 257)

Specifies several parameters that control how pulses are counted and defined.

Define (see page 259)

Specifies parameters that control where measurements are taken on a pulse.

Levels (see page 264)

Specifies parameters that control the method and levels used to calculate some pulse
values.

Freg Estimation (see

page 264)

Specifies the reference used for computing frequency errors.

Restore defaults. Sets the Pulse Table parameters to their default values.

Measurements Tab

The Measurements tab is used to specify the measurements that appear in the Pulse Table.

Measurermerits |Params IDeﬁne ILeveIs | Freq Estimati0n|

Shiowe in Pulse

Peak Power

Pulse Width
Rise Time

A
Average OMN Power Select all

Average Transmitted Power

Clear al

Show in Pulse

Checked measurements appear in the Pulse Table.

Select all

Click Select all to choose all

Clear all

Click Clear all to remove all

Pulse Trace Display

measurements for display in the Pulse Table.

measurements from the Pulse Table display.

The Pulse Trace display shows one measurement result and a trace graph illustrating that measurement
for a selected pulse number. You can also choose to display arrows and lines in the graph that illustrate
where on the pulse the measurement is being taken.
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Pulsed RF Pulse Trace Display

Elements of the Pulse Trace Display

@00

© 2.73 dBm
Resu\t:

= deydi
Hlm mlugfa

“ Pulse 1
@ 5.115us

-97.27 dBm

S ™
[Autescale | © 97305 © Scale: 7.16us

@ @ -

Item Display element Description

1 Optimized indicator The check mark indicator in the upper, left-hand corner of the display shows
when the Pulse Trace display is the optimized display.

2 Result Use this list to select the measurement to show. The measurement chosen

here selects the same result to be displayed in the Statistics view and
highlighted in the Table view. Selecting a result in any of these views causes
the same result to be selected in all of them.

3 Pulse Selects which pulse result is shown. Like the Result, this selection is shared
with the Statistics and Table views. The maximum number of pulses that
can be measured is limited to 10000.

4 Pulse threshold indicator This green triangle indicates the power threshold used to detect pulses. See
Settings > Params > Power threshold to detect pulses.

5 Autoscale Set the axes to values that show all trace points.

Horizontal offset and scale Located along the bottom edge of the trace display, these controls specify the

offset and scale on the horizontal axis.

7 Top of graph adjustment Sets the power level shown at the top of the graph. If the number is greater
than the Ref Level, a white line will appear in the graph to indicate the Ref
Level.

8 Vertical scale Sets the vertical scale value.
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Pulsed RF Pulse Trace Settings

Changing the Pulse Trace Display Settings (see page 255)

Pulse Trace Settings

Menu Bar: Setup > Settings
Front Panel: Settings

Application Toolbar: &

The Setup settings for the Pulse Trace display are shown in the following table.

Settings tab Description

Params (see page 257) Specifies several parameters that control how pulses are counted and defined.

Define (see page 259) Specifies parameters that control where measurements are taken on a pulse.

Levels (see page 264) Specifies parameters that control the method and levels used to calculate some pulse
values.

Freq Estimation (see Specifies the reference used for computing frequency error.

page 264)

Scale (see page 266) Specifies the vertical and horizontal scale settings.

Prefs (see page 267) Specifies whether on not certain display elements are shown.

Pulse Statistics Display

The Pulse Statistics view displays a plot of a pulse measurement's values for every pulse in the analysis
period. For example, the Pulse Statistics display will show the rise time measurement for each of 30
pulses, with rise time on the Y axis and pulse number on the X axis. Alternatively, the Statistics Display
can show an FFT trace for the values of a measurement over all the pulses analyzed. Numeric readouts of
Max, Min, and Average in this display summarize results for the selected pulse measurement.
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Pulsed RF Pulse Statistics Display

Elements of the Pulse Statistics Display

Result

‘ |R\se

“ Pulse 26
70.26 ns
Max: 71,49 ns
Min: 69,44 s

© Fl6ns

Avg: 70.64 ns

‘ “ R8.3nNs
. T
@ ; | Trend | [Autosesle | = 1 © Scale: 40

0519-062

Item Display element Description

1 Optimized indicator The check mark indicator in the upper, left-hand corner of the display shows
when the Pulse Statistics display is the optimized display.

2 Result Use this list to select which measurement statistics to display. The
measurement chosen here selects the same result to be displayed in the
Pulse Trace display and the Pulse Table display. Selecting a result in any of
these views causes the same result to be selected in all of them.

3 Pulse Selects which pulse's result is shown. Like the Result, this selection is shared

with the Statistics and Table views.

Statistics summary Display of measurement statistics for the selected Result.

Vertical range Located at the top of the left graph edge and at the bottom of the left graph
edge, use these controls to adjust the values at the top of the graph and the

bottom of the graph.

256

6 Plot Selects from Trend, Time Trend, FFT, and Histogram for the graph.

7 Autoscale Set the axes to values that show all trace points.

8 Horizontal offset Adjusting this value moves the graph right or left.

9 Trigger indicator Indicates the trigger point on the pulse train if the trigger occurred during the
time frame of the pulse measurements.

10 Pulse indicator For Trend and Time Trend plot types, this indicates the pulse selected by the
Pulse setting. For the FFT plot type, this indicator marks the trace point at
the selected frequency. For Histogram plot types, this indicator marks the
selected results bin.

" Scale Adjusts the horizontal scale.
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Pulsed RF

Pulse Statistics Settings

Changing the Pulse Statistics Display Settings (seec page 257)

Pulse Statistics Settings

Menu Bar: Setup > Settings

Front Panel: Settings

Application Toolbar: &

The settings for the Pulse Statistics Display are shown in the following table.

Settings tab Description

Params (see page 257) Specifies several parameters that control how pulses are counted and defined.

Define (see page 259) Specifies parameters that control where measurements are taken on a pulse.

Levels (see page 264) Specifies parameters that control the method and levels used to calculate some pulse

values.

Freg Estimation (see

Specifies the reference used for computing frequency errors.

page 264)
Scale (see page 266) Specifies the vertical and horizontal scale settings.
Prefs (see page 267) Specifies whether or not certain elements of the display are shown.

Pulsed RF Shared Measurement Settings

The control panel tabs in this section are shared by the displays in the Pulsed RF folder (Setup > Displays).
Changing a setting on one tab changes that setting for all the Pulsed RF displays.

Common controls for pulsed RF displays

Settings tab

Description

Params (see page 257)

Specifies several parameters that control how pulses are counted and defined.

Define (see page 259)

Specifies parameters that control where measurements are taken on a pulse.

Levels (see page 264)

Specifies parameters that control the method and levels used to calculate some pulse
values.

Freg Estimation (see

Specifies the reference used for computing frequency errors.

page 264)

Scale (see page 266) Specifies the vertical and horizontal scale settings.

Prefs (see page 267) Specifies whether or not certain elements of the display are shown.
Params Tab

The Params tab enables you to adjust several measurement parameters for Pulsed RF displays.
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Pulsed RF Params Tab

258

Params | Define | Levels | Freg Estimation | Scale | Prefs

Measurernent Filter: | Gaussian - Power threshold to detect pulses:  -12 dBc

Bandwidth: 10 MHz Minirnurm OFF tirme between pulses: 0,000 s
Mayx rumber of pulses: 100

Setting Description
Measurement Filter Specify whether a filter is used to limit the bandwidth of the input signal.
Bandwidth Sets the bandwidth of the measurement filter.
Power threshold to detect Specifies the level used for locating pulses in the data.
pulses
Minimum OFF time between Specifies the time the signal must fall below the power threshold for two pulses to be
pulses considered separate pulses.
Max number of pulses Specifies the number of pulses to measure within the analysis time.

Measurement Filter
Three choices are available for the measurement filter:

B No Filter - Max BW: The widest acquisition bandwidth available is used. The Bandwidth setting is
disabled, but shows the value in use.

®  No Filter: - This is the default. The Bandwidth control is enabled for you to specify an acquisition
bandwidth.

®m  Gaussian - The Bandwidth control is enabled for you to specify a value. The instrument uses an
acquisition bandwidth two times wider than the entered value.

Power Threshold to Detect Pulses

Specifies the minimum power level the trace must exceed to be detected as a pulse. The range for this
setting is: -3 to -70 dBc. The setting resolution is 1 dB. The default value is -10 dB.

Max Number of Pulses

If the Analysis Time contains fewer pulses than specified, the analyzer will measure all the pulse within
the analysis time. If there are more pulses in the Analysis Time, than the specified number, the analyzer
measures the specified number of pulses and ignores the rest. The range for this setting is: 1 - 10000.
The setting resolution is: 1. If this setting is not checked, the analyzer will measure all pulses within the
Analysis Time, up to a maximum of 10000 pulses.

To determine the maximum number of pulses that can be analyzed, use the following equation:
Max number of pulses that can analyzed = Pulse Rate X capacity

where:
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®H  Pulse rate is the number of pulses per second (frequency).
®  Capacity is a length of time which is displayed on the Acquire > Sampling Parameters tab.

Note that the maximum number of pulses is affected by several parameters. For example, measurement
bandwidth affects the sample rate. The measurement algorithm also can reduce the maximum number of
pulses that can be analyzed (by increasing the sample rate) based on the characteristics of the signal.

Additionally, when FastFrame is enabled, determining the maximum number of pulses is even more
challenging. In FastFrame mode, the signal analyzer samples the signal around events of interest and
ignores the signal between events of interest. Thus, if the instrument is only looking at pulses and
ignoring the signal between pulses, the number of pulses that can be analyzed depends strongly on the
characteristics of the pulse itself (for example, fewer wide pulses can be analyzed than narrow pulses,
all other things being equal).

Define Tab

The Define tab enables you to specify parameters that control where measurements are made on a pulse.
The settings available depend on the measurement selected.

| Params | Define |Levels | Freq Estimation | Scale | Prefs |

Measurement(s):

IImpuIse Response v‘ Time method: | Absolute A Ref (R): 100 %
Apply arnpl corrections

91 Apply amp x%7if N Start (5): 0,000 s
Keep-out time (+/-): 0.000 <

R L

{E + Length (L) 1.00 us

The following paragraphs describe the settings that appear on the Define tab according to the
Measurement(s) selection.

Freq-Domain Linearity

| Params | Define |Levels | Freq Estimation | Scale | Prefs |

Measurement(s):

IFreq—domain Lineatity v‘ Tirme method: | Absolute - Ref (R): 100 %
M\ Start (5): 0.000 s

R 5 L

Length (L): 100 us
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Setting Description
Time method Specifies how the measurement's duration is determined. The choices are

Absolute and Relative.

Absolute time method

Ref (R)

Ref specifies the level along the pulse rising edge that is defined as the point
from which Start time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%;
Default: 100%

Start ()

Start specifies the time the instrument waits after the rising-edge reference before
starting to measure the pulse. The Start time is measured from the point along the
pulse rising edge specified by the Ref setting. Start Range: £100 ms; Resolution:
3 digits; inc/dec small: 1 ns, large: 1,2,5,10...; Default: 0

Length (L)

Length specifies the period of time that is used for pulse measurements The
measurement time begins at the Start point and continues for the amount of time
specified by Length.

Relative time method

Length

In the Relative time method, Length specifies the percentage of the top of the pulse
that is used for measurements. The instrument automatically determines the pulse
top. The measurement length is centered within the pulse ON time.

Impulse Response

| Params | Define |Levels I Freq Estimation I Scale I Prefs |

Measurementis):

Ilmpulse Resporse vI

Apply arnpl corrections
Keep-out time (+/-): 0.000 ¢

L

Tirne method: | Absclute hd Ref (R): 100 %
M\ Start (5): 0.000 5

R S L
Length (L) 1.00us
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Setting

Define Tab

Description

Apply ampl corrections

Enable/disable corrections that remove errors due to the window function and to
the time offset of the side lobe.

Keep-out time (+/-)

The Keep-out time specifies a region that is ignored when the trace is analyzed for
side lobes. The setting defines a region to the left and to the right of the center

of the main lobe. Lobes that fall within this time region are not eligible to be the
“highest side lobe”.

Time method

Specifies how measurement parameters are determined. The choices are
Absolute and Relative.

Absolute time method

Ref (R)

Ref specifies the level along the pulse rising edge that is defined as the point
from which Start time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%;
Default: 100%

Start (S)

Start specifies the time the instrument waits after the rising-edge reference before
starting to measure the pulse. The Start time is measured from the point along the
pulse rising edge specified by the Ref setting. Start Range: £100 ms; Resolution:
3 digits; inc/dec small: 1 ns, large: 1,2,5,10...; Default: 0

Length (L)

Amount of time that should be included in the measurement. The measurement
time begins at the Start point and continues for the amount of time specified by
Length.

Relative time method

In the Absolute time method, Length specifies the period of time that is used for
pulse measurements.

Length

In the Relative time method, Length specifies the percentage of the top of the pulse
that is used for measurements. The instrument automatically determines the pulse
top. The measurement length is centered within the pulse ON time.

Freq Diff, Phase Diff

Params | Define | Levels | Freq Estimation | Scale | Prefs

Measurement(s):
Freq Diff, Phase Diff -

Setting

W Measurernent point: 1.000 us

Description

Measure point

Specifies the period in time after the 50% rising edge at which frequency and
phase difference measurements are made.
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Ripple
| Pararms | Define |Levels I Freq Estimation I Scale I Prefs |
Measurementis):
’Ripple v] Timne method: | Relative 100 %
_/ﬁ_:ﬁ\ 0.000 s
L%
TF—100%—T
Length (L): 50.0 %
Setting Description
Length Length specifies the percentage of the top of the pulse that is used for
measurements. The instrument automatically determines the pulse top. The
measurement length is centered within the pulse ON time. Only the Relative Time
method is available for Ripple.
Overshoot

| Pararms | Define |Levels I Freq Estimation I Scale I Prefs |

Measurementis):

’Overshoot v] Tirne method; Ref (R): 100 %

o Start (5): 0.000 s
RS L%

Length (L) 25.0 %
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Setting Description
Time method Specifies how measurement parameters are determined. The choices are

Absolute and Relative.

Absolute time method

Ref (R)

Ref specifies the level along the pulse rising edge that is defined as the point
from which Start time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%;
Default: 100%

Start (S)

Start specifies the time the instrument waits after the rising-edge reference before
starting to measure the pulse. The Start time is measured from the point along the
pulse rising edge specified by the Ref setting. Start Range: £100 ms; Resolution:
3 digits; inc/dec small: 1 ns, large: 1,2,5,10...; Default: 0

Length (L)

Amount of time that should be included in the measurement. The measurement
time begins at the Start point and continues for the amount of time specified by
Length.

Relative time method

Ref

Ref specifies the level along the pulse rising edge that is defined as the point
from which Start time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%;
Default: 100%

Start

Start specifies the time the instrument waits after the rising-edge reference before
starting to measure the pulse. The Start time is measured from the point along the
pulse rising edge specified by the Ref setting. Start Range: +100 ms; Resolution:
3 digits; inc/dec small: 1 ns, large: 1,2,5,10...; Default: 0

Length

In the Relative time method, Length specifies the percentage of the top of the pulse
that is used for measurements. The instrument automatically determines the pulse
top. The measurement length is centered within the pulse ON time.
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Levels Tab

Use the Levels tab to set parameters that control the method and levels used to calculate some pulse values.

|Params | Defing | Lewels |Freq Estimation | Scale | Prefs |

100% Level 50% Level RisefFall Levels
Pulse & G
Ulsa Average ol

2

¥ armplitude @ ‘roltage @ 10 - 90%

100%:

Ind dent Ri 100%:
ooy A O o

Setting Description

100% Level Specifies the method used to determine the 100% level(s).

50% Level Specifies the method used to determine the 50% level on the pulse.

Rise/Fall Levels Select whether to use the 10% to 90% or 20% to 80% points (based on voltage level)

to define the rise and fall times.

100% Level

Use the 100% Level settings to select the method used to determine the 100% level(s) used for calculating
pulse parameters, for example, Rise, Fall, and Width.

The Pulse Average Amplitude defines the pulse top as the average of the values of all the points along
the pulse top. This average is used as the 100% level, from which the 10, 20, 50, 80 and 90% levels are
calculated. Pulse measurements are referenced against these various levels. For example, Rise is the time
between the 10 and 90% (or 20 and 80%) levels on the rising edge of the pulse. When the Pulse Average
Amplitude method is selected, the same 100% level is used for both rising and falling edges.

Because some RF pulse types have droop (a height difference between the beginning and ending points of
the pulse top), the 100% percent level on the rising edge may not be equal to the 100% level on the falling
edge. The Independent method of pulse point location is designed for pulses with different 100% levels
at their rising and falling edges. The Independent method calculates the 100% level for the rising edge
separately from the 100% level of the falling edge. As a result, the 10, 20, 50, 80 and 90% levels are also
different for the rising and falling edges, allowing for more accurate measurements on pulses with droop.

50% Level

Select Voltage to use -6 dB as the 50% point. Select Power to use -3 dB as the 50% level.

Freq Estimation Tab

Use the Freq Estimation tab to specify parameters used for determining frequency offset.
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Freq Estimation Tab

| Params | Define | Levels | Freq Estimation | Scale | prefs |

Pulse Frequency Reference
Modulation type:
Freq Offset: 1891 Hr Auto
ILinear Chirp v‘
Chirp Slope: GO0 Heils Auto
Setting Description
Modulation type Specifies which algorithm to use for estimating frequency error.

Pulse Frequency Reference

Specifies the method used to determine the pulse frequency error and if applicable,
the chirp slope.

Auto Selecting Auto causes the instrument to calculate the frequency offset and if applicable,
the chirp slope.

Freq Offset If Auto is not enabled, specify the value for frequency offset here. If Auto is enabled, the
offset is set to zero and this readout displays the calculated frequency error.

Chirp BW If Auto is not enabled, specify the value for Chirp Slope here. If Auto is enabled,
this readout displays the calculated Chirp slope. This setting is used only when the
modulation type is set to Linear Chirp.

Modulation Type

Frequency estimation is performed by the instrument using selectable methods, depending on signal type.
The selections for modulation type are CW (constant phase), CW (changing phase), Linear Chirp and
Other. Select the method of frequency method based upon a best match to your signal based on the

following descriptions:

B CW (constant phase): The signal is not designed to change in either frequency or phase during the
measured pulse train.

B CW (changing phase): The signal does not change the carrier phase within each pulse, although it
could change the phase from one pulse to another pulse. The signal is not designed to make frequency

changes.

B Linear Chirp: The signal changes frequency in a linear manner during each pulse. The signal has the
same carrier phase at the same time offset from the rising edge of the pulse.

m  Other: The signal is not one of the listed types. You must manually enter the Frequency Offset value.

The following table maps the appropriate signal type selection with the signal characteristics.

Signature Phase offset from one pulse to another

Zero Any (unknown)
Cw CW Constant Phase CW Changing Phase
LFM Linear Chirp N/A
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Scale Tab
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Scale Tab

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

| Params I Defing | Levels I Freq Estimation | Scale |Prefs |

Wertical Horizontal
Scale: 100.00 dB Scale: 348ns Full scale:
Position: 2,73 oBm HESSTEIElS Position:  £.99 ms ® Selerted
—— — Ma pulse
Setting Description
Vertical Controls the vertical position and scale of the trace display.
Scale Changes the vertical scale. The units for this setting depend on the statistic selected
from the Result drop-down list in the Pulse Statistics display.
Position Adjusts the Reference Level away from the top of the trace display. The units for this
setting depend on the statistic selected from the Result drop-down list in the Pulse
Statistics display.
Autoscale Resets the scale of the vertical axis to contain the complete trace.
Horizontal Controls the span of the trace display and position of the trace.
Scale Allows you to change the span.
Position Allows you to pan a zoomed trace.

Full Scale (Pulse Trace

Specifies the Horizontal scale default.

display only)
Selected Sets the horizontal scale default to be based on the result value for the currently-select
pulse.
Max Pulse Sets the horizontal scale default to be based on the largest value for the selected pulse
measurement.
Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Plot (Pulse Statistics display
only)

Specifies the FFT, Trend, Time Trend, or Histogram plot.

Reset Scale

Restores all settings to their default values.
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Prefs Tab

Prefs Tab

The Prefs tab enables you to change parameters of the measurement display. The parameters available on
the Prefs tab vary depending on the selected display.

| Params | Define | Levels | Freq Estimation | Scale | Prefs |

Shiowy graticule

[V]Showy Marker readout in graph (selected marker)
(Time Trend only)

Histogram readout: | Count - Eins: 182 Auto

Settings on the Pulsed RF Displays Prefs Tab

The following table describes the settings that appear on the Prefs tab of the Pulsed RF displays: Pulse
Statistics and Pulse Trace. There is no Prefs tab for the Pulse Table display.

Setting

Description

Show graticule

Displays or hides the graticule in the trace display.

Show Marker readout in
graph

When a marker is enabled, this setting displays or hides the maker readout, but not the maker
itself, on Time Trend plots.

Histogram readout
(present only when
Histogram is the selected

plot type)

Controls the parameters Histogram readout and Bins. Histogram readout can be set to either
Count or %. Count indicates the number of hits that fell into each bin. % indicates percentage
of the total count (for the acquisition) that fell into each bin.

Bins

Specifies how many "bins" or histogram bars the results are distributed into.
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Overview

Audio Analysis measures basic time- and frequency-domain parameters of analog audio signals modulated
on a carrier (AM, FM and PM modulation) or unmodulated (non-carrier) audio signals (Direct).

For modulated signals, the measurement analysis first demodulates the signal to provide the Audio signal
waveform. Direct input signals bypass the demodulation step. For FM and PM demodulation, the carrier
frequency error is estimated during demodulation.

The Audio signal waveform excursions are then measured to determine the Peak and RMS waveform
parameters. Next, the analysis detects the highest-amplitude frequency component within the audio
bandwidth, and makes a high-accuracy frequency measurement of the frequency component. This value is
called the Audio Frequency.

A spectral analysis of the Audio signal waveform is performed to determine the presence and level of
harmonically- and/or non-harmonically-related narrowband spurs and wideband noise. The Audio
signal, harmonic and non-harmonic spurs, and noise level data are combined to produce signal summary
parameters including SINAD, Modulation Distortion, Signal-to-Noise, Total Harmonic Distortion, and
Total Non-Harmonic Distortion.

Controls are provided to allow the user to select audio filters of Low Pass, High Pass, FM De-emphassis,
or Standard-defined response, as well as completely user-definable filter response. Filtering can be applied
as needed to modify the audio spectrum result before measurement to remove unwanted spurs or noise.

Flexible control parameters are provided to allow setting the Audio Bandwidth for analysis, the Resolution
Bandwidth (RBW) and RBW filter type of the spectral analysis, and number and level qualifications for
Harmonic and Non-harmonic spur detection. Multiple-spectrum averaging can be enabled to provide a
smoothed spectrum for results with less variability than single-spectrum results.

The Audio Spectrum display shows the frequency spectrum waveform with detected harmonic and
non-harmonic components identified by markers, and a corresponding table of frequency and level values
for the spur components. The markers and table provide easy visualization of the significant spurs and
their relation to the fundamental Audio frequency signal.

Audio Spectrum Display

The Audio Spectrum display shows audio modulation characteristics. You can choose to show just the
spectrum of the audio signal or show the audio spectrum of the signal and the results of distortion
measurements. The Audio Spectrum display can show a table listing the frequency of a Harmonic
Distortion (HD) and Non-Harmonic Distortion (NHD) and its level. The Spectrum graph indicates these
harmonics and non-harmonics with special markers.

To display the Audio Spectrum display:
1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select Audio Analysis.
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Audio Spectrum Settings

3. Double-click the Audio Spectrum icon in the Available Displays box. This adds the Audio Spectrum

icon to the Selected displays box.

4. Click the OK button. This shows the Audio Spectrum display.

Elements of the Audio Spectrum Display

+Peak Normal [cea |
2 100 dEHz?
o dafdiv:

15.0d8

= Audic BW:
50,000 kHz
7] Table
@ i 7 : ] i
1 ) oy | n i i [T
@ L RRE A D T A T
@ -50.0 deHz=
| Autoscale | = 0.0000 He © 50,00 kHz

1 2 3 4 5 ] 7 a8 a 10 11

b HD Freqg (Hz) 2,000k 4,000k |6.000k |9.000k 10,000k [12.000k 14,000k 16,000k |18.000k 20,000k |22.000k ©
HD Lewvel (dBc) 98,97 dBHe® |-B2.24 |-79.08 |-89.34 -88.46 [-80.20 -84.42 -78.73 |-B574 |-80.18 |-103.31 -
MNHD Freq (Hz) 40.000k 34,000k 43,987k 30,000k 28,000k 32,000k
NHC avel (cBc) 72,32 7567 FR04  -FFR14 7477781

Item Display element Description

1 Vertical position Sets the top of graph value.

2 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.

3 Audio BW Specifies the measurement bandwidth of the Audio Spectrum display, which
in turn can influence the acquisition bandwidth.

4 Table Displays a table that shows the distortion measurement results and displays
indicators on the graph that highlight the location of the harmonics on the
trace.

Bottom of graph readout Displays the bottom of graph value.
Non-harmonic threshold Displays the threshold for detecting non-harmonic components.
indicator

7 Analysis results Display of the audio analysis results.

Audio Spectrum Settings

270

Menu Bar: Setup > Settings

Front Panel : Settings

Application Toolbar: %

The measurement settings for the Audio Spectrum display are shown in the following table.
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Settings tab

Description

Audio Summary Display

Params1 Tab (see page 273)

Specifies signal type, Audio Bandwidth, RBW, RBW filter, and Ref Audio Frequency.

Params?2 Tab (see page 275)

Specifies Harmonics and Non-Harmonics measurement parameters.

Audio Filters Tab (see

Specifies the audio filter characteristics.

page 276)
Scale Tab (see page 278) Sets vertical and horizontal scale and position parameters.
Prefs Tab (see page 281) Specifies vertical units, and whether on not some features are displayed in the graph.

Audio Summary Display

To display the Audio Summary display:

1.
2.
3.

Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

From the Folders box, select Audio Analysis.

Double-click the Audio Summary icon in the Available Displays box. This adds the Audio Summary

icon to the Selected displays box.

Click the OK button. This shows the Audio Summary display.

The Audio Summary Display

Item

Display element

Description

1

Measurement results

Measurement results are displayed in this area. The displayed measurements
vary with signal type.

Hum & Noise results

Hum & Noise analysis readout. Hum & Noise appears only when enabled on
the Hum & Noise tab

Audio Summary Displayed Measurements

Table 5: Audio Summary Measurements

Signal type Item

Description

AM, FM, PM

Carrier Power

Average power of the carrier signal with
modulation removed.

Direct Signal Power Average power of the input signal
FM, PM Carr Freq Err Carrier frequency error
AM, FM, PM. Direct Audio Freq Fundamental audio frequency
+Peak +Peak modulation excursion (where the
modulation excursion readout depends on the
signal type) !
-Peak -Peak modulation excursion (where the

modulation excursion readout depends on the
signal type) 1
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Table 5: Audio Summary Measurements (cont.)

Signal type Item Description

Peak-Peak/2 Half peak-peak modulation excursion (where the
modulation excursion readout depends on the
signal type) 1

RMS RMS modulation excursion (where the modulation
excursion readout depends on the signal type) !

SINAD Signal to noise and distortion

Mod Distor Modulation distortion

SIN An estimate of the Signal level to Noise (only)
level, with the HD and NHD components removed

THD Total harmonic distortion

TNHD Total non-harmonic distortion

Ref Ref is the RMS modulation value stored when

the Capture Reference button is pressed.
(Displayed only when Hum & Noise is enabled.)

Diff Diff is the difference between the current RMS
mod value and the Ref value captured previously.
(Displayed only when Hum & Noise is enabled.)

1 For AM signal types, modulation excursion is "% Modulation Depth". For FM signal types, modulation excursion is "Frequency Deviation". For PM
signal types, modulation excursion is "Phase Deviation". For Direct, there is no modulation excursion, it is actually "signal excursion".

Audio Summary Settings

Front Panel: Settings

Application Toolbar: &

The measurement settings for the Audio Summary display are shown in the following table.

Settings tab Description

Params1 Tab (see page 273) Specifies signal type, Audio Bandwidth, RBW, RBW filter, and Ref Audio Frequency.
Params?2 Tab (see page 275) Specifies Harmonics and Non-Harmonics measurement parameters.

Audio Filters Tab (see Specifies the audio filter characteristics.

page 276)

Hum Noise Tab (see page 280) Specifies whether or not Hum & Noise is measured and enables the capture of a signal
to be used as a reference of the Hum & Noise measurement.

Audio Analysis Measurement Settings

The control panel tabs in this section are shared by the displays in the Audio Analysis folder (Setup >
Displays).
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Params1 Tab

Common controls for Audio Analysis displays

Settings tab

Description

Params1 Tab (see page 273)

Specifies characteristics about the audio signal and how measurements are made.

Params?2 Tab (see page 275)

Specifies parameters that control how measurements are made on harmonics.

Audio Filters Tab (see
page 276)

Specifies characteristics of filters applied to the signal before measurements are taken.

Scale Tab (see page 278)

Sets vertical and horizontal scale and position parameters.

Prefs Tab for Audio Analysis
(see page 281)

The Prefs tab enables you to change appearance characteristics of the Audio Analysis
displays.

Params1 Tab

The Params]1 tab is used to specify characteristics of the audio signal to be measured and how the signal

will be measured.

Pararns1 |F‘aram52 | &udio Filters I Hurn & Noise|

Signal Type:  |[aM hd

Audio BW: 20,000 kHz RBW: 40.04H7 Auto
Ref fudio Freq: 2000 A4 Auto REWY Filter:  |Kaiser -

Params1 tab for AM signal types

Setting Description

Signal Type Specifies the type of signal to be analyzed. The available choices are AM, FM, PM,
and Direct.

Audio BW Specifies the bandwidth used for audio analysis.

Ref Audio Freq

A measured value when Auto is selected. If you want to specify the reference audio
frequency, uncheck Auto and enter a value manually. If Ref Audio Freq is set manually,
be aware that the automated detection is still performed, but it is limited to a frequency
range of +1% of the Audio BW centered around the manually specified value.

Carrier Freq Error / Carrier

(FM and PM only) A measured value, when Auto is selected. If Auto is unchecked, you

Freq Offset can specify the Carrier Frequency Offset.

RBW Displays the Resolution Bandwidth for Audio measurements. This value is automatically
set by default to 1/500 of the measurement bandwidth. To manually specify the
RBW, uncheck Auto. The minimum RBW value is limited to the larger of 1 Hz or
AudioBW/10000. The maximum is limited to AudioBW/100.

RBW Filter Specifies the windowing method used for the transform.
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Setting Frequency for Direct Signal Types

Direct (unmodulated) signal analysis is only possible with the instrument Frequency control set to 0 Hz.
You will receive a warning to set Frequency to 0 Hz when Direct signal type is selected, if you haven’t
already done so. Modulated signal types may be selected with Frequency set to 0 Hz, but results are not
meaningful in that case. For modulated signals, Frequency should always be set to a value > Audio
Bandwidth to avoid self-interference of the signal due to spectral folding.

Setting Audio Bandwidth

For AM, FM and PM, the Audio Bandwidth control sets not only the demodulated signal bandwidth, but
also determines the pre-demodulation bandwidth. Set it to a value at least half the pre-demodulation
signal bandwidth, as in this equation:

Audio BW > Signal Bandwidth / 2

NOTE. When performing audio analysis, you should allow the Audio BW control to automatically set the
acquisition bandwidth, rather than manually adjusting the Acq BW control on the Sampling Parameters
tab of the Acquire control panel. The audio measurement will cause the Acq BW setting to be > Audio
BW (Direct) or > 2 x Audio BW (AM, FM, PM).

For Direct signals, set Audio Bandwidth large enough to include any significant harmonics/non-harmonics
or other signal component of interest. For example, to measure up to the 10th harmonic of a signal with a 5
kHz fundamental component, set Audio Bandwidth to 10 x 5 kHz = 50 kHz.

For modulated signals, Audio Bandwidth must be set wide enough to include all significant signal
modulation components in addition to the desired audio analysis bandwidth. For AM this is similar to
Direct. For example, to measure up to the 10th harmonic of an AM signal with 3 kHz fundamental
component, set Audio Bandwidth to 10 x 3 kHz = 30 kHz. This ensures that the bandwidth of the data
provided by the system to the measurement will be at least of 60 kHz (2 x 30 kHz) which is sufficient for
this signal and analysis requirement.

FM and PM are more complex. For FM, the analysis bandwidth needs to be at least twice as wide as the
the sum of peak Frequency Deviation and the Fundamental Frequency (Carsons rule). This is a parallel
condition along with setting Audio Bandwidth large enough for the maximum audio bandwidth to analyze.
Therefore, for FM, Audio Bandwidth should be:

AudioBwW (FM) = MAX( MaxAudioAnalysisFreq, FregDeviation+FundamentalFreq )

where MaxAudioAnalysisFreq is the highest audio frequency desired in the analysis. For example, for

an FM signal with fundamental signal of 5 kHz and peak frequency deviation (one-sided) of 10 kHz,
Acquisition Bandwidth should be at least (2*(10k+5k)) = 30 kHz, or an Audio Bandwidth of 15 kHz. Also
if the analysis should extend to the 8th harmonic, then the Audio Bandwidth needs to be at least 8*5 kHz =
40 kHz. So Audio Bandwidth should be set to 40 kHz. Using the equation:

AudioBW(FM) = MAX( 8x5kHz, (10+5)kHz ) = MAX( 40 kHz, 15kHz) = 40 kHz
The formula for PM is:

AudioBwW (PM) = MAX (MaxAudioAnalysisFreq, PMFregDeviation+FundamentalFreq)
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where

PMFreqDeviation = PMPhaseDeviationInRadians x FundamentalFreq

RBW Filter Shape

Select Kaiser in most cases for best measurement performance. Select Flattop only if you want to use
standard markers to measure signal amplitude with highest accuracy.

Params2 Tab

The Params?2 tab is used to specify how the signal harmonics are measured and to control spectrum
averaging.

| Params1 | Params2 | audio Filters | Scale | Prefs |

Mon-Harmonics only
Mo, of Harmaonics: 12 Ignore region: 0.0 He
Ma. of Mon-Harmanics: 12 Threshold:  -65.0 dBc
[7] Aweraging: |10 Excursion: 6.0 dB
Setting Description
No. of Harmonics Specifies the number of harmonics to detect. The detected harmonics are tagged with a
number on the spectrum trace. The available range is 1-20.
No. of Non-Harmonics Specifies the number of non-harmonics to detect. The detected non-harmonics are
tagged with a number on the spectrum trace. The available range is 0-20.
Averaging Specifies the number of averages used to compute the results. Range: 2-100.
Ignore region Specifies the region about the signal frequency where the instrument will ignore

non-harmonics.

Non-Harmonic Threshold Specifies the level which a spectrum peak must exceed to be declared a non-harmonic
signal component.

Non-Harmonic Excursion Specifies the difference in level between a spectrum peak and the average noise level
that must be exceeded for the peak to be declared a non-harmonic signal component.

About Averaging In Audio Analysis Displays

Analysis averaging is implemented using a “block” method. This means that the entire record required for
multiple spectrum computations is acquired and analyzed within one analysis cycle. The result of each
analysis update is a complete, independent result from a set of N spectrums averaged together, where N is
the Averaging control value.. Since each update is a fully averaged result, no partially averaged results
are output before a final result is available, so each output is fully valid. However, with large Averaging
values, acquisition record sizes and measurement times may become large, so care should be taken to
select the minimum amount of averaging needed.
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Audio Filters Tab

The Audio Filters tab is used to specify filters to be applied to the acquired audio signal before
measurements are taken. You can select from pre-defined filters or use a filter you define in a text file.
You can also specify the de-emphasis time constant applied to the audio signal and the telecom weighting
filters used to measure noise.

sudo Fiters [scge | P
@ Pre-defined Filters V] LPF: | 200 Hz - [[] De-emphasis: |25 psec~ w

[C] HPF: |50 Hz - [] Standard: CCITT -

_ File:

Pre-defined Filters

You can specify low-pass filter (LPF) and high-pass filter (HPF) settings, a de-emphasis time constant
and/or a telecom weighting filter to match the response of your receiver. Alternatively, you can create a
text file to specify the frequency response points.

To use pre-defined filters:
1. Select the Pre-defined Filters option button.
2. Select the LPF, HPF, De-emphasis and Standard check boxes as appropriate.

3. Select the desired filter parameter from the drop-down list for each of the enabled filters or select User
from the list if you wish to use a custom value. For LPF and HPF, the listed frequencies represent the
3dB cutoff point of the filter.

4. Ifyou select User from the drop-down list, enter a value in the text entry box that appears.
To disable all filtering:
1. Select the Pre-defined Filters option button.

2. Deselect all four filter check boxes.
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Table 6: Predefined audio filters

Filter type Available settings
LPF (Low Pass Filter) 300 Hz
(5th-order Butterworth response) 3 kHz
15 kHz
30 kHz
80 kHz
300 kHz
User !
HPF (High Pass Filter) 20 Hz
(5th-order Butterworth response) 50 Hz
300 Hz
400 Hz
User !

De-emphasis (FM only) 25 ps

50 ps

75 ps

750 ps

User. Range: 25 ps to 10 ms
Standard CCITT

C-message

1 User-entered values are restricted to maximum of 0.9 * Audio BW, and will automatically adjust downward to meet this limit (if required) when
AudioBW is decreased.

Standard. Use this setting to specify the telecom weighting filter. The characteristics of these filters are
described in ITU-T Recommendation O.41, Psophometer for Use on Telephone-type Circuits.

Using Custom Audio Filters

If you want to use audio filters that have a different response shape than the pre-defined filters, you can
create a custom audio filter using a text or CSV file to specify the desired filter frequency response.

To use a custom audio filter:

1. Verify that Audio Spectrum or Audio Summary is the selected display.
Click the Settings icon or select Setup > Settings.

Select the Audio Filters tab.

Click the File button.

A

Click the ... button and navigate to the location of the custom audio filter file you wish to use. Select
the file you want to use and click Open.

6. Acquire a new trace or replay a saved file to see the effect of the custom filter.
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Creating a Custom Audio Filter. A custom audio filter file is either a plain text file or a CSV format file.
The file contains frequency (in Hz) and amplitude (in dB) value pairs which specify the filter frequency
response shape. Each pair must be on a separate line. The filter response between the points is interpolated
using a cubic spline fit.

The following table shows the first few lines of a custom audio filter text file.

0, -100
16.66, -85
50, -63
100, -41
200, -21
300, -10.6
400, 6.3
500, -3.6
600, -2
700, 0.9
800, 0

Format and rule-checking on custom audio filter files is performed as follows:
®  The maximum number of frequency and amplitude pairs is 1000.
B Column 1 (frequency values in Hertz).

- Non-negative values only (zero is allowed).

= Strictly increasing order of frequencies (frequency value on each line > frequency value on
previous line).

= There is no upper limit on the frequency value.

®  Column 2 (amplitude values in dB units, where gain is a positive value and attenuation is a negative
value).

= Values are restricted to the range -200 to +20 dB.

Scale Tab

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change acquisition control settings. In effect,
these controls operate like pan and zoom controls.
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Scale Tab

Pararnsl | Params2 | Audio Filters | Scale | Prefs

Wertical Horizortal
Scale: Left: 0.0000 Hz
Pasition; Reset Scale Right:  200.0 kHz
Log m
Setting Description
Vertical
Scale Changes the range shown between the top and bottom of the graph.
Position Adjusts the level shown at the top of the graph for linear units or the top of the graph
for log units (for example, dBm).
Autoscale Resets the Position so that the highest trace points are in the graph. For linear units
(Volts, Watts), the Autoscale also adjusts Scale.
Horizontal
Left Changes the frequency shown at the left side of the graph.
Right Changes the frequency shown at the right side of the graph.
Autoscale Resets the Left and Right settings to show the entire trace.
Log Sets the graph horizontal axis to a logarithmic scale.
Reset Scale Resets the Vertical and Horizontal settings to their default values.
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Hum & Noise Tab

280

Hum & Noise (available only when the Audio Summary display is the active display) is useful for
comparing residual power or modulation if the Ref value is captured when the Signal is On (Direct) or
modulated (AM/FM/PM). When the signal is turned off (Direct) or modulation turned off (AM/FM/PM),
Diff indicates how much residual Hum and Noise are still present in the measurement value.

Pararnsl | Params2 | Audio Fitters | Hurm 8 Noise

| Measure Hum & Moise:

Capture reference now

To display Hum & Noise measurement:

Select Setup > Displays.

In the Select Displays window, select the Audio Analysis folder.

Double-click the Audio Summary icon so that it appears in the Selected displays box.
Click OK

With the Audio Summary display selected, select Setup > Settings.

LA D o

Select the Hum & Noise tab. Click on the Measure Hum & Noise checkbox so that it is checked.
The Hum & Noise values appear at the bottom list of measurements in the Audio Summary display.
7. Acquire an appropriate signal.

8. While the analyzer is analyzing a signal you want to use as a reference, click the Capture reference
now button to save a reference value.

The Hum & Noise measurement compares the value of a specific signal quantity captured by the Capture
reference now button with the current measured value of that quantity. For Direct signal types (set on the
Params] tab), the Signal Level is captured and compared. The Diff measurement is:

SignalLevel(current) - SignalLevel(Ref)
in dB.

For AM, FM, and PM signal types, the RMS modulation value (related to Modulation Depth, Frequency
Deviation or Phase Deviation) is captured and compared. The Diff measurement is:

20 x logio (RMS(current)/RMS(Ref))
in dB.
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Prefs Tab

The Prefs tab enables you to change appearance characteristics of the Audio Spectrum display.

|Paramsl | Params2 | &udio Filters IScaIe | Prefs |

Units: |dBHz= - Trace points: | 801 -
[¥] Shaw agraticule [V] Sy Marker readaut in graph (selected marker)

Shiow Morm-Harm —r—
Threshold: l|ne L, ]

Setting Description

Units: Specifies the vertical scale units. The units available depend on the signal type selected.
Show graticule Select to display or hide the graticule.

Trace points Sets the number of trace points used for marker measurements and for results export.

Show Marker readout in graph Shows or hides the readout for the selected marker in the graph area.
(selected marker)

Show Non-Harm Threshold Shows or hides the non-harmonic threshold line.
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GP Digital Modulation Overview

Overview

The displays in the General Purpose (GP) Digital Modulation folder (Displays > Folders > GP Digital
Modulation) are:

m  Constellation

B DemodI & Q vs Time

®  EVM vs Time

m  Eye Diagram

B Frequency Deviation vs Time
B Magnitude Error vs Time

®m  Phase Error vs Time

B Signal Quality

®  Symbol Table

®  Trellis Diagram

The General Purpose Digital Modulation Analysis (Option 21) provides vector signal analyzer
functionality. A wide variety of modulation types are supported, allowing you to view your signals in
Constellation, Eye and Trellis diagrams, measure the quality of the modulation, display time-domain
waveforms for demodulated I & Q signals, EVM, Phase Error, Magnitude Error, and more.

Modulation Measurements

NOTE. A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital
Modulation measurements (the actual value varies with modulation type).

SPECMON3 & SPECMONG Printable Help

283



GP Digital Modulation Constellation Display
Measurement Description
EVM The normalized RMS value of the error vector between the measured signal and the ideal

Constellation Display

284

reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and can be reported in units of percent or dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.

Phase Error

The RMS phase difference between the measured signal and the ideal reference signal.

Magnitude Error

The RMS magnitude difference between the measured signal and the ideal reference
signal.

1Q Origin Offset

The magnitude of the DC offset of the signal measured at the symbol times. It indicates
the magnitude of the carrier feed-through signal.

Gain Imbalance

The gain difference between the | and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different from
height.

Rho p

The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

Frequency Error

The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the analyzer.

Quadrature Error

The orthogonal error between the | and Q channels. The error shows the phase
difference between | and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Constellations with quadrature error will show some leakage of
l'into Q and vice versa.

The Constellation Display shows a digitally-modulated signal in constellation form.

To show the Constellation Display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select GP Digital Modulation.

3. Double-click the Constellation icon in the Available Displays box. This adds the Constellation icon
to the Selected displays box.

4. Click the OK button. This shows the Constellation display.

SPECMON3 & SPECMONG Printable Help



GP Digital Modulation

Constellation Settings

Elements of the Constellation Display

B Ele vew Run  Markers Setup Took Window Help

=) “ Freq:2.00000GHz  © Reflev: 0.00 dBm

f
@ Freq Emor: -1.112 Hz, Auto

Marker: MR

Time:  12.00 Sym
Mag: 0.998
Phase: -134.8°
Symbol: 12

Value: 00

@ ‘ RMS: 0.278 % Peak EVM: 0.621% @ 49.00 Sym
Stopped ACQ Bvv: 5.ul TIHZ, ACQ Lengen: 197.590 US

Real Time | Free Run l|ef: Int | Atten: 25 dB

0169-024

®

Item Display element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows
when the Constellation display is the optimized display.

2 Marker Readout Located to the left of the constellation plot or below it, depending on the size of
the window. If markers are enabled, the marker readout shows the time, mag,
phase, symbol marker and symbol value of the point with the selected marker.

3 EVM Readouts The EVM readouts are located below the Constellation plot. The readout
shows EVM Peak (%) and location, RMS (%).

4 Plot Constellation graph.

Changing Constellation Settings (see page 285)

Constellation Settings

Menu Bar: Setup > Settings
Front Panel: Settings

Application Toolbar: &t

The settings for the Constellation view are shown in the following table.
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GP Digital Modulation Demod I & Q vs Time Display

NOTE. You might be able to save time configuring the Constellation display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 308)

Settings tab Description

Modulation Params (see Specifies the type of modulation, symbol rate, and filters to be used in demodulating

page 309) the input signal.

Freg & BW (see page 313) Sets values for frequency error/offset, measurement bandwidth, and frequency deviation
(not every control is present for every modulation type).

Equalizer Tab (see page 314) Enable the Equalizer and adjust its parameters.

Advanced Params (see Specifies additional parameters that are less frequently used.

page 316)

Find (see page 319) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 319) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital

Modulation displays.
Trace (see page 321) Allows you to set the trace display characteristics.
Prefs (see page 323) Enables you to set characteristics of the measurement display.

Demod | & Q vs Time Display

286

The Demod I & Q vs Time displays demodulated I and Q vs. Time. You can choose to display I only,
Q only, or both.

Elements of the Display

To show the Demod I & Q vs Time display:

1. Seclect the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Folders box, select GP Digital Modulation.

3. Double-click the Demod I1&Q vs Time icon in the Available Displays box. This adds the Demod
1&Q vs Time icon to the Selected displays box.

4. Click the OK button. This shows the Demod 1&Q vs Time display.
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X,
@ ¥ Freq Eor: 133.3 Hz, Auto

‘ | o 540 my
© Position:
0.000 W
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[
\ f
| {
iy
\
R, T
|‘ Autsscale | © Position: 14.00 Sym < Scale: 30.00 Sym
‘ 1
0519:034

Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows
when the Demod | & Q vs Time display is the optimized display.

2 Top of Graph Sets the | and Q amplitude value indicated at the top of the graph. Changing
the top value affects the bottom of graph readout. Also, note that the top of
graph setting interacts with the internal vertical scale setting (which is not
user settable) such that the range between the top and bottom of the graph
increases or decreases automatically.

3 Position Specifies the | and Q amplitude value shown at the center of the graph display.

4 Bottom Readout Displays the | and Q amplitude value shown at the bottom of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Position Specifies the horizontal position of the trace on the graph display.

7 Scale Adjusts the span of the graph. By decreasing the scale (time per division), the
graph essentially becomes a window that you can move over the acquisition
record by adjusting the offset.

8 Freq Error This readout can show Freq Error or Freq Offset. When it displays Freq

Error, it shows the difference between the instrument Frequency setting and
the measured value of the signal's carrier frequency. When it displays Freq
Offset, it shows the frequency offset specified on the Settings > Freq & BW
(see page 313) tab. If Freq Error is displayed, it also indicates that the Carrier
frequency detection setting is Auto. If Freq Offset is displayed, it indicates
that the Carrier frequency detection setting is manual.
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Demod I & Q vs Time Settings

Changing Demod 1&Q Settings. (see page 288)

Demod | & Q vs Time Settings

Menu Bar: Setup > Settings

Front Panel: Settings

Application Toolbar: &

The settings for the Demod I & Q vs Time display are shown in the following table.

NOTE. You might be able to save time configuring the Demod I & Q display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 308)

Settings tab

Description

Modulation Params (see

page 309)

Specifies the type of modulation used for the input signal and other parameters.

Freg & BW (see page 313)

Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Equalizer Tab (see page 314)

Enable the Equalizer and adjust its parameters.

Advanced Params (see

page 316)

Specifies additional parameters.

Find (see page 319)

Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 319)

Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 321) Allows you to set the trace display characteristics.
Scale (see page 323) Specifies the horizontal and vertical scale settings.
Prefs (see page 323) Enables you to set characteristics of the measurement display.

EVM vs Time Display

The EVM vs. Time Display shows the Error Vector Magnitude plotted over Time.

NOTE. A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital
Modulation measurements (the actual value varies with modulation type).
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To show an EVM vs. Time display:
1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Folders box, select GP Digital Modulation.

3. Double-click the EVM vs. Time icon in the Available Displays box. This adds the EVM vs. Time
icon to the Selected displays box.

4. Click the OK button. This displays the EVM vs. Time view.

Elements of the EVM vs Time Display

‘ ‘J Freq Error: 133.3 He, Auto
o 164 %

i
. ‘H HW‘(“N \] N ‘l‘“ |
i I '.M.p,w"\, r‘n ”4'\||,|"'|) ”'; ‘Hd \'I"

o jon:
H 0,083 % .
[ #utoscale | o pogtion: 15,00 9vm & Scale: 128,00 Sym
URMS: 0,387 % Peak: 1.292 % @ 135.00 Sym
\ J.
i 0519035

@ H"m \H \M‘l“ ‘J'.I' ! L'\H‘" |
ki

Positi

Item Display element Description

1 Top of graph adjustment Use the knob to adjust the vertical scale.

2 Position Adjusts the vertical position.

3 Autoscale Adjusts the Horizontal and Vertical scale to show the entire trace.

4 Peak and RMS value readout Shows the maximum result, the time it occurred, and the RMS of the result

over the entire analysis length.
5 Scale Sets the length of time shown in the graph.

Changing the EVM vs Time Display Settings (see page 289)

EVM vs Time Settings

Menu Bar: Setup > Settings
Front Panel: Settings

Application Toolbar: o
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Eye Diagram Display

The settings for the EVM vs. Time display are shown in the following table.

NOTE. You might be able to save time configuring the EVM vs. Time display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 308)

Settings tab

Description

Modulation Params (see

page 309)

Specifies the type of modulation used in the input signal and other parameters that
controls the demodulation of the input signal.

Freq & BW (see page 313)

Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Equalizer Tab (see page 314)

Enable the Equalizer and adjust its parameters.

Advanced Params (see

page 316)

Specifies Freq Offset, Magnitude normalization parameters, and enables swapping
land Q.

Find (see page 319)

The Find tab is used to set parameters for finding bursts within the data record.

Analysis Time (see page 319)

The Analysis Time tab contains parameters that define how the signal is analyzed in the
general purpose digital modulation displays.

Trace (see page 321) Specifies the display characteristics of the displayed trace.
Scale (see page 323) Specifies the horizontal and vertical scale settings.
Prefs (see page 323) Specifies whether certain display elements are visible.

Eye Diagram Display

The Eye Diagram Display shows a digitally modulated signal overlapped on itself to reveal variations in

the signal.

To show an Eye Diagram display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select GP Digital Modulation.

3. Double-click the Eye Diagram icon in the Available Displays box. This adds the Eye Diagram icon
to the Selected displays box.

4. Click the OK button. This displays the Eye Diagram view.
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Elements of the Display
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Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows
when the Frequency Deviation vs Time display is the optimized display.

2 Top of Graph The vertical scale is normalized with no units (except for nFSK and C4FM
modulation types where the vertical units are Hz).

3 Position Specifies the value shown at the center of the graph display.

4 Bottom Readout Displays the value indicated by the bottom of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Position Displays the horizontal position of the trace on the graph display.

7 Scale Adjusts the span of the graph in symbols.

8 Freq Error Displays the difference between the maximum and minimum measured

values of the signal frequency during the Measurement Time. The displayed
frequency error is followed by either Auto or Manual. This indicates the
selected carrier frequency detection method (see Settings > Freq & BW).

Changing Eye Diagram Settings (see page 291)

Eye Diagram Settings

Menu Bar: Setup > Settings

Front Panel: Settings

SPECMON3 & SPECMONG Printable Help 291



GP Digital Modulation

Application Toolbar: &

Frequency Deviation vs Time Display

The settings for the Eye Diagram display are shown in the following table.

NOTE. You might be able to save time configuring the Eye Diagram display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 308)

Settings tab Description

Modulation Params (see Specifies the type of modulation used for the input signal and other parameters.

page 309)

Freq & BW (see page 313) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each

of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see

page 316)

Specifies additional parameters.

Find (see page 319)

Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 319)

Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 321) Allows you to set the trace display characteristics.
Scale (see page 323) Specifies the horizontal and vertical scale settings.
Prefs (see page 323) Enables you to set characteristics of the measurement display.

Frequency Deviation vs Time Display

To show a Frequency Deviation vs Time display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select Frequency Deviation vs Time.

3. Double-click the Frequency Deviation vs Time icon in the Available Displays box. This adds the
Frequency Deviation vs Time icon to the Selected displays box.

4. Click the OK button. This displays the Frequency Deviation vs Time view.

292
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Elements of the Display

Markers o Freq: 1.000000 GHz & RefLev: 0.00 dBm

< FreqError: 6.506 mHz, Auto
© 27.7 kHz

© Position
1.35Hz

-27.7 kHz

@ @ Position: 44.00 Sym  Scale: 30.00 Sym
Stopped Acqg F|W: 312.50 kHz, Acg Length: 4.014 ms Real Time Free Run Ref: Int Atten: 25 dB

Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows
when the Frequency Deviation vs Time display is the optimized display.

2 Top of Graph Sets the frequency deviation value indicated at the top of the graph. Changing
the top value affects the bottom of graph readout. Also, note that the top of
graph setting interacts with the internal vertical scale setting (which is not
user settable) such that the range between the top and bottom of the graph
increases or decreases automatically.

3 Position Specifies the frequency deviation value shown at the center of the graph
display.

4 Bottom Readout Displays the value of the frequency deviation value shown at the bottom
of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

Position Specifies the horizontal position of the trace on the graph display.

Scale Adjusts the span of the graph. By decreasing the scale (time per division), the
graph essentially becomes a window that you can move over the acquisition
record by adjusting the offset.

8 Freq Error Displays the difference between the maximum and minimum measured

values of the signal frequency during the Measurement Time. The displayed
frequency error is followed by either Auto or Manual. This indicates the
selected carrier frequency detection method (see Settings > Freq & BW).
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Frequency Deviation vs Time Settings

Changing Frequency Deviation vs Time Settings (see page 294)

Frequency Deviation vs Time Settings

Menu Bar: Setup > Settings

Front Panel: Settings

Application Toolbar: &

The Setup settings for Frequency Deviation vs. Time are shown in the following table.

NOTE. You might be able to save time configuring the Frequency vs. Time display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 308)

Settings tab

Description

Modulation Params (see

page 309)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 313)

Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Equalizer Tab (see page 314)

Enable the Equalizer and adjust its parameters.

Advanced Params (see

page 316)

Specifies additional parameters.

Find (see page 319)

Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 319)

Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 321) Allows you to set the trace display characteristics.
Scale (see page 323) Specifies the horizontal and vertical scale settings.
Prefs (see page 323) Enables you to set characteristics of the measurement display.

Magnitude Error vs Time Display

The Magnitude Error displays the magnitude of the symbol error. The amplitude appears on the vertical
axis while time is plotted along the horizontal axis.

NOTE. A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital
Modulation measurements (the actual value varies with modulation type).
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GP Digital Modulation

To display Magnitude Error vs. Time:

Magnitude Error vs Time Display

1. Select the Displays button or Setup > Displays. This displays the Select Displays dialog box.

2. Select GP Digital Modulation in the Folders box.

3. Double-click the Mag Error vs. Time icon or select the icon and click Add. The icon will appear in
the Selected displays box and will no longer appear under Available displays.

4. Click OK.

Elements of the Display
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Item Display element Description

1 Top of graph adjustment Use the knob to adjust the value of the vertical scale.

2 Position Adjusts the level shown at the bottom of the display.

3 Autoscale button Adjusts the vertical and horizontal settings to provide the best display.

4 Horizontal Position Adjusts the horizontal position of the signal. Units can be either Symbols or

Seconds (Settings > Analysis Time tab > Units).

5 Peak and RMS value readout Displays the Peak value of the magnitude error, the RMS value of the
magnitude error, and the time at which it occurs within the acquisition. Units
can be either Symbols or Seconds (Settings > Analysis Time tab > Units).

6 Horizontal Scale Sets the time spanned by the graph. Units can be either Symbols or Seconds
(Settings > Analysis Time tab > Units).

7 Freq Error Freq Error is the difference between the Center Frequency and the measured

frequency of the signal being tested. This readout will be Freq Offset if the
Freq Offset parameter on the Settings > Advanced Params (see page 316)
tab is set to Manual.
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Magnitude Error vs Time Settings

Changing Magnitude Error vs Time Display Settings (see page 296)

Magnitude Error vs Time Settings

Menu Bar: Setup > Settings

Front Panel: Settings

Application Toolbar: &

The Setup settings for Magnitude Errors vs. Time are shown in the following table.

NOTE. You might be able to save time configuring the Magnitude vs. Time display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 308)

Settings tab

Description

Modulation Params (see

page 309)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 313)

Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Equalizer Tab (see page 314)

Enable the Equalizer and adjust its parameters.

Advanced Params (see

page 316)

Specifies additional parameters.

Find (see page 319)

Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 319)

Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 321) Allows you to set the trace display characteristics.
Scale (see page 323) Specifies the horizontal and vertical scale settings.
Prefs (see page 323) Enables you to set characteristics of the measurement display.

Phase Error vs Time Display

The Phase Error vs. Time display shows the phase angle of the symbol error over time. The phase is
plotted along the vertical axis while time is plotted along the horizontal axis.

NOTE. A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital
Modulation measurements (the actual value varies with modulation type).
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To show the Phase Error display:

Phase Error vs Time Display

1. Press the Displays button or select Setup > Displays.

2. In the Select Displays dialog, select GP Digital Modulation in the Folders box.

3. In the Available displays box, double-click the Phase Error icon or select the icon and click Add.
The Phase Error icon will appear in the Selected displays box and will no longer appear under

Available displays.

4. Click OK to display the Phase Error.

Elements of the Phase Error vs Time Display
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Item Display element Description
1 Freq Error Freq Error is the difference between the Center Frequency and the measured
frequency of the signal being tested. This readout will be Freq Offset if the
Freq Offset parameter on the Settings > Advanced Params (see page 316)
tab is set to Manual.
Top of graph adjustment Adjusts the phase angle shown at the top of the graph.
Position Adjusts the vertical offset.
4 Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the
graph.
Offset Adjusts the horizontal offset.
Peak and RMS readouts Displays the Peak value of the phase error and the time at which it occurred.
Also displays the RMS value over the analysis length.
7 Scale Sets the time spanned by the graph.
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Phase Error vs. Time Settings

Changing the Phase Error vs Time Display Settings (see page 298)

Phase Error vs. Time Settings

Menu Bar: Setup > Settings

Front Panel: Settings

Application Toolbar: &

The settings for the Phase Error vs. Time display are shown in the following table.

NOTE. You might be able to save time configuring the Phase Error vs. Time display by pressing the
Standard Settings button from the Settings control panel. This allows you to select a preset optimized for a
standard from the Select Standard dialog box. See Standard Settings Button. (see page 308)

Settings tab

Description

Modulation Params (see

page 309)

Specifies the type of modulation used for the input signal and other parameters.

Freg & BW (see page 313)

Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Equalizer Tab (see page 314)

Enable the Equalizer and adjust its parameters.

Advanced Params (see

page 316)

Specifies additional parameters.

Find (see page 319)

Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 319)

Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 321) Allows you to set the trace display characteristics.
Scale (see page 323) Specifies the horizontal and vertical scale settings.
Prefs (see page 323) Enables you to set characteristics of the measurement display.

Signal Quality Display

The Signal Quality display shows several measurements of signal quality. The measurements displayed
depend on the modulation type. There is a set of measurements displayed for all modulation types except
nFSK and C4FM. There is a second set of measurements displayed for nFSK and C4FM modulation types.
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Signal Quality = (-5 |[Es)
v
ey Peak facation
EWM; 47,893 % Q7,092 %% 4,14 kSym
-6.395 dB -0.256 dB
Phase Error: 25,803 45,376 ° 4,26 kSym
Mag Errar: 18,943 % 54,693 % 248,00 Sy
MER (RMS): 6.395 dB Rho: 0.783798
10 Origin Offset:  -48.637 dB Frequency Error:  -542.2 kHz
Gain Imbalance:  -0.019 dB Quadrature Error: 0,211 °

Signal Quality display for all modulation types except nFSK, C4FM, OQPSK, and SOQPSK
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Signal Quality display for OQPSK and SOQPSK modulation types
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Signal Quality
<
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Signal Quality display for nFSK modulation type

"\ Signal Quality
+

Modulation Fidelity

RMS Error Magnitude:
Carrier Frequency Error:
Deviation:

Length:

0.116 %
111.2 mHz
399.2 Hz
128 Sym

Signal Quality display for C4FM modulation type
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Signal Quality Display
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Elements of the Display

Measurements for all modulation types except nFSK, C4FM, OQPSK and SOQPSK

Measurement Description

EVM The normalized RMS value of the error vector between the measured signal and the ideal
reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of 1/Q signal power to I/Q noise power; the result is
indicated in dB.

1Q Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates
the magnitude of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Gain Imbalance The gain difference between the | and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different form
height.

Quadrature Error The orthogonal error between the | and Q channels. The error shows the phase

difference between | and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Not valid for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.
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Signal Quality Display

Measurements for OQPSK and SOQPSK modulation types

Measurement

Description

EVM

The normalized RMS value of the error vector between the measured signal and the ideal
reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Offset EVM

Offset EVM is like EVM except for a difference in the time alignment of the | and Q
samples. For EVM, | and Q samples are collected at the same time, for every symbol
decision point (twice the symbol rate for offset modulations). For Offset EVM, the | and Q
symbol decision points are time-aligned before collecting the | and Q samples. In this
case, one | and one Q sample is collected for each symbol (half as many samples as the
same number of symbols for (non-offset) EVM.

Phase Error

The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is
indicated in dB.

1Q Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates

the magnitude of the carrier feed-through signal.

Frequency Error

The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Gain Imbalance

The gain difference between the | and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different form
height.

Quadrature Error

The orthogonal error between the | and Q channels. The error shows the phase
difference between | and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Not valid for BPSK modulation type.

Rho

The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.
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Signal Quality Settings

Measurements for nFSK modulation types

Measurement Description
Peak FSK err Peak value of the frequency deviation error at the symbol point.
RMS FSK Err RMS value of the frequency deviation error at the symbol point.

Peak Mag Err

The Peak magnitude difference between the measured signal and the reference signal
magnitude.

RMS Mag Err The RMS magnitude difference between the measured signal and the reference signal
magnitude.
Freq Error The frequency difference between the measured carrier frequency of the signal and the

user-selected center frequency of the instrument.

Freq Deviation

Frequency distance from the center frequency at the symbol point.

Symbol Rate Error

This compares the user-entered symbol rate to the instrument calculated symbol rate of
the analyzed signal.

Symbol Rate

When in Auto-symbol rate, the instrument calculates the symbol rate of the signal and
the instrument calculates the error between the user entered value and the instrument
calculated value.

Measurements for C4FM modulation type

Measurement

Description

RMS Error Magnitude

RMS value of the frequency deviation error at the symbol point.

Carrier Frequency Error

Frequency difference between averaged signal frequency and the center frequency.

Deviation

Frequency distance from the center frequency at the symbol point.

Length

Number of symbols in the analysis area.

Changing the Signal Quality Display Settings (see page 303)

Signal Quality Settings

Menu Bar: Setup > Settings

Front Panel: Settings

Application Toolbar: &

The Setup settings for Signal Quality are accessible only when the Signal Quality display is selected.

NOTE. You might be able to save time configuring the Signal Quality display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 308)
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Settings tab Description
Modulation Params (see The Modulation tab specifies the type of modulation used for the input signal and other
page 309) parameters.
Freq & BW (see page 313) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each

of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Equalizer Tab (see page 314)

Enable the Equalizer and adjust its parameters.

Advanced Params (see

page 316)

The Advanced Params tab specifies frequency offset, magnitude normalization method
and allows you to swap the | and Q signals.

Find (see page 319)

Find tab is used to set parameters for finding bursts within the data record.

Analysis Time (see page 319)

The Analysis Time tab contains parameters that define the portion of the acquisition
record that is used for analysis.

Prefs (see page 323)

The Prefs tab enables you to set characteristics of the measurement display.

Symbol Table Display

304

The Symbol Table Display is like the Constellation Display except that a text table is used to display data
bits at a symbol rather than a graph. The Synch Word characters, if used, are in bold font.

To display the Symbol Table:

1. Select the Displays button or select Setup > Displays. This displays the Select Displays dialog box.

2. From the Folders box, select GP Digital Modulation.

3. Double-click the Symbol Table icon in the Available Displays box. This adds the Symbol Table icon

to the Selected displays

box.

4. Click the OK button. This displays the Symbol Table view.

Marker: M1

Time:  0.00 Sym Walue: 10

Symbol: O
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Using Markers

Markers are indicators in the display that you can position on a trace to measure values such as frequency,
power, and time. A Marker always displays its position and, if the Delta readout is enabled, will display
the difference between its position and that of the Marker Reference. Within the Symbol Table, colored
cells indicate the location of markers. The selected Marker is highlighted with a light green background.
All other markers are highlighted with a light gray background. In the Symbol Table, the marker readout
below the table shows the marker location in time, symbol numbers and symbol value.

Changing the Symbol Table Display Settings (see page 305)

Symbol Table Settings

Menu Bar: Setup > Settings

Front Panel: Settings

Application Toolbar: &

The Setup settings for the Symbol Table view are shown in the following table.

NOTE. You might be able to save time configuring the Symbol Table display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 308)

Settings tab Description

Modulation Params (see The Modulation tab specifies the type of modulation used for the input signal and other
page 309) parameters.

Freq & BW (see page 313) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each

of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Equalizer Tab (see page 314) Enable the Equalizer and adjust its parameters.

Advanced Params (see The Advanced Params tab specifies additional parameters.

page 316)

Find (see page 319) Find tab is used to set parameters for finding bursts within the data record.

Analysis Time (see page 319) The Analysis Time tab contains parameters that define the portion of the acquisition
record that is used for analysis.

Prefs (see page 323) The Prefs tab enables you to set characteristics of the measurement display.

Trellis Diagram Display

To show an Trellis Diagram display:
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1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

N

From the Folders box, select GP Digital Modulation.

w

Double-click the Trellis Diagram icon in the Available Displays box. This adds the Trellis Diagram
icon to the Selected displays box.

=

Click the OK button. This displays the Trellis Diagram view.

Elements of the Display
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Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows
when the Frequency Deviation vs Time display is the optimized display.

2 Top of Graph Sets the phase value indicated at the top of the graph. Changing the top value
affects the bottom of graph readout. Also, note that the top of graph setting
interacts with the internal vertical scale setting (which is not user settable)
such that the range between the top and bottom of the graph increases or
decreases automatically.

3 Position Specifies the phase value shown at the center of the graph display.

4 Bottom Readout Displays the value of the phase value shown at the bottom of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Position Displays the horizontal position of the trace on the graph display.

7 Scale Adjusts the span of the graph in symbols.

8 Freq Error Displays the difference between the maximum and minimum measured

values of the signal frequency during the Measurement Time. The displayed
frequency error is followed by either Auto or Manual. This indicates the
selected carrier frequency detection method (see Settings > Freq & BW).
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Trellis Diagram Settings

Changing the Trellis Diagram Settings (see page 307)

Trellis Diagram Settings

Menu Bar: Setup > Settings

Front Panel: Settings

Application Toolbar: &

The settings for the Trellis Diagram display are shown in the following table.

NOTE. You might be able to save time configuring the Trellis Diagram display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 308)

Settings tab

Description

Modulation Params (see

page 309)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 313)

Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Equalizer Tab (see page 314)

Enable the Equalizer and adjust its parameters.

Advanced Params (see

page 316)

Specifies additional parameters.

Find (see page 319)

Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 319)

Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 321) Allows you to set the trace display characteristics.
Scale (see page 323) Specifies the horizontal and vertical scale settings.
Prefs (see page 323) Enables you to set characteristics of the measurement display.

GP Digital Modulation Shared Measurement Settings

The displays in the GP Digital Modulation folder (Setup > Displays) are each a different format for
presenting the results of a single underlying analysis. For this reason, all controls that affect the analysis
parameters are shared by all the displays in the GP Digital Modulation folder.

Changing a setting on one tab changes that setting for all the GP Digital Modulation displays. For
example, if you change the Modulation Type for the Constellation Display, it also changes the Modulation
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type setting for the Signal Quality display. There are some controls that affect only the way an individual
display presents its results, such as graph scaling.

Common controls for GP digital modulation displays

Settings tab Description

Modulation Params (see Specifies the type of modulation, symbol rate, and filters to be used in demodulating
page 309) the input signal.

Freq & BW (see page 313) Sets values for frequency error/offset, measurement bandwidth, and frequency deviation

(not every control is present for every modulation type).
Equalizer Tab (see page 314) Enable the Equalizer and adjust its parameters.

Advanced Params (see Specifies additional parameters that are less frequently used.

page 316)

Find (see page 319) Used to set parameters for finding a burst within the data record and for entering a Synch
word.

Analysis Time (see page 319) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 321) Allows you to set the trace display characteristics.

Prefs (see page 323) Enables you to set characteristics of the measurement display.

Standard Settings Button

308

On every GP Digital Modulation control panel there is a button labeled Standard Settings. This button is
used to recall settings optimized for analyzing the selected standard. See the following table for a list of
the standards for which standard settings are available. Choosing a standard from the dialog box changes
only settings for GP Digital Modulation displays.

All of the presets in the Standard Settings Dialog make the following settings:
®m  Analysis Length: Auto

B Points per Symbol: 4

B Data Differential: No

®  Burst Mode: Off

B Burst Detection Threshold: -10 dBc
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Parameter values set by presets in the standard settings dialog

Standard Modula- Symbol Meas. Reference Filter Other
tion Rate Filter Filter Parameter
802.15.4 OQPSK 1e6 None Half sine NA
SBPSK-MIL SBPSK 2.4e3 None SBPSK- NA
MIL
SOQPSK-MIL SOQPSK 2.4e3 None SOQPSK- NA 1
MIL
CPM-MIL CPM 19.2e3 None None NA
SOQPSK-ARTM Tier 1 SOQPSK 2.5e6 None SOQPSK- NA 1
ARTM
Project25 Phase 1 C4FM 4.8e3 C4FM-P25 RC 0.2
CDMA2000-Base QPSK 1.2288¢6 IS-95 TXE- IS-95 REF NA
Q_MEA
W-CDMA QPSK 3.84e6 RRC RC 0.22

1 Center Symbol Position, Half Shift Removed

Modulation Params Tab

Menu bar: Setup > Settings > Modulation Params

The Modulation Params tab specifies the type of modulation on the input signal and other parameters
that control the demodulation of the input signal.

Modulation Params | Freqg & B | Advanced Params | Find | Analysis Time | Trace | scale | prefs |

Modulation type: |QPSK - Measurerment Filter: [Root raised cosine v]

Syrbol Rate: 40 kHz Reference Filter: ’Raised Cosine v]

Filter Parameter: 0.300

Parameter Description

Modulation type Specifies the type of modulation on the input signal.

Symbol Rate Specifies the symbol rate in Hertz.

Measurement Filter Specifies the filter used for measurements.

Reference Filter Specifies the filter used as a reference.

Filter Parameter Enter a value used for defining the Reference Filter. (Not present for some filter types)
Modulation index (Present only for CPM modulation type)

Modulation Type

The modulation types that can be demodulated and analyzed are:
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Modulation type Description
QPSK Quadrature Phase Shift Keying
8PSK 8-Phase Shift Keying
D8PSK Differential Eight Phase Shift Keying
D16PSK Differential Sixteen Phase Shift Keying
PI/2DBPSK Pi/2 Differential Binary Phase Shift Keying
DQPSK Differential Quadrature Phase Shift Keying
PI/ADQPSK Pi/4 Differential Quadrature Phase Shift Keying
BPSK Binary Phase Shift Keying
OQPSK Offset Quadrature Phase Shift Keying
16QAM 16-state Quadrature Amplitude Modulation
32QAM 32-state Quadrature Amplitude Modulation
64QAM 64-state Quadrature Amplitude Modulation
128QAM 128-state Quadrature Amplitude Modulation
256QAM 256-state Quadrature Amplitude Modulation
MSK Minimum Shift Keying
2FSK 2-Frequency Shift Keying
4FSK 4-Frequency Shift Keying
8FSK 8-Frequency Shift Keying
16FSK 16-Frequency Shift Keying
CPM Continuous Phase Modulation
SOQPSK Shaped Offset Quadrature Phase Shift Keying
SBPSK Shaped Binary Phase Shift Keying
C4FM Constant Envelope 4-Level Frequency Modulation
Symbol Rate

Specifies the symbol rate for demodulating digitally modulated signals. The symbol rate and the bit rate

are related as follows:
(Symbol rate) = (Bit rate)/(Number of bits per symbol)

For example, the number of bits per symbol is 3 for 8PSK.

Measurement and Reference Filters

The available measurement and reference filters depend on the selected modulation type. If a particular
filter is not practical for a selected modulation type, it is not presented as an available filter. To determine
which filters are available, make certain that your desired modulation type is selected. See the following
table.
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GP Digital Modulation Modulation Params Tab
Modulation type Measurement filters Reference filters
BPSK None None
PI/2DBPSK RootRaisedCosine RaisedCosine
8PSK RaisedCosine Gaussian
D8PSK Gaussian User
DQPSK User Rectangular (freq)
PI/4DQPSK Rectangular (freq) IS-95REF
16QAM IS-95TX_MEA
320AM IS-95TXEQ_MEA
64QAM
128QAM
256QAM
QPSK
MSK None None
Root Raised Cosine Gaussian
RaisedCosine User
Gaussian
User
Rectangular (freq)

0QPSK None None
RootRaisedCosine Half sine
User RaisedCosine
IS-95TX_MEA User
IS-95TXEQ_MEA IS-95REF

SOQPSK None SOQPSK-MIL
User SOQPSK-ARTM

User

CPM None None
User User

2FSK None None

4FSK Gaussian Gaussian

8FSK RootRaisedCosine RaisedCosine

16FSK RaisedCosine User
Rectangular (freq)
User

C4FM C4FM-P25 RaisedCosine

User

SBPSK None SBPSK-MIL

User User
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312

The measurement filter is applied before the demodulation bit is detected and the ideal reference is
calculated.

The reference filter is applied to the internally generated ideal reference signal before the EVM is
calculated.

How to Select Filters

In a signal transmitter/receiver system, the baseband signal might be filtered for bandwidth limiting or for
another kind of necessary shaping that needs to be applied. Normally, a filter in the transmitter (Ft) and a
filter in the receiver (Fr) are applied.

The Measurement Filter setting in the analyzer corresponds to the baseband filter in the receiver (Fr): This
setting tells the analyzer what filter your receiver uses. When the analyzer is set to the same filter used by
the receiver, the analyzer sees the signal as your receiver would. The Measurement Filter setting should be
the same as the filter used in the receiver under normal operation (as opposed to testing).

The Reference Filter setting in the analyzer corresponds to the baseband filter in the transmitter-receiver
combination (Fr * Ft). The baseband filter for the transmitter-receiver combination is often referred to as
the System Filter. This filter is called the reference filter because it is used to recreate a reference signal
that is compared to the received signal. This recreated reference signal is the ideal signal with Fr * Ft
applied; differences between this ideal signal and the received signal enables the determination of signal
quality, such as EVM measurements.

The following is an example of a hypothetical signal that is transmitted into a vector signal analyzer
for analysis:

Assume that a signal is transmitted using a baseband filter (Ft). It then travels through a transmission
medium (air/cable/etc) where it may affected by the communication channel (Fc). The signal is received
and filtered by the receiver’s filter (Fr). At this point, the signal has passed through Ft and Fr, and in
addition, the communication channel might have affected it (so: Ft * Fr * Fc). This double-filtered
signal is demodulated as it was received to determine the symbols/bits in it. The obtained bits are used
to regenerate a baseband ideal signal that can be compared against the received signal to determine
signal quality. However, to determine the effect of the environment on the signal quality, the ideal
signal must be filtered by the REFERENCE FILTER (Ft * Fr), so that the ideal signal and the filtered
signal differ only by the effect of the environment. So, the received signal is the ideal signal filtered by
Ft * Fr * Fc and the reference signal is the ideal signal filtered by Ft * Fr, since they only differ
by the effect of Fc, the comparison will show the effect of the communication channel on the signal.
The communication channel can also include the hardware path the signal follows after (Tx) or before
(Rx) digitizing; this would account for Tx/Rx hardware linear and non-linear distortion.

Common examples of how these filters are used are shown below:

B For Transmit Filter = Root Raised Cosine (RRC), Measurement Filter = RRC, the Reference Filter
= RRC "2 = Raised Cosine

®  For Transmit Filter = Raised Cosine (RC), Measurement Filter = None, the Reference Filter = Raised
Cosine (When the Measurement Filter = None, the Reference Filter = Transmit Filter)

m  For Transmit Filter = Gaussian, Measurement Filter = None, the Reference Filter = Gaussian
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Filter Parameter

The filter parameter specifies the alpha for the Root Raised Cosine or Raised Cosine filter, or the
bandwidth-time product (BT) for the Gaussian filter, when selected as the Reference filter. Some filter
types have a fixed parameter value that is specified by industry standard, while other filter types by
definition have no filter parameter. For filter types with no filter parameter, there is no filter parameter
control present in the control panel.

Freq & BW Tab

The Freq & BW tab specifies a group of settings that affect how measurements are made.

| Modulation Params | Freq & BW | advanced Params | Find | Analysis Time | Trace | Scale | Prefs |

Freguency Error; 152348 Auto
Measurernent By 3052 AN [,&,utu -
Frequency Deviation: 4857 &HF Auto

Freq & BW tab with nFSK or C4FM modulation type selected and Frequency Error readout enabled (Auto selected)

Modulation Params | Fren & BV | Advanced Params | Find | Analysis Time | Trace | Scale | Prefs |

Frequency Error,  -400.8 Hr Auto

Measurernent By 8400 by

Freq & BW tab with SOQPSK modulation type selected and Frequency Offset enabled (Auto deselected)
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Setting Description
Frequency Error / Frequency When Auto is enabled, this readout displays frequency error and the measurement
Offset is made at the calculated frequency. When Auto is disabled, this setting changes to

Frequency Offset. When set to Frequency Offset, this setting is used to demodulate a
signal that is not at the center frequency. The measurement is made at the user-entered
offset. The Measurement Filter (if any, specified on the Modulation Params tab) is applied
about the offset frequency whether set automatically or manually.

Measurement BW This setting allows you to override the automatic bandwidth calculation and directly enter
a bandwidth value. If you enter a value for the measurement bandwidth, be aware that
the actual bandwidth of data provided to the measurement will be at least as wide as
the value you request and may be as much as two times wider than requested. This
override of the selected measurement bandwidth is done so that the instrument uses
sufficient bandwidth relative to the chosen symbol rate to ensure good signal quality
measurements.

Frequency Deviation For nFSK modulation types, this setting specifies the frequency deviation. Select Auto to
make the instrument do this automatically. Deselect Auto to enter a value manually.

This setting is present for only nFSK and C4FM modulation types.

Equalizer Tab

314

The Equalizer tab enables you to apply an adaptive equalizer to a digitally modulated signal to compensate
for linear distortions in the signal. The Equalizer is available only for displays in the GP Digital
Modulation folder (Select Displays window). The analyzer implements a decision directed, feed-forward
FIR filter to correct linear distortion in the input signal.

Modulation Params | Freq & Bw| Equalizer | Advanced Params | Find | Analysis Time | Prefs

V| Enable Equalization Made: |Train - TapsfSyrmbol: |2 -
Reset Equalization Convergence:  0.001 Taps: 81

Length: 41 Sym

Parameter Description

Enable Equalization This setting turns the Equalizer on and off.

Reset Equalization Initializes the equalizer filter for training.

Mode Specifies whether the equalizer is in learning (Train) mode or analysis (Hold) mode.

Convergence Specifies the update rate. Maximum value: 0.002. Default value: 0.0005

Taps/Symbol The number of filter coefficients per symbol used by the filter. Available choices are
1,2,4,and 8.

Taps The number of filter coefficients. Range: 3 to 100 (you can set a higher number, but

100 is the practical limit).

Length Specifies the number of symbols analyzed (or filter length).
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Selecting the Mode

When enabled, the Equalizer is in either Train mode or Hold mode. When the equalizer is in Train mode, it
will update internal filter parameters whenever you adjust the Convergence, Taps/Symbol, Taps, or Length
values. When it is in Hold mode, the Equalizer uses the parameter values (both internal and the values
accessible on the Equalizer tab) in effect when it was placed into Hold mode.

NOTE. The Equalizer does not need to be retrained if the modulation type is changed. You can train the
Equalizer by using a simpler modulation type (such as QPSK), place the Equalizer into Hold mode and
can then measure more complex modulation types such as QAM.

Training the Equalizer

To obtain the desired results using the Equalizer, you must first train the Equalizer. This is an iterative
process where you adjust some filter parameters (and the analyzer adjusts internal parameters) to achieve
the lowest error possible on the acquired signal.

To configure the Equalizer:

Press the Displays button or select Setup > Displays.

In the Select Displays window, select GP Digital Modulation from Folders.
Add Signal Quality to the Selected Displays and select OK.

With the Signal Quality display selected, select Setup > Settings.

Select the Modulation Params tab set the parameters as necessary for the signal.
Select the Equalizer tab.

Set the Convergence value to 0.0005.

Set Taps/Symbol to 2.

S A A A R o

Click the Reset Equalization button to reset the equalizer.

—
(=]

. Set the Mode to Train.

[
j—

Click Enable Equalization so it is checked.

—
N

. On the Signal Quality display, examine the value for EVM.

13. Change the Convergence, Taps/Symbol, and Taps values iteratively to achieve a minimum EVM value.

NOTE. Changing the Taps/symbol or Taps values resets the equalizer.

Using the Equalizer

To use the equalizer:

1. Select and configure a GP Digital Modulation display.
2. Select Setup > Settings.
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3. Select the Equalizer tab.
4. Select Enable Equalization so it is checked.

5. Verify that Mode is set to Hold if you have previously trained the Equalizer. If you have not previously
trained the Equalizer, train the Equalizer (see page 315) and then set the Mode to Hold.

Advanced Params Tab

The Advanced Params tab specifies additional parameters that control the demodulation of the signal.

| Modulation Params I Freg & BW| Advanced Params |Find | Analysis Time I Trace I Scale | Prefs |

Mag Normalze: [RMS Symbal Magnitude = | [ swapIand Q

[ Wser Symbal Map (per Modulation Type):

o]

Advanced Params tab for all modulation types except nFSK and C4FM

| Modulation Params I Freq & ElWl Advanced Params |Find | Analysis Time I Trace I Scale | Prefs |

[ swapland
[7] symbal rate search

[7] User Symbal Map {per Modulation Type):

(-]

Advanced Params tab for modulation type nFSK

| Modulation Params I Freq & BWl Advanced Params |Find | Analysis Time I Trace I Scale | Prefs |

[ Swapland 2

[7] User Syrnbal Map (per Modulation Type):

(-]

Advanced Params tab for modulation type C4FM
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Parameter

Advanced Params Tab

Description

Mag Normalize

(not present for nFSK or C4FM
modulation types)

Select RMS Symbol Magnitude or Max Symbol Magnitude. This setting applies to Mag
Error and EVM.

Swap | and Q

When enabled, the | and Q data are exchanged before demodulating.

Symbol rate search

(Present only for nFSK
modulation types)

Determines whether to automatically detect or manually set the symbol rate. When
selected, automatically detects the symbol rate to perform analysis. The calculated
symbol rate is displayed in the Signal Quality display. The Symbol Rate Error is also
calculated and displayed when Symbol rate search is enabled.

User Symbol Map (per
Modulation Type)

Enables the use of custom symbol maps. This enables you to specify the location of
symbols in the display. This control can be set independently for each of the modulation
types.

Mag Normalize

Specifies whether Magnitude Normalization uses the RMS Symbol Magnitude or the Maximum Symbol
Magnitude as the basis for normalization. Use RMS Symbol Magnitude on QPSK modulations (equal
magnitude symbol locations), and use Maximum Symbol Magnitude for signals that have a large difference
in magnitude among the symbol locations (such as 128QAM). It prevents the instrument from using the
very low magnitude center symbols when normalizing the constellation. The outer symbols are a better
normalization reference than the center in this case.

Swap | and Q

Use the Swap I and Q control to correct a signal sourced by a downconverter that inverts the frequency

of the signal under test.

User Symbol Map

A User Symbol Map is a text file that specifies the location of symbols in the display. The symbol map
is unique for each modulation type. The easiest way to create a custom symbol map is to start with
the default symbol map and modify it. The default symbol map file is located at C:\RSA6100B Files.
The default symbol map file is named DefaultSymbolMaps.txt. See Symbol Maps (see page 324) for
illustrations of the default symbol mapping.

To specify a user symbol map:

1. Click the ... button.

Lol

Navigate to the directory containing the user symbol text file you want to use.
Select the desired file in the Open window and click Open.

Select User Symbol Map to enable the user symbol map.

Editing the User Symbol Map. The symbol map is a plain text file and can be edited with any plain text

editor.
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CAUTION. Whenever you reinstall the program software, the existing DefaultSymbolMaps.ixt file will be
overwritten. To create a custom symbol map, you should make a copy of the default symbol map file, edit
the copy to suit your needs, and save it with a new name. Guidance on how to edit the symbol map file
is contained within the default symbol map file.

The following excerpt from the default symbol map file explains the structure of the file and how to edit it.

##
##

##
##
##
##
##
##
##
##
##
##
##
##
##
##
##
##

Symbo1l Mapping Definitions
version 1.2

This file defines the mapping of modulation states to symbol values.

File Format :

1. cComments begin with '##' and may appear after the last field in a Tine
2. A symbol map begins and ends with a 1ine containing the name of the
modulation type. These names must exactly match the name of one of the
modulation types in the RSA software

3. Empty cells may be included to preserve the constellation shape.

4. Blank Tines are ignored.

5. A modulation type which does not match the name of an existing

type will be ignored.

Usage

1. The file is intended to be edited with Notepad or similar text editor

The following text is an example of a symbol map.

##
##

Symbol Map for 32 QAM
(Resembles the shape of the constellation)
32QAM
00011 00010 00001 00000

01001 01000 00111 00110 00101 00100
01111 01110 01101 01100 01011 01010
10101 10100 10011 10010 10001 10000
11011 11010 11001 11000 10111 10110

11111 11110 11101 11100
32QAM

SPECMON3 & SPECMONG Printable Help



GP Digital Modulation

Find Tab

Find Tab

The Find tab is used to set parameters for finding bursts within the data record. This is a post-acquisition
operation. Synch Word search controls are also on this tab.

| Modulation Params | Freq & Elwl Advanced Params | Find |£«nalysis Time | Trace | Scale | Prefs |

Burst Detection

Mode:  |Off

Threshold:  -10 dBc

Use Synch Word: Clear

0 o0 02 0o 01 DO 10 0o 11 -
=]
16
24 o

Setting

Description

Burst Detection: Mode

Select whether to analyze bursts

- Auto: If a burst is found, analyze just that burst period. If a burst is not found, analyze
the whole analysis length.

- On: If a burst is found, analyze just that burst period. If a burst is not found, display
an error message.

- Off: Analyze the whole analysis length.
If the signal isn't adequate for demodulation, an error message is shown.

Burst Detection: Threshold

Sets the level required for the signal to qualify as a burst. Enter a value in dBc down
from top of the signal.

Use Synch Word When enabled, specifies the string of symbols to look for. Enter the search string with
external keyboard or the on-screen keyboard.
Clear Blanks the search string field.

Analysis Time Tab

The Analysis Time tab contains parameters that define how the signal is analyzed in the general purpose

digital modulation displays.

| Modulation Params | Fren & Bv | Equalizer | Advanced Params | Find | Analysis Time | Trace I Scale I Prefs

Analysis Offset: -85.6587 ns

Analysis Length: 128 Sy

Actual: 128 Sym

[¥] auto Tirme Zero Reference: | Trigger -
[¥] auto Units:  |Symbals -

The settings values on this tab are the same as those on the main Analysis control panel for the instrument
with the only difference being that Analysis Length can be set in either Seconds or Symbols in this location.
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Setting Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the
requirements of the selected display.

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in

either seconds or symbols, depending on the Units setting. For most modulation types,
the Analysis Length set when Auto is enabled is 128 symbols. For some modulation
types, a longer length is used.

Auto When enabled, causes the instrument to set the Analysis Length value based on the
requirements of the selected display.

Time Zero Reference Specifies the zero point for the analysis time.

Actual This is a displayed value, not a setting. It is the Analysis Length (time or symbols)
being used by the analyzer; this value may not match the Analysis Length requested
(in manual mode).

Units Sets the units of the Analysis Length to either Symbols or Seconds.

Analysis Offset

Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis
Offset outside the range of time covered by the current acquisition data. (all time values are relative
to the Time Zero Reference).

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the
current range of acquisition data settings. When the next acquisition is taken, its Acquisition Length will
be increased to cover the new Analysis Length, as long as the Sampling controls are set to Auto. If the
Sampling parameters are set to manual, or if the instrument is analyzing saved data, the actual analysis
length will be constrained by the available data length, but in most cases, measurements are able to be
made anyway. The instrument will display a notification when measurement results are computed from
less data than requested. Range: 0 to [(end of acquisition) - Analysis Length)]. Resolution: 1 effective
sample (or symbol).

Analysis Length

Use the analysis length to specify how long a period of time is analyzed by a measurement. As you adjust
this value, the actual amount of time for Analysis Length, in Symbol or Seconds units, is shown below the
control in the "Actual" readout. This setting is not available when Auto is checked. Range: minimum
value depends on modulation type. Resolution: 1 symbol. A maximum of approximately 80,000 samples
can be analyzed (the actual value varies with modulation type).

Time Zero Reference

All time values are measured from this point (such as marker position or horizontal position (in Y vs Time
displays). Choices are: Acquisition Start or Trigger.
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Parameter Description
Acquisition Start Offset is measured from the point at which acquisition begins.
Trigger Offset is measured from the trigger point.

Trace Tab

Menu Bar: Setup > Settings > Trace

The Trace tab allows you to set the trace display characteristics of the selected display.

| Madulation Params | Freq & ElWl Equalizer | Advanced Params I Find I Analysis Time | Traces |I3refs |

Trace: Show Freeze

All GP Digital Modulation displays

Content: Pointsfsyrmbol:
Q Offset: |Use shared Pref - Symbol paint location:

Example traces tab for constellation display set to SOQPSK modulation type

Note that some settings are not present for all modulation types and some settings are not present for
all displays.

| Madulation Params | Freq & ElWl Equalizer | Advanced Params | Find | Analysis Time | Traces |Prefs |

Trace: (Tracel = Show [C] Freeze

Al GP Digital Modulation displays
Content: Pointsfsymbal:

Phase multiplier:

Example trace tab for constellation display set to CPM modulation type

| Modulation Params | Freq & ElWl Equalizer | Advanced Params I Find I Analysis Time | Trace |Scale | Prefs |

Trace: E [¥] showe
Pointsfsyrbol:
Content: Syrbol point location:

Example trace tab for Demod 1&Q display
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Setting

Trace Tab

Description

Trace

Selects the trace that is hidden or displayed based on whether or not Show is selected.

Show

Specifies whether the trace selected by Trace is displayed or hidden.

Freeze

Halts updates to the trace selected by the Trace setting. Present for the Constellation
display only.

Content

Selects whether to display the trace as vectors (points connected by lines), points
(symbols only without lines), or lines (lines drawn between symbols, but no symbols are
displayed). The choices available depend on the display.

Q Offset

For traces with offset modulation (OQPSK and SOQPSK), this setting enables the trace
to be displayed with Q offset or without Q offset. Choices available are Remove Q
offset, Include Q Offset, and Use Shared Pref. Selecting Use Shared Pref causes the
analyzer to add or remove Q offset according to the Remove Q Offset setting located on
the Prefs tab. Setting the Q Offset on the Traces tab changes the Q offset only for the
Constellation display. If other GP Digital Modulation displays are shown, they will use the
use the Remove Q Offset setting on the Prefs tab regardless of the Q Offset setting on
the traces tab for the Constellation display. The Q Offset setting is available only when
the modulation type is set to OQPSK or SOQPSK.

Points/symbol

Select how many points to use between symbols when connecting the dots. Values:
1,2,4,8.

Symbol point location

Selects whether to evaluate the symbol value at the center or the end of the eye opening.
This control is only present for some of the supported modulation types.

Phase Multiplier

Sets the multiplication constant for the phase multiplication display: x1 (default), x2, x4,
x8, x16, or x32. The phase multiplication display facilitates observation of noisy CPM
signals by multiplying measurement signal phase by the constant to reduce the number
of phase states and expand the phase difference between adjacent symbols.

Comparing Two Traces in the Constellation Display

When the Constellation display is the selected display, you can use the Traces tab to enable the display
of a second trace. The second trace is a version of the current acquisition. You can choose to freeze a
trace in order to display the current live trace to an earlier version of itself, you can display the trace
as a second trace with or without Q Offset, or you can choose to display both traces frozen in order

to compare the trace to itself at different times.

To display a second trace in the Constellation display:

AU S

Trace 1.
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Select the Traces tab.

If more than one display is present, select the Constellation display to ensure it is the selected display.

Click the settings icon or select Setup > Settings from the menu bar.

Select Trace 2 from the Trace drop-down list.
Click the Show checkbox so that it is checked.

Specify the Content as desired. Trace 2 lines appear in blue to aid in distinguishing Trace 2 from
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Scale Tab

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency.

| Modulation Params | Freq & ElWl Equalizer | Advanced Params I Find I Analysis Time | Trace | Scale |F‘refs |

Wertical Harizantal
Scale: 200 my Scale:  128.00 sy
Position:  0.000 W Position: -1.00 Sy
Autoscale Auto Autoscale
Setting Description
Vertical Controls the vertical position and scale of the trace display.
Scale Changes the vertical scale units.
Position Position adjusts the reference level away from top of the graph.
Autoscale Resets the scale of the vertical axis to contain the complete trace.
Horizontal Controls the span of the trace display and position of the trace.
Scale Allows you to, in effect, change the span.
Position Allows you to pan a zoomed trace without changing the Measurement Frequency.

Position is only enabled when the span, as specified by Freq/div, is less than the
acquisition bandwidth.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.
Auto

A Note About Units

The Units used for the horizontal scale can be either Seconds or Symbols. To set the units for the horizontal
scale, display the Analysis Time tab. On the tab, select the appropriate units from the Units drop-down list.

Prefs Tab

The Prefs tab enables you to change appearance characteristics of the GP Digital Modulation displays.
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Symbol Maps

Modulation Params | Freq & Bw | Equalizer | Advanced Params | Find | Analysis Time | Trace | Scale | Prefs

V| Showe graticule

Setting

Radlix: |Binary - |

| Showr Marker readout in graph (selected marker)

Description

Show graticule

Shows or hides the graticule.

Show Marker readout in graph

(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Radix

Specifies how symbols are displayed in the Symbol Table display and in the Marker
readout in the Constellation display.

Remove Q offset

The I and Q data traces are displayed with an offset of half a symbol when the modulation
type is set to SOQPSK or OQPSK. You can remove this offset by selecting Remove Q
offset. (Which is only present when the modulation type is set to OQPSK or SOQPSK.)

Show EVM and Offset EVM

results

Adds EVM results in the display when enabled (Offset EVM is always displayed). Present
only in Signal Quality display and with SOQPSK and OQPSK modulation types only

Symbol Maps

324

This topic shows the symbol mapping for each digital modulation technique.

QPSK OQPSK SOQPSK
1] 3 01 | 11 o | 11
0| 2 00 | 10 0 | 10
8PSK
Left Right
3
2 1
6 0
7 4
5

0163009
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BPSK SBPSK

1 0 1 0

D8PSK

Phase shift Symbol value

(radians) (binary)

0 000

/4 001

/2 011

3/4 010

m 10

5tr/4 11

3m/2 101

7T/4 100

Pi/2 DBPSK

Phase shift Symbol value

(radians) (binary)

+11/2 0

-T1/2 1

DQPSK

Phase shift Symbol value

(radians) (binary)

0 00

/2 01

m "

3m/2 10

Pi/4 DQPSK

Phase shift Symbol value

(radians) (binary)

+17/4 00

+311/4 01

-T1/4 10

-3m/4 1"
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Symbol Maps
MSK
Phase shift Symbol value
direction
;
16QAM
Left Right
3 2 1 0
7 6 5 4
B A 9 8
F E D C
32QAM
Left Right
3 2 1 0
9 8 7 6 5 4
F E D C B A
15 14 13 12 1 10
1B 1A 19 18 17 16
1F 1E 1D 1C

0189-011
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64QAM
Left Right
7 6 5 4 3 2 1 0
F E D C B A 9 8
17 16 15 14 13 12 " 10
1F 1E 1D 1C 1B 1A 19 18
27 26 25 24 23 22 21 20
2F 2E 2D 2C 2B 2A 29 28
37 36 35 34 33 32 31 30
3F 3E 3D 3C 3B 3A 39 38
128QAM
SD| SF | 4F | 4D 1A | 1B | OB | OA
5C| S5E | 4E| 4C | 18 ] 19 | 09 08
4A | 48 | 54 | 56 | 46 | 44 | 10 1 15 1 14 | 1C | 1D
4B | 49 | 55 | 57 | 47 | 45 | 12 13 1 17 | 16 1E | 1F
5B | 59 | 51 53 | 43 | 41| 02 | 03 [ 07 | 06 | OE | OF
S5A | 58 | 50 | 52 | 42 | 40 [ 00 | O1 05 [ 04 | OC | OD
6D | 6C | 64 | 65 | 61 60 | 20 | 22 | 32 | 30 38 | 3A
6F | 6E | 66 | 67 | 63 | 62 | 21 23 | 33 | 3 39 | 3B
TRV TEL 76 | 77| 73 72 | 25 | 27 | 37 | 35 29 | 2B
my77C| 4] 7N 70 1 24 | 26 | 36 | 34 28 | 2A
68 | 69 | 79 | 78 | 2C | 2E | 3E | 3C
6A | 6B | 7B | 7A | 2D | 2F | 3F | 3D
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256QAM
Left Right
EF FD EB F9 E7 F5 E3 F1 OF 3F 4F 7F 8F BF CF FF
CE DC CA D8 C6 D4 C2 DO 0C 3C 4C 7C 8C BC CcC FC
AF BD AB B9 A7 B5 A3 B1 0B 3B 4B 7B 8B BB CB FB
8E 9C 8A 98 86 94 82 90 08 38 48 78 88 B8 C8 F8
6F 7D 6B 79 67 75 63 71 07 37 47 77 87 B7 C7 F7
4E 5C 4A 58 46 54 42 50 04 34 44 74 84 B4 C4 F4
2F 3D 2B 39 27 35 23 31 03 33 43 73 83 B3 C3 F3
0E 1C 0A 18 06 14 02 10 00 30 40 70 80 BO Co FO
E1 D1 Al 91 61 51 21 1" 01 13 05 17 09 1B 0D 1F
E2 D2 A2 92 62 52 22 12 20 32 24 36 28 3A 2C 3E
ES D5 A5 95 65 55 25 15 4 53 45 57 49 5B 4D SF
E6 D6 AB 96 66 56 26 16 60 72 64 76 68 7A 6C 7E
E9 D9 A9 99 69 59 29 19 81 93 85 97 89 9B 8D 9F
EA DA AA 9A 6A SA 2A 1A A0 B2 Ad B6 A8 BA AC BE
ED DD AD 9D 6D SD 2D 1D C1 D3 C5 D7 C9 DB CD DF
EE DE AE 9E 6E SE 2E 1E EO F2 E4 F6 E8 FA EC FE
Swon
2FSK 4FSK
Left Right Left Right
0 1 0 1 3 2
8FSK
Left Right
0 1 2 3 7 6 5 4
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0163015
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16FSK

Left Right
0 1 2 3 4 5 6 7 15 | 14 [ 13 | 12 | 11 10 | 9 8
C4FM

Left Right

1 10 | 00 | O1

0163020

CPM

Phase shift Symbol value
(h = modulation index) (binary)

-3h 1

-h 10

+h 01

+3h 00

Overview: User Defined Measurement and Reference Filters

The Modulation Parameters control tab for GP Digital Modulation displays enables you to load custom
measurement and reference filters. If the existing filters do not meet your requirements, you can create
your own filters for use in the measurement and reference settings. This section describes the structure of
user filters and provides two examples of customized filters. See User Filter File Format (see page 330).

Loading a User Measurement Filter
To load a your own measurement filter:

1. From the Modulation Params control tab (Settings > Modulation Params), click on the drop-down
list for Measurement Filter.

2. Select one of the filter names that starts with User. This displays the Manage user filters window.

3. Enter a name for the filter in one of the Name (editable) boxes. This name will appear in the
drop-down list on the Modulation Params tab, prefaced with User. The maximum number of
characters for the filter name is 20.
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4. Click the Browse button and navigate to the directory containing the filter you want to load. Select
the filter and click Open. If you wish to use a filter that is not in the list, select User other and
locate and open the file you wish to use.

5. Click OK to load the filter and return to the Modulation Params page.

User Filter File Format

330

The filter file is selected on the Modulation Params control panel tab used by the GP Digital Modulation
displays (Option 21 only). It stores the user-defined measurement or reference filter coefficient data in
CSV format. The following figure shows the file structure.

J:ORate Oversampling rate of the filter (samples/symbol)
# Filiterl FilterQ A
0.97321,0.01947
0.89559,0.04051
0.77497,0.05942
0.62333,0.07202
0.45524,0.07438 > 1Q pairs (1 to 1024) of the filter coefficient in time domain

0.28614,0.06354

0.13045,0.01947

0163023

User filter file structure

A filter file is a plain text file, in comma-separated-variable format. The file extension must be CSV.

The filter file contains the following variables:

Rate. Specifies the oversampling rate (the number of samples per symbol). The filter coefficient data will
be interpolated by the specified rate.

Filterl,FilterQ. Specifies IQ pairs (1 to 1024) of the filter coefficient in time domain.

Rules for Creating a Filter File
B A line beginning with “#” is a comment line.
B Enter a positive value for the oversampling rate.

B A decimal number can be expressed by fixed point or floating point. For example, 0.01 and 1.0E-2 are
both valid.

B “0” (zero) and “,0” (comma zero) can be omitted. For example, “1.5,0”, “1.5,”, and “1.5” are
equivalent.

B Lines with only a comma and blank lines are skipped.
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Example filters. For your reference, two example filters, Raised Cosine and Gaussian, are shown here.
Both filters contain 65 data points with an oversampling rate of 8.

Raised Cosine (a = 0.3)

(Row 1 to 18) (Row 19 to 36) (Row 37 to 54) (Row 55 to 68)
# Rate 0.0383599,0 0.973215,0 0.0743803,0
8 0,0 0.895591,0 0.0720253,0
# Filter| FilterQ -0.047715,0 0.774975,0 0.0594205,0
0,0 -0.0984502,0 0.623332,0 0.0405144,0
-0.0062255,0 -0.143898,0 0.455249,0 0.0194761,0
-0.0136498,0 -0.174718,0 0.286147,0 0,0
-0.0209294,0 -0.181776,0 0.130455,0 -0.0151973,0
-0.0263419,0 -0.157502,0 0,0 -0.0246357,0
-0.0280807,0 -0.0971877,0 -0.0971877,0 -0.0280807,0
-0.0246357,0 0,0 -0.157502,0 -0.0263419,0
-0.0151973,0 0.130455,0 -0.181776,0 -0.0209294,0
0,0 0.286147,0 -0.174718,0 -0.0136498,0
0.0194761,0 0.455249,0 -0.143898,0 -0.0062255,0
0.0405144,0 0.623332,0 -0.0984502,0 0,0
0.0594205,0 0.774975,0 -0.047715,0

0.0720253,0 0.895591,0 0,0

0.0743803,0 0.973215,0 0.0383599,0

0.063548,0 10 0.063548,0
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Gaussian (BT = 0.5)

User Filter File Format

(Row 1 to 18) (Row 19 to 36) (Row 37 to 54) (Row 55 to 68)
# Rate 0.00191127,0 0.978572,0 0.000401796,0
8 0.00390625,0 0.917004,0 0.000172633,0
# Filterl FilterQ 0.00764509,0 0.822878,0 7.10E--05,0
2.33E-10,0 0.0143282,0 0.707107,0 2.80E-05,0
9.11E-10,0 0.0257149,0 0.581862,0 1.06E-05,0
3.42E-09,0 0.0441942,0 0.458502,0 3.81E-06,0
1.23E- 08,0 0.0727328,0 0.345977,0 1.32E-06,0
4.21E-08,0 0.114626,0 0.25,0 4.37E-07,0
1.39E-07,0 0.172989,0 0.172989,0 1.39E-07,0
4.37E-07,0 0.25,0 0.114626,0 4.21E-08,0
1.32E-06,0 0.345977,0 0.0727328,0 1.23E-08,0
3.81E-06,0 0.458502,0 0.0441942,0 3.42E-09,0
1.06E-05,0 0.581862,0 0.0257149,0 9.11E-10,0
2.80E-05,0 0.707107,0 0.0143282,0 2.33E-10,0
7.10E-05,0 0.822878,0 0.00764509,0

0.000172633,0 0.917004,0 0.00390625,0

0.000401796,0 0.978572,0 0.00191127,0

0.000895512,0 1,0 0.000895512,0
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Using Markers

Markers are indicators in the display that you can position on a trace to measure values for the X and Y
axes, such as frequency, power, and time. A Marker always displays its position and, if enabled, will
display the difference between its position and that of the Marker Reference (MR).

You can display up to five markers including the marker reference. Markers can all be placed on the
same trace or they can be placed on different traces. There are two types of Markers: Reference and
Delta Markers. The Marker Reference (labeled MR in the graph) makes absolute measurements and is
also used for calculating differences when Delta readouts are enabled. The Delta Markers (labeled M1
to M4 in the graph) are used to measure other points on the trace or the difference between the Marker
Reference and the Delta marker.

The following table shows the appearance of the four types of marker readouts.

Marker Reference Absolute Marker Delta Marker Readout DPX Bitmap Marker Readout

Readout Readout

Referenca Marker label Absolute Marker label Delta Marker label Number of times p|Xe| has been
Power level at marker Power level at marker Difference in power level hit. May increase or decrease

between Delta Marker and
Marker Reference

Difference in frequency
between Delta Marker and
Marker Reference

over time if persistence is used.

Frequency at marker Frequency at marker Frequency at the marker

Power level at marker.

The following table shows the appearance of the marker indicators as they appear on the trace.

Marker Reference Absolute Marker Delta Marker
MR n1
(] L]

Controlling Markers with the Touchscreen Actions Menu

In addition to controlling the marker actions from the front panel or screen menu items, you can use the
touch screen actions menu to move markers or add and delete markers.
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IE Select
f

A
]

B F

Span Zoom
CF Pan
Zoaom

Pan
Feset scale

Marker to peak
Add marker
All rmarkers off

To use the Touchscreen Actions menu, touch the display and hold for one second, then remove your finger.
You can also use a mouse to display the Touchscreen Action menu by clicking the right mouse button.

Menu item Description

Marker to peak Moves the selected marker to the highest peak. If no marker is turned on, this control
automatically adds a marker.

Next Peak Moves the selected marker to the next peak. Choices are Next left, Next right, Next
lower (absolute), and Next higher (absolute).

Add marker Defines a new marker located at the horizontal center of the graph.

Delete marker Removes the last added marker.

All markers off Removes all markers.

Measuring Signal Density, Frequency and Power on a DPX Bitmap Trace

334

To measure the signal density, frequency and power at a point on a DPX Bitmap trace:

1.

2.
3.

Select Markers > Define Markers.
Select the Marker Properties tab.

Click Add. This displays a drop-down list under MR (Marker Reference), found inside the Reference
box. The first marker defined is always designated the Marker Reference. Subsequently defined
markers are designated as Delta Markers (you can also select and adjust markers by clicking on an
existing marker on a trace).

From the drop-down list, select Bitmap.

Click the close control panel button ( ) to remove the Define Markers control panel.
Touch or click on the MR marker on the trace to activate the marker.

Drag the marker to the desired location on the bitmap.
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Measuring Signal Density, Frequency and Power on a DPX Bitmap Trace

NOTE. Markers on the DPX Bitmap trace can be placed on any point in the display, unlike markers

in other displays that can be placed only on a trace. This enables you to measure the signal density,
frequency, and power level at any point on the graph.

7). Tek RSAG100A - [DPX Spectrum] (=13
File View Run  Markers Sstup  Tools  Window  Help -8 %
‘ Displays | | Markers [|Seftings || Trig || Acg || Anz | ¢ Freq: 2.05119 GHz < RefLev: 0.00 dBm
o v Bitmap ow File:sweep and pulse.

© -15.51 dBm

© dB/div: 351 ) 4 \

11551 dBm
© CF: 205119 GHz

Define
Markers

© Span:40.00 MHz

Marker Praperties | Define Peaks

Reference

Defta Markers

MR

M1 M2 M2 M4
(in selected
display)
All off

0070028

Searching for peaks on the DPX bitmap trace. To locate peaks on the DPX Bitmap trace, use the arrow
buttons on the Marker toolbar. The left / right arrows move the selected marker to the next peak lower
or higher in frequency. The up and down arrows search for peaks at the same frequency. The peaks on

the DPX Bitmap trace are defined by the settings for the DPX Signal Density on the Markers > Define
Markers > Define Peaks (see page 338) tab.
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Measuring Frequency and Power in the Spectrum Display

To measure the frequency and power at a point on a Spectrum trace:
1. Select Markers > Define Markers.
2. Select the Marker Properties tab.

3. Click Add. This displays a drop-down list under MR (Marker Reference), found inside the Reference
box. The first marker defined is always designated the Marker Reference. Subsequently defined
markers are designated as Delta Markers (you can also select and adjust markers by clicking on an
existing marker on a trace).

4. From the drop-down list, select the trace to which you want to assign the marker.

B T & 5 1% | Frequency: 1900335 GHz Reflew 0.00 dBrm Preset Replay o) Stop

I Trace 1 [YIShow  +Paak Naormal |Clear |
© 0,00 dBm
o dBfdiv:

10.0dB
<~ RBW.

10.0 kHz

VBW!

-100.00 dBrn
| Autoscale | © CFi 1,900335 GHz = Spar: 1,000 MHz
Define Marker Properties | Define Peaks

Markers | |

Reference Delta Markers —

| Add ‘ Marker: MR M1

] Attachto: a0 - [Trace1 -

| Delete ‘ (in selected

_— display)

Readouts:  |Delta
| wofi | |l —]
Markers - MR |Frequency | 1.000335 GHe [ Tocenter | [ Poak | [«| [*] [#] [#] [ Tane | [ x|

5. Click the close control panel button to remove the Define Markers control panel.
6. Click on the marker on the trace to activate that marker.

7. Use the knob or the arrow keys on the front panel to move the marker to the desired location on the
trace. You can also click on the marker location text box in the Markers toolbar at the bottom of the
screen and adjust it with your mouse wheel. The Peak button in the Markers toolbar and the arrow
buttons to the right of it control marker peak searching on the trace.

8. Read the frequency and power level of the marker position on the display.

9. Read the signal density, frequency and power level of the marker position on the display.
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Marker Action Controls

Controls for enabling and moving markers and for initiating marker peak searches are found in several
locations. There are buttons for a few of the most common marker activities on the front panel of

the instrument, used along with the knob for adjusting marker positions. The Markers menu contains
selections for peak searches and the Marker toolbar also has buttons for peak searches. All graphs that
support the markers offer a pop-up menu for marker actions.

Peak

Selecting Peak from the Markers menu moves the selected marker to the highest level peak within the
acquisition record.

Next Peak

Selecting Next Peak displays a submenu that enables you to move the selected marker to the next peak.

Setting Description

Next Left Moves the selected marker to the next peak to the left of the current marker position.
Next Right Moves the selected marker to the next peak to the right of the current marker position.
Next Lower (absolute) Moves the selected marker to the lower level peak (in absolute terms) on the trace.
Next Higher (absolute) Moves the selected marker to the higher level peak (in absolute terms) on the trace.

Marker to Center Frequency

Changes the center frequency to match the frequency of the selected marker.

Enabling Markers and Setting Marker Properties

The Define Markers Control Panel is used to enable markers and set their properties. You can set up to five
markers including the marker reference. Markers are shown in most displays.

Markers have two types of on-screen readouts: Absolute and Delta. When Readouts is set to Absolute,
each readout displays only the marker's position on the trace. In Frequency displays, this means the marker
readout shows the frequency and power of the trace at the marker position. When Readouts is set to Delta,
each delta marker (M1-M4) readout displays both the marker's position on the trace and the difference
between its position and the position of the Reference Marker (MR).
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Defining Markers

Define
Markers

Add

i

Delete

]

21 Off

Marker Properties | Define Peaks

Enabling Markers and Setting Marker Properties

Reference

Marker: MR

Attach to: Trace 1 -

(in selected
display)

Delta Markers

M1

Tracel ~

Readouts:  |Delta -

1. Select Markers > Define Markers to display the Define Markers control panel.

2. Select Add to turn on the next marker. A drop-down list under the marker label allows you to assign
the marker to a trace.

NOTE. The first marker defined will always be MR. The MR marker is the reference for delta marker

readouts.

3. Select the trace to which the marker should be attached from the drop-down list.

4. Click Add to add additional markers.

5. Click the close button to remove the Define Markers control panel.

Defining Peaks

You can specify two amplitude values that define peaks. For the DPX display, you can also define peaks
based on signal density characteristics.

Define
Markers

Add

i

Delete

21 Off

Marker Properties | Define Peaks

Amplitude

Peak Threshold:  -150 dBm

Minimum Bxcursion: & dB

DPX Signal Density
Density Threshold: 1,000 %%

Minirnurn Excursion: 100,000 m%s

Smoothing (pixels squared);. S

NOTE. The settings shown in the DPX Signal Density section of the Define Peaks tab are not used
by SignalVu-PC.

338
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Amplitude
Peak Threshold Peak Threshold specifies the level that the signal must exceed to be considered a peak.
Minimum Excursion Minimum Excursion specifies how much the signal must decrease and then increase

before another peak can be declared.

DPX Signal Density

Density Threshold Density Threshold specifies the signal density (number of hits per displayed pixel) that
the DPX bitmap must exceed to be considered a trigger event.

Minimum Excursion Minimum Excursion specifies how much the signal density must decrease and increase
again before another peak can be declared.
Smoothing (pixels squared) Smoothing specifies the number of pixels around the marker that are averaged together

to reduce "noise" in the readout of signal density. The value of this control is the number
of pixels on each side of the square area used for averaging. With Smoothing = 1, no
averaging is done and the marker z-axis readout is the hit count (density) of a single
pixel. Use this control to characterize how wide or narrow a range of pixels should be
averaged to determine the signal density.

Select Markers > Define Markers to display the Define Markers control panel.
Select the Define Peaks tab.
To define the level for Peak Threshold, enter a value in the Peak Threshold number entry box.

To define the amount the trace must dip, enter a value in the Peak Excursion number entry box.

U N o

Click the close button to remove the Define Markers control panel.

Using the Markers Toolbar

Front Panel: Markers
Application toolbar:
Menu bar: View > Marker Toolbar

Select Marker Toolbar to display or hide the Marker Toolbar in the application window. The Marker
Toolbar enables you to operate existing markers or define new markers.

Markers W MR Frequency = |1.900335 GHz To Center | | Peak [iJ m m m Table E

Enabling a marker or adjusting the position of a marker automatically opens the Markers toolbar.
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Icon / Readout Description
Opens the Define Markers control panel.
M1 Selected marker readout. This readout shows which marker is selected. The pop-up

menu allows you to choose the selected marker, add markers, and turn all markers off.

Fraguency  |1.4875 GHz Marker position controls. For frequency displays, this readout shows the marker position
in Hertz. For time displays, this readout shows the marker position in seconds. The
position of the selected marker can be changed by selecting the numeric readout and
using the knob to adjust the value.

Changes the analyzer's Center Frequency to the frequency of the selected marker.
Not selectable for time markers.
Moves the marker to the highest peak on the signal. On displays that scale about zero

on the vertical axis (for example, Magnitude Error, EVM, and Frequency vs. Time), the
highest peak selected by the Peak button is an "absolute value", therefore, negative
peaks are included in the search for the highest peak.

(] Moves the selected marker to the next peak to the left of the current position.

(*] Moves the selected marker to the next peak to the right of the current position.

(+] Moves the selected marker to the next lower peak value. The peak value here refers to
the numeric value of the peak amplitude. Thus, when repeatedly moving the marker, it
can move to the right or left depending on the location of the next lower value.

Moves the selected marker to the next higher peak value. The peak value here refers to
the numeric value of the peak amplitude. Thus, when repeatedly moving the marker, it
can move to the right or left depending on the location of the next higher value.

Displays/hides the marker table from the display.

[x] Removes the Marker Toolbar from the display.

Using Noise Markers in the Spectrum Display

In the Spectrum display, you can set Markers to Noise Mode to measure noise on the trace. Markers in
Noise Mode operate just as they do in normal mode, but the readouts for the markers are in dBm/Hz
and dBc/Hz.

dBm/Hz is the power in milliwatts referenced to a 1 Hz bandwidth. To make this measurement, the
analyzer assumes that the measured signal is random noise. It then converts the measured power (made at
any RBW) to the power that would be measured had a 1 Hz filter been applied for the measurement.

dBc/Hz represents dBm/Hz referenced to a carrier. Here, it is assumed that the carrier is a CW signal,
and its signal level does not change when the RBW is changed, so the Reference Marker measurement
on the carrier is unchanged from any other marker measurement. However, the delta marker values
are converted to dBm/Hz, and then a difference value, in dBc/Hz, is calculated between each delta
measurement and the reference.

Measuring Noise

To measure noise on a Spectrum trace:
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b

e ® XS

12.
13.
14.
15.
16.

Select Markers > Define to display the Markers control panel.

Click Add. The first marker defined is always designated the Marker Reference. Subsequently defined
markers are designated as Delta Markers (you can also select and adjust markers by clicking on an
existing marker in the display).

Click Add again so that there are at least two markers defined.
Check that Readouts is set to Delta.

If you have more than one trace defined, use the drop-down list for each marker to set it to the trace
on which you want to measure noise.

Select the Settings button to display the Spectrum settings control panel.
Click the Prefs tab.

Click the Marker Noise Mode check box so it is checked.

Click the Traces tab.

. Verify that Detection is set to Average for the trace you are using for this measurement.

11.

Click the (Analysis) icon.

Select the Units tab.

Select dBm for the Amplitude units.

Click the Close button to remove the control panel.
Move the markers to the desired locations on the trace.

Read the frequency and power level for the selected marker in the upper corners of the display. To
display the delta measurement in dBc/Hz, select the delta marker (M1, M2, M3 or M4) by clicking
on it or pressing the front-panel Select button until it is selected.
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The Search Tool (Limits Testing)

You can specify pass/fail conditions for the Spectrum, Spurious, Frequency Settling Time and Phase
Settling Time displays. When these conditions are met, the instrument can perform actions such as
stopping acquisitions or saving data.

Search (Limits Testing) Settings

Menu Bar: Tools > Search

Selecting Search displays the Search control panel. These settings define search parameters and specify
actions to be performed when the search condition is met.

Search m
Eg:ﬂﬁ Search in: [Spectrum: Trace 1 'I
Search for: [is greater than vl -20.00 dBm
Setting Description
Enable Search Select to perform a search.
Define (see page 343) Specifies which result to search and what to search for.
Actions (see page 347) Specifies the action to take when the search condition is met.

Define Tab (Search)

The Define tab sets the parameters for a search. From this tab, you specify which trace to search and what
kind of violation to search for.

Search Define | actions -

Enable
Search Search in; [SDectrum: Trace 1 vl

Search for: [is greater than vl -20.00 dBm
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Search Define | actions
Enable .
Search Search in: lSpeEtrum: Trace 1 v]
Search for: Iis outside rmask v] le
Search Defing | Actions
Eg:ﬂﬁ Search in: [Phase Settling: Mask Test vJ
Search far: [pass vJ

Setting Description
Search in Specifies which result to search.
Search for Specifies what to search for. You can specify a search based on a signal level or a mask.
Search In

The choices for Search in are: Phase Settling: Mask Test, Freq Settling: Mask Test, Spectrum Trace 1,
Spectrum Trace 2, Spectrum Trace 3, Spectrum Math Trace, Spectrogram Trace, and Spurious. The
available choices include only results from displays that are currently open.

NOTE. Ifyou select a trace result that is not the selected trace in the target display, you will not see the
results of the Search until you select the trace in the target measurement display that is the "Search in"
trace.

Search For

The Search for setting has selections that vary based on which display's results you are testing.

Pass/Fail Searches for Spurious and Settling Time

The Frequency Settling Time, Phase Settling Time measurements, and Spurious measurements each
include their own mask test functions that provide pass/fail results. Controls for defining and enabling
these mask tests are found in the displays' own control panels. Search can be configured to look for
either a Pass result or a Fail result in one of these measurements and then perform your specified Search
actions when that result occurs.

Greater Than/Less Than Searches for Spectrum

If you select a greater than/less than search, you also specify the level that defines a violation. When you
select either is greater than or is less than, a text entry box appears to the right of the drop-down list.
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Use the text entry box to specify the signal level you wish to search for. While not as flexible as mask
testing, this type of search is quicker to set up.

Mask-Based Searches for Spectrum

If you specify a mask-based search for the Spectrum display, then you need to edit the mask to specify the
levels that define a violation. When you select is outside mask or is inside mask, an Edit limits button is
displayed. Select the Edit limits button to display the Mask Editor.

st Mask Editor =N E=R=
l Add Point l Delete Undo X: Frequency ¥ Power
-10.000000 MHz -20 dBmn
-5.000000 MHz -20 dBm
-2,000000 MHz -10 dBmn
X ais values
2.000000 MHz -10 dBmn
5 Absolute 5.000000 MHz -20 dBm
10.000000 MHz -20 dBmn
@ Relative
Mew Table Load... ‘ Save As... ‘ l Apply ‘ | 0K | l Cancel

To edit a search mask for a Spectrum display search:
1. Click Edit limits to display the Mask Editor.
2. Click New Table to create a table. This clears the existing points and loads the default table.
3. Select the X axis values setting:
a. Select Absolute to specify mask point locations based on signal frequency.
b. Select Relative to specify mask point locations as offsets from the center frequency.
4. To edit values in the table:
a. To edit an existing value, double-click on the cell you want to edit.

b. To add a new point to the table, click on Add Point. Edit the values as required and click Apply
when you are finished with your changes.

To specify a frequency multiplier, you can type K, M, or G. For the power level, you only need to specify a
numeric value. The unit is set to the current Units setting (Setup > Analysis > Units).

1. To delete a point from the table, select the point to be removed, and click Delete.

2. To close the Mask Editor without saving your changes, click Cancel (if you have already clicked
Apply, this only cancels changes since the last time Apply was clicked).
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3. If Search mode is already enabled and the instrument is in Run mode, you can run a Search using your
changed points without closing the Mask Editor, by clicking Apply.

4. To save changes and close the Mask Editor, click OK.
5. To save the mask to a file for later recall, click Save As.
6. From the Save As dialog, name the file and save it in the desired location.

Masks are saved only in CSV (Comma Separated Value) format.

Performing a Mask-Based Search

To perform a Search using a mask:

1. Select Tools > Search.

Click the Enable Search check box.

Select the trace that you wish to search from the Searching drop-down list.

Verify that the trace you selected to search is the selected trace in the display.

Select either is outside mask or is inside mask from the Search for drop-down list.
Click the Edit limits button.

Edit the table as necessary or click Load to use a previously saved mask.

If you load a saved a mask, use the Open dialog box to locate and open the mask file.

Click OK.

A e T LR o o B

The following figure shows the results of an is outside mask Search. The vertical red bar highlights
results that match the Search definition.

<  Trace 1 VIShow +Peak Mormal Clear

< 1.00 dBm

@ dB/fdiv:
10.0 dB

< REW:
10,0 kHz

V| VB,
500 Hz

-99.00 dBm
Autoscale < CF 1.900000 GHz < Span: 1.000 MHz
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Actions Tab

The Actions tab is used to specify an action to be taken when the search condition is met.

Search Defing | Actions D
Enable During Run or Replay Dwuring Run anky
Search [[] Beep [] Save acquisition data TIQ -
] stap [T Save trace

[7] Save picture PHG -
Setting Description
During Run or Replay Actions specified here will occur in either Run mode or Replay mode.
Stop The analyzer stops when the search condition is met.

During Run Only

Actions specified here are taken only during Run mode (while acquiring live data).

Save acquisition data

Saves acquisition data to a file when the search condition is met. Use the drop-down
list to specify the format of the saved data. The available file formats are: TIQ, CSV,
and MAT (see page 379).

Save trace

Saves Trace data to a file when the search condition is met.

Save picture

Saves a screen capture to a file when the search condition is met. Use the drop-down
list to specify the format of the saved picture. The available file formats are: PNG, JPG,
and BMP (see page 379). Note that no trace will be saved if the searched trace isn't a
saveable trace type. For example, a Spurious trace is not saveable.

AutoSave File Naming

When one of the AutoSave actions is enabled, the name of the saved file is automatically incremented
even if the Automatically generate filenames option (Tools > Options > Save and Export) is not enabled.
When the file is saved, it will be saved to the last location a file was saved. You can check this location
by selecting File > Save As. The Save dialog will show you the current save location. If you want to
save the file in a different location, save a file (any type) in the desired location. This resets the save
destination to the new location.
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Analyzing Data Analysis Settings

Analysis Settings

Menu Bar: Setup > Analysis
Application Toolbar:

The Analysis control panel provides access to settings that are used by all displays. These settings affect
only post processing and they do not control hardware settings.

Analysis Analysis Time | Spectrurn Time | Frequency | urits |
Analysis Offset: 80,000 s V] auto Time Zero Reference: | Acquisition Start =

Analysis Length: 2,000 us Auto

Actual 1000 us

Setting Description

Analysis Time (see page 349) Specifies the length of time to use in measurements.

Spectrum Time (see page 351) Specifies whether the Spectrum Analysis display uses the same Analysis Time
parameters as all the other displays or if it uses a different Offset and Length.

Frequency (see page 351) Specifies the measurement frequency (center frequency).

Units (see page 355) Specifies the Power units for all displays.

Analysis Time Tab

The Analysis Time tab contains parameters that define the portion of the acquisition record that is used
for analysis.

Analysis Time |Spectrum Time I Frequency I Units |

Analysis Offsets 80.000 rs [¥] auto Time Zero Reference:  |Acquisition Start

Analysis Lenath: 1.000 us Alto

Actual 1,000 us
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Setting Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the
requirements of the selected display.

Analysis Length Specifies the length of time to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Length value based on the
requirements of the selected display.

Time Zero Reference Specifies the zero point for the analysis time.

Actual This is a displayed value, not a setting. It is the Analysis Length (time) being used by the

analyzer; this value may not match the Analysis Length requested (in manual mode).

Analysis Offset

Use analysis offset to specify where measurements begin. Range: 0 to [(end of acquisition) - Analysis
Length)]. Resolution: 1 effective sample (or symbol).

Analysis Length

Use the analysis length to specify how long a period of time is analyzed by a measurement. After you
enter a value, this box changes to show the actual value in use, which is constrained by Acquisition Time.
This setting is not available when Auto is checked. Range: minimum value depends on modulation type
to Acquisition Length. Resolution: 1 effective sample (or symbol).

Time Zero Reference

The analysis offset is measured from this point. Choices are: Acquisition Start or Trigger Point.

Parameter Description
Acquisition Start Offset is measured from the point at which acquisition begins.
Trigger Point Offset is measured from the trigger point.
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Spectrum Time Tab

This tab controls whether the Spectrum display uses the same Analysis Time parameters as all the other
views or uses a different Offset and Length. These settings do not apply to the DPX display because it has
no acquisition record or analysis time.

_Analysis Time | Spectrum Time | Frequency I Lnits

Spectrum Time Mode

@ Independent

' Use Analysis Time settings

Spectrum Time

Spectrumn Offset: 80,000 ks Auto

Spectrum Length:  1.520 mw Auto

Actual: 1520 ms

Settings Description

Spectrum Time Mode
Independent Causes the spectrum analysis views to use the settings unique to those displays.
Use Analysis Time settings ~ Causes the spectrum analysis views to use the settings on the Analysis Time tab.

Spectrum Time (only available when Independent is selected)

Spectrum Offset

Sets the beginning of Spectrum Time with respect to the selected time reference point
(selectable in the Analysis Time tab as either Acquisition Start or Trigger).

Spectrum Length

The amount of data, in terms of time, from which spectrum traces are computed.

Auto When enabled, causes the instrument to set the Spectrum Length value based on the
RBW setting.
Actual This is a displayed value, not a setting. It is the Spectrum Length (time) being used

by the analyzer; this value may not match the Spectrum Length requested (in manual
mode). The actual spectrum length is always an integer multiple of the time needed to
support the RBW value.

Frequency Tab

The Frequency tab specifies two frequency values: the Measurement Frequency and the Spectrum Center
Frequency. The Measurement Frequency is the frequency at which most displays take measurements. The
Spectrum Center Frequency is the center frequency used by the Spectrum, DPX Spectrum, Spectrogram
and Time Overview displays.
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Lnalysis Time | Spectrum Time | Fredquency | Units

Measurement Frequency:  1.500000 GHz

V| Lock Center Frequency of Spectrum

Spectrum Center Frequency:

displays to Measurement Frequency

+ 1.500000 GHz

Frequency Tab

The following screen capture shows a display with both the Measurement Frequency and the Spectrum

Center Frequency locked together.
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Normally, the Measurement Frequency and the Spectrum Center Frequency are locked together so

that both have the same setting. But in some situations, for example, where a signal contains a set of
channels, it is useful to unlock the Measurement Frequency from the Spectrum Center Frequency.
When the Spectrum Center Frequency is unlocked from the Measurement Frequency, you can adjust the
Measurement Frequency so that measurements can be taken at different frequencies without resetting the
center frequency. The following screen capture shows the magenta-colored measurement frequency

indicator still located at the center

frequency.
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The following screen capture shows the measurement frequency indicator located at 2.0402 GHz while the
Spectrum Center Frequency is still located at 2.0000 GHz.
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You can drag the Measurement Frequency indicator on the screen to set the measurement frequency. Note
the base of the Measurement Frequency indicator. The width of the box indicates the widest measurement
bandwidth in use among the open displays. You can see how the width of this box changes with the
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measurement bandwidth by, in this example, adjusting the Measurement BW setting for the Constellation
display (Settings > Freq & BW tab). As you adjust the setting, you will see how the width of the box at the
base of the Measurement Frequency Indicator changes.

The Measurement Frequency indicator is useful for interpreting system behavior when MeasFreq is
unlocked. If a measurement has a wide bandwidth relative to the spectrum span, and the Measurement
Frequency is far from spectrum center, the measurement is likely to fail because its required frequency
range exceeds the frequency range of the available data. In such a case, the navigation control will show
that the measurement bandwidth extends outside the Spectrum's span.

There are interactions between frequency unlocking and RF & IF Optimization (see the Amplitude control
panel (see page 363)). When Best for multiple displays is the selected optimization, the instrument is
allowed to use its full bandwidth to meet the needs of all open displays. This is the most user-friendly
optimization because it decreases the number of Acq BW too small errors, but it can increase noise and
slightly decrease measurement accuracies. For all other optimization types, the instrument optimizes the
acquisition bandwidth for the selected display, improving measurement quality somewhat, but reducing
concurrent measurement capability.

There are also interactions with trigger settings. When the Spectrum Center Frequency is unlocked from
Measurement Frequency, the RF triggers (Trigger Source = RF Input) can tune to either Spectrum Center
Frequency or Measurement Frequency. When a spectrum display is selected, the trigger frequency is the
same as the Spectrum Center Frequency. When one of the other displays that uses Measurement Frequency
is selected, the trigger is tuned to the Measurement Frequency also. This allows you to trigger on the
signal you are measuring. But, there is an exception: when the selected RF & IF Optimization is Best for
multiple displays, the trigger is always tuned to the Spectrum Center Frequency.

The reason the trigger frequency is affected by Measurement Frequency and RF & IF Optimization, is
that these functions control how the acquisition is tuned. The optimization Best for multiple displays
keeps the acquisition centered about the Spectrum Center Frequency at all times. To accommodate
off-center Measurement Frequencies, it just widens the acquisition bandwidth. Other optimizations
tune the acquisition frequency to match that of whichever display is currently selected. The RF trigger
module receives the same acquisition data as all the measurements, tuned to the center of the current
acquisition bandwidth.
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Units Tab

The Units tab specifies the global Amplitude units for all the views in the analysis window.

| Analysis Time | Spectrum Time I Frequency | Units |

Amplitude

dBm e

note: select ... fm units
whien using antenna table

NOTE. If you are using an External Loss Table for antenna corrections (Ampl > External Gain/Loss
Correction), be sure to set the Amplitude units to dBuA/m, dBuV/m, V/m or W/m?.

Replay Overview

The Replay function enables you to reanalyze data with different settings and even different measurements.
You can replay all the acquisitions in memory, a single acquisition, a single frame within an acquisition (if
Fast Frame is enabled), or any contiguous set of data records from acquisition history. You can replay the
DPX Spectra that make up a DPXogram display.

Replay Select data records | Select DRX Spertra | Acquisition Info | Replay Speed |
—_— Select acquisitions Select Al Select frames
DPX Spectra ~
2 1: 10/24f2011 12:4:30.26 1: 10/24f2011 12:4:30.26
! 10f24/2011 ! 10f24/2011
SHErE 12:4:30.26 SHErE 12:4:30.26
‘ 10/24/2011 ‘ 10/24/2011
Stapif 525 12:4:46.60 o L 12:4:46.60
[ Show toolbar
825 10/24/2011 12:4:46.60 1: 10/24/2011 12:4:46.60

Displaying the Replay Control Panel
To display the Replay control panel:

B From the menu bar, select Replay > Select data records from history.

Selecting the Data Type to Replay

You can choose to replay either acquisition data or DPX spectra. Choose Acq Data to replay any
acquisitions except DPXogram acquisitions. Choose DPX Spectra to replay a DPXogram acquisition.
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Select Data Records Tab

The Select data records tab is used to select which data records to replay. A data record is the smallest unit
that can be replayed. Note that what constitutes a data record can vary. If FastFrame is not enabled, a
data record consists of a single acquisition. If FastFrame is enabled, each acquisition can contain multiple
frames, and a data record consists of a single frame.

Select data recards |Acquisition Info | Replay Speed|

select acquisitions Select &l

1: 7f25/2011 17:39:29,72

. 7252011

Start: 1 17:29:29.72
. 7252011

Stop: 304 17:39:33.79

304 : Fi23/2011 17:39:33.79

Without FastFrame enabled

Select data recards |Acquisition Info | Replay Speed|

select acquisitions Select &l select frames
1 3/10/2010 4:47:40.22 1 ;3102010 4:47:40.22
, 3/10/2010 , 2/10/2010
Staig 1 4:47:40.22 Staig 1 4:47:40.22
, 310/2010 , 3/10/2010
Stend 1 4.47:40.22 ston:{10 4147:51.74
1 3/10/2010 4:47:40.22 10 1 3102010 4:47:51.74

With FastFrame enabled

Date and Time Stamps. The line that appears above each Start box (one for acquisitions and one for frames
when FastFrame is enabled) is a date stamp that displays the date and time the first record in the current
acquisition was acquired. The line that appears below each Stop box is a date stamp that displays the date
and time the last record in the current acquisition was acquired.

The line that appears to the right of each Start box displays the date and time the selected acquisition or
frame was acquired. The line that appears to the right of each Stop box displays the date and time the
selected record or frame in the current acquisition was acquired.

Select All button. Selecting Select All resets the Start and Stop values. The Start value is reset to the first
acquisition or frame of the current acquisition. The Stop value is reset to the last acquisition or frame in
the current acquisition.

Select DPX Spectra Tab

The Select DPX Spectra tab is used to select which DPXogram spectra to replay. A spectra is the smallest
DPXogram unit that can be replayed. It is equivalent to one line in the DPXogram display.
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Select data records | Select DPX Spectra |Acquisiti0n Info | Feplay 5peed|

Select spectra Selact Al
1: 9/29/2011 17:36:53.05
. 920/2011
B 17:36:53.05
, oy20/2011
stop: |602 17:377.82
602 0/20/2011 17:37:7.82

Date and Time Stamps. The line that appears above the Start box is a date stamp that displays the date and
time the first DPX spectra in the current acquisition was acquired. The line that appears below the Stop box
is a date stamp that displays the date and time the last DPX Spectra in the current acquisition was acquired.

The line that appears to the right of each Start box displays the date and time the selected DPX Spectra was
acquired. The line that appears to the right of each Stop box displays the date and time the selected DPX
Spectra in the current acquisition was acquired.

Select All button. Selecting Select All resets the Start and Stop values. The Start value is reset to the first
DPX Spectra of the current acquisition. The Stop value is reset to the last DPX Spectra in the current
acquisition.

Acquisition Info Tab

Displays information about acquisition settings and sets the number of decimal places used for displaying
the time stamp.

Replay Speed Tab

Sets the speed at which data records are replayed.

| Select data recards | Select DPX Spectra | Acquisition Info | Replay Spesd |

Sl U Fast

Replay Menu

The Replay menu provides controls that let you choose how to replay acquisitions. The replay function
enables you to, in effect, “rerun” an analysis while applying different measurements to the same set of
acquisition data.
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Acq Data
Menu item Description
Acq Data Select Acq Data to replay acquisitions.
DPX Spectra Select DPX Spectra to replay a DPXogram display.

Replay all selected records

Replays the sequence of records specified by Start and Stop on the Select data records
tab.

Loop overall selected records

Replays the sequence of records specified by Start and Stop on the Select data records
tab continuously.

Replay current record

Replays the currently selected acquisition (or frame).

Replay from selected

Displays a submenu that you use to specify which records are to be replayed.

First record

Replays the first record within the selected set.

Previous

Replays the previous record within the selected set.

Next

Replays the next record within the selected set.

Last record

Replays the last record within the selected set.

Pause Suspends replay of the data records as soon as the current record's replay action is
completed. Press Pause again to begin replay with the next record in the sequence.

Stop Halts the replay of acquisitions. If replay is started after Stop has been selected, replay
starts from the first acquisition.

Select all Selects all acquisitions for replay.

Select records from history

Displays the Select data records tab of the Replay control panel. Use the Select data
records tab to specify which acquisitions and frames you would like to replay.

Replay toolbar

Displays or hides the Replay toolbar.

Acq Data

Selecting Acq Data selects acquisition data as the source for replay. Selecting Acq Data does not start
replay, it only selects the type of acquisition data that will be replayed.

DPX Spectra

Selecting DPX Spectra selects DPX spectra as the source for replay. Selecting DPX Spectra does not start
replay, it only selects the type of acquisition data that will be replayed.

Replay All Selected Records

Selecting Replay all selected records replays all the selected data records. The set of selected records
may comprise a single record, all records in acquisition history, or a subset of the records in history.
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Replay Current Record

Selecting Replay current record replays the current data record. You can identify the current acquisition
record by looking at the Replay toolbar. The first number to the right of the Select button identifies the
current data record. For example, if the number is 2:10, it means the current record is the tenth frame of
the second acquisition in history.

Replay from Selected

Select Replay from selected to replay records as selected from the submenu. The records replayed can
be from the acquisition memory (history) or from a saved acquisition data file that has already been
recalled as the current acquisition data.

Pause

Select Pause to suspend playback. Selecting Pause again restarts the replay at the point it was paused.

Stop

Select Stop to halt the replay of data. Selecting any Replay action restarts replay of records from the
beginning.

Select All

Select Select all to select all data records for replay.

Select Records from History

Selecting Select records from history displays the Select data records tab of the Replay control panel.
The Select data records tab allows you to specify which records in the acquisition history will be used
when the Replay button is selected.
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Replay Toolbar

Displays or hides the Replay toolbar that appears below the main tool bar.

Replay: Acq Data SlHA e WD Select 21 Select.. §9 120 9/421/2011 11:27:36.27
Replay toolbar

Item Description

Replay Selects data type to be replayed.

Replays the first record in the selected set.

4

Replays the previous record in the selected set.

4

Replays the current record in the selected set.

@

Replays the next record in the selected set.

Replays the last record in the selected set.

4l

Replays all records in the selected set.

Replays all records in the selected set continuously until stopped.

L

Pauses replay. Pressing pause suspends replay with the current record. Selecting pause
] again starts Replay with the next record.

8 Stops replay. Starting any replay action after pressing stop starts a new Replay action
rather than continuing from the record at which the previous replay action was stopped.

Selact Al Pressing Select all selects all records in history for replay. Selecting Select all resets the
el Start and Stop values on the Select data records tab of the Replay control panel.

Pressing Select displays the Select data records tab of the Replay control panel. The
select... Select data records tab allows you to select records from acquisition history for replay.
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Item Description
1:10 371072010 4475174 This readout shows informa.ti.on about the data record bejng replayed. The information
displayed shows the acquisition and frame number and time stamp for the current data
record.
P The Info button displays the Acquisition Info tab of the Replay control panel. The
L1 Acquisition Info tab displays information about the acquisition data such as acquisition

bandwidth, sampling rate and acquisition length. All data records in the acquisition
history were acquired with identical parameters. When any of these parameters are
changed, all records in history are deleted as soon as the first record acquired under the
new parameter values is received.
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Amplitude Settings

Menu Bar: Setup > Amplitude
Application Toolbar:

Amplitude Settings

The Amplitude control panel provides access to power-related settings that are used by all displays within

the analyzer application.

Internal Sattings | External GainfLoss Correction | Extermal Probe Correction |

[C] External Gain value; 0.0 dB

Apply external corrections to:

External Loss Tables (Loss = 0, Gain < 0)

[ |Ext Loss Table 1 Edit...

O Al acquired data (filter method) O |Ext Loss Table 2 Edit...
Traces in applicable displays SErTE—
@ see User Marual for list) [0 |Ext Loss Table 3 Edit...

Setting Description
Internal Settings (see Sets the parameters that control the acquisition of the signal.
page 363)

External Gain/Loss Correction Specifies whether a correction is applied to the signal to compensate for the use of

(see page 366) external equipment.

External Probe Correction (see  Specifies whether a correction is applied to the signal if the analyzer detects a probe is
page 370) connected to the instrument. (Probes are connected to the analyzer through the RTPA2A

Real-Time Spectrum Analyzer TekConnect Probe Adapter.)

Internal Settings Tab

On the Internal Settings tab, you can specify the Reference Level for the signal analyzer's RF front end,
the settings for the internal attenuator, enable/disable the optional internal preamp, and specify the RF &

IF Optimization.

Internal Settings | External GainfLoss Correction | Extemal Probe Correction |

RefLevel, 0.00 dBm [T Internal Preamp
1.0 MHz - 6.2 GHz
Internal Attenuator: 15 dB [ auta [¥IManitor attenuator Lse

RF & IF Optimization: |Best for multiple displays v]
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Internal Attenuator

The Internal Attenuator setting can be set to Auto or manual. When Auto mode is enabled, the attenuation
setting is displayed but is not adjustable. When Auto is disabled, the attenuator operates in manual mode,
allowing you to set the internal attenuation. The internal attenuation setting range is 0 - 75 dB.

Internal Preamp

If your instrument has the optional internal preamp installed, use this setting to switch the preamp on or off.

NOTE. To ensure the best accuracy, turn on the Internal Preamp and allow it to run for 20 minutes to
thermally stabilize before taking critical measurements.

Monitor Attenuator Use

The input attenuator relays are rated for several million cycles. Some measurement settings result in high
rates of attenuator switching and could prematurely age the relays. Enabling this function causes the
instrument to monitor the attenuator switching rate. When a high rate of switching is maintained for more
than an hour, the instrument will halt acquisitions and display a message about the condition. To restart
acquisitions, press Run. If the check box is not selected, the monitoring function is disabled.

NOTE. This feature is provided to prevent accidental long-term high-rate attenuator switching (thus
extending attenuator life). If you need to run the instrument for extended period, such as overnight or over
a weekend, disable the setting to prevent the halting of acquisitions.

RF & IF Optimization

Specifies how the gain and bandwidth should be optimized (in the RF and IF stages of the front end). The
available settings are: Best for multiple displays, Auto, Minimize Sweep Time, Maximize Dynamic Range
(Spectrum/Spectrogram only) and Minimize Noise.

You can select RF & IF optimizations to achieve the best dynamic range, fastest sweep speed, or minimum
displayed noise. These choices affect the RF and IF attenuation levels, the selection of the acquisition
bandwidth, digitizer and the resolution of the mathematical operation performed on the acquisitions used in
varying conditions of span, reference level and resolution bandwidth. The following paragraphs describe
the effects of choosing each of the available choices.

Best for multiple displays (Default). This setting is the instrument default and is set as part of the Preset
function. When this is selected, the instrument considers all the open displays and chooses an Acquisition
Bandwidth wide enough to satisfy as many measurements as possible. Instead of optimizing the
measurement performance of the selected display, this setting decreases the incidence of non-selected
displays being unable to run because the acquisition bandwidth is set too small by the selected display.

Auto. The Auto setting is an optimized trade-off of the competing performance choices.

Minimize sweep time. Selecting Minimize Sweep Time causes the instrument to use the widest available
acquisition bandwidth when sweeping across spans greater than the maximum available real-time span.
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RSA6100B Series: For instruments without Option 110 (110 MHz acquisition BW), this control has no
effect. For instruments with Option 110, the swept update rate is improved by approximately 3X compared
to all other RF/IF optimization choices. RSA5100A Series: For instruments with Option 40/85, swept
update rate is significantly faster than Auto. This setting has no effect in instruments without Option 40/85

Maximize dynamic range. Selecting Maximize Dynamic Range has several effects:
B Sets RF attenuation to allow higher drive levels at the RF mixer.

B Sets IF gain levels to optimize the IF for the higher signal levels that result from allowing higher
drive levels at the mixer.

®m  Selects the acquisition path used in the instrument taking into account the user-specified Resolution
Bandwidth (RBW). When an RBW of less than 30 kHz (RSA6100B) or 20 kHz (RSAS5100A) is
selected, the instrument uses a narrow-band (312.5 kHz) acquisition path, regardless of the selected
span or measurement bandwidth. This results in the best rejection of out-of-band signals in the IF
stage of the analyzer, but comes at the cost of slower update rates for all signal analyzer spans and
measurement bandwidths greater than 312.5 kHz.

B Increases the resolution of the mathematics used in calculations of all signal results from 16 bits to
28 bits whenever span or measurement bandwidth is set to <312.5 kHz. This is made possible by the
high levels of decimation applied to signals processed in these narrow bandwidths.

Minimize noise. This mode increases the system gain at points past the RF mixer. This has the effect of
reducing the displayed average noise level.

The table below summarizes the conditions.

Settings RF auto Selected Acquisition IF Gain/Loss Notes and Trade-offs
attenuation Bandwidth settings
(min 10 dB,
max 55 dB)
Best for Multiple Ref Level Acquisition Bandwidth is Neutral Swept Speed, Dynamic
Displays +15 dB set to the value required Range, Noise Floor

to service as many of the
open displays as possible.

Auto Ref Level Driven by the Neutral Swept Speed, Dynamic
+15 dB measurement bandwidth Range, Noise Floor may
of the selected display. If not be optimal

span is greater than the
available acquisition BW,
unit sweeps using 25 MHz
(SPECMON3) or 85 MHz
(SPECMONSG) acquisitions
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External Gain/Loss Correction Tab

Settings RF auto Selected Acquisition IF Gain/Loss Notes and Trade-offs
attenuation Bandwidth settings
(min 10 dB,
max 55 dB)
Minimize Ref Level Unit uses widest available Neutral RSA6100B Series: For
Sweep Time +15 dB acquisition BW for spans units equipped with
greater than maximum Option 110 (RSA6100B),
acquisition BW. swept update rate is
approximately 3 times
faster than Auto. No
effect in units without
Option 110.
RSA5100A Series: For
units with Option 40/85,
swept update rate is
significantly faster than
Auto. No effect in units
without Option 40/85
Maximize Ref Level Driven by span and IF attenuation Might result in very
Dynamic Range +20 dB user-selected RBW increased to slow sweep speeds in
when a spectrum-type improve dynamic wide spans when RBW
display is selected, range. This < 20 kHz.
or by measurement causes higher
bandwidth and filter noise level.
bandwidth when other
display types are selected.
For RBW < 20 kHz,
the high dynamic range
312.5 kHz path is used
regardless of selected
span or measurement
bandwidth. Sweeps
are made in 85 MHz
(SPECMONS) or 25 MHz
(SPECMON3) acquisitions.
Minimize Noise Ref Level Same as Auto Set to minimize Might result in earlier IF
+15 dB noise level. overload under some

signal conditions.

External Gain/Loss Correction Tab

The External Gain/Loss Correction tab allows you to apply a correction to a signal to compensate for the
use of external equipment, such as an amplifier or attenuator. You can specify whether the corrections on
this tab apply to all acquired data or only to a set group of displays.

366
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External Gain Value

Use the External Gain Value setting to apply a flat gain/loss correction to the signal. Positive values
represent a gain and negative values represent a loss. The range is —50 to +30 dB. Resolution is 0.1 dB.

NOTE. Selecting Preset clears the check box, but it does not change the value.

Apply External Corrections To

Use the two selections to specify whether the enabled external loss tables are applied to all acquired data
or only to fraces in the Spectrum, Spectrogram, Spurious, and Amplitude vs Time displays.

When choosing whether to correct sample data or traces, keep the following in mind:

B [fsample data is acquired while data correction is enabled, that data record is permanently corrected.
If the acquisition is saved and recalled, the recalled acquisition includes corrections. Corrections
are not saved separately from the raw data; they are used during the acquisition process to adjust
the data values.

m  Trace corrections can be applied at any time, as they are part of the measurement's computations.
Using Replay will apply trace corrections to a trace if this control is enabled (and an external loss
table is specified and enabled).

m  Be aware that if you recall acquisition data that was saved with data corrections and you use Replay
with trace corrections selected and an external loss table enabled, the trace will be calculated using
corrected data and also corrected with trace corrections. This probably creates incorrect traces.

B When only Traces are being corrected, triggering operates on uncorrected acquisition data. Frequency
masks and trigger level lines in the displays are also not corrected, so there is a visual discrepancy
between data traces and trigger indicators in the graphs under this condition.

B When only Traces are being corrected, triggering operates on uncorrected acquisition data. Frequency
masks and trigger level lines in the displays are also not corrected, so there is a visual discrepancy
between data traces and trigger indicators in the graphs under this condition.

Trace Corrections Versus Data Corrections

Because of the real-time nature of the instrument and desire to frequently reanalyze stored acquisitions, it
is possible to apply amplitude corrections in real time. Applying real-time corrections to the incoming
data means that, the correction factors present during the acquisition are already part of the data when
the data is stored and then reanalyzed. This also allows the DPX display to maintain its update rate
while presenting an amplitude-corrected display.

Real-time gain/loss factors are applied by creating a correction filter that is applied by the same digital
signal processing hardware used to correct for calibration and alignment factors in the instrument. This
process does have limitations. In creating a digital filter to represent the gain/loss table, a limited number
of filter taps are be used in order for the filter to be practically realizable. If your amplitude corrections
contain discontinuities or extremely sharp transitions, the filter used will contains errors and ringing.
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If the above is the case, we recommended that you use trace corrections. These are very similar to a
conventional spectrum analyzer, and may be applied to the spectrum, spectrogram, spurious search and
amplitude vs. time displays. These traces may contain transitions of any type within the maximum and
minimum correction values allowed in the tables.

External Loss Tables

368

Use an External Loss Table to apply a frequency dependent gain/loss correction to the signal. When an
External Loss Table is selected, the analyzer adjusts the signal according to the values in the table. An
external loss table allows you to compensate the signal level for variations in cable loss, antenna frequency
response or preamp frequency response.

You can create external loss tables from the analyzer application and save them as files. External loss tables
are saved as plain text files in CSV (Comma Separated Value) format. The tables have a CSV file extension.

You can change the title for each table. However, note that the title is only a label. It is not tied to the file
name of any table you may have loaded or saved.

NOTE. If you are using an External Loss Table for antenna corrections, be sure to set the Amplitude units
(Setup > Analysis > Units) to dBuA/m, dBuV/m, V/m or W/m?.

Creating an External Loss Table
You can create an external loss table with the analyzer application. No external application is required.
To create an external loss table:

1. Click Edit. to display the Table Editor.

o= Tahle Editar - Ext Loss Table 1 = ||
dd Poirt Undo X Frequency Y Loss (Atten)
2.000000 GHz

Frequency Interpolation

@ Linear

Log (affects only
= Trace Correction)

Mew Table

Load... ‘

wend) o] [ [em]

2. Click New Table to create a table. This clears all entries in the existing table and loads the default table.
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3.

To edit values in the table:
a. To edit an existing value, double-click on the cell you want to edit.
b. To add a new point to the table, click on Add Point. Edit the values as required.

c. Click Apply if you want to test your table without closing the editor (the table must be enabled
with the check box in the control panel and measurements must already be running).

To specify a frequency multiplier, you can type K, M, or G.
To delete a point from the table, select the point to be removed, and click Delete.
Select the Frequency Interpolation method:
= Select Linear when the frequency scale of the spectrum or spurious measurements are linear.
= Select Log when the frequency scale of the spectrum is logarithmic.
When you have entered all the necessary values, click Save As (to save the table in a file) or click OK.

From the Save As dialog, name the file and save it in the desired location.

External loss tables are saved in CSV (Comma Separated Value) format.

Loading an External Loss Table

To load an external loss table file:

1.

2
3.
4

Click Edit to display the Table Editor.

Click Load to display the Open dialog box.

Navigate to the location of the desired file, select it and click Open.
Click OK.
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External Probe Correction Tab

The External Probe Correction tab is used to specify whether a correction factor is applied to the signal
when a Tektronix P7000 Series probe is connected to the analyzer through the Tektronix RTPA2A
Real-Time Spectrum Analyzer TekConnect Probe Adapter.

| Internal Settings | External GainfLoss Carrection | External Probe Correction |

Probe connected

[¥] Correct data for probe attenuation: 20,2 dB

The analyzer can detect when an RTPA2A TekConnect probe adapter is connected to the instrument.
The only setting available on the tab specifies whether a correction is applied to the signal or not. The
amount of correction is specific to the probe and is communicated to the signal analyzer through the
RTPA2A TekConnect probe adapter.

If the signal analyzer does not detect a probe adapter, the setting to correct for a probe is dimmed and No
probe detected is displayed on the tab.

| Internal Settings | External GainfLoss Carrection | External Probe Carrection |

Mo probe detected

Correct data for probe attenuation:
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Continuous Versus Single Sequence

Menu Bar: Run > Single Sequence / Continuous

Selecting Single Sequence sets the acquisition mode so that when you press Run, a single acquisition

sequence is performed and the instrument stops once the acquisition sequence is completed. Selecting
Continuous sets the acquisition mode so that an acquisition sequence is started as soon as you select

Continuous and as one acquisition sequence completes, another begins.

Note that an acquisition sequence can require more than one acquisition. For example, in a spectrum view,
the trace function might be set to Average 100 acquisitions Thus, a complete acquisition sequence would
consist of 100 acquisitions that are averaged together to create the trace that is displayed.

Run

Menu Bar: Run > Run
Application Bar / Front Panel: Run

Selecting Run begins a new acquisition/measurement cycle.

Resume

Menu Bar: Run > Resume

Restarts data acquisition, but does not reset accumulated results, such as Average or MaxHold. This
allows you to stop acquisitions temporarily, then continue. If the accumulation is already complete, for
example, 10 acquisitions or 10 averages have already been completed, each subsequent Resume command
will cause one more acquisition to be taken, and its results added to the accumulation. Not available if
instrument settings have been changed.

Abort

Menu Bar: Run > Abort

Selecting Abort immediately halts the current acquisition/measurement cycle. In-process measurements
and acquisitions are not allowed to complete. Visibility and accuracy of results is unspecified after an abort.
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The Acquire Control Panel

Menu Bar: Setup > Acquire
Application Toolbar:

Selecting Acquire displays the Acquire control panel. These settings control the hardware acquisition
parameters for the signal analyzer. Normally, these parameters are automatically adjusted for selected
measurements. You can use Acquire to change these parameters manually if necessary.

r:;::lmm Sampling Parameters | advanced | Fastsave | Input Params|
Froros o adjust | all Auto (recommended) - Zg:gﬂniii}ss o [@FastErame
o 50,00 MHz R TR Max frames: 10

99233 902 kSamples Actual: 9

1,190 ms Using: 10.71 ms 803 kSamples 89.1 % of capacity
Tab Description
Sampling Parameters (see Sets the parameters that control the acquisition of the signal.
page 372)
Advanced (see page 374) Sets the Dither parameters.
FastSave (see page 377) Sets the FastSave parameters. Initiates FastSave acquisitions.
Run

Run mode specifies whether the analyzer will stop acquiring data after it completes a measurement
sequence.

®  Continuous - In Continuous mode, once the analyzer completes a measurement sequence, it begins
another.

= Single - In Single mode, once the analyzer completes a measurement sequence, it stops.

NOTE. A measurement sequence can require more than one acquisition. If the analyzer is configured to
average 100 traces together, the measurement sequence will not be completed until 100 traces have
been acquired and averaged.

Sampling Parameters Tab

372

The Sampling Parameters tab enables you to set the controls for data acquisition. There are two settings
on the Sampling Parameters Tab, the Adjust setting and FastFrame. Depending on the setting chosen
for Adjust, two additional parameters can be set. Normally, the best results are achieved by leaving
the Adjust control set to All Auto. Manually overriding the automatic settings affects both real-time
and swept acquisitions.
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Sampling Parameters | Advanced | FastSave | Input Params|
Adjust [AII Auto (recormmmended) v‘ 75.00 MSfs
13.3 nsec/Sample FastFrame
o 60,00 MHz May fr 10
Capacity: 12.0ms Pt rames
o 299233 902 kSamples Actual: 9
o 1.190 ms Using: 10.71ms 203 kSamples 29.1 % of capacity

Sampling Control

There are three sampling parameters that interact with each other: Acquisition Bandwidth, Acquisition
Length, and Acquisition Samples. Acquisition Bandwidth is the frequency range of the acquisition.
Acquisition Length refers to the time over which the acquisition occurs. Acquisition Samples is the
number of samples acquired over the acquisition time. The parameters available for Adjust and how the
parameters are determined are shown in the following table.

Adjust User sets Analyzer calculates

All Auto N /A N /A All values based on the
open displays, with the
highest priority given to the
selected display

Acq BW / Acq Samples Acq BW Acq Samples Acq Length

Acq BW / Acq Length Acq BW Acquisition Length Acq Samples

Acquisition Memory Usage

The center portion of the tab shows how the acquisition memory is used.

Readout Description

Samples/s, sec/Sample Readout of the acquisition sample rate and sample period.

Capacity The maximum period of time and number of samples that could be acquired with the
current sampling parameters.

Using The total amount of acquisition memory that will be used based on the current settings.

FastFrame

FastFrame is a feature that allows you to segment the acquisition record into a series of frames, or data
records. A typical use of FastFrame is to record data samples around signal events of interest, while
not wasting memory on irrelevant data between these events. FastFrame is only valid for real-time
acquisitions. If any measurement is configured for swept acquisitions, an error message is displayed:
Disabled: FastFrame doesn't support swept settings.

Setting Description
FastFrame Enables FastFrame acquisition mode.
Max Frames Specifies the maximum number of frames to record in a single acquisition process.
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The Actual readout shows the actual number of frames that will be acquired into the acquisition memory.
This number changes based on the Acq BW, Acq Samples, and Acq Length values. This number will
never be greater than the value set by Max Frames.

Advanced Tab (Acquire)

374

Provides access to Advanced Acquire settings.

Sampling Parameters | Advanced |Fast8ave | Input F‘arams|

Dither Contral: | Aufo Dither Status: On {required by selected RF & IF Optimization)
Setting Description
Dither Can be set to Auto or Manual. In Auto mode, each measurement sets Dither as

appropriate for the measurement. In Manual mode, the user setting overrides the
measurement preference.

Dither

Dither is the process of adding noise to the analog signal prior to the analog-to-digital conversion. The
purpose of adding noise is to randomize the quantizing process of the ADC (analog-to-digital converter) so
it does not appear as discrete components in locations where the distortion components of the ADC would
fall. All ADCs produce quantizing errors that appear as noise (quantizing noise) or as discrete components
which are less desirable. Without dither and in the presence of tones that are close to sub-multiples of the
sample rate or correlated to the sample rate, all the quantizing energy can fall in the same locations as
discrete distortion components. This can increase what appears as spurious tones but they are not related
to the normal spurious mechanisms or true distortion. Adding noise can randomize the quantization
process so those tones aren’t produced.

In general, you should leave the Dither setting on Auto. In the Auto mode, individual measurements will
select the best guess dither setting (on or off). In Manual mode, the user setting overrides individual
measurements’ dither settings enabling the user to determine the best use for the best measurement.

NOTE. If'the RF & IF Optimization (see page 364) is set to Best for multiple displays, you cannot change
the Dither setting.

Dither is not always necessary. The signal itself can be used to randomize quantizing errors. Since the
input signal is not under control of the instrument, the use of dither is signal dependent and its use must be
determined by the user. Typically, pure tones create the most problems with quantizing errors. Dither
should be used for those input types. Many digital modulation types are noise-like, so dither is usually not
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needed for modulation types such as CDMA, GSM and many others. Dither also uses up a bit of headroom
in the ADC, typically 2-3 dB. If the largest dynamic range to the noise floor is needed, that is Signal to
Noise Ratio, the dither can probably be turned off. The measurements for Channel Power/ACLR and
MCPR automatically turn dither off for just that reason. Signals in the range of -6 dB to -40 dB below the
reference level usually show the greatest benefit from having dither present. The user can find the best
use by observing the results for the particular input signals while setting dither on or off. There are cases
where dither can make things worse. If dither makes an improvement in the measurement, it should be left
on. It is doing its job to improve dynamic range. If it makes it worse, dither should be left off.

FastSave

FastSave (also known as Fast Save) is a way to automatically save acquisitions to a file. It is a way to
collect data, not to analyze the data. Analyzing the data require recalling the saved acquisition data file.

When making acquisitions and performing analysis, the instrument creates a cache file with a copy of the
acquisition that it uses as the source for analysis and displays. To Save a waveform as a .TIQ or .MAT file,
the instrument pulls data from the cache, formats the data for the chosen file type, and writes again to the
disk with a .TIQ or .MAT extension. Normal operation requires creation of the cache file and reading of a
cache file prior to analysis or save functions. These hard-drive read and write cycles can be time consuming
for large files. If you need only to save data for later analysis, a mode named FastSave is available.

Real Time Processes
(Triggers, DPX)

AD Hardware Decimation Acq. Memory
Conversion ) (16 to 24 b/sample) 4 or 8 Bytes per
(14b/Sample) 4 or 8 Bytes per 1Q Pair IQ Pair T

PC Bus

Analysis U
and Display ) PC Memory
(pulls from cache (] | cacheFie no 8B/Sample

to PC memory) yes
U 0070-033
Save/Recall as .tiq or .mat <:> tigor mat
Save: Pulls from cache to PC memory, File
adds Header information, writes to new file

Recall: Pulls from .tiq or .mat file
to create cache
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FastSave mode bypasses cache file creation and writes directly to a file. This eliminates two of three disk
read or write operations. Depending on the file size, FastSave reduces the time required for data acquisition
up to 65%. Using FastSave means that on/y real-time processes will be used. The instrument triggers

and DPX display are not affected. All other measurements are suspended, and an information message
(Disabled - FastSave is selected) is displayed in the graph area of each display.

Preparing for a FastSave Acquisition
1. Configure the instrument as necessary to capture the signal event you are interested in.
On the Setup > Acquire > FastSave tab, specify the Base file name.

2

3. Click the ... button to specify the location where the acquisition files will be saved.

4. Set the number of files to save by entering a number in the Max files saved per Run box.
5

Specify the file format (TIQ or Matlab).

Starting a FastSave Acquisition
To start a FastSave acquisition:
1. Select the Acq button to display the Acquire control panel.
2. Select the FastSave tab.
3. Seclect the FastSave acquisition data checkbox ton enable FastSave acquisition.
4. Start a FastSave acquisition:
a. If the instrument is running when you enable FastSave, FastSave acquisitions begin immediately.

b. If the instrument is paused when you select FastSave, select Run to begin FastSave acquisitions.

NOTE. When using FastSave in Single Sequence, it is possible for more than one acquisition to be saved
under the following conditions.

* The DPX display is open
* Acquisition length is less than about 50 ms

FastSave can store more than one short acquisition in the time it takes DPX to acquire, process and
display one set of DPX spectrums (about 50 milliseconds). Thus, you may find that FastSave creates more
than one file under these conditions. To limit FastSave to a single acquisition per process, set Max files
saved per run to 1 in the FastSave tab (Setup > Acquire > FastSave).

FastSave Status Messages

Once the FastSave acquisition begins, a status messages appears in the graph area. The message that
appears depends on whether the instrument was running or paused when FastSave acquisition data was
clicked.
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FastSave Tab

m  Disabled - FastSave is selected: This appears when acquisition is paused. It means that the display
update is disabled until FastSave is disabled. FastSave acquisition will not begin until you select Run.

B Saving X of XX - FastSave is active and saving files. This appears only while FastSave is active.

B Done saving - restart with Stop, then Run .. More - Displayed when the specified number of files
have been saved. FastSave can be restarted by selecting Run to begin a new set of acquisitions.

FastSave Tab

Use FastSave tab is used to configure and initiate FastSave (see page 375) acquisitions.

Sampling Parameters | Advanced | FastSave | Input Params

FastSave acquisition data

(1 acquisition per file,

Analysis disabled except DPX)

Format: | TIQ -

Setting

Location:

| \RsA81004 Files =
Base file narme: Max files sawed per Run:
SAWVED 10

Description

FastSave acquisition data

Enables/disables FastSave acquisitions. If acquisitions are running, selecting the
FastSave acquisition data checkbox immediately begins saving acquisition data to files.
If the instrument is paused, FastSave acquisitions will not begin until you select Run.

Format

Specifies the file format of the FastSave acquisition data files. Files can be saved in
TIQ or MAT format.

Base file name

Specifies the base name for acquisition data filenames. When acquisition data files are
saved, a 24-character timestamp is appended to the base file name. The maximum base
file name length cannot exceed 232 characters.

Location

Specifies the directory location where files will be saved. Files can be saved on the
local hard drive, a network location or even a USB- connected drive. However, due to
the time required to transfer files across a network or by USB, the local hard drive is
the only recommended location.

Max files saved per Run

Specifies the number of files to be saved each time a FastSave acquisition is started.
The number of files that can be saved is limited only by the storage space available.
Each saved acquisition file uses about 3.3 MB of space.
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Saving and Recalling Data, Settings, and Pictures

You can save different types of data for later recall and analysis.

Data type Description Save as type

Setup files Saves all of the setup information for Setup (.Setup)
all displays, except those settings that
are not part of Preset.

Picture of Selected Display Saves a capture of the screen in the Picture (.BMP, .PNG, .JPG)
(PNG/JPG/BMP) specified format. This option is useful

for including the graphic in reports or

other applications. Marker readouts

and other information are included.

Results Export files Saves the trace and numeric data for Results export (various)
the selected display. The trace and
numeric data are saved as CSV files.

Measurement Settings Saves a list of settings relevant to the Measurement settings export (TXT)
selected measurement to a text file.
This option is useful for including the
measurement settings in reports.

Trace Saves a trace for later recall into the Selected trace (various)
display from which it was saved.

Data Saves data for reanalysis by Acquisition data with setup (TIQ); or
RSA6100B Series Real-Time Acquisition data export (CSV or MAT)

Spectrum Analyzers, RSA5100A
Series Real-Time Signal Analyzers,
SPECMON Series Real-Time
Spectrum Analyzers, or as data to use
with external software (either CSV
(comma-separated value) or MAT
(MATLAB format). For fastest capture
of data files in TIQ or MAT format,
use FastSave. This function disables
caching and analysis of incoming data,
greatly decreasing the time required to
save files to local or network storage.

Saving Files

Saving files follows the same procedure regardless of the type of data being saved. To save setups
(including application presets), pictures, results, or acquisition data:

1. Ifyou are going to save DPX Spectra (DPXogram) acquisition data, stop acquisitions.

Saving while running is allowed by the analyzer, but data files saved while running will not contain
any DPX spectral data.

2. Select Save As from the File menu to open the Save As dialog box.
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3. Navigate to the folder where you want to save the setups, or use the default location.

= To save setups so that they appear in the User Presets list, save your setup in the folder
C:\SPECMON Files\User Presets. The saved setup will appear in the User Presets window with
the name you give the file.

5. Enter a file name.

6. Select the type of file to save from the Save as type drop-down list.

7. Click Save.

8. Ifyou save acquisition data (Acq data with setup (TIQ), Acq data export (CSV), and Acq data export
(MAT)), the File Contents window appears. In the File Contents window, you need to specify the data
type, data records, and data length to save the acquisition data.

File Contents El@
Data types Data records
10 records Current acquisition
DPX spectra Current frame
@ Both I and DPX Selected acquisitions, frames
@ allin history
Data length
@ Entire record
Analysic length only
‘ Save ‘ ‘ Cancel

a. Select the data type: Choose 1Q data, DPX Spectra, or both. DPX spectral data only exists while
either the DPXogram or Split DPX display is open, and acquisitions are stopped. 1Q data is not
available when FastSave is turned on. In cases where the selected data type is not available, the
file will be saved without that data.

b. Select the data records you want saved. Frames can be saved only when FastFrame was enabled
during acquisition.

c. Select the desired data length. The data length controls are enabled only when 1Q data is being
saved.

d. Click Save to save the acquisition data file.

Saving Data with FastSave

To save data using FastSave, use the procedure Preparing for a FastSave Acquisition (see page 376).

Recalling Files

You can recall three types of files: Setup files, Selected Trace, and Acquisition data with setup. Recalling
data follows the same procedure regardless of the type of data being recalled.
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1. Select Recall from the File menu to open the Open dialog box.
2. Navigate to the folder containing the file you want to recall.

3. Select the type of file to recall from the Files of type drop-down list. This selection determines the
files that appear in the Open dialog box.

4. Select the file to recall.
5. Click Open.

To open an .iqt file:

Setup Files

You can set up the instrument as desired and then save the settings in a setup file. This enables you to
quickly setup the instrument by recalling previously saved setups.

Exporting Results

Save for further analysis of results in other programs, such as MATLAB or Excel.

Pictures of the Selected Display

You can save pictures of the instrument display for documentation purposes. When saving pictures of
the display, you can select from three file types: BMP, JPG, or PNG.

Measurement Settings

You can save a list of settings relevant to the selected display to a file for documentation purposes. The
exported file uses tab characters to separate values. The settings included in the file depend on the selected
display. The contents of the file are the same as a Results export except it does not include the results.

Saving Acquisition Data with Setup
Save for later analysis with the analyzer. The setup is saved as part of the acquisition data file so you can

choose when recalling data whether or not to also recall the associated acquisition and analysis parameters.

Saving Acquisition Data Export in CSV Format

Save for examining results in other programs, such as MATLAB or Excel.

Data, Settings, and Picture File Formats

You can save different types of data for later recall and analysis.
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Data, Settings, and Picture File Formats

File type File extension Description

Setup files .setup Setup files enable you to save instrument settings for later recall. Using
these files saves setup time and ensures consistent measurements.

Picture .png/.jpg/.omp Screen capture of analyzer application window. They are useful for
documenting results in test reports.

Results Export .CsV Results files contain the trace points and numeric values that were
produced by the selected measurement. The header of a Resullts file
includes key acquisition and analysis settings to aid in the interpretation
of the data. The file is saved as a plain text file, but the contents are
formatted as CSV (comma-separated values). Results files can be
opened from applications such as Microsoft Excel and MATLAB.

Measurement Jxt Measurement settings files contain a list of settings that describe how

Settings the instrument is set up for the selected measurement. The list contains

measurement settings (for example, Span), trace settings (for example,
whether or not a trace is selected) and global settings (for example,
Frequency and Reference Level). The list of settings contained in the
file varies depending on which display is selected.

Selected Trace

varies with display

Trace files contain the trace results data in binary format. These
files are only readable by the analyzer application. Several of the
instrument's measurements allow you to recall a Trace file for visually
comparing a saved trace to a live trace.

Acquisition Data
with Setup

tiq

These files contain the acquisition data record and complete instrument
setup (in binary format). Use these files to save data for later recall and
analysis. When you save an Acquisition Data file, the current Setup

is always saved with the file. At the time of recall, you will be asked
whether you want to restore only the acquisition data or both data and
setup. If the instrument is already set up for a specific measurement,
you will probably want to recall only the acquisition data. Recalling
both data and setup returns the instrument to the same state it was

in at the time you saved the file.

Acquisition Data

.CSV

These files contain 1Q sample data before it has been processed by
a measurement. The acquisition data points are saved as IQ pairs.
Use this format to import the acquisition data into Microsoft Excel for
further analysis.

Acquisition Data

.mat

These files contain IQ sample data before it has been processed by
a measurement. The acquisition data points are saved as IQ pairs.
Use this format to import the acquisition data into MATLAB for further
analysis.

Range file

.CSV

These files contain a list of settings that describe how the instrument is
set up for the Spurious measurement. The file contains the number of
ranges enabled, the start and stop frequencies for each enabled range,
the limits for each enabled range, the mask type and more.
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Results Export File Format

The Results Export format contains trace points and/or scalar results produced by the measurement. The
file contains general information about the measurement settings at the top of the file and the results data in
the second part of the file. Groups of settings or results are headed with [text], as described below.

At the top of the file is the measurement name and the date and time data was acquired.

The first group of settings is [Global Parameters]. These settings include the Measurement Frequency,
Acquisition Data, Reference Level and others.

The second group of settings is [Parameters]. These settings are specific parameters which vary depending
on the measurement.

The next group is [Trace Parameters], which may not be present, depending on the measurement. Within
this group, there are parameters specific to a trace. There will be a Trace Parameters group for each
trace shown on the display.

The next group is [Results]. These are scalar results for the measurement.

Next is [Traces]. The Traces group consists of one or more [Trace] groups. There is one Trace group for
each trace. Each [Trace] group contains background information about the trace (units, number of points, x
scaling, and others depending on the measurement) at the top of the group, followed by the trace points.

Acquisition Data with Setup File (.tiq) Format

The file consists of two parts - the header that is in XML and the data that is in binary format.

Header. The header consists entirely of the DataFile element. This element is broken down into
sub-elements.

1. DataSetsCollection

2. Setup

DataSetsCollection. The DataSetsCollection contains a DataDescription element, a DataSet element,
and a ProductSpecific element.

Binary data. Binary data is a sequence of Int32 values, which are 1Q pairs (I,Q,L,Q, ...) in binary Little
Endian format.
To convert these values to volts, multiply the individual values by the Scaling value in the DataDescription.

The binary data starts at an offset into the file == the "offset" attribute in the DataFile element. This
offset number will always start at the 19th character into the file (starting with 1), and will always be 9
characters long.

NOTE. You should not casually modify the XML header, because this will change the offset to the start of
the binary data.
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Acquisition Data Files (.csv)

The acquisition data files have two sections. At the top of the file is the following information:

®  SamplingFrequency - The sampling frequency in Hertz.

B NumberSamples - The number of IQ samples in the file.

®  DateTime - When the data was acquired.

B Frequency - The center frequency in Hertz.

B AcquisitionBandwidth - The acquisition bandwidth Hz.

Following the AcquisitionBandwidth are the data. The data are IQ pairs, in volts.

Groups of settings or results are headed with [some text].

The first thing in the file is the measurement name and the date/time when the acquisition was taken.

The first group [Parameters] are global parameters. Measurement Bandwidth in this group is the
measurement bandwidth used by the General Signal Viewing measurements (Spectrum, Amplitude vs.
Time, etc). It also includes some source settings, like Acq BW, Dither, Preamp, and RF Attenuation.

The second group [Parameters] are measurement-specific parameters.

Another group which can occur is [Trace Parameters]. Within this group, there will be a set of parameters,
one for each trace that is currently shown.

Another group is [Results]. These are scalar results for the measurement.

Another group is [Traces]. It has [Trace] groups under it, one for each trace. Each [Trace] group has
some background information about the trace (units, number of points, x scaling, etc), and the trace
points themselves.

Acquisition Data Files (.mat)

The acquisition data files saved in MATLAB format contain the following MATLAB variables:
B InputCenter - The center frequency in Hertz.

B XDelta - The sample period in seconds.

B Y - A complex array containing IQ pairs.

B [nputZoom - The acquisition bandwidth in Hertz.

The MATLAB format used to save acquisition data has the following properties and limitations:
B Files are stored in MATLAB Level 5 format.

B MATLAB Level 5 file size is limited to 2 GB.
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B The instrument acquisition memory limit is 1 GB (1.024 Gigabytes). Because of the way acquisition
data is processed, 1 GB of acquisition memory requires 2 GB of memory to store. When header
information (instrument settings) is added to the acquisition data, the resulting file size is >2 GB.

®  [facquisition memory is filled (1 GB), exporting the data to MATLAB format will result in a file that
exceeds 2 GB in Matlab level 5 format. A PC with sufficient memory is required to open the file. If
memory is not sufficient, Matlab will warn the user. To check how much acquisition memory is filled,
select Setup > Acquire > Sampling Parameters. When the instrument is stopped, or you are analyzing
a recalled data file, you can find the acquisition length under File > Acquisition Data Info.

Printing Screen Shots

You can screen print shots (screen captures) two ways: use File > Print or save a picture file and print the
file using a separate graphics program. Printing a screen capture is the same as printing with any windows
program. For details on the available file formats for saving a screen capture, refer to Data, Settings, and
Picture File Formats (see page 381). For details on saving a picture to a file, see Saving and Recalling
Data, Settings, and Pictures (see page 379).

To print a screen shot:
1. Select File > Print.

2. Select File > Print Preview if you wish to review the screen shot before sending it to the printer.

3. Select File > Print to print the file to a printer.
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Online Help

Menu Bar: Help > User Manual

Online Help

This menu item displays this help. The help is a standard Windows help system. The Online Help menu
item is the only method available to display the help; there are no other links to the help within the software.

About

the Tektronix RTSA

This window displays information about the software and hardware versions for the analyzer.

Ahout Tektroniz Real Tirne Signal Analyzer

Tektronix Real Tirme Signal Analyzer

Tektronix’

Enabling Innowation

Installed Options

RSAS106A W2, 7.0022

Copyright © 2006 - 2010 Tektronix, Inc. Al rights reserved

Internal Prearp (Opt S0)

Frequency Mask Trigger (Cpt 52

Signal Cutput Package (Opt 55)

advanced Signal Analysis (COpt 200

General Purpose Modulation Analysis (Opt 217
Phase Moise and Jitter Measurement (Opt 11)

m

Hardware Information

Serial Murnber: RS1

AcqControlBrd: Yer Ox03
acqCtrl bing Wer Ouffffff Gen Ouffffffff Inage OxfFFf
PPC Bld SirnulationMode: Yer 0x00 Gen 0x00 Image Ox00

Warning: This computer program is protected by copyright
lawe and international treaties, Unauthorized reproduction ar
distribution of this program, or any portion of it, may result
in severe civil and criminal penalties, and will be prosecuted
to the maximum extent possible under law,

Copy Info
Ok

Version

At the top of the window is a line that displays the version of the analyzer application software.

Installed Options

This text box lists the instrument options installed on the analyzer. This window does not list every option
installed on the instrument, just those that can be detected by the software.

H

ardware Information

This text box lists information about the instrument hardware versions.
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Copy Info

The Copy Info button copies information about the instrument to the Windows clipboard. This information
may be useful if you need to have your instrument serviced.

Configure In/Out Settings

Menu bar: Setup > Configure In/Out.

The Configure In/Out control panel enables you to configure the analyzer inputs and outputs. The settings
in this control panel are shared by all application windows.

Config In/Out | Trigger [/ |Frequency Reference | Other OutpLts

Trig 1 (front) Impedance

@ soq

Dok

Settings tab Description
Trigger 1/0 Specifies the impedance for the Trig 1 input.
Frequency Reference Specifies the source of the Frequency Reference. You can select between an Internal

(10 MHz) source and an external source.

Other Outputs (see page 392) Specifies whether the 28 VDC, Analog IF and 1Q outputs are on or off. Additional settings
are available for IF and |1Q outputs.

Connecting an RF Signal

388

The analyzer has a single RF signal input located on the front panel. The input impedance is 50 Q. The
input frequency range for each analyzer model is listed in the following table. The maximum measurable
continuous input power for all models is 1 W.

Model Input frequency range
SPECMON3 1 Hz to 3 GHz
SPECMONG 1 Hz t0 6.2 GHz

About RF Input Protection

The following paragraphs describe how the analyzer behaves to protect the RF input during power-off,
power-on, power-on self test (POST), and attenuator switching:

B When switched off (or when power is removed), the RF input is electronically disconnected from the
input connector. The analyzer always has a minimum 10 dB attenuation applied during power-up and
power-on-self-test. This is accomplished by always switching the attenuation control to Auto during
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these states. The minimum Auto attenuation value is 10 dB and is applied prior to the pre-amplifier
(Option 50/51) in the signal path.

B When switching attenuator values, the action is performed in a 'make before break' sequence, such that
the attenuation never switches to zero during an attenuator switching sequence. For example, consider
switching from 20 dB to 15 dB attenuation. This change requires the instrument to switch from using
one 20 dB attenuator to using one 10 dB and one 5 dB attenuator. This attenuator switching is done
such that the 10 dB and 5 dB attenuators are switched in prior to switching out the 20 dB attenuator.

To connect an RF signal:

1. If the source signal is greater than 1 Watt (+30 dBm), connect the source signal to an attenuator.
Connect the attenuator output to the RF Input connector.

c CAUTION. To prevent damage to the analyzer, do not connect signals greater than +30 dBm (1 Watt).

c CAUTION. To prevent damage to the analyzer, do not turn the equipment under test on or off with a LISN
(Line Impedance Stabilization Network) RF cable connected to the analyzer. The power cycling of the
equipment under test causes surge currents that can damage the sensitive input of the analyzer.

2. Connect the signal to the RF INPUT connector.

The maximum limits for the input signal are as follows:

SPECMON series maximum input signal limits

Characteristic Description
Maximum DC Voltage + 5V (RF input)
Maximum Measurable Input Power + 30 dBm (RF input, RF ATT Auto)

50 Watts peak (RF Band, RF = 30 dB (<10 ms pulse width, 1% Duty Cycle
repetitive pulses))
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Connecting a Signal Using a TekConnect Probe

You can connect a signal to the analyzer using a TekConnect Probe by using an RTPA2A Real-Time
Spectrum Analyzer TekConnect Probe Adapter. The RTPA2A enables you to use Tektronix P7000 Series
active and differential probes to connect to signals. See the RTPA2A Instruction Manual for instructions
on how to connect the probe adapter and a probe to the analyzer.

Installing the RTPA2A Probe Adapter Device Driver

When the RTPA2A probe adapter is connected to the instrument's USB port for the first time, the Windows
Add Hardware wizard may automatically start. If the wizard does start, use the procedure below to install
the device driver for the new hardware. (If the wizard does not start, the probe adapter device driver is
already installed.)

To properly install the probe adapter device driver:

1. Seclect the option for Windows to install from a specific location (then select Next).

2. Only search for the driver in the following location depending on your instrument:
= C:\Program Files\TektronixX\SPECMON\RSA\ProbeAdapter

3. If Windows warns about Windows Logo testing, select Continue Anyway.

4. Seclect Finish after the Found New Hardware wizard completes.

Connecting External Trigger Signals

390

External trigger signals are connected to the analyzer using the Trig In connector on the front panel. There
is also an additional trigger input on the rear panel, the Trig 2 In.

To connect a trigger signal to the analyzer, connect the signal to the Trig In connector on the front panel,
or the Trig 2 In connector on the rear panel.

Table 7: External trigger signal input requirements

Input Level Impedance
Trig In -25Vto+25V 50 Q or 5,000 Q
Trig 2 In +5 V (TTL) 10,000 Q

Enabling External Trigger

To use an external trigger signal, select either Trig In (front) or Trig 2 In (rear) in the Source control on
the Trigger control panel's Event tab .
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Digital 1/Q Output

The Real-time Digital I/Q Output is a means for the you to obtain the analyzer digital baseband I/Q signals
in a real-time data stream. This output enables you to use the analyzer as a down-converter and then pass
the down-converted baseband 1/Q signals to external equipment for either additional processing or storage.

|Q Outputs

Connect to the 1Q output signals on the rear panel of the signal analyzer. The rear panel connectors are
LVDS connectors. For full details on the connectors, see the SPECMON3 Real-Time Spectrum Analyzer
and SPECMONG Series Real-Time Spectrum Analyzer Specifications and Performance Verification
Technical Reference (Tektronix part number 077-0742-XX). A PDF file of the manual is located on the
Documents CD that shipped with your instrument. If you do not have access to the Documents CD, a PDF
of the manual can be downloaded from the Tektronix Web site, www.tektronix.com/manuals.

NOTE. The IQ and IF outputs are disabled when an alignment is running.
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Other Outputs

The Other Outputs tab is accessed from the Configure In/Out control panel (Setup > Configure In/Out).
The IQ output settings appear only when Option 55 is installed.

| Trigger /O | Frequency Reference | Other Outputs |

28V DC power 1Q Output
@ Off @ off
2 On D On

_) Test (Counting Pattern)

1Q Output

The Digital IQ Output transmits the digitized analyzer data for capture and storage by external equipment.
The 1/Q data is provided in 16-bit, two’s complement format, along with clock and data-valid signals.

There are three selections available for the IQ Output: Off, On, and Test. When in the “Off” position, the
1Q Output is disabled, and all lines are static. When in the “On” position, the data is output as described in
the SPECMON3 Real-Time Spectrum Analyzer and SPECMONG6 Series Real-Time Spectrum Analyzer
Specifications and Performance Verification Technical Reference (Tektronix part number 077-0742-XX).

Use the “Test” position to verify operation when setting up your equipment. When in the “Test (Counting
Pattern)” position, the I channel data will be counting up and the Q channel data will be counting down.
The EXT IQ CLK and EXT 1Q DAV signals will operate at a rate consistent with the instrument SPAN
setting.

Mapping Measurements

The SPECMON3 and SPECMONG6 can record measurements on a map using the included RSA Map
software. The RSA Map software lets you record measurements on a geo-referenced map or a bitmap map
for documentation purposes. If an external GPS receiver is connected to the analyzer, measurements can
be mapped at the GPS coordinates where the measurement was taken. Using an external GPS receiver,
RSA Map can perform repeat measurements using either time or distance to initiate measurements.

RSA Map software can also save results for future reference or analysis.

To map measurements:

m  Select Tools > RSA Map. This launches the RSA Map software in a separate window.
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File View Tools Help

% @ fr AW

Pl i

Stopped

Lat: -66.384429 | Long : 117.408538 | Scale:1:236830785 | WorldMap.bmp

Spectrum

x

Menu Overview

Full documentation on how to use RSA Map is provided in the RSA Map Help. In RSA Map, select

Help > User Manual.

Menu Overview

The main menus are:
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Menu

File Menu

Description

File (see page 394

Select measurements, open and save files, print documents, and preset.

View (see page 398)

Change display size, display the Marker toolbar and Status bar.

Run (see page 400)

Start, stop and abort acquisitions, select single or continuous acquisition mode.

Replay (see page 357) Replay measurements; select which record(s) to play, Replay/Stop/Pause, or enable
continuous loop.

Markers (see page 401) Define markers and search for signal peaks.

Setup (see page 401) Change settings for acquisition, trigger, analysis, measurements, amplitude, alignments,
and configure infout settings.

Tools (see page 402) Perform searches, access diagnostics, install upgrades and configure user preferences.

Window (see page 404) Controls the size and layout of displays within the analyzer application.

Help (see page 405) Access the help, display information about the instrument hardware and software.

File Menu
Command Description

Recall (see page 394)

The Recall dialog enables you to recall saved data, setups and traces.

Save (see page 395)

Saves a file without asking for a file parameters (based on most recent settings).

Save As (see page 395)

Displays the Save dialog enabling you to specify the parameters of the save operation.

Acquisition save options (see

page 29)

Displays the Save and Export tab of the Options control panel which allows you to specify
how much data is saved in acquisition files.

FastSave Acquisitions (see

page 377)

Displays the FastSave tab of the Acquire control panel which allows you to configure
FastSave acquisitions.

Acquisition data info (see

page 357)

Displays the Acquisition Info tab (see page 357) of the Replay control panel. The info
on this tab describes such acquisition parameters as acquisition bandwidth, sampling
rate, RF attenuation, and acquisition length.

Measurement Data Info (see

page 397)

Displays the characteristics of the most recently analyzed record in the display.

Print (see page 397)

Prints the selected display.

Print Preview (see page 397)

Displays a preview of the print output.

Preset (Main) (see page 398)

Preset resets the instrument to factory defaults. Acquisition data and settings that have
not been saved will be lost.

More presets (see page 398)

Displays a control panel where you can configure options for Presets.

Recall

394

Menu Bar: File > Recall
Front Panel: Recall

Application Toolbar:

Use the Recall command to load previously saved acquisition data, setups or trace data.
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To Recall Data or Setups

1. Select File > Recall. This displays the Open dialog box.

Open @
@\:/Vl o« Default (T » RSAS100A Files » Sample Data Records - |¢,| | Search Sampis Data Records j el |
Organize » MNew folder =y O @
* Name ‘ Date modified Type Size
s Libraries .
j o . B| ACPRDemo 312011 550 Ak TIO File £
4 OCUMments b
J“ Musi | FrDerno 3172011 850 Ak TIO File
@' Music
Pict L || FreqHopDemo 37142011 §:50 Ak TIO File
E‘ V'; Hres B FreqSettling_forvideaDerma 42372000 553PM  TIQ File 4
idens
B Frequency settling Fast Frame 310/2010 48 Ard - TIO File 4
o 8| IPR for 100 MHz LFM chirp at 1GHz CF 10, 3/7/2011 8,11 Akd TIO File
I e
s T:)mfpulerc B Maodified_Wikax6408M20M 27172011 2:44 P TIO) File
t (C:
& Default (C) B Phase settling fast frames 31172000 452 80 TIQ File 3 .
B2 WinT_external (E: U o >
21 items
File name: - IAcq data with setup (TIQ) v]
[ Open ] I Cancel I

2. Select the file type to be recalled and click Open.

Save / Save As

Menu Bar: File > Save / Save As

Use Save / Save As to store acquisition data, setups, and traces. Save is also used to export traces, results
and pictures of the display for use in other programs.

Difference Between Save and Save As

Use Save As to specify what kind of data you want to save and where the data should be saved. Use Save
to quickly save the same data as you saved the last time you executed a Save, without having to specify the
data type and location.

For example, suppose you want to save a picture of a spectrum trace each time you adjust a circuit to
document how the adjustments affect the output of the circuit. The first time you want to save a picture of
the display, you will need to select Save As. From the Save As dialog box, you specify the type of data you
want to save (Picture of Selected Display) and specify the location of the saved file. As long as the Save
and Export option (see page 27) is set to automatically name saved files, the next time you want to save a
picture of the display, you can just press Save on the front panel and a picture of the selected display will
be saved without requiring you to type a file name or the location of the file to be saved.
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Save / Save As

What Data Types Can Be Saved

Data type

Description

Acquisition Data

Data collected during acquisition that can be recalled for later analysis. Data is saved
in a format readable only by RSA6100B/RSA5100A/SPECMON Series instruments or
oscilloscopes running SignalVu software. You can save acquisition data as IQ records
only, DPX spectra (DPXogram data) only, or both IQ records and DPX Spectra.

Setup

Configuration information detailing instrument settings. Data can be saved in a
format readable only by SignalVu-PC, oscilloscopes running SignalVu software, or
RSA6100B/RSA5100A Series instruments.

Selected Trace

Saves the selected trace for later analysis by the analyzer. Data is saved in a
format readable only by SignalVu-PC, oscilloscopes running SignalVu software, or
RSA6100B/RSA5100A Series instruments.

Exported Traces and Numeric
Results

Save traces and results in a file format that can be used by other programs.

Pictures of the Display

Save screen images in graphic image file formats that can be used in other programs.

Exported Acquisition Data

Save acquisition data records in a file format that can be used by other programs.
Acquisition data can be saved in either comma-separated-variable format or MATLAB
format.

Data, Settings, and Picture File Formats (see page 381).

Options for Saving Pictures of the Display

Option Setting Description
Image PNG Saves exported screen captures in Portable Network Graphics format.
Format JPG Saves exported screen captures in Joint Photographic Experts Group (JPEG)
format.
BMP Saves exported screen captures in Windows bitmap format.
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Measurement Data Info

The Measurement Data Info command in the File menu displays a listing of acquisition-related information
about the last data analyzed by the selected measurement. The last data can be from the current acquisition
or it could be from a recalled data file.

-~

Measurementdatainf-:nrrnatil:nn || | (]

Last record analyzed in selected Display:

Timestarmnp: 7272011 4:26:46 PM
BiA: 85,000 MHz

Center: 1.9000 GHz

Length: 5,187 us

Samples: 778

Sarmple rate: 150,000 MHz

Mezs rarant bancwicdth and length are 2
sutrest of arquisition Bancdwidth and fength

Dare

Print

Menu Bar: File > Print
Front Panel: Print

Print displays the Windows Print dialog box for printing a screen capture of the display. To save ink when
printing, use the Colors tab to set the color scheme. See Options Settings (see page 27).

Print Preview

Menu Bar: File > Print Preview

Print Preview shows how a print out will appear when it is printed.
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Preset (Main)

Menu Bar: File > Preset

Preset resets settings and clears all acquisition data. Settings and acquisition data that have not been saved
will be lost. Settings in the Config In/Out (see page 388) control panel are not reset by Preset.

After Preset resets the analyzer settings, it displays the Spectrum view.

Preset does not affect time or date settings; the Windows operating system settings, or Tools > Alignments
or Tools Options menu items.

More Presets

The analyzer includes a set of configuration files that are tailored to specific applications or displays.
These configuration files open selected displays and load settings that are optimized to address specific
application requirements. You can add to the default presets by creating your own User presets. For
detailed information about these presets, see Application Presets . See Creating Application Presets .

View Menu

The View menu enables you to control the display of items in the application window.

Command Description

Full Screen (see page 398) Toggles all views between full-screen size and user-selected size.

Replay Toolbar (see page 360) Shows or hides the Replay toolbar.

Marker Toolbar (see page 339) Shows or hides the Marker toolbar. Enables you to define Markers and perform Peak
searches.

Status Bar (see page 399) Shows or hides the Status bar.

Full Screen

398

Menu Bar: View > Full Screen

When unchecked, clicking Full Screen resizes the application window to fill the screen. Full Screen mode
maximizes the application window, and turns off the application title bar.

When checked, clicking Full Screen restores the application window to its previous size. The application
title bar is restored.
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Status Bar

The Status Bar displays information on specific instrument settings. It contains only status information; it
does not display any error information. The Status bar has no controls. It can be hidden.

Elements of the Status Bar

Area within Bar Description

Run Status Displays the running state. For example, some run states are Arm, Ready, Triggered,
Analyzing, or Stopped.

Status message area Displays status messages (for example, ADC Overrange). When there no status
messages to report, displays current acquisition parameters (for example, Acq Length:
22.320 us).

Acquisition mode Displays either Real Time or Swept. Indicates how the next acquisition will be acquired.

Trigger Settings Displays Trigger settings. For example, you will see Free Run, Power, Trig In (front),
Frequency Mask and others.

Frequency Reference Setting Indicates whether the internal or external reference source is selected. Displays Ref;
Int or Ref: Ext.

Internal Attenuator setting Displays the setting of the internal attenuator.

Preamp Setting If the optional preamp is installed, this indicates whether the preamp is on or off. If the

preamp is on, displays Preamp: ON, 3 GHz max. as a reminder that the input frequency
range is restricted when using the preamp.

Run Status Indicators

Indicator Description

Acquiring The analyzer is capturing the signal.

Analyzing The analyzer has captured the signal and is processing the signal record.

Arm The trigger circuitry is filling the pretrigger portion of the signal record.

File Data The analyzer is analyzing recalled acquisition records.

Replaying The analyzer is analyzing recalled waveform or acquisition records.

Stopped If Stopped is displayed, Signal acquisition has been halted. This can occur because the

Run button has been pressed or because a trigger event has occurred, signal acquisition
has occurred and Run mode was set to Single.

Triggered If Triggered is displayed, the analyzer has recognized a valid trigger and is filling the
posttrigger portion of the signal record.
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Showing or Hiding the Status Bar

®  Select View > Status Bar to toggle the display of the Status bar.

Run Menu

The Run menu provides access to commands that control the signal acquisition.

Command Description

Run (see page 371) If acquisition mode is Stopped, selecting Run begins a new measurement/acquisition
cycle. If acquisition mode is Run, pressing Run halts the current measurement/acquisition
cycle after it completes.

Resume Restarts data acquisition, but does not reset accumulated results, such as Average
or MaxHold. This allows you to stop acquisitions temporarily, then continue. If the
accumulation is already complete, for example, 10 acquisitions or 10 averages have
already been completed, each subsequent Resume command will cause one more
acquisition to be taken, and its results added to the accumulation. Resume is not
available if instrument settings have been changed.

Abort (see page 371) Immediately halts the current measurement/acquisition cycle.

Single Sequence (see Selects the single-sequence acquisition mode. This is only a mode selector; it does
page 400) not initiate an acquisition.

Continuous (see page 401) Selects the continuous acquisition mode. Selecting Continuous does initiate acquisitions.

Single Sequence Acquisition Mode

Menu Bar: Run > Single

Selecting Single sets the Run mode to Single. In Single mode, as soon as one acquisition sequence
completes, acquisition stops.

Note that a single acquisition sequence can require more than one acquisition. For example, in a spectrum
view, the trace function might be set to Average 100 acquisitions. Thus, a complete acquisition sequence
would consist of 100 acquisitions to produce 100 intermediate traces that are averaged together to create
the final trace that is displayed. Once the 100 acquisitions have been completed, acquisition stops.

This is only a mode selector, it does not initiate an acquisition.
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Continuous Acquisition Mode

Menu bar: Run > Continuous

Selecting Continuous places the analyzer in the Continuous acquisition mode. In Continuous mode, the
analyzer acquires and displays acquisitions repeatedly. The Continuous and Single Sequence acquisition
modes are mutually exclusive.

Selecting Continuous restarts acquisitions.

Replay Menu

The Replay Menu (see page 357) allows you to rerun measurements using the data in acquisition memory
or a recalled TIQ file. You can use this to compute new results for old data after you change settings
or measurements.

Markers Menu

The Markers menu provides to settings that define and control the location of markers.

Setting Description

Peak (see page 337) Moves the selected marker to the highest peak on the trace.

Next Peak > Moves the selected marker to next peak depending on the setting chosen.
Marker to Center Frequency Sets center frequency to the frequency of the selected marker.

Define Markers (see page 337) Displays the Define Marker control panel.

Setup Menu

The Setup menu provides access to control panels that specify parameters for numerous signal analyzer
functions.
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Command Description

Displays (see page 31) Displays the Displays control panel.

Settings (see page 414) Displays the Settings control panel for the selected display.
Trigger Displays the Trigger control panel.

Acquire (see page 372) Displays the Acquire control panel.

Analysis (see page 349) Displays the Analysis control panel.

Amplitude (see page 363) Displays the Amplitude control panel.

Configure In/Out (see Displays the Configure In/Out panel.

page 388)

Preset (Main) (see page 402) Initiates the factory Preset.

More presets (see page 398) Recalls Application, DPX, or User Presets, or displays the Presets tab of the Options
control panel (Setup > Options).

Preset (Main)

Menu Bar: Setup > Preset (Main)
After Preset (Main) resets the analyzer settings, it displays the Spectrum display.

Preset does not affect time or date settings, the Windows operating system settings, or Tools > Alignments
or Tools Options menu items.

Tools Menu

Provides access to several utilities for controlling instrument functions.

Command Description

Search (see page 343) Enables you to locate and highlight specified signal levels in Spectrum displays.
Alignments (see page 21) Displays the Alignments dialog box.

Diagnostics (see page 404) Displays the Diagnostics dialog box.

Install Upgrades (see Used to activate upgrades you have purchased.

page 404)

Options (see page 27) Displays the Options control panel.

RSA Map (see page 392) Launches the RSA Map application for mapping measurement results.

Alignments Dialog

Menu Bar: Tools > Alignments
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The analyzer can adjust itself, optimizing the internal signal path used to acquire the signal you measure.
Alignment optimizes the analyzer to take more accurate measurements based on the ambient temperature.
The Alignments dialog enables you to specify when alignments occur, either automatically or only when
manually initiated.

Rlgnmerts o e
- automatically align as needed. Restart measurement if interrupted.

@ Run alignments only when "align Now" button is pressed,

Aligr Mo Abart

Elements of the Alignments Dialog

Setting Description

Automatically align as needed Specifies that alignments run as ambient conditions require.

Run alignments only when Specifies that alignments will never run unless manually initiated.
"Align Now button is pressed.

Align Now Use to manually initiate an alignment.

Abort Stops the alignment process.

Close Closes the Alignments dialog box.
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Diagnostics

Menu Bar: Tools > Diagnostics

Diagnostics

The Diagnostics menu item displays the Diagnostics Tests window, which enables you to run variety of
tests to verify the operation of the signal analyzer. For detailed information on running diagnostics, refer
to the SPECMON3 Real-Time Spectrum Analyzer and SPECMONG6 Real-Time Signal Analyzer Service

Manual, Tektronix part number 077-0755-XX.

Diagnastics

Diagrostics ‘F’Dwer-On Self Tests | Diagnostics Failure Info

Test Progress

=] allmodules, All Tests
- Hardware Init

Digital Interface Board

RF Interface

LOZ_REF

LO1

MFC LO

MFC 15G

MFC 26G

RF Corwverter

ADC

DPS4 Board

1Q Cutput Board

Front Panel

Dgggdﬂﬂﬂﬂﬂﬂﬂﬁ

RUN STOP

Current Series
Count: 0
Date: 7/27/2011
Time: 4:34 PM
Temp:

Repeat
O Times: 0
) until Fail

_ Continuous

@ Single Test

Exit Diagnostics

Install Upgrades

You can install upgrades on your analyzer as your needs change. To install upgrades, you will need an
Option Installation Key. For information about available options or to make a purchase in North America,

call 1-800-833-9200. Worldwide, visit www.tektronix.com to find contacts in your area.

Full instructions on how to install your upgrade and activate the option with the Option Installation
Key are provided in the upgrade kit instructions.

Arranging Displays

Use the Window menu to arrange how windows are displayed. Displays can be set to appear full screen
(one display at a time) or with all (selected) displays visible at once. When all displays are visible at
once, you can rearrange the displays by dragging the title bar of a window (deselect Window > Lock
Windows to move displays around).
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Command Description

Close View Closes the selected view.

Cascade Positions windows in a cascade view (not available when Lock Windows is selected).
Tile Horizontally Positions widows in a horizontal orientation (top to bottom).

Tile Vertically Positions widows in a vertical orientation (side by side).

Lock Windows Locks the windows into their current position, preventing them from being moved. If the

windows are locked, the Cascade arrangement is not selectable.

(List of windows) A numbered list of open windows.

Help Menu

The Help menu provides access to the help and version information about the analyzer hardware and

software.

Command Description

User Manual On-line Displays the help.

User Manual (PDF) Displays a PDF version of the help.

Application Reference (PDF) Displays a PDF version of the analyzer Applications Manual.
Quick Start Manual (PDF) Displays a PDF version of the analyzer Quick Start User Manual.

Displays information about the analyzer model and installed options.

Error and Information Messages

The following list describes some of the common error and information messages that might appear
during instrument operation. Messages that apply specifically to one or more measurements appear in the
displays. Messages that pertain globally, such as those about hardware status, are shown in the Status Bar
at the bottom of the analyzer application window.

Acq BW too small for current setup

The display needs a wider acquisition bandwidth than what the current data record contains. This can be
due to any of the following reasons:

B The sampling parameters are being manually controlled.

In the Acquire control panel > Sampling Parameters tab, set the Adjust control to All Auto to allow the
software to pick the sample rate and record length that it needs.

B A display other than the one you intended has been selected. The selected display has requested
a smaller acquisition bandwidth to achieve a better accuracy or dynamic range for its particular
measurement.

Select the display that contains the message. Click Run if the instrument is not already acquiring data.

B Acquisitions are not running and the measurement now requests a wider bandwidth than the last
acquisition.
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Click Run to perform a new acquisition with a wider bandwidth.
B The data is from a recalled TIQ file.

There is no way to increase the acquisition bandwidth for saved 1Q data. You must adjust the measurement
settings so that less bandwidth is required.

Analysis failure: <description of error>

The instrument is unable to complete a measurement due to difficulty in characterizing the signal. For
example, due to either the signal or settings, the instrument may not be able to recognize a pulse so it
can compute the pulse measurements.

B Try changing settings to improve analysis. For example, when Pulse Trace is displayed, try changing
the settings on the Settings > Params.

Analysis failure: Carrier detection failed

The instrument was unable to locate a carrier signal. Try adjusting the Carrier Threshold or Integration
BW values, if the measurement has these controls.

Analysis Length was limited

This message appears if the "Results Length", the time over which the measurement computed its results,
is less than the Actual Analysis Length reported in the Analysis Time control panel tab and the Time
Overview display. The Results Length is indicated by the magenta line below the Time Overview graph.
This can occur because the acquisition contained more data samples than a measurement can process (for
example, digital demodulation is limited to 80,000 samples) or the measurement had to use some of the
first and last samples for pre-measurement processes.

Analysis length too small for current setup

Increase the Analysis Length or decrease the RBW (Spectrum, ACPR, MCPR).
Avg Tx not available in Volts units

The Average Transmitted Power measurement is not defined for Volts.

Can't get acquisition data record

No acquisition record currently exists in memory (run an acquisition or recall a file), or an error has
occurred. Repeat the acquisition.

Can't replay data from swept acq

The measurement could not produce results because it is a real-time only measurement but was asked to
reanalyze (Replay) an acquisition taken in swept mode.

Can't replay. Live data needed for swept settings

The measurement could not produce results because it was asked to reanalyze (Replay) the acquisition but
it is in Swept acquisition mode. Swept-mode measurements cannot analyze recalled data.

CISPR accuracy limited by acq memory. Adjust RBW or freq range
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The CISPR function was applied, but the available data did not represent a long enough time to satisfy
CISPR requirements. Increasing RBW reduces the amount of time needed for analysis. Reducing
frequency range (for example, by reducing Span), decreases sample rate, allowing the available memory
to cover a longer time period.

If this data is from a saved file, the error cannot be cleared.
If this data is from a saved file, this error cannot be cleared.

This data was acquired when the input signal contained peaks greater than 6 dB above the Reference
Level setting.

If the data is from a file, this error cannot be cleared.
Data from unaligned instrument

The acquisition data was captured when the instrument was not aligned. This message refers to the
acquisition data currently being analyzed, but not necessarily to the current status of the instrument.
Measurements made on this data might not be accurate.

Data from uncalibrated instrument
Disabled: data is from swept acquisition

The display needs to run in real-time mode. The display associated with this message cannot run now
because it is not the selected display, and the selected display is performing multiple acquisitions (it is
in swept mode).

B Change the settings of the selected display so it is performing real-time acquisitions.

m  Select the associated display to make it the selected display. When it is selected, it will force the
acquisition parameters to change to meet its own needs.

Frequency exceeds preamp range

This is a warning that signals below the minimum preamp operating frequency are likely to be severely
attenuated (this is 100 kHz for option 51, 1 MHz for option 50).

Needs swept acq or larger AcqBW - Acquire data while display is selected

The display is not running because it needs to perform multiple acquisitions (it must be in swept mode) but
it is not the selected display. Only the selected display can perform multiple acquisitions.

B Select the display showing this message to give it control of acquisitions parameters.

Sometimes, only one display can work and the others will be blank and show errors. This happens when
different displays have conflicting demands on the acquisition data record.

Export failure: file not saved

An error occurred while exporting Results. The file was not created.

=  Export the results again.

Export failure: unable to open results file for export. File not saved.

The Export Results file could not be opened for writing, so the export of results was not completed.

B Verify that there is sufficient free space on hard disk.
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Insufficient data for CISPR. Acquire while display is selected

This message appears when a measurement is not the selected measurement and CISPR filters are selected.
Set the measurement to be the selected measurement and reacquire the signal.

IQ Processing Error: 8012

This message occurs in GP Digital Modulation displays. The most likely cause for this message is that
there are not enough symbols to analyze. This can happen if:

B The Analysis Length is set too short. Increase the Analysis Length on the Analysis Time tab.

®m  The Analysis Offset has pushed the Analysis Time so far out that the actual Analysis Length is too
short, even though the user-requested Analysis Length would have been long enough without the
excessive offset. Decrease the Analysis Offset on the Analysis Time tab.

B The input signal is bursted, and the burst does not contain enough symbols.
Needs swept acq or larger Acq BW - Acquire data while display is selected

The display has one of two problems: It is not the selected display, which prevents it from controlling
the hardware acquisition parameters, and setting the acquisition mode to Swept; or its settings require a
wider data bandwidth.

m  Select the display that you are interested in and it will change the acquisition to meet its own needs.

m  Increase the acquisition bandwidth manually or by changing the selected display's settings to cause
the wider bandwidth.

No Math trace: unmatched trace lengths

A math trace could not produced because the traces selected to generate the math trace do not have
the same number of points. This can easily happen if both traces are recalled, but were saved under
different “Points” settings. This can also occur if one of the selected traces is a live trace and the other
trace is a recalled trace.

B In a Spectrum display, as long as one trace is live, you can change the “Points” setting (Setup >
Settings > Freq & Span tab) to match the recalled trace.

®  If you are using two recalled traces to generate the Math trace. You must recreate at least one of
the traces.

No burst detected

The Burst Detection Mode (see page 319) is On, but no burst was detected in the signal.

B Check that the Threshold setting is properly set.
Not enough samples for current setup

The measurement was not able to run because the combination of analysis length, offset, and measurement
bandwidth relative to acquisition bandwidth, were such that not enough samples were available for the
measurement to analyze. This can occur when two or more displays are shown and one display requires

a wide acquisition bandwidth and another display requires a much narrower bandwidth. The display
requiring the much narrower bandwidth must decimate and filter the acquisition record which can result in
too few samples left for the measurement.
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B Increase the Analysis Length to provide more samples.
B Close any displays you don't currently need.
Not enough samples — try increasing MeasBW

The measurement was not able to run because there are not enough samples available for the measurement
to analyze. The Settling Time measurement requires at least 256 samples. This can occur when two or
more displays are shown and one display requires a wide acquisition bandwidth and another display
requires a much narrower bandwidth. The display requiring the much narrower bandwidth must decimate
and filter the acquisition record which can result in too few samples left for the measurement.

B Increase the Analysis Length to provide more samples.
m  Close any displays you don't currently need.
No FFT (not all pulses have results)

If a pulse cannot be measured (because its shape is too indistinct or it does not meet the parameters that
define a pulse (see page 257)), its results will be “- -" for every measurement on that pulse. The instrument
cannot compute an FFT.

No pulses found
The instrument was unable to find any complete pulses in the signal.

m  Make sure the analysis length (see page 349) includes at least one complete pulse cycle, from before
one rising edge until after the next rising edge.

Pulse Detection Error
The instrument was unable to detect a pulse.

B The pulse Measurement Filter (see page 257) needs to be smaller. Try reducing the bandwidth and/or
selecting the Gaussian filter.

m  Detection threshold is not set to the proper level for the signal. Adjust the Power threshold to detect
pulses (see page 257).

m  The pulse interval is too long for the current settings. Try decreasing the filter bandwidth (see
page 257), as this may reduce the number of data points to a manageable quantity.

RBW conflict. Increase Span or Analysis Length

The measurement is not running because the actual RBW used by the measurement is too large for the
current acquisition span. Typically, the analysis length is too short as well.

B FEither increase the span or increase the Analysis Length.

RBW decreased

The current span or acquisition bandwidth is too small to allow a wider RBW filter.

®  Increase the span or acquisition bandwidth if the decreased RBW is not acceptable.
RBW increased

The current Spectrum Length (or Analysis Length if Spectrum Length is not Independent) is too small
to allow the requested RBW.
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B Increase the Spectrum Length (or Analysis Length) if the increased RBW is not acceptable.
RBW limited by AcqBW to: XX Hz

The requested RBW is too close to the acquisition BW. Increase the frequency range of the measurement
(for example, Span).

RBW too small/large for current Acq BW

If the RBW is set manually, it is possible for the acquisition bandwidth to be incompatible with the
RBW setting.

®  Change the RBW setting.

B Adjust the Acq BW setting, either directly (Setup > Acquire > Sampling Params: select on of the
manual modes) or by adjusting the measurement bandwidth of the selected display (Setup > Acquire >
Sampling Params: All Auto).

Recall error: Setup not completely restored

An error occurred while recalling a Setup file. Thus, the current setup may be a combination of settings
from the Setup file and the previous Setup.

B Recall the setup again.
Recall failure: problem with file or file contents

An error occurred while recalling a Setup, Trace or Data file. This can occur because of a problem opening
the file (operating system error) or because of a problem with the contents of the file.

®m  Recall the file again.

Restoring acquisition data

This is a status message displayed while data is being restored from a file.
Save failure: file not saved

An error occurred while saving a Setup or Data file.

m  Save the file again.

Saving acquisition data

This is a status message displayed while data is being saved to a file.
Selected VBW does not use full Spectrum Length

This message can occur when the Spectrum Length is greater than required for the VBW filter. If you
look at the Time Overview display, the Magenta line for Results Length indicates the part of the Spectrum
Length that was actually used. The measurement results are correct, but don't include some of the data in
the selected Spectrum Length. To clear this message, you can set the Spectrum Length to Auto.

Setup error: <description of error>
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When this message appears, it includes text that explains the problem. For example, the ACPR display
might show: “Setup error: channels can’t overlap”. Setup errors are the result of conflicts in instrument
settings. These types of errors occur when a user makes manual changes to settings. In the example
above, the channel settings in the Channel Power and ACPR display have been set so that the channels
overlap in frequency.

B Adjust the instrument settings, or change a setting back to Auto, to eliminate the error.
Setup error: Integration BW exceeds Measurement BW

When this message appears, it includes text that explains the problem. Setup errors are the result of
conflicts in instrument settings. These types of errors occur when a user makes manual changes to settings.

= Adjust the instrument settings, or change a setting back to Auto, to eliminate the error.
Setup error: Measurement time for Freq & Phase results

The Measurement time for Freq & Phase results (see page 259) specifies how far across the pulse top the
instrument should wait before measuring the Phase Difference and Frequency Difference for each pulse.
If this value is set too large for any of the pulses in the signal, the measurement point ends up on the
falling edge or during the pulse off time.

B Decrease the Measurement time for Freq & Phase results setting (Settings > Define tab).

Unexpected software error. Please cycle power and try again. If the problem persists, contact
your Tektronix Service Center.

An unrecoverable error has occurred, and the instrument application software will shut down.

VBW not applied - Acq BW too small

Increase VBW or measurement bandwidth. Make sure Sampling Parameters are set to Auto.

VBW not applied - Spectrum Length too short

This message occurs when the requested VBW can't be produced because the Spectrum Length is too short.

To clear this problem, set the Spectrum Length to Auto or manually increase the Spectrum Length (see
Setup > Analysis > Spectrum Time tab). If Spectrum Length is coupled to Analysis Length, set Analysis
Length to Auto or manually increase it (see Setup > Analysis > Analysis Time tab).

Displaying the Windows Event Viewer

When the analyzer generates an error message, information about the error is logged to the Windows
Event Viewer.

To display the Windows Event Viewer:
1. Select Start > Control Panel.

2. Seclect Administrative Tools. (If your instrument displays control panels in Category View, select
System and Security. and then select Administrative Tools.)

3. Double-click Event Viewer.
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4. From the Event Viewer window, select Windows Logs, then select Application. This displays a list of
all errors that have been reported to the operating system from applications.

2] Bt Viewer ==

File  Action ‘iew Help
«x| 2B H

18] Event Viewer (Lacal) Application  Hu F Actions
> [ Custom Yiews
4 [l Windows Logs

Date and Tirme Source EventID Task Ca.. Application -

T/2T/2011 4:38:07 PM gqupdat... 0 Mone < Open Saved Log...
/2172011 £:38:07 P gupdat.. 0 None ¥ Create Custorn Yiews.
/2172011 4:38:06 P gusve 0 Mone Tmport Custorn View..
/212011 4:36:17 P TekRSA 3 MNone
/2142011 £01:46 P Certific... B4 More ClearLag..
Applications and Services Lo 772742011 401146 P Certific.. 65 Mone T Filter Current Log...
2 Subsriptions T/27/2011 3:38:02 PM Certific.., 4 MNone [ Froperties
T/21/2011 3:36:02 PM Certific.. 65 Mone B Find..
Evert 0, gupdatem w | b Save Al Events As...

Attach a Task To this L.

General | Details v ,
e

The description for EventID 0 fram source gupdatem cannot be found, Either the compar| | G Refresh
that raises this event is not installed on your local computer or the installation is corruptec B e ,
can install or repair the component on the local computer, P

If the event ariginated on another cormputer, the display information had to be saved with] | E¥ENt D, updaterm —

[E] Event Properties

e AppIEEED ] Attach Task To This Ev..
Source: qupdatern Logged: /2772011 4:33:07 PM [ Sove Selected Bver..
EventID: 0 Task Categany: Mone

Level: Infarmation Keywards: Classic By Copy 4
User: {73 Computer: PC-BEAY-0030.globalte | (G Refresh

OpCode: H Help 4

More Information:  Event Log Online Help

< T r

Errors reported to the Event Viewer from the analyzer application appear under Source as TekRSA.

5. Double-click the last error reported for TekRSA to see details on the most recently reported error.
Please note that many items reported as “errors” are simply informational and do not mean that your
instrument is impaired. Contact the Tektronix Customer Support Center or Service Center if you
are concerned about an error shown in the Event Viewer. Do not send an instrument out for repair
based solely on these event reports.
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12| Event Properties - Event 2, TekRSA&, @

General | Details

Log Entry -

Exception duting test - message:Object reference not setto an instance of an object,

FromSubsystem:

Diagnostics - —
2]

Log Narme: Application —

Source: TekR32 Logged: TAATAA011 93427 Ah ¥

EwventID: 2 Task Category: Mone

Level: Errar Keywords: Classic

User: MFR, Computer: PC-BEAY-N039.global tektronixne

OpCode:

Mare Infarmation:  Event Log Online Help

Copy Close

Dealing with Sluggish Instrument Operation

Over time you might notice that acquisitions seem to be occurring sluggishly. This can occur if the disk is
too full or if someone has accidently deleted the instrument cache file. While the instrument automatically
recreates a missing 4 GB cache file, if the disk is too full when the replacement cache file is created, the
cache file can be fragmented and result in sluggish performance.

If your instrument appears to be performing acquisitions slowly, do the following:

B Delete unnecessary files to create free space. After deleting unnecessary files, run a commercial
disk defragmentation program.

B Ifremoving unnecessary files and defragging the hard drive does not improve instrument performance,
reinstall the operating system and application software. To do this, back up all your data and files, and
then reinstall the instrument operating system. After reinstalling the operating system, reinstall the
application software.

On/Standby Switch

Use this button to power the instrument on or to shut down (set the instrument to standby).
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Before shutting down, you should first exit the instrument application and any other active Windows
applications to avoid error messages on shutdown or the next power up.

How to Find Out If Instrument Software Upgrades Are Available

Software upgrades might be available from Tektronix. They can either be downloaded from the Tektronix
Web site or they can be ordered from your local Tektronix representative. To see if a software upgrade

is available for your instrument, use your browser to go to www.tektronix.com/software. Search by

the instrument model number.

To add additional software options or features, you will need an option key from Tektronix. When you
receive the software from Tektronix, install it on your instrument. When prompted, enter the option key,
and then follow the online instructions to complete the upgrade.

Settings

Menu Bar: Setup > Settings
Front Panel / Application Toolbar: Settings

The Settings menu item enables access to control panels that allow you to change settings for the selected
display. The control panel that appears when you select Settings depends on the selected display. The
Settings control panel for the Spectrum display is shown in the following figure.

Spectrum Fren & Span |gw | Traces | Scale [ prefs |

Settings
Center: 1,9000 GHz Spar: 85.0 MHz Max Span

Start: 1.8570 GHz

Stop: 1.9425 GHz

Restore Step Size: 5.0000 Mz v
Defaults F s

The control panel for the CCDF display is shown in the following figure.

CCDF Settings | Parameters | Traces | Prefs
Measurement Time
@ Single {use Analysis Length)
O Total Time: | 22.000 ms Span:  BS.0MHz
Restare 7 Continuous
Defaults

Settings Control Panels

Acquire (see page 372)

AM Settings (see page 126)
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Amplitude Settings (see page 363)

Amplitude vs Time Settings (see page 104)

Analysis Settings (see page 349)

Audio Spectrum Settings (see page 270)

Audio Summary Settings (see page 272)
CCDF Settings (see page 181)

Channel Power and Strength Settings (see page 153)

Configure In/Out Settings (see page 388)

Constellation Settings (see page 285)

DPX Spectrum Settings (see page 70)

EVM vs Time Settings (see page 289)

Eye Diagram Settings (see page 291)

FM Settings (see page 134)

Frequency Deviation vs Time Settings (see page 294)

Frequency vs Time Settings (see page 106)

Magnitude Error Settings (see page 296)

MCPR Settings (see page 159)

Occupied Bandwidth Settings (see page 168)

OFDM Channel Response Settings (see page 229)

OFDM Constellation Settings (see page 231)
OFDM EVM Settings (see page 232)

OFDM Magnitude Error Settings (see page 234)
OFDM Phase Error Settings (see page 236)
OFDM Power Settings (see page 238)

OFDM Summary Settings (see page 241)
OFDM Symbol Table Settings (see page 243)

Phase Error vs Time Settings (see page 298)

Phase Noise Settings (see page 186)

Phase vs Time Settings (see page 108)

PM Settings (see page 142)

Pulse Statistics Settings (see page 257)
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Pulse Table Settings (see page 252)

Pulse Trace Settings (see page 255)

RF I Q vs Time Settings (see page 110)

Search (Limits Testing) Settings (see page 343)

Spectral Emissions Mask Settings (see page 211)

Settling Time Settings (see page 201)

Signal Quality Settings (see page 303)

Spectrogram Settings (see page 99 )

Spectrum Settings (see page 95)

Spurious Settings (see page 173)

Symbol Table Settings (see page 305)

Time Overview Settings (see page 90)

Trellis Diagram Settings (see page 307)
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Accuracy

The closeness of the indicated value to the true value.

ACLR

Adjacent Channel Leakage power Ratio is the ratio of the RRC (Root Raised Cosine) filtered mean power
centered on the assigned channel frequency to the RRC filtered mean power centered on an adjacent
frequency (defined in 3GPP).

ACPR Measurement

Adjacent Channel Power Ratio (ACPR) is the ratio of the mean power centered on the assigned channel
frequency to the mean power centered on an adjacent channel frequency. In the 3GPP specification, it
is called ACLR (Adjacent Channel Level Ratio) and both the main channel and adjacent channels are
required to be filtered with RRC (Root Raised Cosine) filters.

Acquisition

A series of time-contiguous frames. This is also called a Block.

Analysis Length

The length of time in the Analysis Time.

Analysis Time

The portion of the acquisition record over which one or more measurements are calculated.
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ASK

Acronym for Amplitude Shift Keying. The process, or result of a process, in which the amplitude of the
carrier is varied in accordance with the state of a digital input signal.

Block

An integer number of time-contiguous frames. See also: Acquisition.

Calibrator

A signal generator producing a specified output used for calibration purposes.

Carrier

The RF signal upon which modulation resides.

Carrier Frequency

The frequency of the CW component of the carrier signal.

Carrier Signal

The electrical signal, typically a sine wave, upon which modulation is impressed.

Carrier-to-Noise Ratio (C/N)

The ratio of carrier signal power to average noise power in a given bandwidth surrounding the carrier;
usually expressed in decibels.
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CCDF - Complimentary Cumulative Distribution Function

The Complementary Cumulative Distribution Function (CCDF) represents the probability that the peak
power above average power of a measured signal exceeds a threshold.

CCDF is a plot of the percent of time that a signal's power value exceeds it average value versus the
amount by which it exceeds the average. The CCDF plot has a log of probability on the Y-axis (100% at
the top) and dB above average amplitude on the X-axis (0 at the left).

CDMA

Acronym for Code Division Multiple Access.

Center Frequency

The frequency corresponding to the center of a frequency span of the analyzer display.

Check Mark Indicator

The check mark indicator in the upper-left corner of the display indicates the display for which the
acquisition hardware is optimized. When you have more than one display open, the display with the
check mark indicator has control over the acquisition hardware. To give a display priority over any
others, click its title bar.

CISPR

International special committee on radio interference. (Comité international spécial des perturbations
radioélectriques)

CW

Acronym for Continuous Wave.
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CW Signal

Continuous wave signal - a sine wave.

DANL

Acronym for Displayed Average Noise Level. See Sensitivity (see page 430).

dBfs

A unit to express power level in decibels referenced to full scale. Depending on the context, this is either
the full scale of the display screen or the full scale of the analog-to-digital converter (ADC).

dBm

A unit of expressed power level in decibels referenced to 1 milliwatt.

dBmV

A unit to express voltage levels in decibels referenced to 1 millivolt.

dBuV

A unit to express voltage levels in decibels referenced to 1 microvolt.

Decibel

Ten times the logarithm of the ratio of one electrical power to another.
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Detection

The process by which a long waveform is decimated (reduced) down to the desired number of trace points,
by dividing the waveform into intervals and choosing a single value to represent each interval in the trace.

Display Reference Level

A designated vertical position representing a specified input level. The level may be expressed in dBm,
volts, or any other units.

Distortion

Degradation of a signal, often a result of nonlinear operations, resulting in unwanted signal components.
Harmonic and intermodulation distortion are common types.

Dynamic Range

The maximum ratio of the levels of two signals simultaneously present at the input which can be measured
to a specified accuracy.

EVM

Acronym for Error Vector Magnitude.

Export

Save data to a file in a format other than application-native.

FastFrame

FastFrame segments the acquisition record into a series of frames and then captures acquisitions as single
frames. You can then view and measure each frame individually.
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Field Strength

Field Strength measures the absolute electromagnetic power at the antenna for a specified frequency
and bandwidth.

FFT

Fast Fourier Transform - a mathematical process to calculate the frequency spectrum of a discrete number
of time domain sample points.

Filter

A circuit that separates electrical signals or signal components based on their frequencies.

FM

Acronym for Frequency Modulation.

Frame

A series of time-contiguous samples, long enough in duration and at a sufficient sample rate to produce
a spectrum view of a specified span and RBW.

Frequency

A series of time-contiguous samples, long enough in duration and at a sufficient sample rate to produce
a spectrum view of a specified span and RBW.

Frequency Band

The continuous range of frequencies extending between two limiting frequencies, expressed in hertz.
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Glossary Frequency Domain View

Frequency Domain View

The representation of the power of the spectral components of a signal as a function frequency; the
spectrum of the signal.

Frequency Drift

Gradual shift or change in displayed frequency over the specified time due to internal changes in the
analyzer, where other conditions remain constant. Expressed in hertz per second.

Frequency Range

The range of frequencies over which the performance of the instrument is specified.

Frequency Span

A continuous range of frequencies extending between two frequency limits.

Frequency Settling Time

The time measured from a reference point to when the signal of interest settles to within user-defined
tolerance.

GPIB

Acronym for General Purpose Interface Bus, the common name for the communications interface system
defined in IEEE Std. 488.

Graticule

The calibrated grid overlaying the display screen of analyzers, oscilloscopes, and other test instruments.
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Glossary Grayed Out

Grayed Out

An on-screen control is “Grayed Out” if it is not adjustable.

I/Q

Acronym for In-phase / Quadrature.

IF

Acronym for Intermediate Frequency.

Import

Bring data into the application from a file of some format other than application-native.

Impulse Response

The Impulse Response trace display shows normalized power on the vertical axis and time on the
horizontal axis.

Input Impedance

The impedance at the desired input terminal. Usually expressed in terms of VSWR, return loss, or other
related terms for low impedance devices and resistance-capacitance parameters for high impedance
devices.

LISN

Acronym for Line Impedance Stabilization Network.
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Glossary Local Oscillator (LO)

Local Oscillator (LO)

An oscillator which produces the internal signal that is mixed with an incoming signal to produce the IF
signal.

Marker

A visually identifiable point on a waveform trace, used to extract a readout of domain and range values
represented by that point.

Max Hold

Digitally stored display mode which, at each frequency address, compares the incoming signal level to
the stored level and retains the greater level. In this mode, the display indicates the peak level at each
frequency after several successive acquisitions.

MCPR (Multiple Carrier Power Ratio)

The ratio of the signal power in the reference channel or group of channel to the power in adjacent channels.

Min Hold

Digitally stored display mode which, at each frequency address, compares the incoming signal level to
the stored level and retains the lower level. In this mode, the display indicates the minimum level at
each frequency after several successive sweeps.

Modulate

To regulate or vary a characteristic of a signal, typically in order to transmit information.
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Glossary Modulating Signal

Modulating Signal

The signal which modulates a carrier. The signal which varies or regulates some characteristic of another
signal.

Modulation

The process of varying some characteristic of a signal with a second signal.

Noise

Unwanted random disturbances superimposed on a signal which tend to obscure it.

Noise Bandwidth (NBW)

The exact bandwidth of a filter that is used to calculate the absolute power in dBm/Hz.

Noise Floor

The noise intrinsic to a system that represents the minimum limit at which input signals can be observed;
ultimately limited by thermal noise (kTB). The analyzer noise floor appears as a “grassy” baseline in the
display, even when no signal is present.

Open (Recall)

Bring data into the application from a file of application-native format.

OQPSK

Acronym for Offset QPSK (Quadrature Phase Shift Keying).
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Glossary Phase Settling Time

Phase Settling Time

The time measured from a reference point to when the signal of interest settles to within user-defined
tolerance.

PM

Acronym for Phase Modulation.

Primary Marker

The marker displayed in the Single Marker mode whose frequency and/or position is changed when
tuning with the general purpose knob.

PSK

Acronym for Phase Shift Keying. The process, or result of a process, in which the carrier phase is varied
discretely in accordance with a digital code.

QAM

Acronym for Quadrature Amplitude Modulation. The process, or result of a process, in which the amplitude
and phase of the carrier are varied concurrently by synthesizing two orthogonal ASK waves (see ASK).

Real-Time Analysis

Measurement technique based on triggering on an RF signal, seamlessly capturing it into memory, and
analyzing it in the frequency, time, and modulation domains.
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Glossary Real-Time Bandwidth

Real-Time Bandwidth

The frequency span over which real-time seamless capture can be performed, which is a function of the
digitizer and the IF bandwidth of a Real-Time Signal Analyzer.

Real-Time Seamless Capture

The ability to acquire and store an uninterrupted series of time domain samples that represent the behavior
of an RF signal over a long period of time.

Reference Level

The signal level represented by the uppermost graticule line of the analyzer display.

Residual FM (Incidental FM)

Short term displayed frequency instability or jitter due to instability in the analyzer local oscillators. Given
in terms of peak-to-peak frequency deviation and expressed in hertz or percent of the displayed frequency.

Residual Response

A spurious response in the absence of an input signal. (Noise and zero pip are excluded.)

RBW

The RBW determines how well the analyzer can resolve or separate two or more closely spaced signal
components.
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Glossary Ripple

Ripple

The Ripple measurement result is displayed in either Watts or Volts. The amplitude units selected on
the Setup > Analysis > Units tab determine whether the measurement is presented in Watts or Volts.
Volts are shown for linear units (for example, volts or amps); Watts are shown for non-linear units (for
example, watts or dBm).

DelPos

DelNeg RefPos

0070-031

The Ripple measurement, in Watts, is calculated as follows:
%Ripple (Watts) = 100 x (RatioPos + RatioNeg)
Where:

2
RatioNeg = (((35}%2) + 1) ) -1

2
RatioPos = (((3:}1;‘;55) + 1) > -1

®  DelPos = Delta Positive in Volts

®m  RefPos = Reference Positive in Volts

B DelNeg = Delta Negative in Volts (this is a positive value)
m  RefNeg = Reference Negative in Volts

The Ripple measurement, in Volts, is calculated as follows:

% Ripple (Volts) = 100 x (RatioPosV + RatioNegV')
Where:

®m  RatioPosV = DelPos/RefPos

B RatioNegV = DelNeg/RefNeg
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Glossary Secondary Marker

Secondary Marker

The “second” marker displayed only in the Delta Marker mode.

Sensitivity

Measure of a analyzer’s ability to display minimum level signals, usually expressed as displayed average
noise level (DANL (see page 420)).

Shape Factor (Skirt Selectivity)

The ratio of the frequency separation of the two (60 dB/3 dB) down points on the response curve to the
static resolution bandwidth.

Signal

As used in this help, the signal refers to the input signal before it is processed. The signal is an input.

Signal Strength

Signal Strength locates the direction of a signal using a directional antenna and an audio tone and a
visual display.

Span

Span is the range of frequencies displayed in a spectrum window. Span, start frequency and stop frequency
are related by the following equation: Span = (stop frequency) - (start frequency). The settings for center,
start and stop frequencies are related to the setting for span; when one parameter is changed, the others are
changed automatically.
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Glossary Span Per Division (Span/Div)

Span Per Division (Span/Div)

Frequency difference represented by each major horizontal division of the graticule.

Spectrogram

Frequency vs. time vs. amplitude display where the frequency is represented on the x-axis and time on the
y-axis. The power level is indicated by variations in color.

Spectrum

The frequency domain representation of a signal showing the power distribution of its spectral component
versus frequency.

Spectrum Analysis

The technique or process of determining the frequency content of an RF signal.

Spectrum Analyzer

A device for determining the frequency components of a signal.

Spectrum Time

Analysis Time for spectrum analysis views. Spectrum time can be the same as Analysis Time, but it
can be different.

Spur

A spur is a signal peak that exceeds a user-definable threshold (See Spurious > Settings > Ranges) and
excursion setting. A spur that also exceeds a limit (either Absolute or Relative) specified on the Settings
> Limits tab is considered a violation.
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Glossary Spurious Response

Spurious Response

A response to a analyzer wherein the displayed frequency is not related to the input frequency.

Time Measurement

This is the time in seconds relative to the time reference point in the first acquisition record in the data set.

Time Reference

The point in time during the acquisition record used as the zero point for counting time. The time reference
can be set to either the start of the acquisition record or the trigger point.

Trace

As used in this help, trace refers to the displayed signal. The displayed signal can be a processed version of
the input signal (for example, it may be averaged.) The trace is a result or output.

Vector Signal Analyzer

Like a spectrum analyzer, a device for determining the frequency components of a signal. However, unlike
a standard spectrum analyzer, the vector signal analyzer is optimized for analyzing digitally modulated
RF signals.

Vertical Scale Factor, Vertical Display Factor

The number of dB, volts, etc., represented by one vertical division of a spectrum analyzer display screen.
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Glossary Violation

Violation

A violation is a spur that exceeds either an Absolute or Relative limit (depending on the selected mask)
specified on the Settings > Limits tab. A spur is a signal peak that exceeds a user-definable threshold (See
Spurious > Settings > Ranges) and excursion setting.
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Glossary Violation
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Symbols and Numbers

-6dB RBW (MIL) Filter shape
Spectrum display BW
tab, 118
3-D Spectrogram display, 97
3-D Waterfall
Spectrogram/DPXo-
gram, 101
Spectrogram/DP Xogram
display, 80

A

Abort acquisition, 371
About the RTSA, 387
Abs

Ranges and Limits table, 178
Abs & Rel

Ranges and Limits table, 178
Abs OR Rel

Ranges and Limits table, 178
Abs Same

Ranges and Limits table, 178
Abs Start (dBm)

Ranges and Limits table, 178
Abs Stop (dBm)

Ranges and Limits table, 178
Accessories, 6
accuracy, 417
ACLR, 417
ACLR measurement, 153
ACPR measurement, 417
Acq Data

Replay menu, 358
Acq Data/DPX Spectra, 355
Acquire control panel, 372
acquisition, 417
acquisition data

saving, 379
Acquisition data files, 29
Acquisition Info tab, 357
acquisition memory usage, 373
Actions tab

Search, 347

Actual BW
Freq & BW tab, 72
adaptive equalizer, 314
adjacent channel leakage
ratio, 149
Adjacent Channel Power
measurement, 153
Adjacent Channel Power
Ratio, 33
Advanced Params tab
OFDM Analysis
displays, 245
Advanced Params Tab
GP Digital Modulation
displays, 316
Advanced tab (Acquire), 374
Alignments, 402
Align Now, 21
Auto button, 21
Off button, 21
+AM, 36
AM display, 36
-AM
AM display, 36
AM display, 125
AM measurements, 36
Ampl Scale tab
DPXOgram display, 80
Amplitude control panel, 363
Amplitude vs. Time display, 103
Amplitude vs. Time display
Settings, 104
Analysis control panel, 349
analysis length, 417
analysis time, 417
Analysis Time tab
GP Digital Modulation
displays, 319
OFDM Analysis
displays, 246
Options control panel, 27
Analysis Time tab (Analysis
control panel), 349
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application presets
saving, 379
Application presets, 22
Apply ampl corrections, 260
arranging windows, 404
ASK, 418
attenuator settings, 363
Audio BW, 273
setting, 274
Audio checkbox
Chan Power & Strength
display, 150
Audio Demod tab, 86
audio filters
custom, 277
Audio Filters tab
Audio Analysis displays, 276
Audio Freq
Audio Summary display, 271
Audio Spectrum display, 269
Audio Spectrum settings, 270
Audio Summary settings, 272
Auto
Ranges and Limits table, 178
Auto button (Alignments
dialog), 21
automatically generate
filenames, 27
Automatically increment
filename/number, 29
Average Channel Power
measurement, 153
Average ON Power, 37
Average Transmitted Power, 37
Averaging
Audio Analysis displays, 275
Params?2 tab, 275

B

Base file name
FastSave tab, 377
BER, 83
See also Tx BER
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black text
settling time
measurements, 195
Blackman-Harris 4B Filter Shape
Spectrum display BW
tab, 118
Blizzard color scheme, 29
block, 418
Blue background (cells), 169
Burst detect threshold, 136
BW (Hz)
Ranges and Limits table, 178
BW Tab
Amplitude vs. Time
display, 105
DPXOgram display, 118
Spectrum display, 118

C

C4FM modulation type
measurements, 36
C4FM signal quality
measurements, 303
calibration, 22
See also Alignments
calibrator, 418
Carr Freq Err
Audio Summary display, 271
carrier, 418
carrier frequency, 418
Carrier frequency detection, 143
Carrier Frequency Error, 36
Carrier Power
Audio Summary display, 271
carrier signal, 418
carrier-to-noise ratio (C/N), 418
CCDF, 33
CCDF - Complimentary
Cumulative Distribution
Function, 419
CCDF display, 180
CDMA, 419
center frequency, 419
Center Frequency
Freq & BW tab, 72
Chan Power and Strength
display, 149
changing the input connector, 389
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channel power, 149
Channel Power, 33
Channel Power (Main), 151
Channel Power and ACPR
Settings control panel, 153
Channel Power measure-
ment, 152
Channels tab
Channel Power & Strength
display, 154
Channels tab (MCPR), 163
check mark indicator, 15
CISPR, 419
CISPR Filter shape
Spectrum display BW
tab, 118
Classic color scheme, 29
Color (DPXogram)
DPXogram display, 80
Configure In/Out control
panel, 388
connecting signals, 388
connecting trigger signals, 390
Constellation display, 284
displaying a second trace, 322
Constellation display
settings, 285
Continuous Acquisition
Mode, 401
Convergence
Equalizer tab, 314
correction tables, 366
creating presets, 22
CW, 419
CW signal, 420

D

DANL, 420
Data file formats, 381
Data length

File Contents window, 380
Data properties

File menu, 397
Data Range tab

OFDM Analysis

displays, 246

Data records

File Contents window, 380

Data types
File Contents window, 380
dBfs, 420
dBm, 420
dBmV, 420
dBuV, 420
De-emphasis
Audio Filters tab, 277
decibel, 420
default settings, restore, 21
Define Markers, 337
Define Peaks tab, 338
Define tab, 343
Pulsed RF displays, 259
Settling Time displays, 201
Delta Markers, 337
Demod 1&Q vs Time display
settings, 288
Density tab, 82
detect
AM display, 129
FM display, 137
General Signal Viewing
displays, 114
PM display, 145
Time Overview, 91
detection, 421
AM display, 129
FM display, 137
General Signal Viewing
displays, 114
PM display, 145
Time Overview, 91
Detection
DPX display, 75
detector
AM display, 129
FM display, 137
General Signal Viewing
displays, 114
PM display, 145
Time Overview, 91
Detector
Ranges and Limits table, 178
Deviation, 36
Diagnostics, 404
Diff
Audio Summary display, 272

SPECMON3 & SPECMONG Printable Help



Digital I/Q output, 391
Digital Phosphor Spectrum, 62
Disabled - FastSave is
selected, 377
display reference level, 421
Displays
arranging, 31
Frequency Settling Time, 193
interactions between, 31
OFDM Channel
Response, 227
OFDM Constellation, 230
OFDM EVM, 231
OFDM Mag Error, 233
OFDM Phase Error, 236
OFDM Power, 237
OFDM Summary, 239
OFDM Symbol Table, 242
Phase Settling Time, 193
selecting, 31
SEM (Spectrum Emission
Mask), 208
distortion, 421
Dither Control, 374
documentation, 7
Done
Ranges and Limits table, 178
Done saving - restart with Stop,
then Run, 377
Dot Persistence, 72
DPX
Bitmap settings, 72
DPXogram Settings, 72
DPX Density, 82
DPX display
DPXogram, 62
Frequency, 62
Phase, 62
Spectrum, 62
Zero Span, 62
DPX presets, 22
DPX Spectra
Replay menu, 358
DPX Spectra/Acq Data, 355
DPX Spectrum settings, 70
DPXogram
DPX display, 62

Droop, 37

Droop dB, 37

Duty Factor (%) measurement, 37

Duty Factor (Ratio)
measurement, 37

dynamic range, 421

E

Elements of the display, 15
Enable Equalization
Equalizer tab, 314
Equalizer tab
GP Digital Modulation
displays, 314
error message
Windows Event Viewer, 411
Error messages, 405
Event Viewer, 411
EVM, 35
EVM vs. Time display, 288
EVM vs. Time Settings, 289
Excrsn (dB)
Ranges and Limits table, 178
Expand
Ranges and Limits Tab, 177
export, 421
External Gain value, 366
External Gain/Loss Correction
tab, 366
External Loss Tables, 366
External Probe Correction
tab, 370
external trigger
enabling, 390
external trigger signals
connecting, 390
Eye Diagram display settings, 291

F

Fall Time, 37
Fast Save, 375
See also FastSave
FastFrame, 421
FastSave
configuring, 376
overview, 375
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starting, 376
status messages, 376
FastSave acquisition data
FastSave tab, 377
FastSave tab, 377
FFT, 422
field strength, 422
File Contents window, 380
File formats, 381
File Menu, 394
filter, 422
Filter Parameter
GP Digital Modulation
displays, 309
Filter Shape
Ranges and Limits table, 178
Spectrum display BW
tab, 118
Find tab
GP Digital Modulation
displays, 319
finding bursts in data
GP Digital Modulation
displays, 319
FlatTop (CW ampl) Filter Shape
Spectrum display BW
tab, 118
FM, 422
FM display, 132
FM measurements, 36
Format
FastSave tab, 377
frame, 422
Freq & BW tab
DPX display, 72
RFI& Qvs Time display, 112
Freq & BW Tab
GP Digital Modulation
displays, 313
Freq & Span tab
General Signal Viewing
displays, 113
Freq Deviation, 38
Freq Diff, Phase Diff setting, 261
Freq Error, 36
Freq Estimation tab
Pulsed RF displays, 264
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Freq, Span & RBW tab
Channel Power & ACPR
display, MCPR
display, 160
RF Measurements
displays, 219
Freq-domain Linearity
setting, 259
frequency, 422
Frequency
DPX display, 62
frequency band, 422
Frequency Deviation vs. Time
settings, 294
frequency domain view, 423
frequency drift, 423
Frequency Error, 35
GP Digital Modulation
displays, 313
Frequency Offset
GP Digital Modulation
displays, 313
frequency range, 423
frequency settling time, 423
measuring, 197
Frequency Settling Time
display, 193
Frequency Settling Time
settings, 200
frequency span, 423
Frequency tab, 351
Frequency tab (Phase Noise), 188
Frequency vs. Time display, 105
Frequency vs. Time Settings, 106
Front panel connectors, 9
Front panel controls, 9
Full Screen, 398

G

Gain Imbalance, 301
GPIB, 423
GPIB tab, 27
graticule, 423
Graticule On/Off

RF Measurements

displays, 225

grayed out, 424
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H

Hanning Filter Shape

Spectrum display BW

tab, 118

Help Menu, 405
Hide sensitive readouts, 27
Hide Sensitive readouts, 28
Histogram readout

Pulsed RF displays, 267
HPF

Audio Filters tab, 276
Hum & Noise

Audio Summary display, 280

1/Q, 424
IF, 424
Ignore Region
Params2 tab, 275
import, 424
Impulse Response Amplitude, 38
Impulse Response setting, 260
Impulse Response Time, 38
Information messages, 405
input impedance, 424
input protection, 388
Installed options, 7
Internal Attenuator
Internal Settings tab, 363
Internal attenuator (Internal
Settings tab), 363
Internal Preamp
Internal Settings tab, 364
Internal Settings tab, 363
1Q Origin Offset, 35
1Q output signals, 391
1Q vs. time view, 109
is greater than (search), 344
1s inside mask, 343
is inside mask (search), 345
is less than (search), 344
is outside mask, 343
is outside mask (search), 345

K

Kaiser (RBW) Filter Shape
Spectrum display BW
tab, 118
Keep-out time, 260

L

Length, 36
Equalizer tab, 314
Levels tab
Pulsed RF displays, 264
Limit lines, 343
Limits
Spurious display, 179
Link to Span, 112
LISN, 424
Load
Ranges and Limits Tab, 177
Ranges and Limits table, 178
local oscillator (LO), 425
Location
FastSave tab, 377
Lock Center Frequency of
Spectrum displays, 351
Lock Center Frequency of
Spectrum displays to
Measurement Frequency
Frequency tab, 352
Log
Audio Spectrum display, 279
Log (Horizontal)
Spectrum display, 96
Loop over all selected records
Replay menu, 358
LPF
Audio Filters tab, 276

Mag Error, 35

Magnitude Error vs. Time
display, 294

Magnitude Error vs. Time
settings, 296

manuals, 4

mapping measurements, 392

marker, 425

Marker Noise mode, 340
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Marker Properties tab, 337
Marker to Center Frequency, 337
Markers, 339
Marker Toolbar, 339
Using Markers, 333
Using Markers in Noise
Mode, 340
Markers menu, 401
Markers snap to peaks when
dragged, 29
Mask
Ranges and Limits table, 178
Mask Editor, 343
Mask tab
Settling Time displays, 204
mask testing
settling time
measurement, 189
MATLAB file format, 381
Max files saved per Run
FastSave tab, 377
Max Freq Error, 38
max hold, 425
Max number of pulses
Pulse Table display, 257
Max Number of Pulses
Params tab, 258
Max Phase Error, 38
Max trace points, 103
Settling Time displays, 208
MCPR (multiple carrier power
ratio), 425
MCPR display, 156
MCPR settings, 159
Meas BW
Frequency Settling Time, 202
Meas Frequency
Frequency Settling Time, 201
Measurement BW, no filter, 112
Freq & BW tab, 72
Measurement Filter
GP Digital Modulation
displays, 309
Params tab, 258
Measurement Frequency, 351
Frequency tab, 352
Measurement Length
Time Params tab, 203

Measurement Params tab
Channel Power & ACPR
display, MCPR
display, 161
Measurement point, 261
Measurement settings export, 379
Measurements, 33
Measurements tab, 253
measuring settling time, 197
measuring Tx BER, 83
Menus, 393
MER (RMS), 302
min hold, 425
Min Settled Duration
Time Params tab, 203
Mod Distor
Audio Summary display, 272
Mode
Equalizer tab, 314
modulate, 425
modulating signal, 426
modulation, 426
modulation measurements, 34
Modulation Params tab
GP Digital Modulation
displays, 309
OFDM Analysis
displays, 244
modulation types supported, 309
Monitor attenuator use, 363
Monitor Attenuator Use
Internal Settings tab, 364
moving windows, 404
Multi-Carrier Power Ratio, 33
Multiple Carrier Power Ratio, 158

N

Network Connections, 19
nFSK modulation type
measurements, 36
nFSK signal quality
measurements, 302
No. of Harmonics
Params?2 tab, 275
No. of Non-Harmonics
Params2 tab, 275
noise, 426
noise bandwidth (NBW), 426
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noise floor, 426
Noise markers, 340
Non-Harmonic Excursion
Params?2 tab, 275
Non-Harmonic Threshold
Params2 tab, 275
None
trace motion, 71
Normal
trace motion, 71

0]

OBW Level Left/Right, 165
OBW Ref Power, 165
Occupied Bandwidth, 168
Occupied Bandwidth
settings, 168
Occupied BW display, 165
OFDM Channel Response
display, 227
settings, 227
OFDM Constellation
display, 230
settings, 231
OFDM EVM
display, 231
settings, 232
OFDM Mag Error
display, 233
settings, 234
OFDM Phase Error
display, 236
OFDM Power
display, 237
settings, 238
OFDM Summary
display, 239
settings, 241
OFDM Symbol Table
display, 242
settings, 243
Off

Index

Ranges and Limits table, 178

Off button (Alignments
dialog), 21

Offset & Limits Table tab
SEM display, 214

Offset EVM, 35
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On
Ranges and Limits table, 178
On/Standby switch, 413
online help, 387
Open (Recall), 426
Optimization
Channel Power & ACPR
display, MCPR
display, 161
Options
installed, 7
Options control panel, 27
OQPSK, 426
OQPSK and SOQPSK modulation
type measurements, 35
Other Outputs tab, 392
Overlap, 99
Overshoot, 37
Overshoot dB, 37
Overshoot settings, 262

P

Parameters tab

AM display, 127

CCDF display, 182

FM display, 136

Occupied BW display, 169

Phase Noise display, 189

PM display, 143

SEM display, 212

Spurious display, 174
Params tab

DPX display, 71

Pulsed RF displays, 257
Paramsl tab

Audio Analysis displays, 273
Params2 tab

Audio Analysis displays, 275
Pass /Fail readout

SEM display, 209
Pass/Fail Limit Testing

Spurious display, 179
Pass/Fail searches, 344
Pause

Replay menu, 358
+Peak

Audio Summary display, 271
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-Peak
Audio Summary display, 271
Peak Channel Power (Main), 151
Peak Excursion, 337
Peak FSK err, 36
Peak Mag Err, 36
Peak Power, 37
Peak Threshold, 337
Peak/Avg Ratio, 33
Peak-Peak/2
Audio Summary display, 272
Phase
DPX display, 62
Phase Deviation, 38
Phase Error, 302
Phase Error vs. Time display, 296
Phase Error vs. Time settings, 298
Phase Noise display, 182
Phase Noise settings, 186
phase settling time, 427
measuring, 197
Phase Settling Time display, 193
Phase Settling Time settings, 196
Phase vs. Time display, 107
Phase vs. Time settings, 108
pictures
saving, 379
+Pk
FM display, 36
PM display, 37
-Pk
FM display, 36
PM display, 37
Pk-Pk
FM display, 36
PM display, 37
Pk-Pk/2
FM display, 36
Planar Crown input
connector, 389
PM, 427
PM measurements, 37
power measurements, 149
Power Threshold to Detect Pulses
Params tab, 258
Pre-defined Filters
Audio Filters tab, 276

Prefs tab
AM display, 132
FM display, 140
General Signal Viewing
Displays, 120
GP Digital Modulation
displays, 323
OFDM Analysis
displays, 250
Options control panel, 27
PM display, 148
Pulsed RF displays, 267
RF Measurements
displays, 225
Settling Time displays, 208
Preset (File menu), 398
Preset (Settings menu), 402
presets, 22
Presets
recalling, 26
Presets tab
Options control panel, 28
primary marker, 427
Print, 397
Print Preview, 397
Probes, 390
Processing tab
SEM display, 213
PSK, 427
pulse measurements, 251
Pulse Statistics display, 255
Pulse Statistics display
settings, 257
Pulse Table display, 251
Pulse Table settings, 252
Pulse Trace display, 253
Pulse Trace display settings, 255
Pulse Width, 37
Pulse-Pulse Freq Difference, 38
Pulse-Pulse Phase Difference, 37
pulses
how many can be
analyzed, 258

QAM, 427
Quadrature Error, 34
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R

Range file, 381
Ranges and Limits Tab
Spurious display, 176
RBW, 428
RBW (Time-domain BW) filter
Freq & BW tab, 72
real-time analysis, 427
real-time bandwidth, 428
real-time seamless capture, 428
rear panel connectors, 19
recalling Presets, 26
Red background (cells), 169
red text
settling time
measurements, 195
Ref
Audio Summary display, 272
Ref Channel tab
SEM display, 214
Ref level (Internal Settings
tab), 363
Reference Filter
GP Digital Modulation
displays, 309
Reference Level, 428
Reference tab
Spurious display, 174
Rel
Ranges and Limits table, 178
Rel Same
Ranges and Limits table, 178
Rel Start (dB)
Ranges and Limits table, 178
Rel Stop (dB)
Ranges and Limits table, 178
Repeat, 371
Repetition Interval, 37
Repetition Rate, 37
Replay all selected records
Replay menu, 358
Replay control panel, 355
Replay current record
Replay menu, 358
Replay from selected
Replay menu, 358
Replay menu, 357
Replay Speed tab, 357

Replay toolbar, 360
Replay menu, 358
Reset Equalization
Equalizer tab, 314
Reset layout
Ranges and Limits Tab, 177
residual FM (incidental FM), 428
residual response, 428
results
saving, 379
Resume, 371
RF & IF Optimization
Internal Settings tab, 364
RF Channel Power
measurement, 152
RF I & Q vs. Time display, 109
RF I & Q vs. Time settings, 110
RF input connector, 389
RF input protection, 388
Rho, 35
Ripple, 37
Ripple dB, 37
Ripple measurement
calculation, 429
Ripple settings, 262
Rise Time, 37
RMS
Audio Summary display, 272
FM display, 36
PM display, 37
RMS Error Magnitude, 36
RMS FSK Err, 36
RMS Mag Err, 36
RMS Phase Error, 38

Roll
trace motion, 71
RSA Map, 392
RTPA2A, 390
Run, 371
Run menu, 400
S
S/N

Audio Summary display, 272
Sampling Parameters Tab, 372
Save

Ranges and Limits Tab, 177
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Save and Export tab, 27
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Save As
Ranges and Limits table, 178
saved file types, 379
saving
acquisition data, 379
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presets, 22
results, 379
setups, 379
Saving and Recalling Data, 379
Saving X of XX, 377
Scale tab
AM display, 131
Audio Analysis displays, 278
DPX Spectrum display, 78
FM display, 139
General Signal Viewing
displays, 120
GP Digital Modulation
displays, 323
OFDM Analysis
displays, 248
Phase Noise display, 147
Pulsed RF displays, 266
RF Measurements
displays, 224
SEM display, 217
Settling Time displays, 207
Spectrogram display, 101
Spectrum display, 96
Search, 343
Search control panel, 347
Search For, 344
Search In, 344
search using a mask, 345
secondary marker, 430
Security tab, 27
Options control panel, 28
Select all
Replay menu, 358
Select data records tab, 355
Select records from history
Replay menu, 358
SEM display, 208
sensitivity, 430
Set to max BW, 112
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OFDM Power, 238
OFDM Summary, 241
OFDM Symbol Table, 243
Options control panel, 27
Phase Error vs. Time, 298
Phase Noise, 186
Phase Settling Time, 196
Phase vs. Time, 108
Pulse Statistics display, 257
Pulse Table display, 252
Pulse Trace display, 255
restoring defaults, 21
RFI & Q vs. Time, 110
Signal Quality, 303
Spectrogram display, 99
Spectrum display, 95
Spectrum Emission
Mask, 211
Spurious display, 173
Symbol Table display, 305
Time Overview display, 90
Trellis Diagram display, 307
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Settled Frequency
definition, 189
Settled Phase
definition, 189
settling time
measuring, 197
Settling Time, 189
definition, 189
Settling Time decimal places
Settling Time displays, 208
settling time measurement
text color, 195
Setup Menu, 401
setups
saving, 379
shape factor (skirt
selectivity), 430
Show graticule
General Signal Viewing
Displays, 120
Pulsed RF displays, 267
Settling Time displays, 208
Show Marker Readout in Graph
General Signal Viewing
Displays, 120
Pulsed RF displays, 267
RF Measurements
displays, 225
Settling Time displays, 208
Show recalled trace, 114
AM display, 128
FM display, 137
PM display, 144
Time Overview display, 91
signal, 430
Signal Power
Audio Summary display, 271
Signal Quality display, 298
Signal quality measurements, 301
Signal Quality settings, 303
signal strength, 149
SINAD
Audio Summary display, 272
Single, 400
sluggish operation, 413
span, 430
span per division, 431

Span/RBW Ratio

Spectrum display BW

tab, 118

spectrogram, 431
Spectrogram display, 97
Spectrogram display settings, 99
spectrum, 431
Spectrum

DPX display, 62
spectrum analysis, 431
spectrum analyzer, 431
Spectrum Center Frequency, 351

Frequency tab, 352
Spectrum display, 94
Spectrum display settings, 95
Spectrum Emission Mask

display, 208

settings, 211
Spectrum Monitor

Spectrogram, 102
spectrum time, 431
Spectrum Time tab, 351
Spectrums/line, 99
Split

DPX display, 62
spur, 431
Spur

defining, 179
Spurious, 169
Spurious display settings, 173
spurious response, 432
Standard

Audio Filters tab, 276
Standard settings button

SEM display, 211
Standard Settings button, 308
Start (Hz)

Ranges and Limits table, 178
Status Bar, 399
Step size

Freq & BW tab, 72
Stop

Replay menu, 358
Stop (Hz)

Ranges and Limits table, 178
Sweep time, 71
symbol maps, 324
Symbol Rate, 36
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Symbol Table display, 304
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settings, 305

T
Taps

Equalizer tab, 314
Taps/Symbol

Equalizer tab, 314
Target Reference

Frequency Settling Time, 202
THD

Audio Summary display, 272
Thrshld (dBm)

Ranges and Limits table, 178
Thunderstorm color scheme, 29
Time, 38
Time & Freq Scale tab

Spectrogram display, 101
Time measurement, 432
Time Overview, 88
Time Overview display

settings, 90
Time Params tab

Settling Time displays, 203
time reference, 432
time scale status readout, 99
TIQ acquisition data files, 29
TIQ acquisition data files

parameters, 28
TNHD

Audio Summary display, 272
Tolerance (+/-)

Frequency Settling Time, 202
Tools Menu, 402
Total AM

AM display, 36
Touch Screen, 13
Touch Screen Off, 9
Touch-screen Actions, 13
trace, 432
Trace 2

Constellation display, 322

Trace motion for Sweep
>1sec, 71
Trace tab
AM display, 128
FM display, 137
GP Digital Modulation
displays, 321
OFDM Analysis
displays, 248
PM display, 144
Settling Time displays, 204
Time Overview display, 91
Traces tab
DPX Bitmap, 72
DPX display, 75
DPXOgram view, 72
General Signal Viewing
displays, 114
RF Measurements
display, 220
Spectrogram display, 100
Traces tab — Math Trace
General Signal Viewing
displays, 117
Transform Window
Spectrum display BW
tab, 118
Trellis Diagram display
settings, 307
trigger signals
connecting, 390
troubleshooting, 404
Tx BER
measuring, 83
overview, 68
tab, 83
user pattern file format, 84

U

Uniform (None) Filter Shape
Spectrum display BW
tab, 118
Units tab, 355
Upgrades, 404
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loading, 329

user pattern file format
Tx BER, 84

User presets, 22

User Symbol Map, 317

vV

VBW, 97
Channel Power & ACPR
display, MCPR
display, 160
RF Measurements
displays, 219
Spectrum display BW
tab, 118
VBW (Hz)
Ranges and Limits table, 178
VBW On
Ranges and Limits table, 178
vector signal analyzer, 432
vertical scale factor, vertical
display factor, 432
View Menu, 398
violation, 433

W

Waterfall
Spectrogram/DPXo-
gram, 101
Spectrogram/DPXogram
display, 80
Window menu, 404
Windows Event Viewer, 411

X

x dB BW Ref Power, 165
x dB Level, 169

V4

Zero Span
DPX display, 62
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